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In this document, MONTAGE M6, MONTAGE M7, and MONTAGE M8x are collectively called
“MONTAGE M.”

Indication Description

Indicates that malfunction, failure, or data loss may occur.

Indicates supplemental information.

About this manual

Information

The illustrations and LCD screens as shown in this Operation Manual are for instructional
purposes only.

Unless indicated otherwise, the illustrations and displays as shown in this Operation Manual
are based on the MONTAGE M6 (in English).

Lightning is the trademark of Apple Inc., registered in the U.S. and other countries.

The MIDI 2.0 logos ( ) are trademarks or registered trademarks of the Association of
Musical Electronics Industry (AMEI) and THE MIDI MANUFACTURERS ASSOCIATION
INCORPORATED (MMA).

The company names and product names in this manual are the trademarks or registered
trademarks of their respective companies.

Indications in this document

Model name

Others
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The information on how to use the Operation Manual (HTML) is shown below. For more
information on how to use the PDF version, refer to the manual for your viewer software.

Enter the keyword in the search box on the upper right corner to search within the Operation
Manual.

To add to the Bookmarks, click the star icon on the right of the heading title.
To remove a bookmark, click the “ ” on the right of the heading title.

Click or tap the icon at the bottom of the page and select the printer.

Using the MONTAGE M Operation Manual

Searching

Bookmarking

Printing out
Saving the page as a PDF file
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New features;

Fixed problems;

Fixed problems;

Fixed problems;

New features;

Fixed problems;

Firmware versions

v1.22 to v2.00

A new effect type (Shimmer Reverb) has been added.

New waveforms (New CFX and CP80) and Performances have been added.

Wave Folder has been added to AN-X Parts.

The AN-X Smart Morph function has been added.

Now supports the MIDI 2.0 Protocols.

Improvements have been made to the user interface.

Fixed other minor problems.

v1.21 to v1.22

Fixed a problem in which some Performance information is not loaded properly when loading
the following model files.
* MOTIF XS, MOTIF XF, MOXF, MONTAGE, MODX, MODX+

v1.20 to v1.21

Fixed a communication error with Expanded Softsynth Plugin for MONTAGE M.

v1.11 to v1.20

Now supports Expanded Softsynth Plugin for MONTAGE M.

You can now see the parameter values when operating the knobs while a graph is displayed
on the Sub display.

You can now make partial changes to the font size on the Live Set screen and the Category
Search screen.

Improvements have been made to the user interface.

v1.10 to v1.11

Fixed a problem in which Keyboard AT Mode also affects MONTAGE M6/7.

Fixed other minor problems.
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New features;

Fixed problems;

v1.00 to v1.10

New Performances have been added.

Improvements have been made to the user interface.

Fixed other minor problems.
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This chapter explains the basic structure of MONTAGE M and how to use it.

Contents

Using the MONTAGE M

Basic structure

Setting up for Live Performance

Recording and playing back

Managing backup files of your Performances

Using microphones and audio devices

Connecting external MIDI instruments
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Contents

Basic structure

Block diagram and data flow

Tone generator block

Internal memory
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This instrument consists of eight main functional blocks: Controller, Motion Sequencer, Tone
Generator, Effects, Sequencer, Arpeggio, Envelope Follower, and A/D Input.

(Click or tap the text in the functional block to jump to the corresponding page.)

(1) Control message

Block diagram and data flow
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(2) Audio signal
(3) Controller
(4) Motion Sequencer
(5) Tone Generator
(6) Effects
(7) Sequencer
(8) Arpeggio
(9) Envelope Follower
(10) A/D Input
(11) Control Matrix
(12) Computer
(13) External MIDI equipment
(14) Microphone, audio equipment, etc.
(15) Powered speakers, etc.
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The tone generator block is equipped with a hybrid sound engine combining three synthesis
systems.

The AWM2 sound engine features waveforms containing sampled wave data you can assign to
each element, and then modify the sound by using Filters and EGs (envelope generators). Each
Normal Part uses up to 128 elements to generate a wide range of rich sounds that help you
create expressive sounds. Since the “raw” waveforms sampled from the actual acoustic
instruments have been processed to enable each note to be used for various music, this sound
engine produces the realistic sound of musical instruments such as piano and wind instruments,
for example. You can use this sound engine not just for reproducing realistic instrument sounds
but also for creating completely new sounds by using filters and the EG. For the Drum Part, you
can use up to 73 drum keys to assign the waveforms of percussion sounds to each key on the
keyboard to create a desired drum kit.

Tone generator block

AWM2 sound engine

Normal Part
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The Drum Part has a maximum of 73 drum keys you can use for creating desired drum kits by
assigning the waveforms of percussion sounds to each key on the keyboard.

The FM-X sound engine uses eight oscillators (Operators) to modulate the frequency of the
waves generated by each Operator to create rich harmonic overtones.
The Operators are grouped into two roles: Carrier and Modulator. The Modulators modulate the
next Operator while the Carriers generate the resulting sounds. The function in which the
Operator modulates itself is called “feedback.” The FM-X sound engine features pre-
programmed Algorithms that have 88 different patterns for connecting the Operators. With this
sound engine, you can use the parameters to control the harmonic overtones of the Operator
waves and apply the same high-quality filters, effects, and EQ available in the AWM2 sound
engine to create more complex sounds than possible with conventional FM sound engines.

Drum Part

Individual drum sounds (different for each key) (C0 to C6)

FM-X sound engine
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(1) Feedback
(2) Modulator
(3) Carrier
(4) Operator
(5) Frequency Modulation
(6) Algorithm
(7) Example of FM (Frequency Modulation)
(8) Modulator wave
(9) Carrier wave
(10) Modulated wave

The AN-X is a virtual analog sound engine that digitally reproduces the behavior of analog
synthesizers in great detail.
With their traditional and innovative features, the oscillators of this next-generation AN sound
engine provide more flexibility in modulation and wave-shaping functions so that you can create
a wide variety of sounds—from “real” vintage to edgy and extreme.

AN-X sound engine

Features three Oscillators and one Noise generator.

OSC3 modulates OSC1 and OSC2 (either with frequency modulation or ring modulation)

Each OSC controls the shape of the waves by using Pulse Width, OSC Self Sync, or Wave
Shaper.

You can set each OSC to output before or after Filter 1 and Filter 2.
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The internal memory of this instrument holds the saved Performances, Live Sets, Songs, and
other settings.
This chart shows the data flow between the internal memory and the external device.

(Click or tap to enlarge the image.)

Contains the Preset Performances, Preset Arpeggios, Preset Audition Phrases, and other
settings.
You cannot overwrite the data in the Preset memory since it is read-only.

Internal memory

Preset memory
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The Edit buffer is the work area for editing Performances, Live Sets, Songs, and other settings.
This work area allows both reading and writing, and the contents within this work area are
erased when the instrument is turned off.
The edited Performances and Motion Sequences should be saved to the User Memory before
selecting a different Performance or turning off the instrument.
(Other settings are saved automatically.)

The User memory has two areas: User and Library.

The User area holds the stored Performances and Motion Sequences, and other settings for the
entire instrument, such as Utility settings and other User data edited in the Edit buffer.
When a User Performance is edited, you can store it as a new Performance or overwrite the
existing Performance.

The Library area allows up to 16 library files (.Y2L) to be loaded from the USB flash drive. The
settings saved in the Library area cannot be edited. To edit the settings in the Library area, send
the data to the Edit buffer by selecting a Performance stored in the Library area or loading a
Motion Sequence from the Library area. After editing, the data will be saved to the User area.

The User memory is used for reading and writing, and the data within this area will be retained
after the instrument is turned off.

The Recall buffer and Compare buffer are areas used for temporarily saving the settings you
are editing.

The Recall buffer is used as a backup for the Edit buffer.
If you accidentally changed to a different Performance without first storing the setting, you can
use the Recall function to restore the temporarily saved settings from the Recall buffer to the
Edit buffer.

The Compare buffer is the area for keeping settings before making edits. By using the Compare
function, you can bring the settings temporarily saved in the Compare buffer to compare the
edited and unedited sounds.

Edit buffer

User memory

Recall buffer and Compare buffer
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These buffers are for reading and writing data, but the settings will be lost when the instrument
is turned off.
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Shown below is a general workflow guide for the MONTAGE M.

1 Selecting a Performance

Select from the Live set screen or from the Category Search screen.

2 Editing the settings

3 Saving edited settings

4 Creating a Live Set

5 Selecting a Live Set

6 Playing the keyboard

Setting up for Live Performance
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1 Press the [LIVE SET] button.

The Live Set screen appears.

2 If necessary, press the [BANK] button and the [PAGE] button to select a
different screen. Find a Performance you would like to use, and tap the
Performance name on the screen to select it.

Selecting a Performance from the Live Set screen
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The Category Search function allows you to search through Performances, Parts, Rhythm
Patterns, Arpeggios, and Waveforms to find ones you would like to use.
To search for a desired Performance, open the Performance screen, and press the
[CATEGORY] button to open the Performance Category Search screen.
While the Category Search screen is shown, you can use the buttons on the Top Panel to
change the Part Select, Mute or Solo settings.

NOTE
You can also select a Performance by placing the cursor on the Performance Name on the Home screen and
using the data dial, [INC/YES] button, and [DEC/NO] button.

1 Press the [CATEGORY] button.

The Performance Category screen appears.
You can also open the Performance Category Search screen by selecting Category
Search from the context menu for the Performance Name.

(1) Filter
You can use the filter to search through the list of Performances.

Selecting a Performance from the Category Search screen
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NOTE

Select one from Main and Sub.

Select an attribute or combinations of attributes. Depending on the combination,
the filter uses the conditions AND or OR.

You can use the OR condition for categories by pressing the appropriate Category name
selection buttons.
You can also set the OR condition by tapping the category name while holding the [SHIFT]
button.
You can select a Sub category also by simultaneously holding down the [SHIFT] button and
pressing one of the Slot number and Category name selection buttons.

Category

Attribute
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Filter:

Exact match · AWM2, FM-X, and AN-X

AND condition · MC, SSS, and Smart Morph

OR condition
· Single, and Multi
· MOTIF XF, MONTAGE, and MONTAGE M

(2) Bank
(3) Search by keyword
(4) Job
(5) The list of the Performances that correspond to the selected Category and Attribute

The current Performance is shown in white; the Single-Part Performances are
shown in green; and the Multi-Part Performances are shown in blue.

(6) Changing the sort order
(7) Audition

2 Change the filter, bank, and sort order, as needed.

3 Select one from the list shown on the right.

Move the cursor by using the Data dial, up and down buttons, [INC] button, or [DEC]
button.
By using the PAGE buttons or the Display knobs on the top panel, you can scroll down
without changing the Performance.

NOTE
Simultaneously hold down the [SHIFT] button and use the slot number buttons 9 to 16 to select a
specific Performance.

4 To close the Performance Category Search screen, press the [ENTER]
button or [EXIT] button or [PERFORMANCE] button on the top panel, or
tap the  (Home) icon or the  (Exit) icon on the screen.

NOTE
You can use the Part Category Search function if you wish to change one of the Parts in a Multi-Part
Performance (a Performance that has more than one Part).
To open the Part Category Search screen, select a Part you wish to change, and then press one of the
[CATEGORY] buttons while holding down the [SHIFT] button.
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By using the Audition Phrase, you can listen to the sound of the Performance and hear how the
sound will change by operating the controllers, before the selection is finalized.

1 Press the [AUDITION] button on the top panel or tap the Audition button
on the Category Search screen.

The Audition phrase of the current Performance will be played back.
If you select a new Performance in the middle of the audition phrase playback, the
audition phrase of the new Performance will be played back.

If the [AUDITION] button is turned off, the audition function is not available for the
selected Performance, and nothing happens when you press it.

2 To stop the playback of the audition phrase, press the [AUDITION] button
on the top panel once more, or tap the Audition button on the screen.

Selecting an Initialized Performance or a Single-Part Performance using a
filter

Select an Initialized Performance from the list shown by setting Bank/Favorite to All or Preset
and the Category filter to Init.

Select a single-part Performance from the list shown by setting the Attribute filter to Single.

Listening to the Audition phrases
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There are other functions for adjusting the balance between Parts within the Performance or for
quickly switching to different groups of settings that have been registered to the buttons in
advance.

Contents

The Mixing function allows you to adjust the balance between Parts.
The Pan, Volume, and other settings for all Parts are shown on one screen for ease in adjusting
the Mixing parameters for the Performance.

1 Tap to open the screen from the [PERFORMANCE] → Mixing.

The Mixing screen appears.

Using overall functions for the entire Performance

Adjusting the balance between Parts (Mixing)

Procedure for mixing

Using Scenes

Procedure for registering a Scene

Registering Scenes from the Scene screen

Registering the Scenes from other screens

Adjusting the balance between Parts (Mixing)

Procedure for mixing
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(1) Main category for each Part
(2) Switching views for Solo, Mute, and Keyboard Control
(3) Switching between 3-band EQ and 2-band EQ views
(4) EQ for each Part
(5) Parameters for each Part
(6) Switching to 16-part view
(7) Audio part view (16-part view not shown)

With the Audio part, you can set the parameters for the audio input from the A/D INPUT jacks

and the [USB TO HOST] terminal (Digital* Part).

* Refers to the audio set to Digital L/R in audio channels.

2 Select a parameter by using the PART buttons or cursor buttons on the
top panel, or tap the icons and buttons on the screen.

3 Change the value by using the Data dial or relevant Display knob.

If you need to fine-adjust the value, press the [EDIT/ ] button while the Mixing screen
is shown on the display to open the Edit screen.

The Scene is a “snapshot” of various settings, such as Arpeggio type, Motion sequence type,
and Part parameters. By registering different Scenes to each of the eight SCENE buttons, you
can use the SCENE buttons to recall different settings instantly.
This would be convenient, for example, when you wish to change only the Arpeggio and Motion

Using Scenes
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Sequence types, without changing the Performance, to follow the progression of a song, or to
bring out a different aspect of a Performance.

1 Open the screen from the [PERFORMANCE] → Scene.

The Scene screen appears.

(1) Scene tab
(2) Memorize switch
(3) Settings for the tab

When the Memorize switch is On, the parameters for the function appear on the
screen.

2 Setup Scenes 1 to 8.

The functions to which Memory (Memorize Switch) has been set to On will be registered
to the selected SCENE button.
The newly set Scene now becomes active when you press the appropriate SCENE
button.

3 Press the [STORE] button to save the Scene settings to the Performance.

Procedure for registering a Scene

Registering Scenes from the Scene screen
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NOTICE

Make sure to save (store) the Scene settings you have just edited before changing to a
different Performance or turning off the instrument. Without performing the Store operation,
the Scene settings will be lost.

If a parameter that can be registered to a Scene is already assigned to a knob or a control
slider, move the knob or the control slider. Then, simultaneously hold down the [SHIFT] button
and press the SCENE button. After that, press the [STORE] button to save the Scene settings to
the Performance.

Registering the Scenes from other screens
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Contents

Editing the settings

Using Split and Layer

Procedure for editing

Procedure for Full Edit

Using the Navigation screen

Procedure for Quick Edit

Creating tonal changes

Effect connections and settings

Changing the Effect settings

Using Arpeggio

Turning Arpeggio on and off

Changing Arpeggio by using the knobs

Changing the way Arpeggio playback is turned on or off

Using Motion Control

Basics for Motion Control

Customizing the Super Knob settings

Controlling the Super Knob from the pedals

An example of a Super Knob setting

Using Motion Sequencer

Turning Motion Sequencer on or off

Changing Motion Sequencer by using the knobs

Changing the way Motion Sequence is triggered

Editing the Motion Sequence

Using the Envelope Follower

An example of setting the Envelope Follower from the Rhythm Pattern screen

Using Smart Morph
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Split allows you to divide the keyboard into sections to play each section with a different sound,
while Layer allows you to combine multiple sounds on top of each other on a Split section or
across the entire keyboard.
To set up splits and layers on the MONTAGE M, use the Split Points to make the groups of
keyboard sections and assign a Part to each group.

To open the Split setting screen, press the [SPLIT] button.
The Split Job screen for the Performance appears, allowing you to change the Split settings.
By tapping the items on the screen to specify the number and position for the Split Point, you
can set the key range and select a sound for each Part.
By tapping the group button (A, B, C, D) on the screen while holding down the [SHIFT] button,
you can set the Part for more than one group.

When the setup is finished, press the [EXIT] button on the top panel or tap Done on the screen.

Tapping  on the upper left cancels the setup and closes the screen.

To change the note range, simultaneously hold down the [SHIFT] button and press the [SPLIT]
button.
This calls up the Part—Note view of the Performance screen, allowing you to change the note
range of each Part.
Set the value by using the built-in keyboard or Data dial.

Using Split and Layer

28



Editing refers to the Full Edit functions using the Main display and Quick Edit functions using the
Sub display.
You can use Full Edit to access all editing functions and use Quick Edit to instantly access some
frequently used parameters.
By using the [PAGE JUMP] button, you can edit the same parameter from Full Edit and the
Quick Edit.
Also, you can use different screens for the Main display and the Sub display to monitor multiple
parameters at once while switching between Full Edit and Quick Edit.

(1) Quick Edit (View the Sub display)
(2) Full Edit (View the Main display)

1 Select a Performance.

2 On the Performance screen, move the cursor to the desired Performance
Name or Part.

3 Press the [EDIT/ ] button or tap Edit in the context menu.

The Common Edit screen will appear when the cursor is on the Performance Name.
The Part Edit screen for the sound engine will appear when the cursor is on the Part.

4 Select a tab on the first and the second rows to open the screen.

For selecting a tab, you can simultaneously hold down the [SHIFT] button and use the
appropriate Slot number and Category name selection buttons, or simply tap the tab on
the screen. (Refer to the Quick Guide.)

Procedure for editing

Procedure for Full Edit

Example: Normal Part (AWM2)
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Changing the settings in each tab from the top to the bottom is recommended.

5 Edit the settings by changing the parameters shown on the right of the
tabs.

6 Continue editing the parameters on different tabs if necessary.

The target for editing will be shown on the navigation bar.
Select Common for editing the settings for the entire Performance.
Select Part Common for editing the settings for the entire Part.
If you wish to go into detailed settings, select one of the following: Element 1 to 128,
Operator 1 to 8, Oscillator 1 to 3, Noise, and C0 to C6 keys of the Part.

7 When you’ve finished editing, press the [STORE] button to save the
Performance.

You can change the parameter to be edited by opening the Edit screen from:
[PERFORMANCE] → [EDIT/ ] and selecting the desired item from the Navigation
bar.

1 Press the [NAVIGATION] button.

The NAVIGATION screen appears.

Using the Navigation screen
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When you press the [NAVIGATION] button during editing, you can easily find where you
are  on the map.

2 Select the desired parameter for editing.

Select Part Common for editing the settings for the entire Part.
If you wish to go into detailed settings, select one of the following: Element 1 to 128,
Operator 1 to 8, Oscillator 1 to 3, Noise, and C0 to C6 keys of the Part.

3 Select the icon for the setting you wish to change.

Use the Cursor buttons to move the cursor and then press the [ENTER] button. Or, tap
the icon on the screen.

4 Change the parameters shown on the screen.

5 Save the Performance.

1 Use the [QUICK EDIT] button, Tab PAGE buttons, and Tab selection
buttons to change pages and tabs on the Sub display.

Procedure for Quick Edit

31



2 Use Knobs 1 to 8 to change settings.

3 To fine-adjust the settings, press the [PAGE JUMP] button to call up the
corresponding parameter on the Main display.

NOTE
If you have changed to a different tab on the Main display, you can call up the corresponding
parameter on the Sub display by simultaneously holding down the [SHIFT] button and pressing the
[PAGE JUMP] button.
(The parameter may not appear in some cases.)

For creating tonal changes, you can use Oscillators, filters, EGs (or Envelope Generators),
LFOs (or Low-Frequency Oscillators), and effects. By changing those parameters, you can
change the brightness, resonance, or other timbral qualities of the sound.
The available settings are different depending on the sound engine type. Some parameters
(below) are commonly used for all sound engine types.

Creating tonal changes

Oscillator (Osc): Creates the basic sound waves

Pitch: Controls the pitch

Filter: Controls the cutoff frequency

EG: Determines how the sound changes over time

LFO: Determines the cyclical change of the sound

Motion Sequencer: Creates complex changes to the sound over time

Effects: Processes the sound
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The effects available on the MONTAGE M include System effects which are applied to all Parts
in the Performance, Insertion effects which are applied to each Part, Master effects which are
applied to the final output, and Equalizers such as Part EQ and Master EQ. The signal flow
diagram for the effects is shown below.

Effect connections and settings

33



(1) Setting the Part EQ and Insertion effects
[PERFORMANCE] → Part selection → [EDIT/ ] → Effect

(2) Setting the Variation and Reverb effects
[PERFORMANCE] → Part selection → [EDIT/ ] → Effect → Routing
[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Variation
[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Reverb

(3) Setting the Master effect
[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Master FX
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(4) Setting the Master EQ
[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Master EQ

NOTE
The effects for the audio input from the A/D INPUT jack can be set from: [PERFORMANCE] → Common
selection → [EDIT/ ] → Audio In.

For information on the effect category and effect types, see the Effect types.
For information on the Preset program for each effect type, refer to the Data List.

You can change the effects using Full Edit and Quick Edit.
By pressing the [NAVIGATION] button while holding down the [SHIFT] button, the FX Overview
screen will appear, and you can see an overview of the effect settings.
Tap the buttons on the effect names such as Ins A and Var to open the Edit screen.

The Arpeggio function on the MONTAGE M allows you to play typical Arpeggios, as well as add
more complicated rhythm patterns and backing tracks to your keyboard performance. It not only
provides inspiration and full rhythmic passages in your live performances, but it gives you fully
formed instrumental backing parts of various music genres for ease in creating songs.
You can assign the desired eight Arpeggio Types to each Part and simultaneously play back
Arpeggios of up to eight Parts.
Also, you can set the note range (Note Limit) or the strength of the key pressure (Velocity Limit)
for Arpeggio playback.

Changing the Effect settings

Using Arpeggio
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The Arpeggio function lets you play Accent Phrases (the sequence phrase played only when the
keyboard is played at a higher velocity than the specified value) or effect sounds such as guitar
fret noises using the Random SFX function. Some Preset Arpeggio Types are set to play back
Accent Phrases and Random SFX sounds. You can find the Accent Phrases and Random SFX
sounds by using the Arpeggio Category Search screen and checking Accent (Accent Phrase) or
Random SFX for Attribute.

To turn the Arpeggio function on or off, press the [ARP ON/OFF] button on the top panel.

By pressing the [QUICK EDIT] button to select SELECTED PART and then using the Tab
selection buttons to select the ARP/MS tab, you can then use Knobs 1 to 7 to change the
Arpeggios.
Modify the Arpeggios by turning the knobs and listening to the Arpeggio playback. Check the
names of the parameters assigned to Knobs 1 to 7 on the Sub display.
If you wish to fine-tune the settings, press the [PAGE JUMP] button to switch to the Main display
to continue editing.

Normally the Arpeggio is played back while a key is being pressed. However, you can change
the settings so that the Arpeggio continues to be played back after the finger is lifted off from the
key.

The way the Arpeggio playback is turned on or off can be set with Hold and Trigger Mode.

Turning Arpeggio on and off

Changing Arpeggio by using the knobs

Changing the way Arpeggio playback is turned on or off
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[EDIT/ ] → Part selection → Common → Arpeggio → Common

[EDIT/ ] → Part selection → Common → Arpeggio → Advanced

Played back only while a key is being pressed
Hold: Off
Trigger Mode: Gate

Playback continues after the finger is lifted off from the key
Hold: On
Trigger Mode: Gate

Playback is turned on or off each time the key is pressed
Trigger Mode: Toggle
(regardless of the Hold settings)

NOTE
When Arp Master and Arp Part are set to ON, you can turn on the [KEYBOARD HOLD] button on the top
panel to achieve the same effect as setting Hold to ON.

The Motion Control function lets you create Motion (rhythmic and dynamic sound changes) in
real-time, so you can find completely new ways of expression. This function allows you to make
the settings in advance so that you can change the parameters without actually operating the
pedals or wheels. This lets you create dramatic and powerful expressive changes that follow the
beat of your music.

Hold

Trigger Mode

Using Motion Control
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(1) Continuous control of Motion changes
(2) Switch between Motions
(3) Trigger
(4) Control the Motion Sequencer in real time
(5) Rhythmic change
(6) Automation
(7) Multi-dimensional sonic change
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Motion Control can be set by setting the Source for the Controller as well as the control target
(Destination and Parameter) from the Control Assign screen.

For Super Knob, set the Display Filter to SuperKnob and then set the Source (AsgnKnob 1–8)
and Destination.
For Motion Sequence, set the Source to a Motion Sequence Lane from 1 to 4.
For Envelope Follower, set the Source to EnvFollow.

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → Control Assign
[PERFORMANCE] → Part selection → [EDIT/ ] → Mod/Control → Control Assign

By using the Super Knob, you can simultaneously control the Assign 1 to 8 values that are
assigned to Knobs 1 to 8 that are common to all Parts.

Moving the Super Knob while playing the keyboard lets you modify sounds, and you can see
the parameter values on the Sub display.
If the [ASSIGN] button is turned on (and the button is lit), you will see the changes to the Knobs
1 to 8 on the indicator and the Sub display.

By combining the Super Knob and the Motion Sequencer, you can achieve more complex
sound changes.

Basics for Motion Control

Customizing the Super Knob settings
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You can control the Super Knob from the separately sold Foot controller (FC7) connected to the
MONTAGE M.
Follow the procedure shown below.

1 Connect the Foot Controller (FC7) to the FOOT CONTROLLER jack on the
rear panel.

2 Open the screen from: [PERFORMANCE] → [EDIT/ ] → Control →
Control Number.

3 Select SuperKnob for Foot Ctrl1 or Foot Ctrl2, depending on the jack you
have connected the foot Controller to.

4 Close the screen to finish the setup.

The Super Knob settings can be customized.
You can set two or three fixed values for using the Super Knob for morphing sounds. For setting
three fixed values, you need to first enable the Mid setting.

Here, we will explain how to add morphing effects to the layered sound made with three Preset
Performances (acoustic piano, pad sound, and electric piano) while keeping the original settings

Controlling the Super Knob from the pedals

An example of a Super Knob setting

An example of morphing using three fixed values:
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for these Performances.

1 Select sounds for Parts 1 to 3

1-1. Press the [CATEGORY] button and select CFX PopStudioGrand.

1-2. From the Home screen, tap the [+] icon Part 2 to open the Part Category
Search screen and select AN-X Sine Pad PAT.

1-3. From the Home screen, tap the [+] icon on Part 3 to open the Part Category
Search screen and select TV Show FM EP.

2 Set the parameters for Part 1.

2-1. Select Part 1.

2-2. Press the [CONTROL ASSIGN] button while holding down the [SHIFT] button.

The Control View screen appears.

2-3. Turn the Super Knob.

The Control Assign screen appears.

2-4. By tapping the [+] icon, Destination 10 will be added.

Workflow

Select sound for Parts 1 to 3 (Step 1)

Set up the Super Knob to allow the control of the parameters for Parts 1 to 3 (Steps 2 to 4)

Check the settings (Step 5)

Set the parameters for the Super Knob for the leftmost, mid, and rightmost positions. (Steps 6
to 8)
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2-5. Tap the Destination 10 tab and select Volume from Part Param.

2-6. Set Polarity (Curve Polarity) to Bi and set Ratio (Curve Ratio) to +127.
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3 Set the parameters for Part 2.

3-1. Select Part 2.

3-2. Press the [CONTROL ASSIGN] button while holding down the [SHIFT] button
and then turn the Super Knob.

The Control Assign screen for Part 2 appears.

3-3. Tapping the [+] icon adds Destination 7.

3-4. Tap the Destination 7 tab and select Volume from Part Param.

3-5. Set Polarity (Curve Polarity) to Bi and set Ratio (Curve Ratio) to +127.

4 Set the parameters for Part 3.

4-1. Select Part 3.

4-2. Press the [CONTROL ASSIGN] button while holding down the [SHIFT] button
and then turn the Super Knob.

The Control Assign screen for Part 3 appears.

4-3. Tapping the [+] icon adds Destination 8.

4-4. Tap the Destination 8 tab and select Volume from Part Param.

4-5. Set Polarity (Curve Polarity) to Bi and set Ratio (Curve Ratio) to +127.

5 Check to make sure that the parameters for Parts 1 to 3 are set to
Common Assignable Knob.

5-1. Press the COMMON button for Part select.

5-2. Press the [CONTROL ASSIGN] button while holding down the [SHIFT] button
and then turn the Super Knob.

The Control Assign screen for the common part appears.
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5-3. Tap each of the Destination 6 to 8 tabs to check that the Source is set to
AsgnKnob 6 to 8 respectively, and the Destination Parameter is set to Part 1
to 3 Volume.

6 Set the LEFT position on the Super Knob.

This makes the settings for the Super Knob when turned all the way to the left.

6-1. Press the KNOB POSITION [LEFT] button.

6-2. Make sure that the COMMON is selected for Part select and then press the
[ASSIGN] button.

6-3. To set only the CFX PopStudioGrand on Part 1 to sound, turn Knob 6
(Assign6) all the way to the right (to the maximum value) and Knob 7
(Assign7) and Knob 8 (Assign8) all the way to the left (to the minimum
value).

6-4. Save the settings by simultaneously holding down the [SHIFT] button and
pressing the KNOB POSITION [LEFT] button.

7 Set the RIGHT position on the Super Knob.

This makes the settings for the Super Knob when turned all the way to the right.

7-1. Press the KNOB POSITION [RIGHT] button.

7-2. To set only the TV Show FM EP on Part 3 to sound, turn Knob 8 (Assign8) all
the way to the right (to the maximum value) and Knob 6 (Assign6) and Knob
7 (Assign7) all the way to the left (to the minimum value).

7-3. Save the settings by simultaneously holding down the [SHIFT] button and
pressing the KNOB POSITION [RIGHT] button.
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8 Set the Mid position on the Super Knob.

Enable the Mid position and then turn the Super Knob to set the value for the middle
position.

8-1. Hold down the [NAVIGATION] button.

The NAVIGATION screen appears.

8-2. Tap on SUPER KNOB and open the screen for the Super Knob settings.

8-3. Set the value 512 for the Mid position.

8-4. Press the KNOB POSITION [MID] button.

8-5. To set only the AN-X Sine Pad PAT on Part 2 to sound, turn Knob 7 (Assign7)
all the way to the right (maximum value), and Knob 6 (Assign6) and Knob 8
(Assign8) all the way to the left (minimum value).

8-6. Save the settings by simultaneously holding down the [SHIFT] button and
pressing the KNOB POSITION [MID] button.

The main setting is now complete.

Adjust the Curve type, Ratio, and Param for each Part, LEFT, RIGHT, and MID for the KNOB
POSITION if desired.

The Motion Sequencer function lets you create sound changes by controlling parameter times
according to a sequence you create in advance.

Tweaking the settings

Using Motion Sequencer
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It allows you to set up rhythmical changes that are in sync with the Performance tempo,
Arpeggio, or the rhythms input from the connecting device and to control such changes
interactively and in real-time according to the progression of the song.

With the Motion Sequencer, you can use up to four lanes per Part, or eight lanes for a
Performance. You can use up to eight sequence patterns per lane.

You can also set the velocity range for playing the sequence, the way the sequence is played,
or the number of Steps to play the same way you would with the Arpeggio.

The parameters for each lane can be set in the procedure shown below.
[PERFORMANCE] → Part selection → [EDIT/ ] → Motion Seq → Lane

To turn Motion Sequencer on or off, press the [MSEQ ON/OFF] button on the top panel.

By pressing the [QUICK EDIT] button to select SELECTED PART and then using the Tab
selection buttons to select the ARP/MS tab and using the Tab PAGE buttons to select Motion

Turning Motion Sequencer on or off

Changing Motion Sequencer by using the knobs
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Sequence, you can then use Knobs 1 to 8 to change the Motion Sequencer.
Modify the Motion Sequencer settings by turning the knobs and listening to the Motion
Sequencer playback. Check the names of the parameters assigned to Knobs 1 to 8 on the Sub
display.

The way Motion Sequence is triggered can be set with the LaneSw and Trigger parameters.

[PERFORMANCE] → Part selection → [EDIT/ ] → Motion Seq → Lane

Plays back the Motion Sequence when you press a key
LaneSw: On
Trigger: Off

Plays back the Motion Sequence when you press the [MSEQ TRIGGER] button
LaneSw: On
Trigger: On
Sync: Other than Arp

Motion Sequence is comprised of up to 16 steps.
Edit each Step from the Edit Sequence screen.

Changing the way Motion Sequence is triggered

LaneSw, Trigger

Editing the Motion Sequence
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Envelope Follower is the function that extracts the envelope of the waveform from the audio
input and is used as a controller for creating changes in the sound. It allows the output of Parts
and the output from the external device connected to the A/D INPUT jack.

For example, you can set the Envelope Follower of the Part you have assigned a Rhythm
Pattern as a Source to create changes in other Parts. It is useful, for example, when you wish to
lower the volume of a Part while a certain other Part is being played (i.e., ducking).

Each Envelope Follower has its own input source, such as EnvFollow 1 for Part 1, EnvFollow 2
for Part 2, and EnvFollow AD for the Audio Part. The output from each Envelope Follower can
be changed by selecting a different Source from the Control Assign screen.
For example, you can set up the Envelope Follower for Part 1 (EnvFollow 1) to create changes
in Part 2. How the sound is modified by the output from each Envelope follower can be set from
the Control Assign screen.

Using the Envelope Follower
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(1) Input signal to Envelope Follower (Fixed)
(2) Output signal from Envelope Follower (The Destination can be changed)

Settings for the Envelope Follower:

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Routing → Envelope
Follower (EnvFollow MST)

[PERFORMANCE] → Common selection → [EDIT/ ] → Audio In → Routing →
Envelope Follower (EnvFollow AD)

[PERFORMANCE] → Part selection → [EDIT/ ] → Effect → Routing → Envelope
Follower (EnvFollow 1–16)
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You can set the Envelope Follower from the Rhythm Pattern screen. This way, you can quickly
access the Envelope Follower parameters often used for the Rhythm Patterns.

1 Press the [SONG/PATTERN] button while holding down the [SHIFT] button
to open the Rhythm Pattern screen.

2 Select a drum sound from the list shown on the left of the screen.

3 Tap the Envelope Follower.

4 Turn on the Envelope Follower switch.

You can play the keyboard to hear the effect of the Envelope Follower.

5 Change the settings as needed.

Here, set Polarity (Curve Polarity) to Bi, Ratio (Curve Ratio) to −63, Gain (Envelope
Follower Gain) to −12dB.

6 If you wish to further edit the settings, tap Edit to open the screen for the
Envelope Follower settings.

You can select a new kit or Arpeggio type for the Rhythm Pattern by simultaneously
holding down the [SHIFT] button and pressing the [SONG/PATTERN] button to go back to

An example of setting the Envelope Follower from the Rhythm Pattern
screen
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the Rhythm Pattern screen. The Envelope Follower settings are retained after selecting a
new kit or arpeggio for the Rhythm Pattern.

Smart Morph is a function that morphs FM-X Parts or AN-X Parts using machine learning.
By using Smart Morph, you can create a new sound for Part 1 from multiple FM-X Parts or AN-X
Parts to play on the keyboard.

The Smart Morph function analyzes each sound assigned to Parts 9 to 16 and plots one dot per
Part on the map. Each dot on the map represents a sound, and the distance between dots
shows the similarities of these sounds.
Pressing the Learn button automatically generates a dot for the new sound between the existing
dots on the map.

When you tap the dot on the map, the sound for that dot will be selected for Part 1.
You can find a new place you like from the map and save its settings to create a new part.

Also, by dragging the dot on the map while playing the keyboard, or by moving the Super Knob
with the movements of two to eight dots assigned beforehand, you can create completely new
sounds.

Using Smart Morph
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After editing, save the Performance you have created in the internal memory.
Saving the settings to internal memory is referred to as the “Store” operation.

NOTICE

1 Press the [STORE] button.

When saving a new Performance, you will see the Store As New Performance message.
If a Performance with the same name is already stored, you will see the Overwrite
Current Perf. and Store As New Performance options.

2 To save it as a new Performance, tap Store As New Performance.

To overwrite the Performance already stored, tap Overwrite Current Perf., and then tap
Store (YES).

3 Type in the Performance name on the Keyboard screen.

Use the keyboard shown on the Main display. Up to 20 alphanumeric characters can be
used for the name.

Saving edited settings

Saving a Performance

When you select a different Performance or turn off the instrument without first storing the
Performance, you will lose the settings you are editing.

The existing Performances on the User bank will be lost when you overwrite them. When
you save Performances you have edited, make sure not to overwrite existing Performances.
Important settings you’ve made should be saved to a USB flash drive (Save). For the save
operation, see “Saving settings to a USB flash drive as a backup file (Save).”
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4 Tap Done when you have finished entering the name.

When the Store operation is complete, the Performance screen will be shown on the
display.
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Contents

The Live Set function is a convenient way to change among different Performances as you play
songs on a setlist, for example.
On the MONTAGE M, you can create a Live Set simply by registering your favorite Performance
to each slot.

You can register a Performance to the Live Set by following the procedure below.

NOTICE

1 Select a Performance from the Performance screen.

Here, the [LIVE SET] button needs to be fully lit or dimly lit.

2 Simultaneously hold down the [SHIFT] button and press the [LIVE SET]
button.

The Live Set Register screen appears.

Creating a Live Set

Registering a Performance on the Live Set slot

Exchanging Performances registered to the Live Set Slots

Registering a Pattern, Song, or Audio file to the Live Set slot

Setting up a footswitch for changing the Live set slot

Registering a Performance on the Live Set slot

Store the Performance you have just edited before registering the Performance to the Live
Set. However, when you register to the Live Set and select Store As New Perf. and Register
or Overwrite Current Perf. and Register, you do not need to store the Performance in
advance.

When you select a different Performance or turn off the instrument without first storing the
Performance, you will lose the edited settings you have made.
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3 Select a slot for registering the Performance.

Move the cursor using the Slot number and Category name selection buttons, or tap the
slot shown on the screen.

4 Select one of the available store operations and press the [ENTER]
button, or simply tap your selection on the screen.

The selected Performance is registered to the slot.

You can exchange the contents of two slots.

1 Open the screen from: [LIVE SET] (or Live Set icon) → User Bank
selection → [EDIT/ ].

The Live Set Edit screen appears.
When the Live set page on the Preset bank or the Library bank is open, the Live Set Edit
screen will not appear.

2 Tap the JOB button on the screen.

The JOB screen appears.

Store As New Perf. and Register: Store as a New Performance and register to the slot
Overwrite Current Perf. and Register: Overwrite the current Performance and register
to the slot
Register without Storing: Register without storing the Performance first

Exchanging Performances registered to the Live Set Slots
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3 Tap the slot you wish to move the Performance from, and then tap the
Exchange button on the screen.

4 Tap the slot you wish to move the Performance to.

The Performances of the two slots will be exchanged.

5 When the exchange is complete, tap Done to end the operation.

NOTE
If you wish the copy or exchange the entire bank or the entire Live set page, simultaneously hold down
the [SHIFT] button and press the [EDIT/ ] button. Then the dialog box will appear.

You can also add Patterns, Songs, or Audio files to Live Set slots. This way, you can select a
slot for playing back a desired Pattern, Song, or Audio file, and then play the Performance on
the keyboard along with it.

1 Open the screen from: [LIVE SET] (or Live Set icon) → User Bank
selection → [EDIT/ ].

The Live Set Edit screen appears.

Registering a Pattern, Song, or Audio file to the Live Set slot

56



2 Select a slot or tap [+] on the screen.

3 Select one of the Slot Types.

Slot Type Type

Perform Performance

Song Song

Audio Audio file

Pattern Pattern

4 Tap the Pattern Name or Audio Name to open the Load screen.

5 Select the desired pattern or file to register to the slot.

6 Tap Done to finish the setting.

NOTE
You can also register a Pattern or Song to the Live Set slot by pressing the [SHIFT] and [LIVE SET]
buttons if the recorded file is selected on the Pattern screen or Song screen.

You can select a different Live Set slot by using a separately sold footswitch, such as the FC4 or
FC5.
Follow the procedure below.

Setting up a footswitch for changing the Live set slot
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1 Connect a foot switch (FC4 or FC5) to the ASSIGNABLE FOOT SWITCH
jack.

2 Open the screen from: [UTILITY] → Settings → MIDI I/O.

The MIDI I/O screen appears.

3 Set FS Assign to Live Set + or Live Set −.

With Live Set +, you can select the next Live set slot in forward order, and with Live Set −,
you can select the next Live set slot in reverse order.
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For ease and convenience in live performance situations, you can either use the Live Set
screen or the Home screen while playing the keyboard. When using the Home screen, make
sure to select a slot on the Live Set screen.

1 Press the [LIVE SET] button to open the screen.

2 If necessary, change the bank and page.

3 Select a slot.

On the Live Set screen, tap to select a slot on the page.

Selecting Performances for a setlist from the Live Set screen
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NOTE
Slot number and Category name selection buttons can be used for selecting items for the Live Set
screen or the Category Search screen (or whichever screen was last called up).
This allows you to select a different Live Set slot while viewing the Home screen on the Main display.
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Make sure to select a Performance before playing the keyboard.
If desired, you can also play back a specific Pattern, Song, or Audio file (registered to a Live Set
slot) along with your keyboard performance.

You can play the keyboard along with the Pattern, Song, or Audio file registered to the slot.

NOTE
While the Song or Pattern is being played back, you cannot change the Performance or select a different slot.
If you try to do so, an error message will be shown on the screen.

1 Select a slot on the Live Set screen.

2 Press the [ ] (Play) button.

The Pattern, Song, or Audio file registered to the selected slot will then play back.

NOTE
While the Pattern, Song, or Audio file is played back, pressing the [ ] (Play) button shows the same
screen as the Pattern screen, Song screen, or Audio screen.

3 To stop playback, press the [ ] (Stop) button.

Playing the keyboard

Playing back a Pattern, Song, or Audio file registered to a Live Set slot
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You can use the MONTAGE M to record and play back Patterns, Songs, and Audio files.
Patterns and Songs are recorded in the storage area within the instrument, while Audio files are
recorded to a connected USB flash drive.

Contents

Recording and playing back

Terms for recording and playing back

Recording a Pattern

Canceling the last recording action (Undo and Redo)

Playing back the Pattern

Recording a Song

Recording some parts again (Punch-in Punch-out recording)

Canceling the last recording action (Undo and Redo)

Playing back the Song

Recording the Audio

Playing an audio file
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Patterns are comprised of MIDI sequence data, containing short phrases recorded as MIDI
events.
They can be played back in a loop or used with the Scene function.
The MONTAGE M can hold up to 128 Patterns within the memory area.

Songs are comprised of MIDI sequence data, containing information on the operation of the
keyboard and other controllers recorded as MIDI events.
The MONTAGE M can hold up to 128 Songs within the memory area.

Tracks are separate storage locations for recording the keyboard performance. A track holds
the information for one Part.
A maximum of 16 tracks are available on the MONTAGE M, so you can use up to 16 Parts for
recording and playing back.

Terms for recording and playing back

Patterns

Songs

Tracks
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1 Select the desired sound for recording on Track 1.

2 Open the screen from: [SONG/PATTERN] → Pattern.

The Pattern screen appears.

NOTE
You can open the same screen from: [PERFORMANCE] → Play/Rec → Pattern.

3 Change the Length (of the Scene), Tempo, and other settings as needed.

4 Press one of the [SCENE] buttons to select the desired Scene for
recording.

5 Press the [ ] (Record) button.

Recording will be set to standby.

(1) Pattern Name
(2) Name of currently selected Performance
(3) Measure

Recording a Pattern
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(4) Position for recording and playback
(5) Tempo
(6) Quantize
(7) Switching recording types (not shown when recording a new pattern)
(8) Scene
(9) Length of the pattern
(10) Turning on or off the function to start recording at key-on
(11) Turning the loop setting on or off

6 Press the [ ] (Play) button to start recording.

7 Play the keyboard.

When Loop is on, the recorded phrase is played back in a loop while on the recording
screen. This way, you can continue to record new phrases to other tracks without having
to stop and start the recorder each time.

NOTE
When you press the REC button during recording, the REC button will flash and Rehearsal mode is
enabled. In Rehearsal mode, the Pattern will be played back but recording will be temporarily disabled,
making it useful for practicing. During recording, you can switch between the Recording and Rehearsal
modes by pressing the REC button.

8 Select the desired sound for recording on Track 2.

9 Play the keyboard along with the phrase you recorded on Track 1.

10 Record other tracks as needed.

Songs and Patterns are stored automatically when recorded.
If you wish to change the tempo or sound of the recorded Song or Pattern before storing
it, select StorePattern&Perf Settings (or Store Song&Perf Settings for a Song).

NOTE
If you have edited any parameters for the Performance, you will need to store the Performance.

Undo cancels the last recording action and deletes what has been just recorded.
Redo restore the recording that has been canceled by Undo.

Canceling the last recording action (Undo and Redo)
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Undo cancels the last recording action and restores the recording to its original state.

By selecting Redo, the state before performing Undo will be restored.

Undo (does not appear when there are no recordings.)

Redo (does not appear until Undo has been performed.)
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To play back the recorded Pattern, use the Sequencer Transport buttons.

You can use the SCENE buttons to select a Scene for playback.

Playing back the Pattern

67



om01basicoperation0190

In Song recording, the operations of the controllers and knobs as well as the keyboard
performance are recorded to a track as MIDI data. For the keyboard performance, only Parts
having the Keyboard Control switch set to On will be recorded.

For the knob operations, Control Change and Parameter Change messages will also be
recorded.
For more information on Control Change, refer to the Data List.

NOTE
When Arp Rec is On, only the result of the Arpeggio playback is recorded.
When Arp Rec is Off, data of the entire keyboard performance is recorded, enabling you to change the
Arpeggio patterns later.

1 Select a Performance.

2 Press the [SONG/PATTERN] button to open the Play/Rec screen and
select the Song tab, and then press the [ ] (Record) button.

The [ ] (Record) button flashes, and recording is set to standby.

NOTE
Recording can also be set to standby from: [PERFORMANCE] → Play/Rec → Song and by pressing
the [ ] (Record).

3 Change the Time Signature and Rec Quantize as needed.

Recording a Song
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(1) Song Name
(2) Name of the Performance currently selected
(3) Beat
(4) Position for starting playback and recording
(5) Quantize
(6) Shows the total length of the sequence and the current position for playback
(7) Time for the entire sequence
(8) Setting the track on or off for playback
(9) Turning Arpeggio recording on or off (only for a new recording)

4 When the preparation is complete, press the [ ] (Play) button to start
recording.

If the Click Settings is set, the precount starts when you press the [ ] (Play) button.
Start playing the keyboard after the precount.

5 When the keyboard performance is finished, press the [ ] (Stop) button
to stop recording.

There are three types of recording (Record Type) available on the MONTAGE M; Replace,
Overdub, and Punch.

Recording some parts again (Punch-in Punch-out recording)

Replace: overwrites the existing data.

Overdub: adds a layer to the existing sound on the track.
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If you wish to rerecord a specified section, you can set up the Punch-in and Punch-out
parameters for the Punch recording.
When you start the Punch recording, the recorded Song will be played back from the beginning.
When the playback reaches the measure set for Punch-in, the recording starts automatically.
The recording ends automatically when it reaches the measure set for Punch-out, and the rest
of the recorded Song will be played back to the end. For example, if you wish to rerecord
measures 3 to 5 of an eight-measure Song, follow the instructions shown below.

Before re-recording

After re-recording

(1) Start recording
(2) Stop recording
(3) Newly recorded data

For Punch-in Punch-out recording, set up the following parameters in the Record Setup screen.

Punch: overwrites the specified section of the existing data.
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(1) Record Type = Punch
(2) Punch in (measures and beats to start rerecording) = 003:01

Starting from the measure and beat specified here, the sound of the corresponding track
will be turned off and your keyboard performance will be recorded.

(3) Punch out (measures and beats to end rerecording) = 005:01
Starting from the measure and beat specified here, the track will be played back.

Undo cancels the last recording action and deletes what has been just recorded.
Redo restore the recording that has been canceled by Undo.

Tap to see the confirmation screen. Continue cancels the last recording action and restores
the recorder to its original state.

Canceling the last recording action (Undo and Redo)

Undo (does not appear when there are no recordings.)
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Tap to see the confirmation screen. By selecting Continue, the state before performing Undo
will be restored.

Redo (does not appear until Undo has been done.)
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To check the recorded Song, use the Sequencer Transport buttons.

Playing back the Song

73



om01basicoperation0210

You can use the MONTAGE M to record and playback Audio files in stereo (44.1 kHz, 24-bit
wav).
The recording level is fixed, and it is possible to record continuously for up to 74 minutes
(assuming that the USB storage device has sufficient free memory).

1 Connect a USB flash drive to the USB TO DEVICE terminal ([1] or [2]) of
the instrument.

2 Open the screen from: [PERFORMANCE] → Play/Rec → Audio.

The audio recording screen appears.

3 Press the [ ] (Record) button.

The [ ] (Record) button flashes, and recording is set to standby.

(1) Position for recording
(2) Shows the total length of the audio file and the current position for recording
(3) Available recording time
(4) Level meter
(5) Trigger level

Recording the Audio

74



4 Set the Trigger Level (5).

If you set the Trigger Level to manual, recording will begin whenever you press the [ ]
(Play) button.
Alternatively, if you set Trigger Level to a value between 1 and 127, recording will begin
automatically after you have pressed the [ ] (Play) button and then whenever playback
volume exceeds that level.
The level set here will be indicated by blue triangles in the level meter (4). For best
results, set this parameter as low as possible to capture the entire signal, but not so low
as to record unwanted noise.

5 Press the [ ] (Play) button.

If you have set the Trigger Level to manual, recording will begin immediately right after
you press the [ ] (Play) button. While recording, the [ ] (Record) button will light in
red, and the [ ] (Play) button will light in green.
If you have set a value between 1 and 127 as the trigger level, the recording will begin
automatically whenever the playback volume exceeds that level.

6 Play the keyboard.

If you set the Trigger Level to a value between 1 and 127, recording will begin
automatically whenever the playback volume exceeds that level.

7 When you have finished playing, press the [ ] (Stop) button.

The recorded audio file will be saved to the USB flash drive.
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As described below, the MONTAGE M can play audio files (44.1 kHz, 24-bit or 16-bit .wav in
stereo) from a USB flash drive.
You can also play a Performance on the keyboard while playing back the audio file.

1 Connect a USB flash drive to the USB TO DEVICE terminal ([1] or [2]) of
the instrument.

2 Select Load from the context menu from: [PERFORMANCE] → Play/Rec →
Audio, and tap Audio Name.

3 Select the USB flash drive and the desired folder for loading the audio
data.

4 Select the desired wav file on the USB flash drive to load.

(1) Audio name
(2) Volume for playback
(3) Audio length

5 Press the [ ] (Play) button.

Playing an audio file
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The audio file will play back.

6 Move the cursor to Audio Volume (2), and then adjust the playback
volume by using the Data dial.

7 Press the [ ] (Stop) button to stop playback.
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You can save backups of the Performances, Live sets, and the Utility settings you have created
and saved (stored) on the instrument to a USB flash drive, as well as load settings from backup
files from the USB flash drive to the instrument.

This section covers how to save all settings in the User memory to a USB flash drive and how to
load your settings back to the instrument.

Contents

Managing backup files of your Performances

Available file formats

Saving settings to a USB flash drive as a backup file (Save)

Restoring settings from the backup file saved to the USB flash drive (Load)
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Select the appropriate file format for the settings you wish to back up.

Everything in User memory (including the User area, Library area, Songs, and Patterns)

Everything in the User area of User memory (including the Utility settings and Quick
Setups)

User area in User memory, excluding the Utility settings and Quick Setups (one bank for
Live Sets)

If the file size is larger than approximately 2 GB, the file will be divided in two. The second file
will have a different file extension, as shown below.

Patterns and Songs saved to User memory

Files used as User Waveforms

Available file formats

Saving to USB flash drive (Save)

MONTAGE M formats
Backup file (.Y2A)

User files (.Y2U)

Library files (.Y2L)

Backup file (.Y2B)

User files (.Y2W)

Library files (.Y2M)

Generic file format
Patterns and Songs (.MID)

Loading settings from a USB flash drive (Load)

Files saved on the MONTAGE M (.Y2A, .Y2U, .Y2L, .MID)

Generic file formats
Audio file (.WAV and .AIF)

MIDI file (.MID)
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Files used as Patterns and Songs

File formats used for older models
MONTAGE (.X7A, .X7U, .X7L)

MODX, MODX+ (.X8A, .X8U, .X8L)

MOTIF XF (.X3A, .X3V, .X3G, .X3W)

MOTIF XS (.X0A, .X0V, .X0G, .X0W)

MOXF (.X6A, .X6V, .X6G, .X6W)
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1 Connect a USB flash drive to the USB TO DEVICE terminal ([1] or [2]) of
the instrument.

2 Open the screen from: the [UTILITY] → Contents → Save.

You can open the same screen by simultaneously holding down the [SHIFT] button and
pressing the [STORE] button, and then selecting the Save tab.

3 In the Content Type, select Backup File.

4 Select the USB flash drive and desired folder for saving the file.

Saving settings to a USB flash drive as a backup file (Save)
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(1) Parent folder name
(2) Name of the destination folder currently selected in the USB flash drive
(3) Save to
(4) Files saved in the folder

5 Tap [+] for Save As New File.

This calls up the screen for entering names.

NOTE
To overwrite the existing file, confirm the process by tapping the file name on the screen. Tap YES to
save the file.

6 Enter the file name you wish to use.

For specific information on how to enter file names, refer to the Quick Guide.

7 Tap Done to finish entering the name.

The backup file will then be saved to the USB flash drive (Save).
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NOTICE

When settings are loaded, the existing settings on the instrument will be overwritten and lost.
Important settings you want to keep should be saved to a USB flash drive (Save) before
loading the settings.

1 Connect a USB flash drive to the USB TO DEVICE terminal ([1] or [2]) of
the instrument.

2 Open the screen from: [UTILITY] → Contents → Load.

You can open the same screen by simultaneously holding down the [SHIFT] button and
pressing the [STORE] button.

3 In the Content Type, select Backup File.

4 Select the desired source USB flash drive and folder that contains the
settings.

5 Select the desired file on the USB flash drive for loading.

Restoring settings from the backup file saved to the USB flash drive
(Load)
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(1) Parent folder name
(2) Name of desired folder currently selected in the USB flash drive
(3) Files saved in the folder

Performance settings can be backed up or shared using Soundmondo (sound management
and sharing service).

https://www.yamaha.com/2/soundmondo
Soundmondo
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You can connect a microphone, audio equipment (such as a CD player), and an electronic
musical instrument (such as a synthesizer) to the A/D INPUT jacks to play an audio input part
(A/D INPUT Part).
Changes to the volume, pan, effects, and other settings for the audio input Part are applied and
then mixed in with other Parts for the final output of this instrument.

Contents

Using microphones and audio devices

Connecting microphones and audio devices

Using the Vocoder

Example: Vocoder
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1 Make sure to turn off the instrument and set the A/D INPUT [GAIN] knob to
the minimum value.

2 Connect the external device to the A/D INPUT jack(s) on the rear panel.

NOTE
Make sure to use a dynamic microphone. Condenser microphones cannot be used.

(1) Stereo audio equipment (CD player, etc.)

Connecting microphones and audio devices

Connecting a microphone

Connecting audio equipment or an electronic instrument
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3 Turn on the connected device, and then turn on the MONTAGE M.

4 Open the screen from: [UTILITY] → Settings → Audio I/O.

5 Select the A/D Input setting for the device connected to the A/D INPUT
jack(s).

When a microphone or other equipment with a low output level is connected, set this
parameter to Mic. When a synthesizer or a CD player or other equipment with a high
output level is connected, set this parameter to Line.

6 Press the A/D INPUT [ON/OFF] button.

The button lights up and the input from the audio equipment connected to the MONTAGE
M is enabled.

7 Listen to the sound from the external device connected to the MONTAGE
M and turn the [GAIN] knob to adjust the gain.

Adjust the knob so that the SIG/PEAK lamp lights up briefly in red only at the loudest
input sounds.

8 Press the [PERFORMANCE] button and select the Performance you wish
to use with the external device connected to the MONTAGE M.

9 Play the keyboard while singing into the microphone or playing sounds
with the audio equipment.
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Adjust the A/D INPUT volume on the Control sliders.

88



om01basicoperation0280

This instrument is equipped with a Vocoder. The Vocoder is a powerful and popular effect
processor that extracts the characteristics of the voice sung or spoken into the microphone to
modify the keyboard sounds. For example, you can play the keyboard while talking into the
microphone to make the instrument sound robotic.
The Vocoder modifies sound in a way that is similar to the mechanism for the generation of the
human voice. The human voice consists of sounds generated from the vocal cords, which are
then filtered by the throat, nose, and mouth. These resonant sections have specific frequency
characteristics and they function effectively as a filter, creating many formants (harmonic
content).
The Vocoder effect extracts the filter characteristics of the voice from the microphone input and
recreates the vocal formants by the use of multiple bandpass filters. The machine-like ‘robot’
voice is created by passing the pitched sounds of musical instruments (such as a synthesizer
sound) through the filters.

(1) Mic Input or Part Output
(2) Part Output (keyboard performance)
(3) Extracting the characteristic of the input sound
(4) Creating formants
(5) Robot-like voice

To use the Vocoder, connect the microphone, set the A/D Input settings in the Utility screen, and
adjust the gain. Finally, select a Performance that uses the Vocoder effect, as shown below.

1 While the Performance screen is shown, press the [CATEGORY SEARCH]
button.

2 Tap the button(s) on the screen to select the Pad/Choir category.

Using the Vocoder

Example: Vocoder
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3 Tap the search box on the Category Search screen and enter “Vocoder.”

4 Set the Filter to Attribute and select Single.

A list of Performances for Vocoder effects will be shown.

5 Select the desired Performance and press the [ENTER] button to confirm.
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The USB and MIDI terminals on the rear panel are used for connecting to a computer and
external MIDI devices. You can use these terminals to send Program Change messages to
external MIDI devices when you change the Performance.

The Zone function is useful for setting up external MIDI devices.

Contents

Connecting external MIDI instruments

Setting up the Zone function

Connecting and setting up a computer

Connecting a computer and setting up

Installing the Yamaha Steinberg USB driver

Setting up for sending and receiving audio and MIDI

About audio channels

MIDI channels and MIDI ports

Using the MIDI 2.0 functions

About music production using the computer

MIDI recording of your keyboard performance on the DAW

Using the tone generator block to play back Songs on the DAW

Using the Expanded Softsynth Plugin for MONTAGE M

Using the DAW Remote function

Connecting a smart device

Connecting External MIDI Instruments

Connecting a USB MIDI keyboard to the [USB TO DEVICE] terminal

Compatible MIDI devices

Special notes concerning MIDI communication

Connecting an external MIDI device to MIDI terminals
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The Zone function enables control of multiple external devices from the built-in keyboard on this
instrument.
On the MONTAGE M, you can use up to eight Zones per Performance.
For example, you can use this function to switch between the internal tone generator (tone
generator block) and connected external sound modules by velocity or note range.

1 Press the [PERFORMANCE] button to open the Performance screen.

2 Select a Part and open the screen from [EDIT/ ] → General/Pitch →
Zone Settings.

The Zone Settings screen appears.

3 Check the Part Mode setting.

Select Internal to play the sound from the tone generator block, and External to play the
sound from the external sound module.

NOTE
You can also use a shortcut for changing the Part Mode setting. When [PART SELECT] is on, quickly
pressing the corresponding PART button twice (double-clicking) switches between Internal and
External settings.

4 If necessary, set the parameters for Tx/Rx Ch (Transmit-Receive Channel)
and Note Limit.

Setting up the Zone function
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5 Press the [STORE] button to save the Performance.
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By connecting your computer to the MONTAGE M, you can use a DAW or sequencer software
on the computer to create your own music.
The acronym DAW (digital audio workstation) refers to music software for recording, editing,
and mixing audio and MIDI. The notable DAW applications include Cubase, Logic, Pro Tools,
and Live.

By connecting a computer to the [USB TO HOST] terminal, you can send and receive audio
signals and MIDI messages.
An AB-type USB cable and the driver for sending and receiving audio and MIDI are required for
the connection.

You can install the Yamaha Steinberg USB driver or use a generic driver included in your
computer’s operating system.

1 Download the latest driver from the URL shown below.

https://download.yamaha.com/

NOTE

2 Extract the downloaded file and install the Yamaha Steinberg USB driver
on your computer.

For instructions on how to install the driver, refer to the Installation Guide included in the
downloaded file.
When connecting this instrument to a computer, connect the USB cable to the [USB TO
HOST] terminal of this instrument and the USB terminal of the computer as shown below.

Connecting and setting up a computer

Connecting a computer and setting up

Installing the Yamaha Steinberg USB driver

Information on the system requirements is also available at the above URL.
The Yamaha Steinberg USB driver may be updated without prior notice.
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(1) USB terminal
(2) USB cable
(3) [USB TO HOST] terminal
(4) MONTAGE M (Rear panel)

Connect the computer with a USB cable, and then set the parameters for handling audio and
MIDI through the USB connection.
For audio, you only need to connect the cable. And, if necessary, change settings such as
sampling frequency and gain.
For MIDI, connect the cable and then set the parameters for transmitting and receiving MIDI.

For the output of audio signals, you can use the [USB TO HOST] terminal and the OUTPUT
jacks.
If you wish to connect a computer directly to the instrument, use the [USB TO HOST] terminal.
This allows you to use up to 32 channels (or 16 stereo channels) at a sampling frequency of
44.1 kHz, or up to 8 channels (or 4 stereo channels) at a sampling frequency of 44.1 kHz to 192

Setting up for sending and receiving audio and MIDI

Transmission and reception of MIDI messages
Open the screen from the [UTILITY] → Settings → MIDI I/O → MIDI IN/OUT and select USB.
Set the instrument to enable the transmission and reception of MIDI through the [USB TO
HOST] terminal.

Open the screen from the [UTILITY] → Settings → Advanced → USB Driver Mode.
Select Vendor for using the Yamaha Steinberg USB driver, and select Generic for using the
generic driver.

About audio channels
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kHz. To select which signal to output to a specific channel, open the screen from the
[PERFORMANCE] → Part selection → [EDIT/ ] → General/Pitch → Part Settings, and
select the appropriate Part Output.

For the input of audio signals, you can use the [USB TO HOST] terminal and A/D INPUT jacks.
Audio signals coming in through the [USB TO HOST] terminal can contain up to 6 channels (or
3 stereo channels), and Digital In L/R, Main L/R, and Assign L/R are used. These channels are
used exclusively for monitoring when the instrument is connected to the DAW software, for
example.
The signals received at Main L/R are output from the OUTPUT L/R jacks, while the signals
received at the Assign L/R are output from the ASSIGNABLE OUT jacks.
The audio signals received at Digital In L/R can be changed as to volume, effect send, or output
destination settings.
These settings are available also for the audio signals handled through the A/D INPUT jacks.

Audio channel (input) Output destination

Main L/R or 1/2 OUTPUT L/R jacks

Digital L/R or 3/4 Digital In section

Assign L/R or 5/6 ASSIGNABLE OUT L/R jacks

There are 16 MIDI channels for playing 16 Parts on this instrument. When you wish to use more
than 16 channels, you can use MIDI ports, which allow 16 channels per port. While a single
MIDI cable is capable of handling MIDI data for one port (or 16 channels), a single USB cable is
capable of handling MIDI data for up to 8 ports (or 128 channels) simultaneously.
On the MONTAGE M, the determined ports are provided for the USB terminals, as shown
below.

Dedicated for using the tone generator block of this instrument.

Make sure to set to Port 1 on the external MIDI device or the computer, if you wish the tone
generator block to be played on the external MIDI device or the computer.

Dedicated for using the DAW remote control.

MIDI channels and MIDI ports

Port 1

Port 2

Port 3
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Dedicated for receiving MIDI messages from a MIDI device and sending them to another MIDI
device (for MIDI Thru).

On Port 3, the MIDI messages received through the [USB TO HOST] terminal are treated as
“Thru” on the MIDI [OUT] terminal, while the MIDI messages received through the MIDI [IN]
terminal are treated as “Thru” on the [USB TO HOST] terminal.
For sending MIDI messages between the MONTAGE M and the computer through the USB
cable, you need to select the appropriate MIDI Port as well as the MIDI channel. Set the Port
settings on the external device suitable for the situation.

This instrument supports MIDI 2.0 functionality. By connecting this instrument to a computer that
meets the MIDI 2.0 operational requirements, you can use data of higher resolution than that of
any MIDI 1.0 instrument. For more information on MIDI 2.0, refer to the MIDI2.0 Special site
(https://www.yamaha.com/2/midi-2-0/).

For details on the supported MIDI 2.0 messages, refer to the Data List.
https://download.yamaha.com/

To use the MIDI 2.0 functionality, first make settings from [UTILITY] → Settings → USB Driver
Mode to select Generic, and then connect a computer that meets the MIDI 2.0 operating
requirements.

By connecting the MONTAGE M and the computer, you can use the DAW software as in the
examples shown below.

These instructions assume that the instrument and the computer are already connected. Shown
below are some examples of using the DAW software and this instrument.

This shows how to record your keyboard performance on the DAW as MIDI data.

Using the MIDI 2.0 functions

About music production using the computer

Using the DAW software on the computer to record your keyboard performance in MIDI or
audio

Using the tone generator block to play back the Song recorded on the DAW software

MIDI recording of your keyboard performance on the DAW
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1 Open the screen from: [UTILITY] → Settings → Quick Setup.

2 Select MIDI Rec on DAW.

NOTE
Alternately, you can simultaneously press the [QUICK SETUP] button and one of the Slot number and
Category name selection buttons to select MIDI Rec on DAW.

3 Press the [EXIT] button to close the Quick Setup screen or press the
[PERFORMANCE] button to open the Performance screen and select the
desired Performance for recording.

1 Enable MIDI Thru.

MIDI Thru is a setting used for sending MIDI messages from the built-in keyboard to the
computer and back to the Tone generator block of the instrument according to the
settings on the recording tracks.
As shown below, for example, the MIDI data entered from the MONTAGE M are sent to
Channel 1. If MIDI Thru is set to ON on the computer, then the MIDI data is sent to
Channel 3 from the computer to play the tone generator block at Channel 3. By using this
setup, you can record the keyboard performance while listening to the same sound as the
final output.

Settings on the MONTAGE M

Settings on the DAW software
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(1) Tone generator block
(recognizing data over MIDI Channel 3)

(2) Keyboard
(output via MIDI Channel 1)

(3) Local Control ＝ off
(4) Computer (Cubase, etc.)

2 Record the keyboard performance on the DAW.

This shows how to use the DAW software as a Multi-timbral sound generator.
It allows you to use the high-quality MIDI sound generator without placing too much load on
your computer’s CPU.

1 Select a Performance.

After selecting a Performance, you may find it helpful to use the Mixing screen from: the
[PERFORMANCE] → Mixing to mix Part 1 to 16.
Also, set Kbd Ctrl Lock On from the [UTILITY] → Effect Switch screen to set Tx/Rx Ch. of
each Part to enable the reception of messages.

Using the tone generator block to play back Songs on the DAW

Settings on the MONTAGE M

The setting on the DAW software
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1 With the tracks you wish to use for playing the tone generator block, set
the MIDI output to Port 1 on the MONTAGE M.

2 Enter the MIDI data for each track.

The sound engine that corresponds to each track on the MIDI channel should be
controlled on the Mixing screen on the MONTAGE M.

The Expanded Softsynth Plugin (ESP) for MONTAGE M features the same sound engine as the
hardware MONTAGE M.
Since this software plugin works in sync with the hardware MONTAGE M, the same MONTAGE
M sounds can be integrated seamlessly into your music production (where software is most
convenient for a DAW), and into your live performance (where the actual instrument is used
onstage). This lets you use either version of the MONTAGE M, depending on your personal
preferences and specific application.

For more information on the installation and activation of the ESP, access the MONTAGE M
Welcome page from the Expanded Softsynth Plugin for MONTAGE M Download Information
leaflet included with the hardware MONTAGE M.

ESP Manual can be downloaded from the website below.
https://download.yamaha.com/

The DAW Remote function allows you to control the DAW software from the controllers on the
top panel of the MONTAGE M.
This function is available only when the instrument is connected to the computer with a USB
cable. It cannot be used when connected with a MIDI cable.

1 Use an AB-type USB cable to connect a computer to the [USB TO HOST]
terminal of the instrument.

2 Select the DAW software from: [DAW REMOTE] → Settings → DAW.

Using the Expanded Softsynth Plugin for MONTAGE M

Using the DAW Remote function

Settings on the MONTAGE M

Settings on the DAW software
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This section explains how to set up the DAW software.
Depending on the version of your DAW software, the setup procedure may be different or the
setup itself may not be possible. For details, please refer to the relevant owner’s manual for the
DAW software you are using.

NOTE
Once the connection between the computer and MONTAGE M is lost, the DAW software may not recognize
MONTAGE M even after reconnection. If this happens, restart the DAW after the reconnection.

1 Device/Studio → Device Settings.../Studio Setup... to call up the dialog.

2 Select MIDI → MIDI Port Setup and uncheck the In All MIDI Inputs field of
MONTAGE M-2 or MONTAGE M Port 2.

3 Press the [+] button on the upper left corner of the dialog, and then select
Mackie Control from the list.

4 Select Remote Devices → Mackie Control.

5 Set the MIDI Input and the MIDI Output to MONTAGE M-2 or MONTAGE M
Port2.

6 (Optional) Assign desired functions to F1–F8 of User Commands.

1 Select Logic Pro X → Preferences → Advanced and check Show
Advanced Tools.

2 Logic Pro X → Control Surfaces → Setup… to call up the dialog.

3 From New → Install…, select Mackie Control of Mackie Designs.

4 Set the Output Port and the Input Port of Mackie Control to MONTAGE M
Port2.

Cubase

Logic Pro
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5 (Optional) Logic Pro X → Control Surfaces → Controller Assignments... to
set Zone to Control Surface: Mackie Control and assign functions to
Control F1–F8.

1 Setup → Peripherals… to open the dialog.

2 Select the MIDI Controllers tab.

3 Set the Type to HUI and set Receive From and Send To to MONTAGE M-2
or MONTAGE M, Port2 of Predefined.

1 Live → Preferences… to open the dialog.

2 Select the Link/MIDI tab.

3 Select MackieControl for the Control Surface.

4 Set the Input and the Output to MONTAGE M-2 or MONTAGE M Port2.

5 (Optional) Assign desired functions to F1–F8 by setting the operation of
MIDI notes F#2–C#3 in the Edit MIDI Map of the Options menu.

Pro Tools

Live
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You connect a smart device such as a smartphone and a tablet to the MONTAGE M.
Smart device apps that are compatible with the MONTAGE M provide many more convenient
and enjoyable ways to use this musical instrument.

For more information on the apps and supported devices, refer to the Yamaha website.

For details on how to connect the devices, refer to the Smart Device Connection Manual, which
is available on the Yamaha website. For audio signal transfer using iOS, refer to the connection
instructions in the document that use a Lightning to USB Camera Adapter.

To connect a smart device, open the [UTILITY] → Settings screen to set the USB Driver Mode
to Generic.

Connecting a smart device
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Using USB cables and standard MIDI cables (that are commercially available), you can connect
an external MIDI instrument to the MONTAGE M.
You can play an external MIDI instrument from the built-in keyboard, or play the tone generator
block from an external MIDI keyboard or sequencer.

Make sure to match the MIDI Transmit Channel of the external MIDI instrument with the MIDI
Receive Channel of the MONTAGE M.
To set the MIDI Receive Channel of the MONTAGE M, use MIDI I/O Ch. for Parts having
Keyboard Control is set to On, and Tx/Rx Ch. for Parts having Keyboard Control set to Off. If the
Part Mode is set to External, the Part will not receive MIDI messages from the external device.
For more information on MIDI Transmit Channel of the external MIDI keyboard, refer to the
owner’s manual of the MIDI Keyboard you are using.

Use the Zone function if you would like to play sounds from both the internal tone generator
block and the external sound module.
When you wish to play the sound only from the external sound module, lower the volume on the
MONTAGE M, or set Local Control to OFF from: [UTILITY] → Settings → MIDI I/O.
To set the receive channel on the external MIDI device, refer to the owner’s manual of the MIDI
Keyboard you are using.

The MIDI output channel on this instrument should be set to a different value, depending on
whether there are any Parts with Part Mode set to External.
When there are no Parts with Part Mode set to External, MIDI I/O Ch. is used for Part Common
or a Part with Keyboard Control set to On. Tx/Rx Ch. is used for a Part with Keyboard Control
set to Off.
When there are any Parts with Part Mode set to External, Tx Ch. is used for Part Common or a
Part with Keyboard Control set to On. Tx Ch. is used for the Part with the Keyboard Control set
to Off. Any Parts with Part Mode set to Internal will not transmit MIDI messages.

NOTE
You can use either the [USB TO DEVICE] or MIDI terminals to connect the external MIDI instrument.

By connecting a USB MIDI keyboard to the [USB TO DEVICE] terminal, you can use the
connected keyboard just like the built-in keyboard, depending on the specifications of that

Connecting External MIDI Instruments

Connecting a USB MIDI keyboard to the [USB TO DEVICE] terminal
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keyboard.

NOTICE

MIDI communication with a device connected via the [USB TO DEVICE] terminal follows special
rules for allowing the device to behave like a built-in keyboard.

For using MIDI terminals, connect a device with MIDI cables, and then select MIDI from the
[UTILITY] → Settings → MIDI I/O.

The rating of the USB TO DEVICE terminal is a maximum of 5 V/500 mA for each terminal.
Do not connect USB devices having a rating above this, since this can cause damage to the
instrument itself.

Use an AB-type USB cable of less than 3 meters.

Compatible MIDI devices

USB class-compliant MIDI devices
USB MIDI keyboards

Compatible Yamaha MIDI devices
CP1, CP4 STAGE, CP40 STAGE, CP88, CP73, MODX, MODX+, MONTAGE, MOTIF XF,
MOXF, MX, reface, YC

Special notes concerning MIDI communication

MIDI communication is one-way only (sent from the external MIDI device and received by the
MONTAGE M).

All MIDI data is received regardless of the MIDI IN/OUT and MIDI I/O Ch. settings.

For Parts with Keyboard Control set to on, data received on all corresponding channels is
shared.
(For example, when Keyboard Control for Parts 1 to 3 is set to on, data received from any of
channels 1 to 3 will be delivered to all Parts 1 to 3.)

Each Part with Keyboard Control set to off receives the data of only the corresponding
channel for the Part.

Connecting an external MIDI device to MIDI terminals
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This chapter gives descriptions of the parameters shown on the Main display.

Contents

Screens and parameters

Viewing the screens

Performance screen

Common Edit screen

Part Edit (AWM2) screen

Part Common Edit

Element Edit

Drum Part Edit (AWM2) screen

Part Common Edit

Key Edit

Part Edit (FM-X) screen

Part Common Edit

Operator Edit

Part Edit (AN-X) screen

Part Common Edit

Oscillator Edit

Noise Edit

Category Search screen

Live Set screen

Utility screen

Screens shown by pressing specific buttons
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Refer to the Quick Guide for the information shown on the Main display.

The information shown on the Sub display varies depending on what you are editing or what
you selected with the [QUICK EDIT] button.

Indicators Description

1
What you are
editing

Shows what you are editing with Quick Edit (such as a Performance or Part) on the
Sub display.

2 Tabs
Shows the parameters for what you are editing.
Use the Tab selection buttons to change tabs.

3 Page
Shows the pages on the tab.
Use the Tab PAGE buttons to change pages.

4 Parameter area
Shows the values, switches, and parameter names.
Use Knobs 1-8 to change the settings.

The Ring⇔FM parameter for AN-X Part Edit shown on the Sub display corresponds to the
Ring Level and FM Level parameters shown on the Main display.
By moving the knob, you can change the ratio of these modulations.

Viewing the screens

Information on the Main display

Information on the Sub display

About the Ring⇔FM parameter
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The Performance screen lets you select a Performance for playing on the keyboard or modify
the Performance settings to customize the Performance.

Contents

Performance screen

Home

Motion Control

Super Knob

Knob Auto

Super Knob Motion Sequence Edit

User Curve Edit

Mixing

Scene

Play/Rec

Pattern

Pattern Edit screen

Overview

Note

Quantize

Velocity

Gate Time

Cresc. (Crescendo)

Transpose

Roll

Track

Copy/Exchange

Mix

Append

Split

Clear

Divide Drum Tr
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Operation

Song/Event

Get Phrase

Put Phrase

Erase Event

User Arp

Play FX

Chain

Song

Put Track to Arpeggio

Audio

Smart Morph

Play

Edit

Analyze

Super Knob

Job

Home

Press the [PERFORMANCE] button.

Tap the  (Home) icon
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(1) Performance Name
Shows the name of the selected Performance.
Tapping on the name calls up the context menu for Category Search, Edit, and Property.
You can check the status of the Performance with the following flags.

A star will be shown when you turn on the Favorite switch. The same star will be shown
on the Performance Category Search screen.

The blue flag will be shown when you change a parameter in the Performance. The Edit
flag will be turned off when you save the settings with the [STORE] button.

(2) Performance Attribute
The Performance attributes will be shown.

Attribute Description

Performances using the AWM2 sound engine.

(in one color) Performances using the FM-X sound engine.

(in two
colors)

Performances using an FM-X Part containing the Smart Morph
information

(in one color) Performances using the AN-X sound engine

(in two
colors)

Performances using an AN-X Part containing the Smart Morph
information

Favorite Flag ( )

Edit Flag ( )
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Attribute Description

Performances featuring Motion Control

Performances that support Seamless Sound Switching

* Performances that combine multiple sound engine types are indicated with the “+” sign.

(3) Oscilloscope
Shows the waveform of the Main L&R output.

(4) Part Indicator
When the cursor is on the Performance Name or on Parts 1 to 8, the status for Parts 9 to
16 will be shown.
When the cursor is on Parts 9 to 16, the status for Parts 1 to 8 will be shown.
Nothing will be shown when Parts 9 to 16 are not used.

(5) View area for various parameters
Different parameters will be shown in this view area depending on the Display Mode.

(6) Part Name
Part Type and Category, or Part Name will be shown.
You will see the context menu for Category Search, Edit, Copy, and Property when you
tap on the Part Name.
When a Part other than Part 1 is selected and the sound is already set for that Part, the
context menu for Category Search, Edit, Copy, and Delete is shown.
Tap [+] to add a Part.

(7) Keyboard Control Switch
Keyboard Control is used for selecting Parts to play on the keyboard.
When Keyboard Control is set to On, Parts with Keyboard Control set to On can
simultaneously be played, if the Part is set to Common or Keyboard Control for the Part is
set to On.
When Keyboard Control is set to Off, you can play the Part on the keyboard only when
that Part is selected.
Settings: Off, On

(8) Part Mute
Switches Part Mute on or off.
Settings: Off, On

(9) Part Solo
Switches Part Solo on or off.
Settings: Off, On

(10) Part Volume
Sets the volume for the Part.
Settings: 0–127

(11) Part Level Meter
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Shows the audio output level for the Part.

(12) [+] (Add)
When you tap [+], the Part Category Search screen or the Performance Merge screen
opens, allowing you to add a Part to the Performance.

(13) Switching the Display Mode
(14) Changing the View Mode

When you change the Display Mode, different parameters will be shown in the view area of the
Home screen.
You can select a different Display Mode by moving the corresponding display knob.

Opens the Navigation screen.

Opens the Fx Overview screen.

Opens the Control View screen.

Turns the Favorite switch on or off.
Settings: Off, On

Switching the Display Mode

Range

Navigation

Fx Overview

Control View

Favorite
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Sets the note range (the lowest and the highest notes) for the Part.
When the first note specified is lower than the second (for example, C5 to C4), the notes in the
ranges C−2 to C4 and C5 to G8 will be played.
Settings: C−2–G8

Sets the velocity range for the Part.
Settings: 1–127

Sets the output level (Return Level) of the signals processed by the Variation Effect.
Settings: 0–127

Sets the output level (Return Level) of the signals processed by the Reverb Effect.
Settings: 0–127

Sets the Pan of the selected Performance.
Settings: L63–C–R63

Sets the volume of the selected Performance.
Settings: 0–127

Note Limit

Velocity Limit

FX/Pan

Var Return

Rev Return

Pan

Volume
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Sets the level of the signals sent to the Part Variation Effect.
Settings: 0–127

Sets the level of the signals sent to the Part Reverb Effect.
Settings: 0–127

Sets the dry level (or the level of the signals not processed by the System Effect) of the Part.
Settings: 0–127

Sets the Pan position (in the stereo field) for the Part.
Settings: L63–C–R63

Changes the Arpeggio selection.
Settings: 1–8

Changes the Motion Sequence selection.
Settings: 1–8

Var (Part Variation Send)

Rev (Part Reverb Send)

Dry (Part Dry Level)

Pan (Part Pan)

Arp/MS/Porta

Arp Select

MS Select

Portamento Switch
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Sets Portamento on or off for Parts having the Portamento Part Sw set to On.
This switch is linked to the [PORTAMENTO] button on the top panel.
Settings: Off, On

Sets the time length (or speed) for the pitch transition of Portamento.
This is specified as an offset value to the Part Portamento time.
Settings: −64–+63

Sets the Arpeggio on or off for the Part.
When both Arpeggio and Arpeggio Hold are set to On, this is shown as “Arp Hold On.” When
the Arpeggio is set to on, you can switch Arp Hold On or Off by simultaneously holding down the
[SHIFT] button and tapping the Arp On/Off button on the screen.
Settings: Off, On

Sets Motion Sequencer for the Part on or off.
Settings: Off, On

Sets Portamento for the Part on or off.
Settings: Off, On

Sets the time length of the pitch transition for Portamento of the Part.
Settings: 0–127

Portamento Time

Arp On/Off (Arpeggio Part Switch)

MS On/Off (Motion Sequencer Part Switch)

Prt On/Off (Portamento Part Switch)

Time (Portamento Part Time)

Mode/Transpose
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Sets the MIDI channel for input and output of the Part Common and the Part having the
Keyboard Control Switch set to ON.
Settings: Ch1–Ch16

Shifts the pitch of the keys in octaves.
This is linked to the OCTAVE buttons on the top panel.
Settings: −3–+3

Shifts the pitch of the keys in semitones.
Settings: −11semi–+11semi

NOTE
For any notes outside the pitch range between C−2 and G8 (the range that can be played on this instrument),
the resulting notes will sound one octave higher (or lower.)

Sets the Internal tone generator (Int) or the external sound module (Ext) for playing on the
keyboard.
Settings: Int, Ext

Sets the channel for transmitting and receiving MIDI messages for the Zone when Part Mode is
set to Internal and the Keyboard Control Switch is set to Off.
Settings: Ch1–Ch16, Off

MIDI I/O Ch.

Octave Shift (Keyboard Octave Shift)

Transpose (Keyboard Transpose)

Int/Ext (Part Mode)

Ch (Tx/Rx Ch)
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Sets the channel for transmitting and receiving MIDI messages for the Zone when Part Mode is
set to External.
Settings: Ch1–Ch16

Shifts the pitch of the zone in octaves.
Settings: −3–+0 (standard)–+3 (in octaves)

Shifts the pitch of the zone in semitones.
Settings: −11–+0 (standard)–+11

Changes the sound by setting the cutoff frequency of the filter.
When the Low Pass Filter is selected, you can make the sound brighter by setting larger values
here, or darker by setting smaller values.
This is specified as an offset value to the filter cutoff frequency for the Part.
Settings: −64–+63

Adds characteristics to the sound by adjusting the signal level near the cutoff frequency.
This is specified as an offset value to the filter resonance for the Part.
Settings: −64–+63

Ch (Transmit Ch)

Oct (Zone Octave)

Trans (Zone Transpose)

Filter

Cutoff (Cutoff Frequency)

Resonance

FEG Depth
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Sets the range of the cutoff frequency change by the FEG.
This is specified as an offset value to the Part FEG Depth.
Settings: −64–+63

Changes the sound by setting the cutoff frequency of the filter. When the Low Pass Filter is
selected, you can make a brighter sound by setting a larger value to this parameter, and a
darker sound by setting a smaller value.
This is specified as an offset value to the filter cutoff frequency set on the Filter Type screen.
Settings: −64–+63

Adds special tonal variation in the sound by adjusting the signal level near the cutoff frequency.
This is specified as an offset value to the filter resonance set on the Filter Type screen.
Settings: −64–+63

Sets the range of the cutoff frequency change controlled by the Filter EG setting in the Filter
Type screen.
When it is set to 0, the settings in the Filter Type screen will be used as is.
Settings: −64–+63

You can access more detailed information from the Home screen by using View Mode.
You can select a different View Mode by moving the corresponding display knob.
When the cursor is on the Performance Name, pressing the [PERFORMANCE] button also
changes the view.

Shown when the View Mode is set to Part Info and the current Part is a Normal Part (AWM2).

Cut (Part Cutoff Frequency)

Res (Part Resonance)

FEG (Part FEG Depth)

Changing the View Mode

Element Sw/Level
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(1) Element Sw (Element Switch)
(2) Element Level

Switches the Element On or Off.
Settings: Off, On

Sets the output level for the Element.
Settings: 0–127

Shown when the View Mode is set to Part Info and the current Part is a Drum Part.

Element Sw (Element Switch)

Element Level

Drum Key
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Sets the output level for the Drum Key.
Settings: 0–127

Shown when the View Mode is set to Part Info and the current Part is a Normal Part (FM-X).

Changes the Algorithm.
Tapping the Algorithm image calls up the Algorithm Search screen.
Settings: Refer to the Data List.

Sets the feedback level.
Settings: 0–7

Shown when the View Mode is set to Part Info and the current Part is a Normal Part (AN-X).

Drum Key Level

Algorithm

Algorithm (Algorithm Number)

Feedback (Feedback Level)

Virtual Analog
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(1) 1–3 (Oscillator 1–3)
(2) N (Noise)
(3) Oscillator Level
(4) Noise Level
(5) Filter 1, 2
(6) Amplifier

Sets the output level for the Oscillator.
Settings: 0–511

Sets the noise level.
Settings: 0–511

Opens the OSC/Tune screen for Part Edit (AN-X).

Opens the Noise screen for Part Edit (AN-X).

Opens the Filter Type screen for Part Edit (AN-X).

Opens the Amp EG screen for Part Edit (AN-X).

Oscillator Level

Noise Level

1–3 (Oscillator 1–3)

N (Noise)

Filter 1, 2

Amplifier
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Shown when the View Mode is set to Smart Morph.
The map will not be shown when there is no Smart Morph information.

Shown when the View Mode is set to Motion Seq.
Shows the lane set in the View Lane of the current Part.

Shown when the View Mode is set to Velocity—Note.
This is convenient for setting velocity splits when using multiple Parts.

Smart Morph

Motion Seq

Velocity—Note
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Shown when the View Mode is set to Part—Note or Part Info and the current Part is
Common.

On the Motion Control screen, you can set the Motion Control settings applied to the entire
Performance.

In the Super Knob screen, you can set the values for controlling the Super Knob.
You can set a link between the Super knob and each of the assignable knobs.

Operation

Part—Note

Motion Control

Super Knob
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[PERFORMANCE] → Motion Control → Super Knob

(1) Super Knob Link
(2) Assignable Knob 1–8 Value
(3) Assignable Knob 1–8 Value Left
(4) Assignable Knob 1–8 Value Mid
(5) Assignable Knob 1–8 Value Right

Sets the Motion Sequencer for the entire Performance on or off.
This switch is linked to the [MSEQ ON/OFF] button on the top panel.
Settings: Off, On

Sets the Motion Sequencer used for the Super Knob on or off.
Settings: Off, On

Sets the lighting pattern of the Super knob.
Settings: Off, Type 1, Type 2-1, Type 2-2, Type 3-1, Type 3-2, Type 4-1, Type 4-2, Type 5-1,

Type 5-2, Type 6, Type 7-1, Type 7-2, Type 8-1, Type 8-2, Type 9, Type 10, Type 11,
Type 1B, Type 2-1B, Type 2-2B, Type 3-1B, Type 3-2B, Type 4-1B, Type 4-2B, Type
5-1B, Type 5-2B, Type 6B, Type 7-1B, Type 7-2B, Type 8-1B, Type 8-2B, Type 9B,
Type 10B, Type 11B, Rotary 1, Rotary 2, Rotary 3, Rotary 4, Rotary 5, Rotary 6,
Rotary 7, Rotary 8, Rotary 9, Rotary 10

Sets the Super Knob value.
Settings: 0–1023

MS Master (Motion Sequencer Master Switch)

Super Knob MS (Super Knob Motion Sequencer Switch)

LED Pattern

Super Knob (Super Knob Value)
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Set the Mid value for the Super Knob.
Settings: Off, 1–1022

Opens the Common Edit Control Assign screen for setting the parameters controlled by the
Super Knob.

Sets the corresponding knob to link to the Super Knob.
When these switches are set to Off, the operation of the Super Knob will not affect the
parameter of the knob.
Settings: Off, On

Shows the current values for the Assignable knobs (Knobs 1 to 8).
Settings: 0–1023

Shows the value of the assignable knobs (Knobs 1–8) when the Super Knob Value is set to 0
(or the Super Knob is turned all the way to the left).
Settings: 0–1023

Shows the value of the assignable knobs (Knobs 1–8) when the Super Knob Value is set to Mid
Position.
This parameter is not available when the Mid Position is Off.
Settings: 0–1023

Shows the value of the assignable knobs (Knobs 1–8) when the Super Knob Value is set to
1023 (or the Super Knob is turned all the way to the right).
Settings: 0–1023

NOTE
When you set Value Left to a smaller value and Value Right to a larger value, Knobs 1–8 will move in the
same direction as the Super Knob.
When you set Value Right to a smaller value and Value Left to a larger value, Knobs 1–8 will move in the
opposite direction to the Super Knob.

Mid Position

Edit Super Knob

Super Knob Link

Assignable Knob 1–8 Value

Assignable Knob 1–8 Value Left

Assignable Knob 1–8 Value Mid

Assignable Knob 1–8 Value Right

126



In the Knob Auto screen, you can set the Motion Sequencer for the Super Knob (Super Knob
Motion Sequencer).
You can set the Motion Sequencer to automatically control the Super Knob value.
Only one Lane can be used by the Super Knob.

NOTE
Up to eight Lanes can be used at the same time for the entire Performance. However, the Lane set for the
Super Knob is not included in the eight referred to here.

Operation

[PERFORMANCE] → Motion Control → Knob Auto

Sets the Motion Sequencer for the entire Performance on or off.
This switch is linked to the [MSEQ ON/OFF] button on the top panel.
Settings: Off, On

Sets the Super Knob Motion Sequencer on or off.
Settings: Off, On

Sets Knobs to be affected by the operation of the Super Knob.
Settings: Off, On

Knob Auto

Motion Seq Master Sw (Motion Sequencer Master Switch)

Super Knob MS Sw (Super Knob Motion Sequencer Switch)

MS FX (Super Knob Motion Sequencer FX Receive)
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Sets to receive the signals from the [MSEQ TRIGGER] button.
When set to On, the Motion Sequence will not be played back unless you press the [MSEQ
TRIGGER] button.
Settings: Off, On

Changes the Motion Sequence type selection.
Settings: 1–8

Sets randomness of the changes in the Step value of the sequence.
Settings: 0–127

Opens the Motion Sequence screen.

Selects the speed and the timing for the playback of the Super Knob Motion Sequence.
Settings: Off, Tempo, Beat

Off: Plays back the Super Knob Motion Sequencer alone.
Tempo: Plays back at the Performance tempo.
Beat: Plays back in sync with the beat.

Sets the playback speed for the Motion Sequence.
This parameter is available when Super Knob Motion Sequencer Sync is set to Off.
Settings: 0–127

Sets the delay time for starting playback of the Motion Sequence when Sync is set to Off.
Settings: 0–127

Sets the time to reach the maximum amplitude for the Motion Sequence when Sync is set to
Off.
Settings: 0–127

Trigger (Super Knob Motion Sequencer Trigger Receive)

Sequence Select (Motion Sequence Select)

SK MS Random (Super Knob Motion Sequencer Randomness)

Edit Sequence

Sync/Speed tab

Sync (Super Knob Motion Sequencer Sync)

When Sync is set to Off

Speed (Super Knob Motion Sequencer Speed)

Delay Time (Super Knob Motion Seq Lane Key On Delay Time Length)

Fade In Time (Super Knob Motion Seq Lane Fade In Time Length)
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Sets the percentage for stretching or compressing the Super Knob Motion Sequencer
playback time.
This parameter is available when Super Knob Motion Sequencer Sync is set to something
other than Off.
Settings: 50%–6400%, Common

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.
Common: The Unit Multiply value set in the Common Edit is applied.

Sets the delay time for starting the playback of the Motion Sequence when Sync is set to
something other than Off.
Settings: 0–32

Sets the time to reach the maximum amplitude for the Motion Sequence when Sync is set to
something other than Off.
Settings: 0–32

Sets the velocity range (lowest and highest values) for playing back the Motion Sequence.
Settings: 1–127

Resets the Motion Sequence playback when you press any key on the keyboard.
This parameter is not available when the Trigger is On.
Settings: Off, Each-On, 1st-On

Each-On: Each time you play any note, playback starts from the beginning.
1st-On: When you play a note, the sequence will be reset at the first note, and
playback starts from the beginning. When second or subsequent notes are played
while the first note is held, the sequence is not reset until another first note is
played.

Sets the Motion Sequence to loop playback (in repeats) or one-shot playback.
Settings: Off, On

When Sync is set to something other than Off

Unit (Super Knob Motion Sequencer Unit Multiply)

Delay Steps (Super Knob Motion Seq Lane Key On Delay Step Length)

Fade In Steps (Super Knob Motion Seq Lane Fade In Step Length)

Vel Limit (Super Knob Motion Sequencer Velocity Limit)

Loop/Length tab

Key On Reset (Super Knob Motion Sequencer Key On Reset)

Loop (Super Knob Motion Sequencer Loop)
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Specifies the starting point for loop playback of the Motion Sequence.
Settings: 1–16 (should be below the Length setting)

Sets the Motion Sequence length.
Settings: 1–16 (should be above the Loop Start setting)

Sets the length of a step in the Motion Sequence (as a note value).
Settings: 60, 80, 120, 160, 240, 320, 480

The setting screen for the Super Knob Motion Sequencer.
You can create a sequence of up to 16 steps.

Specifies the starting point for the loop playback of the Motion Sequence.
Settings: 1–16 (should be below the Length setting)

Sets the Motion Sequence length.
Settings: 1–16 (should be above the Loop Start setting)

Sets the length of a step in the Motion Sequence (as a note value).
Settings: 60, 80, 120, 160, 240, 320, 480

Loop Start (Super Knob Motion Sequencer Loop Start)

Length (Super Knob Motion Sequence Length)

MS Grid (Super Knob Motion Sequence Grid)

Super Knob Motion Sequence Edit

Loop Start (Super Knob Motion Sequencer Loop Start)

Length (Super Knob Motion Sequence Length)

MS Grid (Super Knob Motion Sequence Grid)
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Changes the Motion Sequence type selection.
Settings: 1–8

Sets the polarity of the Motion Sequence.
Settings: Unipolar, Bipolar

Unipolar: Only positive values are used for the parameter change.
Bipolar: Both positive and negative values are used for the parameter change.

Sets the degree of changes in the Motion Sequence.
Settings: 0–127

Sets the smoothness of the changes in the Motion Sequence over time.
Settings: 0–127

Shows various Jobs.

Sets the value for each step in the Motion Sequence.
You can use Control sliders 1 to 8 to change the values for Steps 1 to 8 and Steps 9 to 16.
Settings: 0–127

Sets the type and direction of each step in the Motion Sequence.
Settings: A, B, Reverse A, Reverse B

Selects a parameter change curve for Pulse A and Pulse B.
Use the Super Knob Motion Sequence Step Type to select which of the curve types to use for
each step.
The vertical axis represents the time while the horizontal axis represents the step value.
Settings: (When a preset bank is selected) Standard, Sigmoid, Threshold, Bell, Dogleg, FM,

AM, M, Discrete Saw, Smooth Saw, Triangle, Square, Trapezoid, Tilt Sine, Bounce,
Resonance, Sequence, Hold, Harmonic, Steps

Sequence Select (Motion Sequence Select)

Polarity (Super Knob Motion Sequence Polarity)

Amplitude (Super Knob Motion Sequence Amplitude)

Smooth (Super Knob Motion Sequence Smoothness)

Job

Super Knob Motion Sequence Step Value

Super Knob Motion Sequence Step Type

Pulse A (Super Knob Motion Sequence Step Curve Type A)
Pulse B (Super Knob Motion Sequence Step Curve Type B)
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(When a user bank is selected) User 1–32
(When a library file is loaded) Curves used in Library 1–16

Adjusts the shape of the step curve in the Motion Sequence.
This setting may not be available depending on the curve type. Also, the range for the
parameter value differs depending on the curve type.

Enables or disables the use of the knobs for controlling the step curve shape of the Motion
Sequence.
Shown only when MS FX is set to On. This setting may not be available depending on the curve
type.
Settings: Off, On

Saves (stores) the edited Motion Sequence.

Loads the Motion Sequence.

Copies the Motion Sequence.

This is the setting screen for the User Curve.
You can create either an 8-point linear curve or an 8-step curve.

Prm 1 (Super Knob Motion Sequence Step Curve Parameter 1)
Prm 2 (Super Knob Motion Sequence Step Curve Parameter 2)

Control (Super Knob Motion Sequence Step Curve Shape Control Switch)

Store Sequence

Load Sequence

Copy Sequence

User Curve Edit
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Indicates the current curve number.
Settings: 1–32

You can save the curve you are editing under a new name.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Sets the Curve type.
Settings: Linear, Step

Sets the input level for the curve.
Input 1 is fixed to the value 0.
Input 8 is fixed to the value 1023 when the Curve Type is set to Linear.
Settings: 0–1023

Sets the output level for the curve.
Settings: 0–1023

On the Mixing screen, you can change the mix by adjusting the volume of each Part and make
effect settings.
The settings in the Mixing screen are saved (stored) in the Performance.

Curve No. (Curve Number)

Curve Name

Curve Type

Input

Output

Mixing
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Operation

[PERFORMANCE] → Mixing

Changes the view.
Settings: Part 1–16, Audio (Part 1–8, Audio part, Master)

Sets the mix for Parts 1 to 16.

(1) Part Category
(2) Keyboard Control

Part 1–16 (Part 1–16 Switch)
Audio (Audio Switch)

When the Part 1–16 view is selected
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(3) Volume
(4) Part Level Meter

The Main category of the selected Part is shown.
Tapping on the name calls up the context menu for Category Search, Edit, and Property.
When a Part other than Part 1 is selected and the sound is already set for that Part, the context
menu for Category Search, Edit, Copy, and Delete appears.
Tap [+] to add a Part.
Settings: Refer to the Data List.

Switches between Mute/Solo view and Keyboard Control view.

Switches Mute and Solo for the Part on or off.
Settings: Off, On

Switches Keyboard Control on or off.
For Parts 9 to 16, the buttons will not be shown since Keyboard Control cannot be set to On for
those Parts.
Settings: Off, On

Switches between the 2-band EQ view and 3-band EQ view of Parts 1 to 16.
Settings: 3-band, 2-band

Shows the EQ setting either in 3-band or 2-band views.
Tapping on the area calls up the context menu of Part EQ.

Sets the level of the signals sent from Parts 1 to 16 to the Reverb Effect.
Settings: 0–127

Part Category

Mute/Solo Switch
Kbd Ctrl Switch

Mute (Part Mute)
Solo (Part Solo)

Keyboard Control

3-band (3-band EQ Switch)
2-band (2-band EQ Switch)

EQ (Equalizer)

Rev Send (Reverb Send)

Var Send (Variation Send)
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Sets the level of the signals sent from Parts 1 to 16 to the Variation Effect.
Settings: 0–127

Sets the dry level (or the level of the signals not processed by the System Effect) of Parts 1 to
16.
Settings: 0–127

Sets the Pan position (in the stereo field) for Parts 1 to 16.
Settings: L63–C–R63

Sets the volume for Parts 1 to 16.
Settings: 0–127

Shows the level for Parts 1 to 16.

Sets the mix for the Audio Part.

(1) Part Category
(2) Digi (Digital Part)
(3) Main (USB Main Part)

Dry Level

Pan

Volume

Part Level Meter

When the Audio view is selected
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(4) Asgn (USB Assign Part)
(5) AD (A/D Part)
(6) Mst (Master)
(7) A/D Part EQ
(8) Master EQ
(9) Digital Part Volume
(10) Part Level Meter
(11) Digi (Digital Part Level Meter)
(12) USB Main Monitor Volume
(13) Main (Main L&R Level Meter)
(14) USB Assign Monitor Volume
(15) Asgn (Assign L&R Level Meter)
(16) A/D Part Volume
(17) AD (A/D Part Level Meter)
(18) Performance Volume

The Main category of the selected Part is shown.
Tapping on the name calls up the context menu for Category Search, Edit, and Property.
When a Part other than Part 1 is selected and the sound is already set for that Part, the context
menu for Category Search, Edit, Copy, and Delete appears.
Tap [+] to add a Part.
Settings: Refer to the Data List.

Tapping on the name calls up the context menu for Edit.

Switches between the Mute/Solo view and Keyboard Control view.

Switches Mute and Solo for the Part on or off.
Settings: Off, On

Part Category

Digi (Digital Part)
Main (USB Main Part)
Asgn (USB Assign Part)
AD (A/D Part)
Mst (Master)

Mute/Solo Switch
Kbd Ctrl Switch

Mute (Part Mute)
Solo (Part Solo)

A/D Part EQ
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Tapping on the area calls up the context menu of Part EQ.

Sets the level of the signals sent from the Digital Part or A/D Part to the Reverb Effect.
Settings: 0–127

Sets the level of the signals sent from the Digital Part or A/D Part to the Variation Effect.
Settings: 0–127

Sets the dry level (or the level of the signals without the System Effect) of the Digital Part or A/D
Part.
Settings: 0–127

Sets the Pan (location in the sound field) of the Digital Part or A/D Part.
Settings: L63–C–R63

Sets the volume for the Audio Part.
Settings: 0–127

Shows the 5-band parametric EQ.
Tapping on the name calls up the context menu for Master EQ Edit.

Sets the output level (Return Level) of the signals processed by the Reverb or Variation Effect.
Settings: 0–127

Digital Part Reverb Send
A/D Part Reverb Send

Digital Part Variation Send
A/D Part Variation Send

Digital Part Dry Level
A/D Part Dry Level

Digital Part Pan
A/D Part Pan

Digital Part Volume
A/D Part Volume
USB Main Monitor Volume
USB Assign Monitor Volume

Master EQ

Rev Return (Reverb Return)
Var Return (Variation Return)

Rev Send (Reverb Send)
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Sets the level of the signals sent to the Reverb Effect.
Settings: 0–127

Sets the level of the signals sent to the Variation Effect.
Settings: 0–127

Sets the Pan (location in the sound field) of the Performance.
This parameter value offsets the pan setting for each Part.
Settings: L63–C–R63

Sets the volume for the Performance.
Settings: 0–127

Shows the level of Parts 1 to 8 and Audio Part.

On the Scene screen, you can register the settings for the Arpeggio type, Motion Sequence
type, and Part parameters to each of the SCENE buttons.
On this screen, set the appropriate Memory (Memory Switch) On, and edit the desired
parameter values so that you can save the settings to the Scene.

NOTE
The Scene function can be set from a screen other than Scene. You can change the assigned Scene
parameters by moving the corresponding knobs and sliders and registering the settings by simultaneously
holding down the [SHIFT] button and pressing the desired SCENE button.

Operation

[PERFORMANCE] → Scene

Var Send (Variation Send)

Pan (Performance Pan)

Performance Volume

Part Level Meter
Digi (Digital Part Level Meter)
Main (Main L&R Level Meter)
Asgn (Assign L&R Level Meter)
AD (A/D Part Level Meter)

Scene
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(1) Scene Select

Select a Scene tab to register the settings.
The Scene1 to Scene8 tabs are linked to the SCENE buttons on the top panel.
Settings: 1–8

Selects each of the parameter values such as Arpeggio, Motion Sequencer, Super knob, Super
knob link, Mixing, Keyboard Control, Amplitude EG, and Arp/MS FX to register to the Scene.
When these switches are set to Off, the parameter values will not be shown on the display even
when the corresponding tabs are selected.
Settings: Off, On

Changes the view between Part 1–16 and Common.
The views are available in the Mixing 1, Mixing 2, Kbd Ctrl, AEG, Arp/MS FX1, and Arp/MS FX2
tabs.

By setting Offset to Off, you can use smaller increments to set some of the Scene parameters.
Shown on the Mixing 1, Mixing 2, and AEG tabs.
Settings: Off (Absolute), On (Offset)

Sets the Motion Sequencer on or off for the entire Performance.
Settings: Off, On

Scene Select

Memory (Memory Switch)

Part 1–16 / Common

Offset (Scene Mixing / AEG Value Mode Switch)

When the Memory Switches for Arp and Motion Seq are set to On

Motion Seq Master (Motion Sequencer Master Switch)
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Changes the Motion Sequence Selection.
Settings: 1–8

Sets the Arpeggio on or off for the entire Performance.
Settings: Off, On

Changes the Arpeggio selection.
Settings: 1–8

Sets the Super Knob value.
Settings: 0–1023

Sets the link between the Super Knob and Assignable Knobs 1–8.
When this switch is set to Off, operation of the Super knob will not affect the parameters of the
Assignable knobs.
Settings: Off, On

Motion Seq Select (Motion Sequence Select)

Arp Master (Arpeggio Master Switch)

Arp Select (Arpeggio Select)

When the Memory Switches for Super Knob and Link are set to On

Super Knob (Super Knob Value)

Super Knob Link

When the Memory Switches for Mixing 1 and Mixing 2 are set to On
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Part 1–16 view: Scene parameters for Parts 1–16 are shown.
Common view: Scene parameters for Parts 1–8 and Common are shown.
Common parameters are applied to the entire Performance.

Sets the Reverb Send for each Part.
Settings: 0–127

Sets the Variation Send for each Part.
Settings: 0–127

Sets the Dry Level of each Part.
Settings: 0–127

Sets the Pan for each Part.
Settings: L63 –C–R63

Sets the Volume for each Part.
Settings: 0–127

Mixing 1

Part 1–16 view

Rev Send (Reverb Send)

Var Send (Variation Send)

Dry Level

Pan

Volume (Part Volume)

Common view
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Sets the Reverb Return.
Settings: 0–127

Sets the Variation Return.
Settings: 0–127

Sets the Pan for the Performance.
Settings: L63 –C–R63

Sets the cutoff frequency for each Part.
Settings: −64–+63

Sets the filter resonance or filter width for each Part.
Settings: −64–+63

Sets the FEG depth for each Part.
Settings: −64–+63

By setting Offset to Off, some Scene parameters can be finely-adjusted.

Settings: (FM-X, AN-X): 0–1023

Settings: (FM-X): 0–127
Settings: (AN-X): 0–255

Settings: (AN-X): −9600–+9600

Rev Return (Reverb Return)

Var Return (Variation Return)

Pan (Performance Pan)

Mixing 2

Part 1–16 view

When Offset is set to On

Cutoff (Cutoff Frequency)

Res (Filter Resonance/Width)

FEG Depth

When Offset is set to Off

Cutoff

Resonance

FEG
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NOTE
It is recommended to set Offset to On when you wish to use both Smart Morph and Scene.

Switches Mute for the Part on or off.
Settings: Off, On

Sets the volume for the Part.
Settings: 0–127

Sets the offset value for the cutoff frequency of the Part.
Settings: −64–+63

Sets the offset value for the filter resonance or filter width of the Part.
Settings: −64–+63

This is specified as an offset value to the Part FEG Depth.
Settings: −64–+63

Mute (Part Mute)

Volume (Part Volume)

Common view

Cutoff (Cutoff Frequency)

Res (Filter Resonance/Width)

FEG Depth

When the Memory Switch for Kbd Ctrl is set to On

Kbd Ctrl (Part Keyboard Control Switch)

144



Switches Keyboard Control for the Part on or off.
When Keyboard Control for the Part is set to Off, no sound will be produced when you play the
keyboard.
Settings: Off (gray), On (green)

Sets the AEG attack time for the Part.
Settings: −64–+63

Sets the AEG decay time for the Part.
Settings: −64–+63

Sets the AEG sustain level for the Part.
Settings: −64–+63

Sets the AEG release time for the Part.
Settings: −64–+63

By setting Offset to Off, some Scene parameters can be finely-adjusted.

When the Memory Switch for AEG is set to On

Part 1–16 view

When Offset is set to On

Attack (AEG Attack Time)

Decay (AEG Decay Time)

Sustain (AEG Sustain Level)

Release (AEG Release Time)

When Offset is set to Off
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Settings: (AN-X): 0–255

Settings: (AN-X): 0–255

Settings: (AN-X): 0–511

Settings: (AN-X): 0–255

Sets the offset value to Attack for the Part.
Settings: −64–+63

Sets the offset value to Decay for the Part.
Settings: −64–+63

Sets the offset value to Sustain for the Part.
Settings: −64–+63

Sets the offset value to Release for the Part.
Settings: −64–+63

Attack

Decay

Sustain

Release

Common view

Attack

Decay

Sustain

Release

When the Memory Switches for Arp/MS FX 1 and Arp/MS FX 2 are set to On
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Sets the swing value of the Arpeggio or Motion Sequencer for each Part.
Settings: −120–+120

Sets the Unit Multiply value of the Arpeggio or Motion Sequencer for each Part.
Settings: 50%–400%, Common

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.
Common: The value set in the Unit Multiply common to all Parts is applied.

Sets the Arpeggio gate time rate for each Part.
Settings: 0%–200%

Sets the Arpeggio velocity rate for each Part.
Settings: 0%–200%

Sets the offset value to Swing for each Part.
Settings: −120–+120

Arp/MS FX 1

Part 1–16 view

Swing

Unit (Part Unit Multiply)

Gate Time (Arp Gate Time Rate)

Velocity (Arp Velocity Rate)

Common view

Swing
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Sets the Unit Multiply for all Parts.
Settings: 50%–400%

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.

Sets the offset value to Arpeggio Gate Time Rate for each Part.
Settings: −100–+100

Sets the offset value to Arpeggio Velocity Rate for each Part.
Settings: −100–+100

Sets the Motion Sequencer Amplitude for each Part.
Settings: −127–+127

Sets the Motion Sequencer Pulse Shape for each Part.
Settings: −100–+100

Sets the Motion Sequencer Smoothness for each Part.
Settings: −127–+127

Sets the Motion Sequencer Randomness for each Part.
Settings: 0–127

Sets the offset value to Motion Sequencer Amplitude for each Part.
Settings: −127–+127

Unit (Common Unit Multiply)

Gate Time (Arp Gate Time Rate)

Velocity (Arp Velocity Rate)

Arp/MS FX 2

Part 1–16 view

Amp (Motion Sequencer Amplitude)

Shape (Motion Sequencer Pulse Shape)

Smooth (Motion Sequencer Smoothness)

Random (Motion Sequencer Randomness)

Common view

Amp (Motion Sequencer Amplitude)
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Sets the offset value to Motion Sequencer Pulse Shape for each Part.
Settings: −100–+100

Sets the offset value to Motion Sequencer Smoothness for each Part.
Settings: −127–+127

Sets the offset value to Motion Sequencer Randomness for each Part.
Settings: −127–+127

On the Play/Rec screen, you can record Patterns and Songs to the Internal memory of this
instrument, and Audio to a USB flash drive, and play back your recordings.

Operation

Shape (Motion Sequencer Pulse Shape)

Smooth (Motion Sequencer Smoothness)

Random (Motion Sequencer Randomness)

Play/Rec

Pattern

Playback and playback standby

[SONG/PATTERN] button → Pattern

[PERFORMANCE] → Play/Rec → Pattern

[ ] (Play) button → Pattern
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(1) Link Icon

Shows the name of the selected Pattern.
By tapping on the name, you will see the context menu for Load, Rename, and New Pattern.
You can select a Pattern by using the [INC/YES] and [DEC/NO] buttons when the cursor is on
the Pattern Name.

The link icon is shown if the Performance used for recording the Pattern and the selected
Performance are the same. If not, the broken link icon will be shown.

Shows the name of the selected Performance.

NOTE
The blue flag will be shown when you change a parameter in the Performance.

The Tempo Settings screen appears.

Shows the meter for the Pattern.

Sets the position for starting playback and recording, as well as the current position of the
playback.

Pattern Name

Link Icon

Performance Name

Click Settings

Time Signature

Position
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The number shown on the left is the measure, and the numbers shown on the right are the
beats and clicks.

Sets the tempo for Pattern playback.
Settings: 5–300

Saves the link between the edited Patterns and the Performance used.

NOTE
If you have edited the Performance parameters, you will also need to store the Performance.

Opens the screen for Pattern edit and jobs.

Shows the name of the selected Scene.
This switch is linked to the SCENE buttons on the top panel.

Sets the sequence length of the selected Scene.
Settings: 1–256

Sets the Pattern to start recording or playback the moment you press a key on the keyboard.
Settings: Off, On

Enables/disables chain playback.
Settings: Off, On

Undo cancels the last recording action and deletes what has been just recorded.
This button is active when you change any settings to a sequence.

Redo restores the recording that has been canceled by Undo. This button is active only after
Undo has been used.

Tempo

Store Pattern & Perf Settings (Store Pattern and Performance Settings)

Edit/Job

Scene

Length

Key On Start

Chain

Undo

Redo
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Switches between Part views.

Operation

Sets the meter of the Scene.
Settings: 1/16–16/16, 1/8–16/8, 1/4–8/4

Quantize is a function that corrects the recorded notes to be on the exact fraction of the beat (in
note values).
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

When Loop is set to On, Pattern recording continues in a loop.
Settings: Off, On

Part 1–8
Part 9–16

Recording standby

[SONG/PATTERN] button → Pattern → [ ] (Record) button

[PERFORMANCE] → Play/Rec → Pattern → [ ] (Record) button

Time Signature

Rec Quantize (Record Quantize)

Loop
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NOTE
Pressing the [ ] (Record) button during Song recording sets the recorder to Rehearsal mode and makes
the [ ] (Record) button flash. In Rehearsal mode, playback of the Pattern continues but recording is
temporarily paused, making it useful for practicing. During Song recording, you can press the [ ] (Record)
button to switch between the Recording mode and Rehearsal mode.

Operation

You can delete specific note events by holding down the [SHIFT] button and pressing the key
corresponding to the note you wish to delete.
Alternately, you can tap on the Erase button on the screen to turn on the function, and then
press the corresponding key on the keyboard to delete the note event.

When you operate a controller during overdub recording, you can delete the existing events of
that controller and record the operation as new events.

Operation

[PERFORMANCE] → Play/Rec → Pattern → (with the Song already recorded) → [ ]
(Record) button → Tap Record Type → Select Overdub from the menu → [ ] (Play) button

Recording

[SONG/PATTERN] button → Pattern → [ ] (Record) button → [ ] (Play) button

[PERFORMANCE] → Play/Rec → Pattern → [ ] (Record) button → [ ] (Play) button

Hold [SHIFT] + key to erase
Erase

Overdub recording
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Selects from Replace or Overdub recording.
Settings: Replace, Overdub

By using the Pattern function, you can register a sequence for each Scene.

Undo cancels the last recording action and deletes what has been just recorded.
This button becomes available when one or more Jobs have been used after a sequence has
been recorded.

Redo restores the recording that has been canceled by Undo. This button becomes available
after Undo is used.

Carries out the selected Job to the MIDI sequence.

Operation

Record Type

Pattern Edit screen

Common operations for all tabs on the Pattern Edit screen

Undo

Redo

Execute

Overview

[ ] (Play) button → Pattern → [EDIT/ ] → Overview
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Tap this button to see the Main and Sub categories of the Part.
It also changes the list shown on the Play/Rec screen.

Tap to see the Part Name.
It also changes the list shown on the Play/Rec screen.

Shows the status of mute and solo settings for the Part.

Shows the selected Scene number.

Opens the Save screen. You can save the sequence of the selected Scene as a MIDI file.

Opens the Load screen for loading a MIDI file.
After you have selected a MIDI file, select a Pattern and Scene in the load location.

Sets the sequence length of the selected Scene.

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Overview

Type

Name

Part Mute Icon
Part Solo Icon

Scene

Save As .mid File

Load .mid File

Length
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Shows the current position of the Scene playback, and lets you specify the playback position.
Settings: 001–256

Quantization is the process of adjusting the timing of note events by moving them closer to the
nearest exact beat. You can use this feature, for example, to improve the timing of a Pattern you
have recorded in real time.

Operation

Specifies the track for the Quantize operation.
Settings: All, 1–16

Specifies the Scene for the Quantize operation.
Settings: 1–8

Specifies the starting measure position for the Quantize operation.
Settings: 001–257

Position

Note

Quantize

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Quantize

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Quantize

Track

Scene

Start Measure
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Specifies the starting beat position for the Quantize operation.
Settings: Depends on the Time Signature setting.

Specifies the starting clock position for the Quantize operation.
Settings: Depends on the Time Signature setting.

Specifies the ending measure position for the Quantize operation.
Settings: 001–257

Specifies the ending beat position for the Quantize operation.
Settings: Depends on the Time Signature setting.

Specifies the ending clock position for the Quantize operation.
Settings: Depends on the Time Signature setting.

Sets the quantization resolution (or a note to be used as a base for the quantization).
Settings: Thirty-second note, sixteenth note triplet, sixteenth note, eighth note triplet, eighth

note, quarter note triplet, quarter note, sixteenth note + sixteenth note triplet, eighth
note + eighth note triplet

Sets the “magnetic strength” of the quantization.
When this parameter is set to 100%, all notes will move to the position specified in Quantize.
A setting of 0% results in no quantization.
Settings: 0%–100%

Changes the timing of the even-numbered beats (backbeats) counted from the value specified
in Quantize to add a swing feel to the rhythms.
Settings: Depends on the Quantize (quantization resolution) setting.

When Quantize is set to quarter note, eighth note, sixteenth note, or thirty-
second note: 0 to half the grid
When Quantize is set to quarter note triplet, eighth note triplet, or sixteenth
note triplet: 1 to half the grid

Start Beat

Start Clock

End Measure

End Beat

End Clock

Quantize

Strength

Swing Rate
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When Quantize is set to eighth note + eighth note triplet, or sixteenth note +
sixteenth note triplet: 0 to half the triplet grid

Changes the gate time (or the actual time for the note to be played) of the even-numbered
beats (backbeats) counted from the value specified in Quantize to add a swing feel to the
rhythms.
Settings: 0%–200%

Changes the Velocity value, letting you change the volume of the notes in the specified range.

NOTE
Velocity is calculated by the formula as shown below.
Adjusted Velocity = (original Velocity × Rate) + Offset
If the result is 0 or less, the value is set to 1. If the result is higher than 128, the value is set to 127.

Operation

Sets the velocity of all notes in the selected section.
When set to Off, Set All will not work.
When set to other than Off, Rate and Offset will be disabled.
Settings: Off, 001–127

Gate Time

Velocity

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Velocity

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Velocity

Set All
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Sets the percentage for changing the velocity.
When set to 99% or lower, the velocity will be slower. When set to 101% or higher, the velocity
will be faster.
At 100% the velocity will be kept unchanged.
This parameter cannot be changed when Set All is set to a value other than Off.
Settings: 0%–200%

Sets the value to add to or subtract from the original Velocity value.
When set to −1 or smaller, the velocity will be slower. When set to +1 or larger, the velocity will
be faster.
When set to 0, the velocity will be kept unchanged.
This parameter cannot be changed when Set All is set to a value other than Off.
Settings: −127–+127

Specifies the time for playing notes in the specified section (Gate Time).

NOTE
Gate Time is calculated by the formula as shown below.
Adjusted Gate Time = (Original Gate Time × Rate) + Offset
If the result is 0 or less, the value is set to 1.

Operation

Rate

Offset

Gate Time

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Gate Time

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Gate Time
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The screen here is the same as the one opened from Note → Velocity on the Pattern Edit,
except that the available Set All settings are different.

Settings: Off, 001–9999

This Job lets you create a crescendo or decrescendo over a specified range of notes.
(Crescendo is a gradual increase in volume, and decrescendo is a gradual decrease.)

Operation

Set All

Cresc. (Crescendo)

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Cresc.

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Cresc.
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Sets the intensity of the crescendo or decrescendo. The velocity values of the notes in the
specified range are gradually increased or decreased starting at the first note in the range. The
velocity of the last note in the range becomes the original velocity of the note plus the Velocity
Range value. If the resultant velocity is outside the 1–127 range, it is set to 1 or 127 accordingly.
The setting of +1 or higher produces a crescendo, and the setting of −1 or lower produces a
decrescendo. A setting of 0 produces no change.
Settings: −127–+127

This Job lets you change the key or pitch of the notes in the specified range.

NOTE
When the Transpose job is carried out, any notes outside the allowed range of C−2–G8 will be automatically
changed to fit within the range.

Operation

Velocity Range

Transpose

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Transpose

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Transpose
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For the most part, the screen here is the same as the one opened from Note → Quantize on the
Pattern Edit.

Specifies the range of keys (notes) for transposing.
Tap to open the context menu and then set Keyboard On to use the keys on the keyboard to set
the range.
Settings: C−2–G8

Sets the range of notes to shift in semitones.
A setting of +12 transposes up one octave, while a setting of −12 transposes down an octave.
The value 0 produces no change.
Settings: −127–+127

This Job creates a series of repeated notes (like a drum roll) over the specified range.

Operation

Note

Transpose

Roll

[ ] (Play) button → Pattern → [EDIT/ ] → Note → Roll

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Roll
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For the most part, the screen here is the same as the one opened from Note → Quantize on the
Pattern Edit, except that the available Track settings are different.

Settings: 1–16

Sets the size of the step (i.e., the number of clocks) between each note in the roll.
By setting a smaller value, you can play faster rolls.
The clock specified here is for the beginning of the range.
Settings: 015–999

Sets the size of the step (i.e., the number of clocks) between each note in the roll.
By setting a smaller value, you can play faster rolls.
The clock specified here is for the end of the range.
Settings: 015–999

Sets the note for rolls.
Tap to open the context menu and then set the Keyboard On, so that you can use the key on
the keyboard.
Settings: C−2–G8

Sets the velocity for the strength of rolls.
The velocity specified here is for the beginning of the range.
Settings: 001–127

Track

Start Step

End Step

Note

Start Velocity

163



Sets the velocity for the strength of rolls.
The velocity specified here is for the end of the range.
Settings: 001–127

NOTE
By setting both Start Velocity and End Velocity, you can create crescendo or decrescendo for the rolls.

This Job copies data from a specified source track to the specified destination track or
exchanges data between two specified tracks.

Operation

Copies data from the specified track to another track.

NOTICE

When Copy Track is carried out, the existing data on the destination track will be overwritten
and lost.

End Velocity

Track

Copy/Exchange

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Copy/Exchange

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Copy/Exchange

Copy
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Exchanges data between two tracks.

Specifies the Pattern to copy from.

Specifies the track to copy from.
Settings: All, 1–16

Specifies the Scene to copy from.
Settings: All, 1–8

Specifies the Pattern to copy to.

Specifies the track to copy to.
This parameter is not available when Source is set to All.
Settings: 1–16

Specifies the Scene to copy to.
This parameter is not available when Source is set to All.
Settings: 1–8

Carries out the Copy operation.

NOTE
When Copy Track is carried out with the track and Scene set to All, the Chain data will also be copied.

Carries out the Exchange operation.

NOTE
When Exchange Track is carried out with the track and Scene set to All, the Chain data will also be
exchanged.

Exchange

Pattern Name *1 Source

Track *1 Source

Scene *1 Source

Pattern Name *2 Destination

Track *2 Destination

Scene *2 Destination

Copy Track

Exchange Track
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Mixes (merges) the data from the specified track A and track B and places the result in track B.

Operation

Specifies the first Pattern to mix.

Specifies the track for the Mix operation.
Settings: 1–16

Specifies the Scene for the Mix operation.
Settings: All, 1–8

Specifies the first Pattern to mix.

Specifies the track for the Mix operation.
Settings: 1–16

Mix

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Mix

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Mix

Pattern Name *1 Source A

Track *1 Source A

Scene *1 Source A

Pattern Name *2 Source B

Track *2 Source B
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Specifies the Scene for the Mix operation.
This parameter is not available when Source A is set to All.
Settings: 1–8

Shows the name of the Pattern to mix to.

Shows the track number for the Mix operation.

Shows the Scene number for the Mix operation.
This parameter is not available when Source A is set to All.

Carries out the Mix operation.

Adds the data in the specified track to the end of another track.

Operation

Scene *2 Source B

Pattern Name *3 Destination B

Track *3 Destination B

Scene *3 Destination B

Mix Track

Append

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Append

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Append
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Specifies the Pattern to add from.

Specifies the track for the Append operation.
Settings: All, 1–16

Specifies the Scene for the Append operation.
Settings: 1–8

Specifies the Pattern to add to.

Specifies the track for the Append operation.
This parameter is not available when Source is set to All.
Settings: 1–16

Specifies the Scene for the Append operation.
Settings: 1–8

Carries out the Append operation.

Splits the data of the specified track at the specified measure and moves the second half to
another specified track.

Operation

Pattern Name *1 Source

Track *1 Source

Scene *1 Source

Pattern Name *2 Destination

Track *2 Destination

Scene *2 Destination

Append Track

Split

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Split

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Split
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Specifies the Pattern to split.

Specifies the track for the Split operation.
Settings: All, 1–16

Specifies the Scene for the Split operation.
Settings: 1–8

Specifies the measure at which the data is to be split.
Settings: 2–256

Shows the Pattern to split into.

Shows the track for the Split operation.

Shows the Scene for the Split operation.

Specifies the Pattern to which the split data is to be sent.

Pattern Name *1 Source

Track *1 Source

Scene *1 Source

Measure *1 Source

Pattern Name

Track

Scene

Pattern Name *2 Destination
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Specifies the track for the Split operation.
This parameter is not available when Source is set to All.
Settings: 1–16

Specifies the Scene for the Split operation.
Settings: 1–8

Carries out the Split operation.

Deletes data of the specified track.

Operation

Specifies the pattern to delete.

Specifies the track for the Clear operation.
Settings: All, 1–16

Track *2 Destination

Scene *2 Destination

Spilt Track

Clear

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Clear

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Clear

Pattern Name

Track
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Specifies the Scene for the Clear operation.
Settings: 1–8

Carries out the Clear operation.

NOTE
When Clear Track is carried out with the track and Scene set to All, the Chain data will also be deleted.

Takes the recorded drums from the specified track and assigns each Instrument (individual
percussion instrument in the drum set) to Tracks 9 to 16.

NOTE
When there is existing data on Tracks 9 to 16 and Parts 9 to 16, carrying out the Divide Drum Track operation
will overwrite the existing data. Undo and Redo cannot be used with this operation.

Operation

Specifies the Pattern for the Divide operation.

Scene

Clear Track

Divide Drum Tr (Divide Drum Track)

[ ] (Play) button → Pattern → [EDIT/ ] → Track → Divide Drum Tr

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Divide Drum Tr

Pattern Name

Track
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Specifies the track for the Divide operation.
Settings: 1–16

Carries out the Divide operation.

Copies a specific section of the Song to the specified track.

NOTICE

The existing data at the copy destination will be overwritten and lost.

Operation

Specifies the Song to copy from.

Specifies the track for the Get Phrase operation.
Settings: All, 1–16

Divide Drum Track

Song/Event

Get Phrase

[ ] (Play) button → Pattern → [EDIT/ ] → Song/Event → Get Phrase

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Get Phrase

Song Name

Track *1 Source
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Specifies the starting measure position for the Get Phrase operation.
Settings: 001–998

Specifies the ending measure position for the Get Phrase operation.
Settings: 002–999

Specifies the Pattern to copy to.

Specifies the track to copy to.
This parameter is not available when Source is set to All.
Settings: 1–16

Specifies the Scene to copy to.
Settings: 1–8

Carries out the Get Phrase operation.

Copies specified measures of the Pattern track to the specified Song track.

NOTE
The copied data will be merged into the existing data on the destination track.

Operation

Start Measure

End Measure

Pattern Name

Track *2 Destination

Scene

Get Phrase from Song

Put Phrase

[ ] (Play) button → Pattern → [EDIT/ ] → Song/Event → Put Phrase

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Put Phrase
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Specifies the Pattern to copy from.

Specifies the track for the Put Phrase operation.
Settings: 1–16

Specifies the Scene for the Put Phrase operation.
Settings: 1–8

Specifies the Song to copy to.

Specifies the track for the Put Phrase operation.
Settings: 1–16

Specifies the measure to copy to.
Settings: 001–999

Carries out the Put Phrase operation.

Pattern Name

Track *1 Source

Scene

Song Name

Track *2 Destination

Measure

Put Phrase to Song
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Erases the event.

Operation

For the most part, the screen here is the same as the one opened from Note → Quantize in
Pattern Edit.

Switches the Auto Select setting of the Event Type.
When this is set to On, you can simply move the controller whose data you wish to erase, and
the corresponding controller’s event will automatically be set for Event Type.
Settings: Off, On

Specifies the type of event you wish to erase.
Settings: Note, Poly, CC, NRPN, RPN, PC, AfterTouch, PitchBend, SysEx, All

Shown when the Event Type is set to CC. Specify the Control Change number of the event to
erase.
Settings: All, 1–127

Erase Event

[ ] (Play) button → Pattern → [EDIT/ ] → Song/Event → Erase Event

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Erase Event

Auto Select

Event Type

CC Number
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Carries out the Erase Event operation.

Registers the data in the specified measures of the Scene as a User Arpeggio.

NOTICE

The existing data at the Destination will be overwritten and lost.

Operation

Specifies the Scene for the User Arpeggio operation.
Settings: 1–8

Specifies the starting measure position for the User Arpeggio operation.
Settings: 1–256

Specifies the ending measure position for the User Arpeggio operation.
Settings: 2–257

Erase Event

User Arp (User Arpeggio)

[ ] (Play) button → Pattern → [EDIT/ ] → Song/Event → User Arp

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → User Arp

Scene

Start Measure

End Measure
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Sets the Arpeggio Number of the User Arpeggio to convert to.
Initially, the lowest unused number will be set.
When you specify a number that is already used, the existing Arpeggio at the Destination will be
lost.
Settings: 1–256

Sets the Main and Sub categories of the converted Arpeggio.
Settings: Refer to the Data List.

Enter the Arpeggio Type Name. Up to 20 characters using alphanumeric characters can be
used.

Sets the track number to convert from for each Arpeggio track.
Settings: 1–16

Selects how the MIDI sequence recorded in the Track is to be converted to an Arpeggio.
You can use a different Convert Type for each Arpeggio track.
Settings: Normal, Fixed, Org Notes

Normal: Only the MIDI sequence using the notes played on the keyboard (at the
octave used) is played.
Fixed: The same MIDI sequence is played back no matter how you play the
keyboard.
Org Notes: Basically the same as Fixed, but the MIDI sequence changes according
to the chords you play on the keyboard.

Sets the root note when the Convert Type of any track is set to Org Notes.
This parameter is not available when there is no track set to Org Notes.
Settings: C−2–G8

Converts the Pattern to a User Arpeggio using the settings on the screen.
This button is not available when all tracks are set to Off because conversion is not possible.

Arp (Arp Number)

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)

Name (Arpeggio Name)

Track

Convert Type

Org Notes Root

Store As User Arp (Store As User Arpeggio)
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Applies effects to the MIDI sequence during Pattern playback. Sets the range and level of the
effect for each parameter of the specified track.

Operation

Specifies the track to be normalized.
Settings: All, 1–16

Specifies the Scene to be normalized.
Settings: All, 1–8

Fixes the effect specified in Play FX to the MIDI data.

Sets the sequence length of the selected Scene.

Shows the current position for the Scene playback, and lets you specify the playback position.
Settings: 001–256

Play FX (Play Effects)

[ ] (Play) button → Pattern → [EDIT/ ] → Play FX

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Play FX

Track

Scene

Normalize Play FX

Length

Position
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Controls Qntz Value, Qntz Str, Swing Vel, Swing Gate, and Swing Rate.

Sets the quantization resolution (or a note to be used as a base for the quantization).
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

Sets the “magnetic strength” of the quantization.
When this parameter is set to 100%, all notes will move to the position specified in the Qntz
Value (Quantize Value).
A setting of 0% results in no quantization.
Settings: 0%–100%

Changes the velocity of the even-numbered beats (backbeats) counted from the value specified
in Qntz Value (Quantize Value) to add a swing feel to the rhythms. This parameter is not
available when the quantize resolution is set to Off.
Settings: 0%–200%

Changes the gate time (or the actual time for the note to be played) of the even-numbered
beats (backbeats) counted from the value specified in Qntz Value (Quantize Value) to add a
swing feel to the rhythms. This parameter is not available when the quantize resolution is set to
Off.
Settings: 0%–200%

Changes the timing of the even-numbered beats (backbeats) counted from the value specified
in Qntz Value (Quantize Value) to add a swing feel to the rhythms. This parameter is not
available when the quantize resolution is set to Off.
Settings: 0–Half of quantize resolution

Play FX1

Qntz Value (Quantize Value)

Qntz Str (Quantize Strength)

Swing Vel (Swing Velocity Rate)

Swing Gate (Swing Gate Time Rate)

Swing Rate (Swing Offset)
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Controls Note Shift, Clock Shift, Gate Time, Velocity Rate, and Velocity Offset.

Adjusts the pitch in semitones.
Settings: −99–+99

Shifts the timing of the notes back or forward in clock increments.
Settings: −120–+120

Changes the gate time (the actual time for the sound of the note to be generated) of the note
events.
Settings: 0%–200%

Changes the velocity by the specified percentage.
Settings: 0%–200%

Increases or decreases velocity by the specified value.
Settings: −99–+99

This Job chains Scenes for playback.

Play FX2

Note Shift

Clock Shift

Gate Time

Velocity Rate

Velocity Offset

Chain
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Operation

Enables chain playback.
Settings: Off, On

Specifies the starting measure position for Scene playback.
Settings: 001–999

Sets the Scene to play back at the specified measure.
Settings: 1–8, End

When there are more than eight rows for the list of Measure and Scene, the up or down arrow
will be shown.

Saves the chain as a Song.

Shows the length of the entire sequence.

[ ] (Play) button → Pattern → [EDIT/ ] → Chain

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Chain

Chain

Measure

Scene

Page

Convert to Song

Length
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Shows the current position of chain playback, and lets you specify the playback position.
Settings: 001–999

In the Song screen, you can record your keyboard performance in MIDI Song, and play back
the Song.
The data of both the keyboard performance and the operation of controllers and knobs is
recorded to the MIDI track.
You can also select Arpeggio playback to be recorded to the Song.

Operation

(1) Link Icon
(2) Song Length
(3) Track Play Switch

Position

Song

Playback and playback standby

[SONG/PATTERN] button → Song

[PERFORMANCE] → Play/Rec → Song

[ ] (Play) button → Song

Song Name
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Shows the name of the selected Song.
Tapping on the name calls up the context menu for Load, Rename, New Song, and User Arp.

You can select a Song by using the [INC/YES] and [DEC/NO] buttons when the cursor is on the
Song Name.

Shows the name of the selected Performance.

NOTE
The blue flag will be shown when you change a parameter in the Performance.

The link icon is shown if the Performance used for recording the Song and the selected
Performance are the same. If not, a broken link icon will be shown.

This calls up the Tempo Settings screen.

Shows the meter for the Pattern.

Sets the position for starting playback and recording, as well as the current playback position.
The number shown on the left is the measure, and the numbers shown on the right are the
beats and ticks.

Sets the tempo for Song playback.
Settings: 5–300

Sets Loop playback on or off.
When set to On, the playback of a section between the Loop Start and Loop End points will be
repeated.
Settings: Off, On

Sets the section for Loop playback. The number shown on the left is the measure, and the
number shown on the right is the beat. This parameter is not available when Loop is set to Off.

Performance Name

Link Icon

Click Settings

Time Signature

Position

Tempo

Loop

Loop Start / End
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Saves the link between the edited Songs and the Performance used.

NOTE
If you have edited the Performance parameters, you will also need to store the Performance.

Pressing this button calls up the Save screen, allowing you to save the Song as a file.
Save As .mid File is not available in the following situations.

Shows the length of the entire sequence.

Turns playback of each track on or off.
Settings: Off, On

Operation

New recording

Store Song & Perf Settings (Store Song and Performance Settings)

Save As .mid File

For a new recording (when there is no Song)

During playback

When recording standby is enabled

During recording

Song Length

Track Play Switch

Recording and recording standby

[SONG/PATTERN] button → Song → [ ] (Record) button

[PERFORMANCE] → Play/Rec → Song → [ ] (Record) button
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When something has already been recorded

Shows the meter for the Song.
Settings: 1/16–16/16, 1/8–16/8, 1/4–8/4

Quantize is a function that corrects the recorded notes to be on the exact fraction of the beat (in
note values).
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

Selects a record type for the tracks already recorded. This parameter is not available for a new
recording.
Settings: Replace, Overdub, Punch

Replace: Overwrite and record in real-time. The existing data will be lost.

Time Signature

Rec Quantize

Record Type
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Overdub: Overdub and record in real-time. The existing data will not be lost.
Punch: Re-record a section and record in real-time. This overwrites the existing data
of a specified section.

Sets the Punch in point (specific measure and beat at which to start re-recording).
This parameter is available only when Record Type is set to Punch.

Sets the Punch out point (specific measure and beat at which to end re-recording).
This parameter is available only when Record Type is set to Punch.

When Arp Rec is On, the results of Arpeggio playback are recorded. When set to Off, only the
keyboard performance is recorded.
This parameter can be set for recording a new Song. The setting cannot be changed after the
recording.
To add something to the Song recorded with Arp Rec set to Off, only Replace can be used for
Record Type.
Settings: Off, On

NOTE
With the Song with Arp Rec set to Off, you can select a different Arpeggio for playback by changing the
Arpeggio selection in the Performance.

Undo cancels the last recording action and deletes what has been just recorded.
This button is active when you change any settings to a sequence.

Redo restores the recording that has been canceled by Undo. This button is only active after
Undo has been used.

Converts the selected Song to a User Arpeggio.
Up to 16 different notes can be converted. (All notes with the same Note Number are counted
as one.)
Make sure to use only up to 16 notes for a Song if you wish to convert it to a User Arpeggio,
especially when you use multiple tracks.

Punch In

Punch Out

Arp Rec

Undo

Redo

Put Track to Arpeggio
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Operation

Open the screen from the [PERFORMANCE] → Play/Rec → Song → Tap on the Song Name to
open the context menu → User Arp

Sets the Arpeggio Number of the User Arpeggio for conversion.
Initially, the next unused number will be set.
Keep in mind that if you change this to a number already being used, the Arpeggio will be
overwritten, meaning that you will lose the existing User Arpeggio for that number.
Settings: 1–256

Sets the Main and Sub categories of the converted Arpeggio.
Settings: Refer to the Data List.

Sets the Arpeggio Name. You can use up to 20 alphanumeric characters.

Sets the track number of the Song to convert from for each Arpeggio track.
Settings: 1–16

Selects how to convert the MIDI sequence recorded in the Song to the Arpeggio from three
different settings.
You can use a different Convert Type for each Arpeggio track.

Arp (Arpeggio Number)

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)

Name (Arpeggio Name)

Song Track

Convert Type
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Settings: Normal, Fixed, Org Notes
Normal: The Arpeggio is played back at the same octave as the recorded MIDI
Sequence.
Fixed: The recorded MIDI sequence is played back the same way no matter how you
play the keyboard.
Org Notes: Basically, the same as Fixed; however, the playback of the MIDI
sequence changes according to the chords you play on the keyboard.

Sets the root note when the Convert Type of any track is set to Org Notes.
This parameter is not available when no track is set to Org Notes.
Settings: C−2–G8

Sets the starting measure for the conversion.
Settings: 1–998

Sets the ending measure for the conversion.
Settings: 2–999

Converts the Song to a User Arpeggio with the settings specified on this screen.
This button is not available when all tracks are set to Off.

On the Audio screen, you can record your keyboard performance as an audio file in WAV (44.1-
kHz, 24-bit stereo) to the USB flash drive. You can record up to 74 minutes or longer, to the
maximum capacity of the USB flash drive.

Operation

Org Notes Root (Original Notes Root)

Start Measure

End Measure

Store As User Arp

Audio

Playback and playback standby

[SONG/PATTERN] button → Audio

[PERFORMANCE] → Play/Rec → Audio

[ ] (Play) button → Audio
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Shows the name of the selected Audio file.
Tapping on the name calls up the context menu for Load.

Sets the position for starting playback, as well as the current playback position.

Sets the position for starting playback. This parameter is not available during recording.
Settings: 0–255

Shows the total length of the audio file.

Shows the audio input and output level.

Operation

[PERFORMANCE] → Play/Rec → Audio → [ ] (Record) button

Audio Name

Position

Audio Volume

Audio Length

Level meter

Recording and recording standby
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Shows the recordable time for audio. This parameter is shown only while recording standby is
enabled.

Selects how to start recording. This parameter is shown only while recording standby is
enabled.

When Trigger Level is set to manual, you can start recording by pressing the [ ] (Play) button.

When Trigger Level is set to a value between 1 to 127, you can start recording after you press
the [ ] (Play) button and the signal level exceeds the specified value. The level set here will
be indicated by blue triangles in the level meter.
For best results, set this parameter as low as possible to capture the entire signal, but not so
low as to record unwanted noise.
Settings: manual, 1–127

Tap on the Smart Morph map, and create changes in the FM-X sound or AN-X sound on Part 1.

Operation

[PERFORMANCE] → Smart Morph → Play

Recordable (Audio Recordable Time)

Trigger Level

Smart Morph

Play
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Operation

[PERFORMANCE] → Smart Morph → Edit

Tap to open the Part Category Search screen for selecting an FM-X sound or AN-X sound.

Tapping on the name calls up the context menu for Category Search, Edit, and Property.

Selects the Part Main Category view or Part Name view for Parts.

Edit

Unused Part

Part being used

Display
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Switches between FM-X and AN-X.
Settings: FM-X, AN-X

Tap the button to start machine learning (map creation).
This button will not be shown when there is no FM-X sound or AN-X sound on Parts 9 to 16.

After the Learn operation, the Undo button will be shown on the upper right.
Use the Undo button to restore the original map before using machine learning.
After the Undo operation, the Redo button will appear, and you can use it to restore the map
before the Undo operation.

Operation

[PERFORMANCE] → Smart Morph → Analyze

Mode

Learn

Undo
Redo

Analyze
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Each dot on the map represents the parameter value indicating a degree or level as a shade of
red.
For the list of available parameters, see “Parameters that can be set for Red, Green, and Blue.”

Each dot on the map represents the parameter value indicating a degree or level as a shade of
green.
For the list of available parameters, see “Parameters that can be set for Red, Green, and Blue.”

Each dot on the map represents the parameter value indicating a degree or level as a shade of
blue.
For the list of available parameters, see “Parameters that can be set for Red, Green, and Blue.”

When set to Auto, the Red, Green, and Blue are automatically reset for the Learn process.
When set to Manual, the Red, Green, and Blue are not reset automatically for the Learn
process.
Settings: Auto, Manual

Tap the button to start machine learning (map creation).

After the Learn operation, the Undo button will be shown on the upper right.
Use the Undo button to restore the original map before using machine learning.

Red

Green

Blue

Coloring

Learn

Undo
Redo
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After the Undo operation, the Redo button will appear, and you can use it to restore the map
before the Undo operation.

Parameter Name Display Name

Random Pan Depth Random Pan Depth

Alternate Pan Depth Alternate Pan

Scaling Pan Depth Scaling Pan Depth

Key On Delay Time Length KeyOnDly Time

Key On Delay Tempo Sync Switch KeyOnDly Sync

Key On Delay Note Length KeyOnDly Note

Pitch Velocity Sensitivity Pitch/Vel

Random Pitch Depth Random Pitch Depth

Pitch Key Follow Sensitivity Pitch/Key

Pitch Key Follow Sensitivity Center Note Pitch/Key Center

PEG Initial Level PEG Initial Lvl

PEG Attack Level PEG Attack Lvl

PEG Decay 1 Level PEG Decay 1 Lvl

PEG Decay 2 Level PEG Decay 2 Lvl

PEG Release Level PEG Release Lvl

PEG Attack Time PEG Attack Tm

PEG Decay 1 Time PEG Decay 1 Tm

PEG Decay 2 Time PEG Decay 2 Tm

PEG Release Time PEG Release Tm

PEG Depth Vel Sensitivity PEG Depth/Vel

PEG Depth PEG Depth

PEG Time Key Follow PEG Time/Key

2nd LFO Wave 2nd LFO Wave

2nd LFO Speed LFO Speed

2nd LFO Phase LFO Phase

Parameters that can be set for Red, Green, and Blue:
FM Common
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Parameter Name Display Name

2nd LFO Delay Time LFO Delay

2nd LFO Key On Reset LFO Key On Reset

2nd LFO Pitch Mod Depth LFO Pitch Mod

2nd LFO Amp Mod Depth LFO Amp Mod

2nd LFO Filter Mod Depth LFO Filter Mod

Algorithm Number Algorithm Number

Feedback Level Feedback Level

LFO Speed Range LFO Speed Range

LFO Extended Speed LFO Ex Speed

Filter Type Filter Type

Filter Cutoff Frequency Cutoff

Filter Cutoff Vel Sensitivity Cutoff/Vel

Filter Resonance/Width Resonance / Width

Resonance Vel Sensitivity Res/Vel

HPF Cutoff Frequency HPF Cutoff

Distance Distance

Filter Gain Filter Gain

FEG Hold Time FEG Hold Tm

FEG Attack Time FEG Attack Tm

FEG Decay 1 Time FEG Decay 1 Tm

FEG Decay 2 Time FEG Decay 2 Tm

FEG Release Time FEG Release Tm

FEG Hold Level FEG Hold Lvl

FEG Attack Level FEG Attack Lvl

FEG Decay 1 Level FEG Decay 1 Lvl

FEG Decay 2 Level FEG Decay 2 Lvl

FEG Release Level FEG Release Lvl

FEG Depth FEG Depth

FEG Time Velocity Sensitivity Segment FEG Segment

FEG Time Vel Sensitivity FEG Time/Vel

195



Parameter Name Display Name

FEG Depth Vel Sensitivity FEG Depth/Vel

FEG Depth / Vel Curve FEG Curve

FEG Time Key Follow FEG Time/Key

FEG Time Key Follow Sensitivity Center Note FEG Center

Filter Cutoff Key Follow Flt Cutoff/Key

Filter Cutoff Scaling Break Point 1 Flt Break Point 1

Filter Cutoff Scaling Break Point 2 Flt Break Point 2

Filter Cutoff Scaling Break Point 3 Flt Break Point 3

Filter Cutoff Scaling Break Point 4 Flt Break Point 4

Cutoff Scaling Offset 1 Flt Cutoff Offset 1

Cutoff Scaling Offset 2 Flt Cutoff Offset 2

Cutoff Scaling Offset 3 Flt Cutoff Offset 3

Cutoff Scaling Offset 4 Flt Cutoff Offset 4

HPF Cutoff Key Follow HPF Cutoff/Key

Parameter Name Display Name

Key On Reset Key On Reset

Freq Mode Freq Mode

Coarse Coarse

Fine Fine

Detune Detune

Pitch/Key Pitch/Key

Pitch/Vel Pitch/Vel

Spectral Spectral

Skirt Skirt

Resonance Resonance

Initial PEG Initial Lvl

Attack PEG Attack Lvl

Attack PEG Attack Tm

Operator
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Parameter Name Display Name

Decay PEG Decay Tm

Attack AEG Attack Lvl

Decay 1 AEG Decay 1 Lvl

Decay 2 AEG Decay 2 Lvl

Rel(Hold) AEG Release Lvl

Attack AEG Attack Tm

Decay 1 AEG Decay 1 Tm

Decay 2 AEG Decay 2 Tm

Release AEG Release Tm

Hold AEG Hold Tm

Time/Key AEG Time/Key

Level Level

Break Point Lvl Break Point

Lvl/Key Lo Lvl/Key Lo

Lvl/Key Hi Lvl/Key Hi

Curve Lo Curve Lo

Curve Hi Curve Hi

Level/Vel Level/Vel

Depth Offset LFO PM Depth

Depth Offset LFO AM Depth

Pitch/Ctrl Pitch/Ctrl

Level/Ctrl Level/Ctrl

Parameter Name Display Name

Random Pan Depth Random Pan

Alternate Pan Depth Alternate Pan

Scaling Pan Depth Scaling Pan

Key On Delay Time Length Delay Length

Key On Delay Tempo Sync Switch KeyOnDly Sync

AN-X Common
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Parameter Name Display Name

Key On Delay Note Length Delay Length

Unison Unison

Unison Detune Unison Detune

Unison Spread Unison Spread

OSC Reset OSC Reset

Voltage Drift Voltage Drift

Ageing Ageing

Pitch EG Attack Time Attack

Pitch EG Decay Time Decay

Pitch EG Sustain Level Sustain

Pitch EG Release Time Release

Pitch EG Time Velocity Sensitivity Time/Vel

Pitch LFO Wave Wave

Pitch LFO Speed Speed

Pitch LFO Key On Reset Key On Reset

Pitch LFO Phase Phase

Pitch LFO Delay Time Delay

Pitch LFO Fade In Time Fade In

Noise Generator Tone Noise Tone

Noise Generator Out Select Connect

Noise Generator Out Level Out Level

Noise Generator Out Level Velocity Sensitivity Out Level/Vel

Filter Common Cutoff EG Attack Time Attack

Filter Common Cutoff EG Decay Time Decay

Filter Common Cutoff EG Sustain Level Sustain

Filter Common Cutoff EG Release Time Release

Filter Common Cutoff EG Time Velocity Sensitivity Time/Vel

Filter Common Cutoff LFO Wave Wave

Filter Common Cutoff LFO Speed Speed

Filter Common Cutoff LFO Key On Reset Key On Reset
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Parameter Name Display Name

Filter Common Cutoff LFO Phase Phase

Filter Common Cutoff LFO Delay Time Delay

Filter Common Cutoff LFO Fade In Time Fade In

Amplitude Level Level

Amplitude Level Velocity Sensitivity Level/Vel

Amplitude Level LFO Depth LFO Depth

Amplitude Level Key Follow Level/Key

Amplitude Saturator Drive Drive

Amplitude EG Attack Time Attack

Amplitude EG Decay Time Decay

Amplitude EG Sustain Level Sustain

Amplitude EG Release Time Release

Amplitude EG Time Velocity Sensitivity Time/Vel

Amplitude LFO Wave Wave

Amplitude LFO Speed Speed

Amplitude LFO Key On Reset Key On Reset

Amplitude LFO Phase Phase

Amplitude LFO Delay Time Delay

Amplitude LFO Fade In Time Fade In

Parameter Name Display Name

Oscillator Wave Wave

Oscillator Octave Octave

Oscillator Pitch Pitch

Oscillator Pitch EG Depth Pitch EG Depth

Oscillator Pitch EG Depth Velocity Sensitivity Pitch EG Depth/Vel

Oscillator Pitch LFO Depth Pitch LFO Depth

Oscillator Self Sync Pitch Sync Pitch

Oscillator Self Sync Pitch Velocity Sensitivity Sync Pitch/Vel

Oscillator
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Parameter Name Display Name

Oscillator Self Sync EG Depth Sync

Oscillator Self Sync LFO Depth Sync

Oscillator Pulse Width Pulse Width

Oscillator Pulse Width Velocity Sensitivity PulseWidth/Vel

Oscillator Pulse Width EG Depth Pulse Width

Oscillator Pulse Width LFO Depth Pulse Width

Oscillator Wave Shaper Shaper

Oscillator Wave Shaper Velocity Sensitivity Shaper/Vel

Oscillator Wave Shaper EG Depth Shaper

Oscillator Wave Shaper LFO Depth Shaper

Oscillator FM Level FM Level

Oscillator FM Level Velocity Sensitivity FM Level/Vel

Oscillator Ring Level Ring Level

Oscillator Ring Level Velocity Sensitivity Ring Level/Vel

Oscillator Out Select Connect

Oscillator Out Invert Enable Invert

Oscillator Out Level Out Level

Oscillator Out Level Velocity Sensitivity Out Level/Vel

Oscillator EG Attack Time Attack

Oscillator EG Decay Time Decay

Oscillator EG Sustain Level Sustain

Oscillator EG Release Time Release

Oscillator LFO Wave Wave

Oscillator LFO Speed Speed

Oscillator LFO Key On Reset Key On Reset

Oscillator LFO Phase Phase

Oscillator LFO Delay Time Delay

Oscillator LFO Fade In Time Fade In

Filter
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Parameter Name Display Name

Filter Type Type

Filter Cutoff Cutoff

Filter Cutoff Velocity Sensitivity Cutoff/Vel

Filter Cutoff EG Depth Filter EG Depth

Filter Cutoff EG Depth Velocity Sensitivity Filter EG Depth/Vel

Filter Cutoff LFO Depth Filter LFO Depth

Filter Cutoff Key Follow Cutoff/Key

Filter Resonance Resonance

Filter Resonance Velocity Sensitivity Resonance/Vel

Filter Saturator Drive Saturator Drive

Filter Saturator Drive Velocity Sensitivity Saturator Drive/...

Filter Out Level Out Level

Parameter Name Display Name

Modifier Wave Folder Wave Folder

Modifier Wave Folder Velocity Sensitivity Folder/Vel

Modifier Wave Folder EG Depth EG Depth

Modifier Wave Folder LFO Depth LFO Depth

Modifier Wave Folder Texture Texture

Modifier Wave Folder Type Type

Modifier EG Attack Time Attack

Modifier EG Decay Time Decay

Modifier EG Sustain Level Sustain

Modifier EG Release Time Release

Modifier EG Time Velocity Sensitivity Time/Vel

Modifier LFO Wave Wave

Modifier LFO Speed Speed

Modifier LFO Key On Reset Key On Reset

Modifier LFO Phase Phase

Modifier
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Parameter Name Display Name

Modifier LFO Delay Time Delay

Modifier LFO Fade In Time Fade In

Operation

[PERFORMANCE] → Smart Morph → Super Knob

When set to On, you can use the Super Knob for following the path on the map from start to
end, instead of running your finger across the touchscreen.
Settings: Off, On

Sets the position of the smallest Super Knob value on the map.
When the cursor is on Start, tap on the map to set the value for the Starting point.

Sets the position of the largest Super Knob value on the map.
When the cursor is on End, tap on the map to set the value of the ending point.

Sets the number of interspersed points (waypoints) between the start and end.
Settings: 0–6

Super Knob

Super Knob Link

Start

End

Waypoints
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Sets the position on the map.

Operation

[PERFORMANCE] → Smart Morph → Job

Opens the Load screen.
On the Load screen, you can select another Performance and import the Smart Morph settings
from that Performance to the current Performance.

Deletes the Smart Morph settings from the selected Performance.

Deletes all Parts 9 to 16 at once to make these Parts unused.
When Parts 9 to 16 are set to unused, the SSS will be enabled.
Parts 9 to 16 are used for creating a Smart Morph map.
When you are finished adjusting the parameters and you no longer need to use the map, you
can delete Parts 9 to 16.

Waypoint 1–Waypoint 6

Job

Load Smart Morph

Delete Smart Morph

Delete Part 9–16
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om02screenparameters0060

On the Common Edit screen, you can edit the parameters for the entire Performance as well as
the parameters for the Audio Part.

Contents

Common Edit screen

General/Pitch

Perf Settings

USB Monitor

Pitch

Edit User Tuning

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Variation

Reverb

Master FX

Master EQ

Envelope Follower Edit

Audio In

Mixing

Routing

Ins A

Ins B

2-band EQ

Arp/MS

Arp Common

Arp Overview (Arpeggio Overview)

MS Common (Motion Sequencer Common)

MS Overview (Motion Sequencer Overview)
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On the Perf Settings screen, you can set general parameters for the Performance.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → General/Pitch → Perf Settings

Sets the Main category and Sub category of the selected Performance.
Settings: Refer to the Data List.

Lane

Motion Sequence Edit

Control

Control Assign

After Touch

Ribbon Settings

Control Number

Control Settings

General/Pitch

Perf Settings

Main Category
Sub Category

Performance Name
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You can save the Performance you are editing under a new name, using up to 20 alphanumeric
characters.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Sets an MC flag to the selected Performance.
When set to On, the MC flag appears on the Performance screen. Also, on the Performance
Category Search screen, the Performance will be filtered by the MC attribute.
Settings: Off, On

Sets the volume of the selected Performance.
Settings: 0–127

Sets the Pan of the selected Performance.
Settings: L63–C–R63

Sets the output level (Return Level) of the signals processed by the Variation Effect.
Settings: 0–127

Sets the output level (Return Level) of the signals processed by the Reverb Effect.
Settings: 0–127

Sets Portamento on or off for Parts having the Portamento Part Sw set to On.
This switch is linked to the [PORTAMENTO] button on the top panel.
Settings: Off, On

Sets the time length (or speed) for the pitch transition of Portamento.
This is specified as an offset value to the Part Portamento time.
Settings: −64–+63

Converts all Songs saved to internal memory into User Auditions.
If any User Auditions already exist, all previous User Auditions will be overwritten.

MC Flag (Motion Control Flag)

Volume (Performance Volume)

Pan (Performance Pan)

Var Return (Variation Return)

Rev Return (Reverb Return)

Portamento Master Sw (Portamento Master Switch)

Portamento Time

Update User Auditions
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Selects the bank for the audition phrases.

Selects the audition phrase.
The preset Performances already have suitable audition phrases assigned.
By playing back the audition phrase, you can listen to the selected Performance in an
appropriate musical context.
Settings: Refer to the Data List.

Shows the name of the audition phrase.

Adjusts the pitch of the notes in the audition phrase in semitones.
Settings: −24–+24

Adjusts the velocity of the notes in the audition phrase.
Settings: −63–+63

On the USB Monitor screen, you can adjust the volume of the audio signals input from the [USB
TO HOST] terminals.
When you tap on the USB Volume in the Audio Signal Flow, the cursor moves to the USB
Volume on the Audio I/O screen.

NOTE
USB Main Monitor Volume and USB Assign Monitor Volume are saved (stored) in the Performance.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → General/Pitch → USB Monitor

Audition Bank

Audition Phrase Number

Audition Phrase Name

Note Shift (Audition Note Shift)

Velocity Shift (Audition Velocity Shift)

USB Monitor
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Adjusts the volume of the audio signals input from the [USB TO HOST] terminal and output to
the OUTPUT jacks.
Settings: 0–127

Adjusts the volume of the audio signals input from the [USB TO HOST] terminal and output to
the ASSIGNABLE OUTPUT (BALANCED) jacks.
Settings: 0–127

Opens the UTILITY Audio I/O screen.
The same screen can be opened from [UTILITY]→Settings→Audio I/O.

On the Pitch screen, you can make pitch settings.

Operation

Monitor Volume Main

Monitor Volume Assign

Audio Settings

Pitch

[PERFORMANCE] → Common selection → [EDIT/ ] → General/Pitch → Pitch

[SHIFT] + [PORTAMENTO]

Portamento View
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Sw, Mode, Time, and Time Mode will not be shown for the Drum Part.

Switches the view between Parts 1 to 8 and Parts 9 to 16.

Sets Portamento to be applied to Parts having the Portamento Part Switch set to On.
This switch is linked to the [PORTAMENTO] button on the top panel.
Settings: Off, On

Sets the time length (or speed) for the pitch transition of Portamento.
This is specified as an offset value to the Part Portamento time.
Settings: −64–+63

The Parts in the same group are given the same pitch.
This is convenient when you wish to apply Portamento to a layered sound or have the same
micro-tuning settings for multiple Parts at once.

Sets Portamento on or off for the Part.
Settings: Off, On

Sets how Portamento is applied by the way you play the keyboard.

Part

Master Sw (Portamento Master Switch)

Time (Portamento Time)

Group (Pitch Control Group)

Sw (Portamento Part Switch)

Portamento Mode
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Settings: Fingered, Full-time
Fingered: Portamento is applied only when you play legato (playing the next note
before releasing the previous one).
Full-time: Portamento is applied to all notes.

Sets the time length (or speed) for the pitch transition of Portamento for the Part.
Settings: 0–127

Sets how the pitch changes over time.
Settings: Rate 1, Time 1, Rate 2, Time 2

Rate 1: Pitch changes at a specific rate.
Time 1: Pitch changes at a specific time.
Rate 2: Pitch changes at a specific rate within an octave.
Time 2: Pitch changes at a specific time within an octave.

Mono / Poly will not be shown for the Drum Part.

Sets the range of the changes created with the Pitch Bend wheel in semitones.
Settings: −48–+0–+24

Time (Portamento Part Time)

Time Mode (Portamento Time Mode)

Pitch Bend / Mono View

Lower (Pitch Bend Lower)
Upper (Pitch Bend Upper)

Mono / Poly

210



Sets the tone generation mode for the keyboard.
Mono is for playing single notes, and Poly is for playing multiple simultaneous notes.
Settings: Mono, Poly

Opens the Control Assign screen for Common Edit.

Micro Tuning Name and Root will not be shown for the Drum Part.

Sets the micro tuning (temperament) for the Part.
Settings: Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti &

Young, 1/4 shift, 1/4 tone, 1/8 tone, Indian, Arabic 1, Arabic 2, Arabic 3, User 1–8
(when a User bank is selected), Library 1-1–16-8 (when a library file is loaded)

Sets the root note for the micro tuning.
This parameter is not shown when the selected type in Micro Tuning Name does not require a
root note.
Settings: C–B

Opens the Global Tuning setting screen.

Opens the User Tuning setting screen.

Edit Control Assign

Micro Tuning view

Micro Tuning Name

Root (Micro Tuning Root)

Edit Global Tuning

Edit User Tuning
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Adjusts the pitch in semitones.
Settings: −24–+0–+24

Adjusts the pitch of the Part in 0.1 Hz increments.
By slightly shifting the pitch, you can detune the sound.
Settings: −12.8Hz–+0.0Hz–+12.7Hz

This is the setting screen for User Micro Tuning.

Note Shift / Detune View

Shift (Note Shift)

Detune

Edit User Tuning

Tuning No. (Micro Tuning Number)
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Indicates the selected User Micro Tuning Number.
Settings: 1–8

You can save the User Micro Tuning you are editing under a new name.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

You can adjust the pitch of each note in cents to set the micro tuning.
Settings: −99–+99

Initializes the selected User Micro Tuning.

On the Filter EG screen, you can set the Filter Envelope Generator (FEG).
This lets you set the degree (or level) of changes to the cutoff frequency and how those
changes evolve over time, starting from the moment you press a key on the keyboard to the
moment the sound decays.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Filter/Amp → Filter EG

Tuning Name (Micro Tuning Name)

C, C♯, D, D♯, E, F, F♯, G, G♯, A, A♯, B

Initialize

Filter/Amp

Filter EG

FEG Atk (FEG Attack Time)
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Sets the length of time it takes for the sound to change from the moment you press a key until
when the Cutoff Frequency reaches the value set at Attack Level.
This is specified as an offset value to the Part FEG.
Settings: −64–+63

Sets the length of time it takes for the Cutoff Frequency to change from the attack level. You can
control the crispness or the decay speed of the sound.
This is specified as an offset value to the Part FEG.
Settings: −64–+63

Sets the length of time it takes for the Cutoff Frequency to fall to the Release level when you
release the key.
This is specified as an offset value to the Part FEG.
Settings: −64–+63

Changes the sound by setting the cutoff frequency of the filter.
When the Low Pass Filter is selected, you can make the sound brighter by setting this to a
larger value, and darker by setting it to a smaller value.
This is specified as an offset value to the filter cutoff frequency for the Part.
Settings: −64–+63

Adds special characteristics to the sound by adjusting the signal level near the cutoff frequency.
This is specified as an offset value to the filter resonance for the Part.
Settings: −64–+63

Sets the depth range of the cutoff frequency change controlled by the FEG.
This is specified as an offset value to the Part FEG Depth.
Settings: −64–+63

On the Amp EG screen, you can set the AEG (Amplitude Envelope Generator) time. By setting
the Amp EG, you can set how the volume changes from the moment you press a key on the
keyboard to when the sound decays.

FEG Decay (FEG Decay Time)

FEG Rel (FEG Release Time)

Cutoff (Cutoff Frequency)

Resonance

FEG Depth

Amp EG
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Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Filter/Amp → Amp EG

The settings on the Amp EG screen are offset values to the AEG for all Parts.

Sets the length of time it takes for the volume to change from the moment you press a key on
the keyboard to when it reaches the maximum.
Settings: −64–+63

Sets the length of time it takes for the volume to change after it has reached the maximum.
Settings: −64–+63

Sets the volume that is maintained while the key is held down.
Settings: −64–+63

Sets the length of time it takes for the sound to decay after you have released the key.
Settings: −64–+63

Attack (AEG Attack Time)

Decay (AEG Decay Time)

Sustain (AEG Sustain Level)

Release (AEG Release Time)
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On this screen, you can set the System Effects applied to all Parts and view the signal flow of
the Master Effects.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Routing

Sets the Variation, Reverb, and Master Effects on or off.
Settings: Off, On

Sets the type for the Variation, Reverb, and Master Effects.
Settings: See the Effect types.

Selects a Preset from the Variation, Reverb, and Master Effects parameters.
Settings: Refer to the Data List.

Effect

Routing

Var (Variation Switch)
Rev (Reverb Switch)
MFX (Master Effect Switch)

Var Type (Variation Type)
Rev Type (Reverb Type)
MFX Type (Master Effect Type)

Var Preset (Variation Preset Number)
Rev Preset (Reverb Preset Number)
MFX Preset (Master Effect Preset Number)
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Sets the Side Chain Part (or the Modulator depending on the effect type) for the Variation and
Master Effects.
This parameter is not available when Master is set to the Modulator Part. In that case, the
parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

Sets the output level (Return Level) of the signals processed by the Variation or Reverb Effect.
Settings: 0–127

Sets the stereo location of the signals processed by the Variation or the Reverb Effect.
Settings: L63 (left)–C (center)–R63 (right)

Sets the send level of the signals processed by the Variation Effect.
Settings: 0–127

Sets the Master EQ on or off.
Settings: Off, On

Opens the settings screen for Envelope Follower.

Sets the Variation Effect.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Variation

Side Chain (Variation Side Chain Part)
Side Chain (Master Effect Side Chain Part)
Modulator (Variation Modulator Part)
Modulator (Master Effect Modulator Part)

Var Return (Variation Return)
Rev Return (Reverb Return)

Var Pan (Variation Pan)
Rev Pan (Reverb Pan)

Var to Rev (Variation To Reverb)

Master EQ (Master EQ Switch)

Envelope Follower

Variation
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(1) Variation Switch

Sets the Variation Effect on or off.
Settings: Off, On

Sets the category and type of the Variation Effect.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
Settings: Refer to the Data List.

Sets the Part for the Side Chain (or the Modulator depending on the effect type) for the Variation
Effect.
This parameter is not available when Master is set to the Modulator Part. In that case, the
parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

The Effect Parameters differ depending on the effect type.
Settings: See the Effect parameters.

Variation Switch

Category (Variation Category)
Type (Variation Type)

Preset (Variation Preset Number)

Side Chain (Variation Side Chain Part)
Modulator (Variation Modulator Part)

Effect Parameter
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Sets the Reverb Effect.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Reverb

(1) Reverb Switch

Sets the Reverb Effect on or off.
Settings: Off, On

Sets the category and type of the Reverb Effect.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
Settings: Refer to the Data List.

The Effect Parameters differ depending on the effect type.
Settings: See the Effect parameters.

Reverb

Reverb Switch

Category (Reverb Category)
Type (Reverb Type)

Preset (Reverb Preset Number)

Effect Parameter

219



Sets the Master Effect.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Master FX

(1) Master Effect Switch

Sets the Master Effect on or off.
Settings: Off, On

Sets the category and type of the Master Effect.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
Settings: Refer to the Data List.

Sets the Side Chain (or the Modulator depending on the effect type) for the Master Effects.
This parameter is not available when Master is set to the Modulator Part. In that case, the

Master FX

Master Effect Switch

Category (Master Effect Category)
Type (Master Effect Type)

Preset (Master Effect Preset Number)

Side Chain (Master Effect Side Chain Part)
Modulator (Master Effect Modulator Part)
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parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

The Effect Parameters differ depending on the effect type.
Settings: See the Effect parameters.

Sets the Master EQ.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Effect → Master EQ

Sets the Master EQ on or off.
Settings: Off, On

Sets the signal level of the Low band.
Settings: −12–+12 (dB)

Sets the signal level of the Lo Mid band.
Settings: −12–+12 (dB)

Effect Parameter

Master EQ

Master EQ (Master EQ Switch)

Low Gain (Master EQ Low Gain)

Lo Mid Gain (Master EQ Low Mid Gain)
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Sets the signal level of the Mid band.
Settings: −12–+12 (dB)

Sets the signal level of the Hi Mid band.
Settings: −12–+12 (dB)

Sets the signal level of the High band.
Settings: −12–+12 (dB)

Sets the frequency of the Low band.
Settings: 32 (Hz)–2.0 (kHz)

Sets the frequency of the Lo Mid band.
Settings: 100 (Hz)–10 (kHz)

Sets the frequency of the Mid band.
Settings: 100 (Hz)–10 (kHz)

Sets the frequency of the Hi Mid band.
Settings: 100 (Hz)–10 (kHz)

Sets the frequency of the High band.
Settings: 500 (Hz)–16 (kHz)

Sets the bandwidth of the Low band.
This parameter is available only when Low Shape (Master EQ Low Shape) is set to Peak.
Settings: 0.1–12.0

Sets the bandwidth of the Lo Mid band.

Mid Gain (Master EQ Mid Gain)

Hi Mid Gain (Master EQ High Mid Gain)

High Gain (Master EQ High Gain)

Low Freq (Master EQ Low Frequency)

Lo Mid Freq (Master EQ Low Mid Frequency)

Mid Freq (Master EQ Mid Frequency)

Hi Mid Freq (Master EQ High Mid Frequency)

High Freq (Master EQ High Frequency)

Low Q (Master EQ Low Q)

Lo Mid Q (Master EQ Low Mid Q)
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Settings: 0.1–12.0

Sets the bandwidth of the Mid band.
Settings: 0.1–12.0

Sets the bandwidth of the Hi Mid band.
Settings: 0.1–12.0

Sets the bandwidth of the High band.
This parameter is available only when High Shape (Master EQ High Shape) is set to Peak.
Settings: 0.1–12.0

Determines whether the EQ is set to a shelving type (that cuts or boosts the signals above or
below a specified frequency setting) or a peaking type (that cuts or boosts the signals at a
specified frequency) for the EQ.
Settings: Shelf, Peak

Opens the settings screen for Envelope Follower.

Shows the input source for the selected Envelope Follower.

Mid Q (Master EQ Mid Q)

Hi Mid Q (Master EQ High Mid Q)

High Q (Master EQ High Q)

Low Shape (Master EQ Low Shape)
High Shape (Master EQ High Shape)

Envelope Follower Edit

Part (Input Source)
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Settings: Master, AD, Part 1–16

Sets the input gain on the input source set for the Part.
Settings: −24.0dB–0.0dB–+24.0dB

Sets the attack time for the envelope follower.
Settings: 1ms–40ms

Sets the release time for the envelope follower.
Settings: 10ms–680ms

Shows the Input level for the signals input from the Input source of the Part you have selected.

Shows the output level of the Envelope Follower.

Opens the Control Assign screen for the selected Part.

On the Mixing screen, you can mix the A/D Part (signals from the A/D INPUT jacks) and the
Digital Part (signals from the [USB TO HOST] terminal*).
* Refers only to the audio for the Digital L/R of the device port.

Operation

Gain (Envelope Follower Gain)

Attack (Envelope Follower Attack)

Release (Envelope Follower Release)

Input Level

Envelope Follower Output

Edit

Audio In

Mixing

[PERFORMANCE] → Common selection → [EDIT/ ] → Audio In → Mixing

[SHIFT] + [A/D INPUT ON/OFF]
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Determines the processing method for the input signals at the left and right channels.
Settings: L Mono, R Mono, L+R Mono, Stereo

L Mono: Uses only the left channel.
R Mono: Uses only the right channel.
L+R Mono: Mixes the left and right channels and processes in mono.
Stereo: Processes the stereo input in stereo.

NOTE
If the sound is input only from the [L/MONO] jack, it is processed in mono.

Sets the volume of the A/D Part or Digital Part.
Settings: 0–127

Sets the Pan position (in the stereo field) for the A/D Part or Digital Part.
Settings: L63–C–R63

Sets the dry level (or the level of the signals not processed by the System Effect) of the A/D Part
or Digital Part.
This parameter is available only when Output Select is set to MainL&R.
Settings: 0–127

Input Mode (A/D Part Input Mode)
Input Mode (Digital Part Input Mode)

Volume (A/D Part Volume)
Volume (Digital Part Volume)

Pan (A/D Part Pan)
Pan (Digital Part Pan)

Dry Level (A/D Part Dry Level)
Dry Level (Digital Part Dry Level)
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Sets the level of the signals sent from the A/D Part or Digital Part to the Variation Effect.
This parameter is available only when Output Select is set to MainL&R.
Settings: 0–127

Sets the level of the signals sent from the A/D Part or Digital Part to the Reverb Effect.
This parameter is available only when Output Select is set to MainL&R.
Settings: 0–127

Sets the output destination for the audio signals from the A/D Part or Digital Part.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and [R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
[R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.
Off: No output of the audio signal for the Part.

On the Routing screen, you can set the effect routing of the A/D Part.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Audio In → Routing

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)

Routing
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(1) A/D Part Insertion FX A Switch
(2) A/D Part Insertion FX B Switch

Switches the view for A/D In and Digital In.
When Digital In is selected, only the Digital Part Reverb Send, Digital Part Variation Send, and
Digital Part Output Select are available.

Turns Insertion Effect A and Insertion Effect B on or off.
Settings: Off, On

Sets the Effect Type.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
By selecting a Preset, you can change the way effects are applied.
Settings: Refer to the Data List.

A/D In
Digital In

A/D Part Insertion FX A Switch
A/D Part Insertion FX B Switch

Type (A/D Part Insertion Effect A Type)
Type (A/D Part Insertion Effect B Type)

Preset (A/D Part Insertion Effect A Preset)
Preset (A/D Part Insertion Effect B Preset)
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Sets the Side Chain Part (or the Modulator depending on the effect type) for the Insertion Effect
A or Insertion Effect B.
This parameter is not available when the Part itself or Master is set to the Modulator. In those
cases, the parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

Sets the effect routing for Insertion Effect A and Insertion Effect B.
The diagram changes accordingly when the settings are changed.
Settings: Ins A→B, Ins B→A

Opens the 2-band EQ for the A/D Part.

Sets the level of the signals (or bypass signals) sent from Insertion Effect A or Insertion Effect B
to the Reverb Effect.
This parameter is available only when Output Select is set to MainL&R.
Settings: 0–127

Sets the level of the signals (or bypass signals) sent from Insertion Effect A or Insertion Effect B
to the Variation Effect.
This parameter is available only when Output Select is set to MainL&R.
Settings: 0–127

Opens the settings screen for Envelope Follower.

Sets the output destination for the audio signals.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and OUTPUT

Side Chain (A/D Part Insertion Effect A Side Chain)
Side Chain (A/D Part Insertion Effect B Side Chain)
Modulator (A/D Part Insertion Effect A Modulator)
Modulator (A/D Part Insertion Effect B Modulator)

Ins Connect (A/D Part Insertion Effect Connect Type)

2-band EQ

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)

Envelope Follower

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)
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[R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
ASSIGNABLE OUTPUT [R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.
Off: No output of the audio signal for the Part.

On the Ins A and Ins B screens, you can set the Insertion Effects.

Operation

(1) Insertion FX Switch

Enables the Insertion Effect.
Settings: Off, On

Ins A
Ins B

[PERFORMANCE] → Common selection → [EDIT/ ] → Audio In → Ins A

[PERFORMANCE] → Common selection → [EDIT/ ] → Audio In → Ins B

Insertion FX Switch
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Sets the category and type of the Insertion Effect.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
By selecting a Preset, you can change the way effects are applied.
Settings: Refer to the Data List.

Sets the Side Chain Part (or the Modulator depending on the effect type) for the Insertion Effect
A or Insertion Effect B.
This parameter is not available when the Part itself or Master is set to the Modulator. In those
cases, the parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

The Effect Parameters differ depending on the effect type.
Settings: See the Effect parameters.

On the 2-band EQ screen, you can set the Part EQ.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Common → Audio In → 2-band EQ

Category (Insertion Effect A Category)
Category (Insertion Effect B Category)
Type (Insertion Effect A Type)
Type (Insertion Effect B Type)

Preset (Insertion Effect A Preset)
Preset (Insertion Effect B Preset)

Side Chain (Insertion Effect A Side Chain Part)
Side Chain (Insertion Effect B Side Chain Part)
Modulator (Insertion Effect A Modulator Part)
Modulator (Insertion Effect B Modulator Part)

Effect Parameter

2-band EQ
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Selects the desired EQ type.
Settings: Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: Bypasses the equalizer leaving the entire signal unaffected.
LPF: Passes the signals above the cutoff frequency.
HPF: Passes the signals below the cutoff frequency.
Low Shelf: Cuts or boosts the signals below the specified frequency setting.
Hi Shelf: Cuts or boosts the signals above the specified frequency setting.
Peak/Dip: Cuts or boosts the signals at the specified frequency setting.

Sets the frequency to be cut or boosted.
This parameter is not available when the EQ Type is set to Thru.
Settings: 63.0Hz–18.0kHz

Sets the signal level of the frequency band set in EQ1 Freq or EQ2 Freq.
This parameter is not available when the EQ Type is set to Thru, LPF, or HPF.
Settings: −12.0dB–+12.0dB

Sets the bandwidth for cutting or boosting the volume of the frequencies set with EQ1 Freq or
EQ2 Freq.
This parameter is available only when the EQ Type is set to Peak/Dip.

EQ1 Type (A/D Part 2-band EQ 1 Type)
EQ2 Type (A/D Part 2-band EQ 2 Type)

EQ 1 Freq (A/D Part 2-band EQ 1 Frequency)
EQ 2 Freq (A/D Part 2-band EQ 2 Frequency)

EQ 1 Gain (A/D Part 2-band EQ 1 Gain)
EQ 2 Gain (A/D Part 2-band EQ 2 Gain)

EQ 1 Q (A/D Part 2-band EQ 1 Q)
EQ 2 Q (A/D Part 2-band EQ 2 Q)
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Settings: 0.1–12.0

Sets the output gain of the 2-band EQ.
Settings: −12.0dB–+12.0dB

On the Arp Common screen, you can set the Arpeggio parameters for the entire Performance.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp/MS → Arp Common

Sets the Arpeggio for the Performance on or off.
This switch is linked to the [ARP ON/OFF] button on the top panel.
Settings: Off, On

Adjusts the timing for starting the next Arpeggio phrase while the first Arpeggio is being played
back, when playing back Arpeggio phrases in multiple Parts. When set to Off, the Arpeggio is
played back when the Part is played on the keyboard.
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)
(Numbers indicated here are clock values.)

Output Level (A/D Part 2-band EQ Output Level)

Arp/MS

Arp Common

Arp Master (Arpeggio Master Switch)

Sync Quantize (Arpeggio Sync Quantize Value)
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Sets the swing value of the Arpeggio and Motion Sequencer for the Performance.
This is specified as an offset value to Part Swing.
Settings: −120–+120

Sets the percentage for stretching or compressing the Arpeggio playback time for the entire
Performance.
This parameter affects Parts for which Unit (Arpeggio Unit Multiply) is set to Common.
The subdivision of the beat and the tempo will change when you stretch or compress the
playback time, so you can create a completely new feel for the originally selected Arpeggio.
Settings: 50%–400%

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.

Sets the strength of the quantize setting that is applied to the Arpeggio for the Performance.
This is specified as an offset value to Part Qntz Strength (Arpeggio Quantize Strength).
Settings: −100–+100

Shifts the pitch of the Arpeggio for the Performance in octaves.
This is specified as an offset value to Part Octave Shift (Arpeggio Octave Shift).
Settings: −20–+20

Shifts the range of the Arpeggio for the Performance in octaves.
This is specified as an offset value to Part Octave Range (Arpeggio Octave Range).
Settings: −6–+6

Sets the Arpeggio Gate Time Rate for the Performance.
This is specified as an offset value to Part Gate Time (Arpeggio Gate Time Rate).
Settings: −100–+100

Sets the Arpeggio Velocity Rate for the Performance.
This is specified as an offset value to Part Velocity (Arpeggio Velocity Rate).
Settings: −100–+100

Swing (Swing Offset)

Unit (Common Unit Multiply)

Qntz Strength (Arpeggio Quantize Strength Offset)

Octave Shift (Arpeggio Octave Shift Offset)

Octave Range (Arpeggio Octave Range Offset)

Gate Time (Arpeggio Gate Time Rate Offset)

Velocity (Arpeggio Velocity Rate Offset)
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Changes the Arpeggio selection.
Settings: 1–8

On the Arp Overview screen, you can set the Arpeggio types from the list of all Parts.

Operation

Switches the view for Parts.
Settings: Part 1–8, Part 9–16

Sets the Arpeggio for the Performance on or off.
This switch is linked to the [ARP ON/OFF] button on the top panel.
Settings: Off, On

Sets the Arpeggio Group for using the same Arpeggio with multiple Parts.
The Parts assigned to the same Group will have the same Arpeggio settings.

Arp Select (Arpeggio Select)

Arp Overview (Arpeggio Overview)

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp/MS → Arp Overview

(When a selected Part is Common) [SHIFT] + [ARP ON/OFF]

Part 1–8
Part 9–16

Arp Master (Arpeggio Master Switch)

Group (Arpeggio Group)
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Changes the Arpeggio selection.
Settings: 1–8

Sets the Arpeggio of each Part on or off.
Settings: Off, On

Settings: Refer to the Data List.

Settings: Refer to the Data List.

Settings: Refer to the Data List.

Sets the velocity range (lowest and highest values) for playing back the Arpeggio.
When this is set so that the higher value is first and the lower value is second (for example,
93 to 34), the Arpeggio is played only for velocities of 1 to 34 and 93 to 127.
Settings: 1–127

Sets the note range (the lowest and the highest notes) for playing back the Arpeggio.
When the first note specified is higher than the second (for example, C5 to C4), the Arpeggio
is played for notes in the ranges of C−2 to C4 and C5 to G8.
Settings: C−2–G8

On the MS Common screen, you can set the Motion Sequencer parameters used for the entire
Performance.

Arp Select (Arpeggio Select)

Sw (Part Arpeggio Switch)

When View is set to Category

Category (Arpeggio Category)
Sub (Arpeggio Sub Category)
Name (Arpeggio Name)

When View is set to Number

Bank (Arpeggio Bank)
Number (Arpeggio Number)
Name (Arpeggio Name)

When View is set to Range

Name (Arpeggio Name)

Velocity Limit (Arpeggio Velocity Limit)

Note Limit (Arpeggio Note Limit)

MS Common (Motion Sequencer Common)
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Operation

Sets the swing value of the Arpeggio and Motion Sequencer for the Performance.
This is specified as an offset value to the Part Swing.
Settings: −120–+120

Sets the percentage for stretching or compressing the Motion Sequencer playback time for the
entire Performance.
This parameter affects Lanes for which Unit Multiply is set to Common.
The subdivision of the beat and the tempo will change when you stretch or compress the
playback time, so you can create a completely new feel for the originally selected Motion
Sequencer.
Settings: 50%–400%

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.

Sets the Motion Sequencer Amplitude (or how much the Sequence changes) for the entire
Performance.
This is specified as an offset value to the Part Amplitude (Part Motion Sequencer Amplitude).
This parameter value offsets the Amplitude of the Lanes within the Performance if MS FX is set
to On for the Lane.

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp/MS → MS Common

(When a selected Part is Common) [SHIFT] + [MSEQ ON/OFF]

Common Swing (Swing Offset)

Common Unit (Common Unit Multiply)

Common Amplitude (Motion Sequencer Amplitude Performance Offset)

236



Settings: −127–+127

Sets the Motion Sequencer Pulse Shape (or the shape of the step curve) for the Performance.
This is specified as an offset value to the Part Shape (Part Motion Sequencer Pulse Shape).
This parameter value offsets the parameters for the Lanes within the Performance if the MS FX
is set to On for the lane and Control is set to On.
Settings: −100–+100

Sets the Motion Sequence Smoothness (or the smoothness of the changes in the sequence
over time) for the entire Performance.
This is specified as an offset value to the Part Motion Seq Smooth (Part Motion Sequencer
Smoothness).
This parameter value offsets the Smoothness of the Lanes within the Performance if MS FX is
set to On for the Lane.
Settings: −127–+127

Sets the Motion Sequencer Randomness (or the randomness of the changes in the step value
of the sequence) for the entire Performance.
This is specified as an offset value to the Part Motion Seq Random (Part Motion Sequencer
Randomness).
This parameter value offsets the Randomness of the Lanes within the Performance if MS FX is
set to On for the Lane.
Settings: −127–+127

Sets the Motion Seq Lane that is shown when the View Mode of the Home screen is set to
Motion Seq.
Settings: Super Knob, 1–4

Sets the randomness of the changes in A/D Part Motion Sequencer Step Value.
Settings: 0–127

Changes the Motion Sequence selection.
Settings: 1–8

Common Shape (Motion Sequencer Pulse Shape Performance Offset)

Common Smooth (Motion Sequencer Smoothness Performance Offset)

Common Random (Motion Sequencer Randomness Performance Offset)

View Lane (Motion Seq View Lane)

AD MS Random (A/D Part Motion Sequencer Randomness)

MS Select (Motion Sequence Select)
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On the MS Overview screen, you can set the Motion Sequencer from the list of all Parts.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp/MS → MS Overview

Sets the Motion Sequencer for the entire Performance on or off.
This switch is linked to the [MSEQ ON/OFF] button on the top panel.
Settings: Off, On

Shows the number of Lane switches set to On.
The number shown on the right side of the slash (/) indicates the maximum number of Lanes
you can simultaneously set to On.

Changes the Motion Sequence selection.
Settings: 1–8

Sets the Motion Sequencer on or off for each Part.
Settings: Off, On

MS Overview (Motion Sequencer Overview)

MS Master (Motion Seq Master Switch)

Active (Active Motion Sequencer)

MS Select (Motion Sequence Select)

PartSw (Motion Sequencer Part Switch)

Lane Switch
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Sets each Lane on or off.
You can use up to four Motion Sequencer Lanes in one Part, or up to eight Lanes in an entire
Performance.
Settings: Off, On

On the Lane screen, you can set the Motion Sequencer parameters for each Lane.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp/MS → Lane

Sets the Motion Sequencer for the entire Performance on or off.
Settings: Off, On

Sets the Motion Sequencer of the Part on or off.
Settings: Off, On

Shows the parameters for the selected Lane.
Settings: 1–4

Sets each Lane on or off.
You can use up to four Motion Sequencer Lanes in one Part, or up to eight Lanes in an entire

Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)

Motion Seq Part Sw (Motion Sequencer Part Switch)

Lane (Lane Select)

LaneSw (Lane Switch)
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Performance.
When set to Off, the parameters for that Lane will not be shown.
Settings: Off, On

Sets Knobs to be affected by the operation of the Super Knob.
Settings: Off, On

Sets whether the selected Lane receives signals from the [MSEQ TRIGGER] button or not.
When set to On, the Motion Sequence will not be played back unless you press the [MSEQ
TRIGGER] button.
Settings: Off, On

Changes the Motion Sequence selection.
Settings: 1–8

Shows the selected Lanes and sequences.

Opens the Motion Sequence screen.
You can create a sequence of up to 16 steps.

Shows the step curve for the selected sequence.

Sets the playback of the Motion Sequence set to the Destination in the Control Assign screen to
synchronize to the Performance tempo or beat.
Settings: Off, Tempo, Beat, Lane1 (when Lanes 2–4 are selected)

Off: Plays back the Lane Motion Sequencer alone.
Tempo: Plays back the Lane Motion Sequencer in sync with the Performance tempo.
Beat: Plays back in sync with the beat.
Lane1: Plays back the Lane Motion Sequencer in sync with Lane 1.

MS FX (Lane FX Receive)

Trigger (Lane Trigger Receive)

Sequence Select (Motion Sequence Select)

Target Sequence

Edit Sequence

Motion Seq Step n Value

Sync/Speed tab

Sync (Lane Sync)

When Sync is set to Off
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Sets the playback speed for the Motion Sequence.
This parameter is available when Sync (Lane Sync) is set to Off.
Settings: 0–127

Sets the delay time for starting playback of the Motion Sequence when Sync is set to Off.
Settings: 0–127

Sets the time for the Motion Sequence to reach maximum amplitude when Sync is set to Off.
Settings: 0–127

Sets the percentage for stretching or compressing the Motion Sequencer playback time for
the current Lane.
This parameter is available when Sync (Lane Sync) is set to Off or something other than
Lane 1.
Settings: 50%–6400%, Common

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.
Common: The value set in the Unit Multiply common to all Parts is applied.

Sets the delay time for starting the playback of the Motion Sequence when Sync is set to
something other than Off or Lane1.
Settings: 0–32

Sets the time to reach the maximum amplitude for the Motion Sequence when Sync is set to
something other than Off.
Settings: 0–32

Sets the velocity range (lowest and highest values) for playing back the Motion Sequence of the
selected Lane.
This parameter is available when Sync (Lane Sync) is set to something other than Lane 1.
When this is set to a range from the highest value to the lowest value, the Motion Sequence will

Speed (Lane Speed)

Delay Time (A/D Part Motion Seq Lane Key On Delay Time Length)

Fade In Time (A/D Part Motion Seq Lane Fade In Time Length)

When Sync is set to something other than Off

Unit (A/D Part Motion Seq Lane Unit Multiply)

Delay Steps (A/D Part Motion Seq Lane Key On Delay Step Length)

Fade In Steps (A/D Part Motion Seq Lane Fade In Step Length)

Lane Vel Limit (Lane Velocity Limit)
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only be played back from two velocity ranges: from the maximum to the highest value, and from
the lowest value to the minimum.
Settings: 1–127

Resets the Motion Sequence playback when you press any key on the keyboard.
This parameter is available when Sync (Lane Sync) is set to something other than Lane 1.
This parameter is not available when Trigger is set to On.
Settings: Off, Each-On, 1st-On

Each-On: The sequence will be reset each time you play any note, and playback
starts from the beginning.
1st-On: The sequence will be reset at the first note, and playback starts from the
beginning. The sequence will not be reset when a second note is played while the first
note is being played.

Sets the Motion Sequence to loop (repeat) playback or one-shot playback.
This parameter is available when Sync (Lane Sync) is set to something other than Lane 1.
Settings: Off, On

Specifies the starting point for loop playback of the Motion Sequence.
Settings: 1–16 (should be below the Length setting)

Sets the number of steps in the Motion Sequence.
Settings: 1–16 (should be above the Loop Start setting)

Sets the length of a step in the Motion Sequence.
Settings: 60, 80, 120, 160, 240, 320, 480

Opens the setting screen for the Motion Sequence.
You can create a sequence of up to 16 steps.

Loop/Length tab

Key On Reset (Lane Key On Reset)

Loop (Lane Loop)

Loop Start (Lane Loop Start)

Length (Motion Seq Length)

MS Grid (Motion Sequencer Grid)

Motion Sequence Edit
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Specifies the starting point for loop playback of the Motion Sequence.
Settings: 1–16 (should be below the Length setting)

Sets the Motion Sequence length.
Settings: 1–16 (should be above the Loop Start setting)

Sets the length of a step in the Motion Sequence.
Settings: 60, 80, 120, 160, 240, 320, 480

Changes the Motion Sequence type selection.
Settings: 1–8

Changes the Lane selection.
Settings: 1–4

Sets the polarity of the Motion Sequence.
Settings: Unipolar, Bipolar

Unipolar: Only positive values are used for the parameter change.
Bipolar: Both positive and negative values are used for the parameter change.

Loop Start (Lane Loop Start)

Length (Motion Sequence Length)

MS Grid (Motion Sequencer Grid)

Sequence Select (Motion Sequence Select)

Lane Select

Polarity (Motion Sequence Polarity)

Amplitude (Motion Sequence Amplitude)
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Sets the degree of changes in the Motion Sequence.
Settings: 0–127

Sets the smoothness of the changes in the Motion Sequence over time.
Settings: 0–127

Shows various Jobs.

Sets the value for each step in the Motion Sequence.
You can use Control sliders 1 to 8 to change the values for Steps 1 to 8 and Steps 9 to 16,
depending on the cursor position.
Settings: 0–127

Sets the type and direction of each step in the Motion Sequence.
Settings: A, B, Reverse A, Reverse B

Selects a parameter change curve for Pulse A and Pulse B.
Use the Motion Sequence Step Type to select which of the curve types to use for each step.
The vertical axis represents the time while the horizontal axis represents the step value.
Settings: (When a preset bank is selected) Standard, Sigmoid, Threshold, Bell, Dogleg, FM,

AM, M, Discrete Saw, Smooth Saw, Triangle, Square, Trapezoid, Tilt Sine, Bounce,
Resonance, Sequence, Hold, Harmonic, Steps
(When a user bank is selected) User 1–32
(When a library file is loaded) Curves used in Library 1–16

Adjusts the shape of the step curve in the Motion Sequence.
This setting is not available depending on the curve type. The range of the parameter value
differs depending on the curve type.

Enables or disables the use of the knobs for controlling the step curve shape of the Motion
Sequence.

Smooth (Motion Sequence Smoothness)

Job

Motion Sequence Step Value

Motion Sequence Step Type

Pulse A (Motion Sequence Step Curve Type A)
Pulse B (Motion Sequence Step Curve Type B)

Prm 1 (Motion Sequence Step Curve Parameter 1)
Prm 2 (Motion Sequence Step Curve Parameter 2)

Control (Motion Sequence Step Curve Shape Control Switch)
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Shown only when MS FX is set to On. This setting may not be available depending on the curve
type.
Settings: Off, On

Saves (stores) the edited Motion Sequence.

Loads the Motion Sequence.

Copies the Motion Sequence.

The Control Assign screen lets you set the Controllers for all Parts.
By assigning a parameter (Destination) to a controller (Source), you can control the sound in a
large variety of ways. You can use physical controllers such as the Pitch Bend wheel and knobs
as well as the Motion Sequencer and Envelope Follower.
Up to 32 controllers can be assigned simultaneously to a Part.

Operation

Store Sequence

Load Sequence

Copy Sequence

Control

Control Assign

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → Control Assign

Tap Edit Super Knob on the Super Knob screen
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Sets the auto select of the Display Filter on or off.
When set to On, moving the controller you wish to set to Source automatically sets the controller
to the Display Filter.
Settings: Off, On

Selects the controller for showing the settings on the screen.
When you select Super Knob, all settings for Knobs 1 to 8 having the Super Knob Link set to On
will be shown.
Settings: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, Super Knob, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16,
EnvFollowAD, EnvFollowMst, All

This allows you to enter a new name for Knobs 1 to 8 to show on the Sub display.
This parameter is not shown when Source is set to something other than AsgnKnob 1–8.

Opens the General/Pitch → Pitch screen.
This parameter is not available when Source is set to something other than PitchBend.

Opens the setting screen for the Motion Sequence.
This parameter is not available when Source is set to something other than MS Lane 1–4.

Auto Select

Display Filter

Display Name (Assignable Knob Name)

Edit Pitch Bend

Edit Motion Sequencer

Edit Envelope Follower
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Opens the settings screen for Envelope Follower.
This parameter is not available when Source is set to something other than EnvFollow 1–16,
EnvFollowAD, or EnvFollowMst.

Sets the parameter to the Destination. Tapping the [+] icon allows you to add a new Destination.
When Source is set to AsgnKnob 1–8, Part1–16 Assign1–8 is added to the settings. In that
case, Curve Type and Curve Ratio are not available.

Sets the controller for controlling the parameters set to the Destination.
When Destination is set to Part1–16 Assign1–8, only AsgnKnob 1–8 will be available. Other
controllers cannot be used.
Settings: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD,
EnvFollowMst

Copies the parameters set to Destination to Display Name.
This parameter is not shown when Source is set to something other than AsgnKnob 1–8.

Deletes the selected Destination.

Sets the parameter to show when you try to set Part1–16 Assign1–8 to the Destination and
multiple Destinations are already assigned to Part Assign.

Sets the Part parameter to the Destination.
Settings: Refer to the Data List.

The parameters shown below appear only when Destination 1–32 is set to Part1–16 Assign1–8.
Also, only the shortcut buttons are available on the screens when Part Knobs 1–8 cannot be
found in Destination.

Opens the Control Assign screen for the selected Part.

Destination

Source

Destination to Name

Delete

Destination (Part Assignable Knob Destination)

Parameter (Part Assignable Knob Parameter)

Edit (Part) Control Assign
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Sets the change curve of the parameter set to Destination.
The horizontal axis represents the controller value set in Source while the vertical axis
represents the parameter value.
Settings: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold,
Harmonic, Steps, User 1–32 (when a User bank is selected), Library 1–16 (when a
Library file is loaded)

Sets the polarity of the curve set in Curve Type.
Settings: Uni, Bi

Uni: Parameter changes occur only within the positive range or the negative range
according to the curve shape.
Bi: Parameter changes occur both in positive and negative ranges according to the
curve shape.

Sets the ratio of the parameter values.
Settings: −128–+127

Adjusts the curve shape.
This setting is not available depending on the curve type.

Opens the setting screen for User Curve.
You can create either an 8-point linear curve or an 8-step curve.

Selects the keyboard Aftertouch settings sent from the Performance to the internal tone
generator on MONTAGE M8x.

Settings: The output of Aftertouch to an external device should be set from [UTILITY] →
Settings → MIDI I/O → AT MIDI Out.

The MONTAGE M8x has a built-in keyboard that supports polyphonic aftertouch.
The built-in keyboards on the MONTAGE M6 and MONTAGE M7 support only Channel

Curve Type

Polarity (Curve Polarity)

Ratio (Curve Ratio)

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)

Edit User Curve

After Touch
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Aftertouch; however, their internal tone generator supports polyphonic aftertouch, allowing you
to use polyphonic aftertouch for playing back Songs and Patterns, as well as for receiving MIDI
messages from an external device compatible with polyphonic aftertouch.
To set Aftertouch reception with the internal tone generator, set the parameter on the Tx/Rx
Switch screen.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → After Touch

Selects the mode for sending Aftertouch messages from the keyboard to the internal tone
generator.

MONTAGE M8x

MONTAGE M7 and MONTAGE M6

Keyboard AT Mode (After Touch Mode)

249



This parameter is set to Channel on MONTAGE M6 and MONTAGE M7, regardless of the
setting here.
Settings: Poly (polyphonic aftertouch), Channel (channel aftertouch)

Sets the Ribbon controller.

Operation

Sets the grid mode for the Ribbon controller.
Settings: Continuous, 5 step, 3 step

NOTE
Set to Continuous if you wish to use the Ribbon Controller setting you have set on the Control Assign screen.

Sets the way the Ribbon Controller functions.
Settings: Hold, Reset

Hold: Retains the value of the position at which you release your finger from the
Ribbon Controller.
Reset: Automatically resets the value to the mid position when you release your finger
from the Ribbon Controller.

Ribbon Settings

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → Ribbon Settings

[SHIFT] + [HOLD]

Ribbon Grid Mode

Continuous mode

Ribbon Mode (Ribbon Controller Mode)
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Selects the Part to be controlled with the Ribbon Controller.
Settings: 1–16, Common

Settings: Refer to the Control Box Destination section on the Data List.

Settings: Depends on the Destination

Sets the Control Change number for the entire Performance.
You can assign specific MIDI Control Change numbers to the Knobs on the top panel and
controllers on the external device.

NOTE
As for controllers not included on this instrument, you can use an external sequencer or external MIDI
controllers.

Operation

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → Control Number

5-step mode

3-step mode

Control Part

Control Destination

Step Value 1–5

Control Number

Ribbon Ctrl (Ribbon Controller Control Number)
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Sets the Control Change number generated by the operation of the Ribbon Controller.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of the
built-in Ribbon Controller.
Settings: Off, 1–95

Sets the Control Change number for the Breath Controller to be received from the external
device.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of the
Breath Controller.
Settings: Off, 1–95

Sets the Control Change number generated by the operation of the Foot Controller connected
to the FOOT CONTROLLER jack.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of the
Foot Controller.
Settings: Off, 1–95, Super Knob

Sets the Control Change number generated by the operation of the [ASSIGN 1] and [ASSIGN 2]
buttons.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of the
[ASSIGN 1] and [ASSIGN 2] buttons.
Settings: Off, 1–95

Sets the Control Change number generated by the operation of the [MSEQ TRIGGER] button.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of the
[MSEQ TRIGGER] button.
Settings: Off, 1–95

Breath Ctrl (Breath Controller Control Number)

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)

Assign Sw 1 (Assignable Switch 1 Control Number)
Assign Sw 2 (Assignable Switch 2 Control Number)

MS Triger (Motion Sequencer Trigger Switch Control Number)

Assign Knob (Assignable Knob Control Number)
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Sets the Control Change number generated by the operation of Knobs 1 to 8.
When this instrument receives a MIDI Control Change message of the number set with this
parameter from the external device, the message is treated the same as the operation of Knobs
1 to 8.
Settings: Off, 1–95

Opens the MIDI settings screen.
The same screen can be opened from the [UTILITY] → Settings → MIDI I/O.

Shows the Control Change number generated by the operation of the footswitch connected to
the FOOT SWITCH [ASSIGNABLE] jack. When this instrument receives a MIDI Control Change
message of the number set with this parameter from the external device, the message is treated
the same as the operation of the footswitch.

Shows the Control Change number generated by the operation of the SCENE buttons. When
this instrument receives a MIDI Control Change message of the number set with this parameter
from the external device, the message is treated the same as the operation of the SCENE
buttons.

Shows the Control Change number generated by the operation of the Super Knob. When this
instrument receives a MIDI Control Change message of the number set with this parameter
from the external device, the message is treated the same as the operation of the Super Knob.

NOTE

Sets the controller mode.

Operation

MIDI Settings

FS Assign (Foot Switch Assign Control Number)

Scene CC (Scene Control Change Number)

Super Knob CC (Super Knob Control Change Number)

When Scene CC and Super Knob CC are set to Off, System Exclusive (SysEx) is used for handling MIDI
messages.
FS Assign, Scene CC, and Super Knob CC are used for the entire instrument. If desired, change these
settings from the Utility MIDI Settings screen.

Control Settings

[PERFORMANCE] → Common selection → [EDIT/ ] → Control → Control Settings

[SHIFT] + [ASSIGN 1]
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Sets the direction of the Control sliders 1 to 8 when the slider mode is set to PART.
Settings: Normal (up from the bottom), Reverse (down from the top)

Sets the [ASSIGN 1] and [ASSIGN 2] buttons for Latch or Momentary setting.
Settings: Latch, Momentary

Latch: Sets to On when you press the button and sets to Off when you press the
button again.
Momentary: Sets to On while you are holding down the button and sets to Off when
you release the button.

[SHIFT] + [ASSIGN 2]

Slider Direction Part 1–8

Assignable Switch 1 Mode
Assignable Switch 2 Mode
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om02screenparameters0070

A Normal Part (AWM2) consists of up to 128 elements.
Part Edit (AWM2) includes Part Common Edit (for setting parameters for the entire Part) and
Element Edit (for setting parameters for each Element in the Part).

Part Edit (AWM2) screen
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om02screenparameters0080

Contents

Part Common Edit

General/Pitch

Part Settings

Zone Settings

Element Settings

Pitch

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

After Touch

Tx/Rx Switch

Control Settings

Part LFO

User LFO Edit
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On the Part Settings screen, you can set general parameters (such as the Part names and tone
generation system) for the Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Part Settings

Sets the Main category and Sub category of the selected Part.
Settings: Refer to the Data List.

You can save the Part you are editing under a new name, using up to 20 alphanumeric
characters.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Sets the volume of the selected Part.
Settings: 0–127

Sets the Pan for the selected Part.
Settings: L63–C (center)–R63

General/Pitch

Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)

Part Name

Volume

Pan

257



Sets the Dry Level of the selected Part.
This parameter is available only when Part Output is set to MainL&R.
Settings: 0–127

Sets the Variation Send of the selected Part.
This parameter is available only when Part Output is set to MainL&R.
Settings: 0–127

Sets the Reverb Send of the selected Part.
This parameter is available only when Part Output is set to MainL&R.
Settings: 0–127

Sets the output destination for the audio signals of the selected Part.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and [R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
ASSIGNABLE OUTPUT [R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.
Off: No output of the audio signal for the Part.

Sets the tone generation mode of the current Part. Mono is for playing single notes, and Poly is
for playing multiple simultaneous notes.
When using the Mono setting for playing the keyboard in Legato, you can create a smooth
transition of sounds from one note to another.
Settings: Mono, Poly

Determines the method for producing the sound when the internal tone generator receives a
Note On message of the same sound twice in a row.
The Multi setting is recommended for most cases. However, the Multi setting uses up many

Dry Level

Var Send (Variation Send)

Rev Send (Reverb Send)

Part Output (Part Output Select)

Mono/Poly

Key Assign (Key Assign Mode)
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notes in the maximum polyphony, so it is recommended to change to Single if sounds in other
Parts are dropped or not played properly.
Settings: Single, Multi

Single: Stops the first note and then plays the same note again. This is convenient for
repeating the same note on the same channel.
Multi: Plays the second note over the first note. This setting makes rolls and repeated
notes sound natural, with crash cymbals or other percussion instruments having a
long decay.

Sets the Part to play only in response to the Arpeggio.
Any Part set to On will be played by the Note On messages sent from the Arpeggio.
Settings: Off, On

Sets the Pan to On or Off from the Element Edit ([EDIT/ ]→Part selection→Element
selection→Amplitude→Level/Pan→Pan).
When set to Off, the Pan in the Element Edit will be set to C (center).
Settings: Off, On

Sets the note range (lowest and highest notes) for the Part.
When the first note of Note Limit is set higher than the second (for example, C5 to C4), the
notes in the ranges C−2 to C4 and C5 to G8 will be played.
Settings: C−2–G8

Sets the velocity range (lowest and highest values) for the Part.
When this is set so that the higher value is first and the lower value is second (for example, 93
to 34), the notes are played only for velocities of 1 to 34 and 93 to 127.
Settings: 1–127

Increases or decreases the velocity value that is sent to the internal tone generator.
Settings: 0–127

When Depth = 64 and Offset
= 32

When Depth = 64 and Offset
= 64

When Depth = 64 and Offset
= 96

Arp Play Only (Arpeggio Play Only)

Element Pan (Element Pan Switch)

TG Note Limit (Note Limit)

TG Vel Limit (Velocity Limit)

Velocity Offset (Velocity Sensitivity Offset)
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(1) Actual resulting velocity (affecting the tone generator)
(2) Velocity with which you play a note

Sets how the level of the velocity value that is sent to the internal tone generator responds to
Velocity or the strength of the keystroke.
Settings: 0–127

(1) Actual resulting velocity (affecting the
tone generator)

(2) Velocity with which you play a note

On the Zone Settings screen, you can set the parameters for the Zone function.
This function allows you to divide the entire keyboard into a maximum of eight sections (Zones)
and independently assign a separate channel to each Zone. This way, you only need one
keyboard to play the sounds of multiple keyboards. You can play multiple Parts on an external
multi-timbral sound module or play both the internal tone generator and any connected external
sound modules.

Velocity Depth (Velocity Sensitivity Depth)

When Offset is set to 64:

Zone Settings
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Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Zone
Settings

Keyboard Control is used for selecting Parts to be played from the keyboard.
When this switch is set to On, you can simultaneously play all Parts having Keyboard Control
set to On, if the Part is set to Common or Keyboard Control for the Part is set to On.
When Keyboard Control is set to Off, you can play the Part on the keyboard only when that Part
is selected.
Settings: Off, On

Sets the velocity range (lowest and highest values) for the Zone.
When this is set so that the higher value is first and the lower value is second (for example, 93
to 34), the notes are played only for velocities of 1 to 34 and 93 to 127.
Settings: 1–127

Sets the note range (lowest and highest notes) for the Zone.
When the first note of Note Limit is set higher than the second (for example, C5 to C4), the
notes in the ranges C−2 to C4 and C5 to G8 will be played.
Settings: C−2–G8

Shifts the pitch of the zone in octaves.
Settings: −3–+0 (standard)–+3 (in octaves)

Keyboard Sw (Keyboard Control Switch)

Zone Vel Limit (Zone Velocity Limit)

Zone Note Limit

Octave Shift

261



Shifts the pitch of the zone in semitones.
Settings: −11–+0 (standard)–+11

Switches the Part Mode.
Settings: Internal, External

Internal: Uses the internal tone generator.
External: Uses the external sound generator. Any Part set to External does not
receive MIDI messages from the external device.

Sets the channel for transmitting and receiving MIDI messages when the Part Mode is set to
Internal.
Settings: Ch1–Ch16, Off

Sets the channel for transmitting and receiving MIDI messages when the Part Mode is set to
External.
Settings: Ch1–Ch16

Shows the channel for controlling the Part set to Common and the Part with the Keyboard Sw
set to On.
This setting is common to the entire instrument. The setting can be changed on the Utility MIDI
Settings screen.
When using Tx/Rx Ch and Transmit Ch, do not use the same channel specified in MIDI I/O Ch.
If the same channel is set to Tx/Rx Ch and Transmit Ch, the setting in MIDI I/O Ch will take
priority.
Settings: Ch1–Ch16

Opens the same screen as the Utility → Settings → MIDI I/O.

When this parameter is set to On, the MIDI Bank, MIDI Pgm Number, MIDI Volume, and MIDI
Pan settings are transmitted to the external device whenever those parameters are changed.
However, the setting is not transmitted when the corresponding transmit switch is set to Off.
Note that this parameter is common to all Performances and cannot be set independently for

Transpose

Part Mode

Tx/Rx Ch (Transmit/Receive Channel)

Transmit Ch

MIDI I/O Ch (MIDI Input/Output Channel)

MIDI Settings

MIDI Send
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individual Performances.
This parameter is available only when Part Mode is set to External.
Settings: Off, On

The transmit switch for sending MIDI Bank MSB and MIDI Bank LSB to the external device.
This parameter is available only when Part Mode is set to External.
Settings: Off, On

Selects the bank for transmitting the Performance selection. You can specify the MSB and LSB
messages.
This parameter is not available when the Transmit Bank Select is set to Off, and is available
only when Part Mode is set to External.
Settings: MSB and LSB: 000–127

This is the transmit switch for sending Program Change messages to the external device.
This parameter is available only when Part Mode is set to External.
Settings: Off, On

Selects the Program Change number for transmitting the Performance selection.
This parameter is not available when the Transmit Program Change is set to Off, and is
available only when Part Mode is set to External.
Settings: 001–128

This is the transmit switch for sending the volume setting to the external device.
This parameter is available only when Part Mode is set to External.
Settings: Off, On

Sets the volume for transmitting the Performance selection.
This parameter is available only when Part Mode is set to External.
Settings: 0–127

Bank Select (Transmit Bank Select)

MIDI Bank MSB
MIDI Bank LSB

Pgm Change (Transmit Program Change)

MIDI Pgm Num (MIDI Program Number)

Vol/Exp (Transmit Volume/Expression)

MIDI Volume

Pan (Transmit Pan)
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This is the transmit switch for sending the pan setting to the external device.
This parameter is available only when Part Mode is set to External.
Settings: Off, On

Sets the pan for transmitting the Performance selection.
This parameter is not available when the Transmit Pan is set to Off.
Settings: L64–C–R63

Opens the Tx/Rx Switch screen.

Sets the maximum number of Elements to use.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Element
Settings

Enables the extension of Element capacity.
When set to Off, only up to eight elements are available.
Settings: Off, On

Sets the maximum number of elements to use.

MIDI Pan

Edit Tx/Rx Switch

Element Settings

Ex Elem Sw (Extended Element Switch)

Element Count
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Settings: 8–128

NOTE
Even when Element Sw is set to Off, the number set in Element Count is saved.

On the Pitch screen, you can set the pitch for the Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Pitch

Portamento is a function for creating a smooth transition between two notes.
By setting this parameter to On, you can apply Portamento to Parts having the Portamento Part
Switch set to On.
This switch is linked to the [PORTAMENTO] button on the top panel.
Settings: Off, On

Adjusts the pitch in semitones.
Settings: −24–+0–+24

Adjusts the pitch of the Part in 0.1 Hz increments.
By slightly shifting the pitch, you can detune the sound.
Settings: −12.8Hz–+0.0Hz–+12.7Hz

Pitch

Master Sw (Portamento Master Switch)

Note Shift

Detune
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Parts assigned to the same group are given the same pitch.

Sets the tone generation mode of the current Part. Mono is for playing single notes, and Poly is
for playing multiple simultaneous notes.
When using the Mono setting for playing the keyboard in Legato, you can create a smooth
transition of sounds from one note to another.
Settings: Mono, Poly

Sets the range of the changes created with the pitch bend wheel in semitones.
Settings: −48–+0–+24

Opens the Control Assign screen with the DisplayFilter set to PitchBend.

Sets Portamento on or off for the Part.
Settings: Off, On

Sets the way Portamento is applied according to your keyboard performance.
Settings: Fingered, Full-time

Fingered: Portamento is applied only when you play legato (playing the next note
before releasing the previous one).
Full-time: Portamento is applied at all times.

Sets the time length (or speed) for the pitch transition of Portamento.
Settings: 0–127

Sets how the pitch changes over time.
Settings: Rate 1, Time 1, Rate 2, Time 2

Rate 1: Pitch changes at a specific rate.
Time 1: Pitch changes at a specific time.
Rate 2: Pitch changes at a specific rate within an octave.
Time 2: Pitch changes at a specific time within an octave.

Pitch Control Group

Mono/Poly

Pitch Bend↓ (Pitch Bend Range Lower)
Pitch Bend↑ (Pitch Bend Range Upper)

Edit Control Assign

Portamento (Portamento Part Switch)

Mode (Portamento Mode)

Time (Portamento Time)

Time Mode (Portamento Time Mode)
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Sets the attack of the legato notes when Mono/Poly is set to Mono.

When set to Mono, the attack of the note may sound unnatural depending on the attack speed
of the waveform assigned to the Part. If this is the case, use this parameter to adjust the attack.
In most cases, it is recommended to set this parameter to a smaller value for waveforms having
a short attack, and a larger value for waveforms having a long attack.
Settings: 0–7

Sets the micro tuning (temperament) for the Part.
Settings: Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti &

Young, 1/4 shift, 1/4 tone, 1/8 tone, Indian, Arabic 1, Arabic 2, Arabic 3, User 1–8
(when a User bank is selected), Library 1-1–16-8 (when a library file is loaded)

Equal
Temperament

Each octave is divided into 12 intervals of equal size.
This is the most commonly used tuning in music today.

Pure Major
Pure Minor

These tunings preserve the pure mathematical intervals of each scale, especially for triad
chords (root, third, fifth).
You can hear this best in actual vocal harmonies, such as choirs and a cappella singing.

Werckmeister
Kirnberger
Vallotti & Young

Each of the scales combines the mean-tone and Pythagorean scales.
The main feature of these scales is that each key has its unique character.
These scales were used extensively during the time of Bach and Beethoven, and even
now they are often used when performing period music on the harpsichord.

1/4 shift
The equal-tempered scale shifted up 50 cents.
You can create tension in your music by mixing this setting with Equal Temperament.

1/4 tone
Twenty-four equally spaced notes per octave.
Playing twenty-four consecutive keys on the keyboard makes up an octave.

1/8 tone
Forty-eight equally spaced notes per octave.
Playing forty-eight consecutive keys on the keyboard makes up an octave.

Indian
Usually observed in Indian music.
Play white keys only.

Arabic Usually observed in Arabic music.

Sets the root note for the micro tuning.
This parameter is shown only when micro tuning that requires a root note is selected.
Settings: C–B

Legato Slope (Portamento Legato Slope)

Micro Tuning Name

Root (Micro Tuning Root)
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Opens the setting screen for User Micro Tuning.

On the Filter EG screen, you can set the Filter Envelope Generator (FEG) for the Part.
The FEG lets you set the degree (or level) of changes to the cutoff frequency and how those
changes evolve over time, starting from the moment you press a key on the keyboard to the
moment the sound decays.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter/Amp → Filter EG

Sets the length of time it takes for the sound to change from the moment you press a key to
when the Cutoff Frequency reaches the value set at Attack Level.
This is specified as an offset value to the Element FEG.
Settings: −64–+63

Sets the length of time it takes for the Cutoff Frequency to change from the attack level. You can
control the crispness or the decay speed of the sound.
This is specified as an offset value to the Element FEG.
Settings: −64–+63

Edit User Tuning

Filter/Amp

Filter EG

FEG Atk (FEG Attack Time)

FEG Decay (FEG Decay Time)
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Sets the Cutoff Frequency level that follows the end of the decay segment (or the level that is
maintained while the key is held down).
This is specified as an offset value to the Element FEG.
Settings: −64–+63

Sets the length of time it takes for the Cutoff Frequency to fall to the Release level when you lift
your finger from the key.
This is specified as an offset value to the Element FEG.
Settings: −64–+63

Changes the sound by setting the cutoff frequency of the filter. When the Low Pass Filter is
selected, you can make the sound brighter by setting this to a larger value, and darker by
setting it to a smaller value.
This is specified as an offset value to the cutoff frequency for the Element.
Settings: −64–+63

Adds special characteristics to the sound by adjusting the signal level near the cutoff frequency.
This is specified as an offset value to the filter resonance or filter width for the Element.
Settings: −64–+63

Sets the depth range of the cutoff frequency controlled by the FEG for the Element.
When it is set to 0, the settings in the Element will be used with no change.
Settings: −64–+63

On the Amp EG screen, you can set the AEG (Amplitude Envelope Generator) for the Part. This
lets you determine how the volume changes from the moment you press a key on the keyboard
to when the sound decays.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter/Amp → Amp EG

FEG Sus (FEG Sustain Level)

FEG Rel (FEG Release Time)

Cutoff (Filter Cutoff Frequency)

Resonance (Filter Resonance)

FEG Depth

Amp EG
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Sets the length of time it takes for the volume to change from the moment you press a key on
the keyboard to when it reaches the maximum.
This is specified as an offset value to the Element AEG.
Settings: −64–+63

Sets the length of time it takes for the volume to change after it has reached the maximum.
This is specified as an offset value to the Element AEG.
Settings: −64–+63

Sets the volume that is maintained after the decay time.
Settings: −64–+63

Sets the length of time it takes after you have released the key to when the sound decays.
This is specified as an offset value to the Element AEG.
Settings: −64–+63

On the Routing screen, you can set the effect routing for the Part.

Operation

AEG Attack (AEG Attack Time)

AEG Decay (AEG Decay Time)

AEG Sustain (AEG Sustain Level)

AEG Release (AEG Release Time)

Effect

Routing
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[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → Routing

(1) VCM Rotary Speaker Switch

Shows the name of the selected Element.
When Ex Elem Sw (General/Pitch → Element Settings) is set to Off, or when there are less than
eight elements, the numbers 1 to 8 are shown.
Settings: 1–128 (up to the Element Count setting)

Sets the Element to be output to Insertion Effect A or Insertion Effect B.
Setting it to Thru bypasses the Insertion Effects.
Settings: Thru, InsA, InsB

Opens the setting screen for the 3-band EQ.

Opens the setting screen for the 2-band EQ.

Sets the position in the signal flow when using the Expression pedal.
Settings: Normal, Pre FX

Normal: Applied after the 2-band EQ
Pre FX: Applied before the Insertion Effects. This setting is effective when used with
non-linear effects such as Distortion. Example of using it with Distortion: When set to

Element (Element Select)

Connect (Element Connection Switch)

3-band EQ

2-band EQ

Expression (Expression Type)
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Normal, the output of Distortion changes. While the distortion level stays the same
and only the volume will change. When set to Pre FX, the input of Distortion changes,
so both the distortion level and the volume will change.

Sets the way the expression effect is applied when Expression Type is set to Pre FX.
Settings: Normal: Volume curve of normal characteristics

Organ: Volume curve of the characteristics simulating a vintage organ

Sets the VCM Rotary Speaker effect, which simulates the characteristics of a rotary speaker by
utilizing VCM technology.
This parameter is available only for Part 1.
Settings: Off, On

Sets the effect routing for Insertion Effect A and Insertion Effect B. The diagram changes
accordingly when the settings are changed.

Settings: Parallel, Ins A→B, Ins B→A
Parallel: (for Normal Part (AWM2) and Drum Part): The output from Insertion Effect A
and Insertion Effect B are individually sent to the Master Effect, Master EQ, Reverb,
Variation, and Envelope Follower.

Ins A→B: The output from Insertion Effect A is sent to Insertion Effect B, and the output
from Insertion Effect B is sent to the Master Effect, Master EQ, Reverb, Variation, and
Envelope Follower.

Exp. Curve (Expression Curve)

VCM Rotary Speaker Switch

Ins Connect (Insertion Connection Type)
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Ins B→A: The output from Insertion Effect B is sent to Insertion Effect A, and the output
from Insertion Effect A is sent to the Master Effect, Master EQ, Reverb, Variation, and
Envelope Follower.

Turns Insertion Effect A and Insertion Effect B on or off.
Settings: Off, On

Sets the Effect Type.
Settings: See the Effect types.

Selects one of the Preset effect parameters for each Effect Type.
By selecting a Preset, you can change the way effects are applied.
Settings: Refer to the Data List.

Sets the Side Chain Part (or the Modulator depending on the effect type) for the Insertion Effect
A or Insertion Effect B.
This parameter is not available when the Part itself or Master is set to the Modulator. In that
case, the parameter value will be shown in parenthesis as in “(Master).”
Settings: Part 1–16, A/D, Master, Off

Sets the level of the signals (or bypass signals) sent from Insertion Effect A or Insertion Effect B
to the Reverb Effect. This parameter is available only when Part Output is set to MainL&R.
Settings: 0–127

Sets the level of the signals (or bypass signals) sent from Insertion Effect A or Insertion Effect B
to the Variation Effect. This parameter is available only when Part Output is set to MainL&R.

A (Insertion Effect A Switch)
B (Insertion Effect B Switch)

Type (Insertion Effect Type)

Preset (Insertion Effect Preset)

Side Chain (Insertion Side Chain Part)
Modulator (Insertion Modulator Part)

Rev Send (Reverb Send)

Var Send (Variation Send)
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Settings: 0–127

Sets the output destination for the audio signals.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and OUTPUT
[R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
[R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.
Off: No output of the audio signal for the Part.

Opens the settings screen for the Envelope Follower.

On the Ins A and Ins B screens, you can set the Insertion Effects.

Operation

Part Output (Part Output Select)

Envelope Follower

Ins A
Ins B

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → Ins A

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → Ins B
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The same as Audio In → Ins A or Ins B in Common Edit.

On the 3-band EQ screen, you can set the Part EQ. The 3-band EQ can be applied before the
Insertion Effect.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → 3-band EQ

Shown below is the setting screen for 3-band EQ.

3-band EQ
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Sets the frequency of the Low band.
Settings: 50.1Hz–2.00kHz

Sets the signal level of the Low band.
Settings: −12.00dB–+12.00dB

Sets the frequency of the Mid band.
Settings: 139.7Hz–10.1kHz

Sets the signal level of the Mid band.
Settings: −12.00dB–+12.00dB

Sets the bandwidth of the Mid band.
Settings: 0.7–10.3

Sets the frequency of the High band.
Settings: 503.8Hz–14.0kHz

Sets the signal level of the High band.
Settings: −12.00dB–+12.00dB

EQ Low Freq (3band EQ Low Frequency)

EQ Low Gain (3band EQ Low Gain)

EQ Mid Freq (3band EQ Mid Frequency)

EQ Mid Gain (3band EQ Mid Gain)

EQ Mid Q (3band EQ Mid Q)

EQ Hi Freq (3band EQ High Frequency)

EQ Hi Gain (3band EQ High Gain)
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On the 2-band EQ screen, you can set the Part EQ.
The 2-band EQ can be applied after the Insertion Effect.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → 2-band EQ

Shown below is the setting screen for 2-band EQ.

Selects the desired EQ type.
Settings: Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: Passes the signals with no effects being applied.
LPF: Cuts the signals above the cutoff frequency.
HPF: Cuts the signals below the cutoff frequency.
Low Shelf: Cuts or boosts the signals below the specified frequency setting.
Hi Shelf: Cuts or boosts the signals above the specified frequency setting.
Peak/Dip: Cuts or boosts the signals at the specified frequency setting.

2-band EQ

EQ1 Type (2band EQ 1 Type)
EQ2 Type (2band EQ 2 Type)
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Sets the frequency to be cut or boosted.
This parameter is not available when the EQ Type is set to Thru.
Settings: 63.0Hz–18.0Hz

Sets the signal level of the frequency band set in EQ1 Freq or EQ2 Freq.
This parameter is not available when the EQ Type is set to Thru, LPF, or HPF.
Settings: −12.0dB–+12.0dB

Sets the bandwidth for cutting or boosting the volume of the frequencies set with EQ1 Freq or
EQ2 Freq.
This parameter is available only when the EQ Type is set to Peak/Dip.
Settings: 0.1–12.0

Sets the output gain of the 2-band EQ.
Settings: −12.0dB–+12.0dB

On the Common screen, you can set the Arpeggio for the entire Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Arpeggio → Common

EQ 1 Freq (2band EQ 1 Frequency)
EQ 2 Freq (2band EQ 2 Frequency)

EQ 1 Gain (2band EQ 1 Gain)
EQ 2 Gain (2band EQ 2 Gain)

EQ 1 Q (2band EQ 1 Q)
EQ 2 Q (2band EQ 2 Q)

Output Level (2band EQ Output Level)

Arpeggio

Common
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Sets the Arpeggio for the Part on or off.
Settings: Off, On

Sets the Arpeggio for the Performance on or off.
Settings: Off, On

Adjusts the timing for starting the next Arpeggio phrase when playing back Arpeggio phrases in
multiple Parts.
When set to Off, Arpeggio playback starts when the Part is played on the keyboard.
The value shown here is in clocks.
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

Sets the Arpeggio Group for using the same Arpeggio on multiple Parts.
The Parts set in the same Group will have the same Arpeggio settings.

This Indicator is set to On for the Part that is in the same Group as the selected Part.

Enables or disables the Hold function which continues to repeatedly play back the Arpeggio
even after you release the key on the keyboard.
Settings: Sync-Off, Off, On

Sync-Off: Repeats Arpeggio playback in the background while your fingers release

Arp Part (Part Arpeggio Switch)

Arp Master (Arpeggio Master Switch)

Sync Quantize (Arpeggio Sync Quantize Value)

Arpeggio Group

Indicator

Hold (Arpeggio Hold)
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the keys and resumes playback when you press any key on the keyboard.
Off: Plays back the Arpeggio only while any key is being held.
On: Repeats Arpeggio playback even after you release the key on the keyboard.

Sets the timing for changing the Arpeggio type while another Arpeggio phrase is still being
played back. You can select Real-time for switching to a new Arpeggio phrase immediately or
Measure for switching to a new Arpeggio phrase at the top of the next measure.
Settings: Real-time, Measure

Sets the way Arpeggio is played back.
Settings: Sort, Thru, Direct, Sort+Drct, Thru+Drct

Sort: Plays back the same Arpeggio regardless of the order of keys played.
Thru: Plays back the Arpeggio differently depending on the order of keys played.
Direct: Does not play back the Arpeggio. Only your keyboard performance will be
played. However, this setting allows you to create sound changes through Control
Change messages such as pan and brightness, depending on the Arpeggio. As such,
it is useful for Arpeggio types that use Control Change or for Arpeggio types included
in the Control category.
Sort+Drct: Plays back the Arpeggio according to the Sort setting, as well as the notes
played on the keyboard.
Thru+Drct: Plays back the Arpeggio according to the Thru setting, as well as the
notes played on the keyboard.

Selects loop (repeat) playback while holding the key on the keyboard, or one-shot playback for
the Arpeggio every time you press a key.
Settings: Off, On

Sets the Part to play only with the Arpeggio.
Parts set to On will be played by the Note On messages sent for the Arpeggio.
Settings: Off, On

Changes the timing of even-numbered beats (backbeats) counted from the value specified in
Quantize Value to add a swing feel to the Arpeggio playback.

Change Timing (Arpeggio Change Timing)

Key Mode (Arpeggio Key Mode)

Loop (Arpeggio Loop)

Arp Play Only (Arpeggio Play Only)

Swing

+1 and higher: Moved behind the beat.

-1 and lower: Moved ahead of the beat.
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Settings: −120–+120

Sets the percentage for stretching or compressing the Arpeggio playback time.
The subdivision of the beat and the tempo will change when you stretch or compress the
playback time, so you can create a completely new feel for the originally selected Arpeggio.
Settings: 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%, Common

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.
Common: The value set in the Unit Multiply common to all Parts is applied.

Sets the reference note for using quantize and swing.
The value shown here is in clocks.
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

Sets the strength of the quantize setting (or how close the notes are to the reference note set in
Quantize Value). A setting of 100% shifts the timing completely to that set in Quantize Value,
while a setting of 0% results in no quantization.
Settings: 0%–100%

Sets the rate for the Gate Time (or time length for playing the notes) of Arpeggio playback. If the
Gate Time is set to the value 0 as a result, the setting will be changed to the value 1.
Settings: 0%–200%

Sets the velocity rate of Arpeggio playback. If the Velocity is set to the value 0 as a result, the
setting will be changed to a value of 1. When it is set to a value larger than 128, the setting will
be changed to a value of 127.
Settings: 0%–200%

0: Does not change the even-numbered beats or add any swing feel.
This setting is useful for creating desired rhythms for playing in swing, shuffle, and bounce
feels.

Unit (Arpeggio Unit Multiply)

Quantize Value (Arpeggio Quantize Value)

Qntz Strength (Arpeggio Quantize Strength)

Gate Time (Arpeggio Gate Time Rate)

Velocity Rate (Arpeggio Velocity Rate)

Arp Vel Limit (Arpeggio Velocity Limit)
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Sets the velocity range (lowest and highest values) for Arpeggio playback.
When this is set so that the higher value is first and the lower value is second (for example, 93
to 34), the Arpeggio is played only for velocities of 1 to 34 and 93 to 127.
Settings: 1–127

Sets the note range (the lowest and the highest notes) for Arpeggio playback.
When the first note specified is higher than the second (for example, C5 to C4), the notes in the
ranges C−2 to C4 and C5 to G8 will be played.
Settings: C−2–G8

Shifts the pitch of the Arpeggio in octaves.
Settings: −10–+0–+10

Shifts the range of the Arpeggio in octaves.
Settings: −3–+0–+3

Selects the Arpeggio.
Settings: 1–8

On the Individual screen, you can set the Arpeggio type parameters for Arpeggio Select 1 to 8.
Tapping the Arpeggio Type setting calls up the menu. Selecting Search opens the Arpeggio
Category Search screen. Selecting Number allows you to specify the Arpeggio Type by number.

Operation

Arp Note Limit (Arpeggio Note Limit)

Octave Shift (Arpeggio Output Octave Shift)

Octave Range (Arpeggio Octave Range)

Arp Select (Arpeggio Select)

Individual

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Arpeggio → Individual

(When a selected Part is something other than Common) [SHIFT] + [ARP ON/OFF]
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The same as the Common screen.

Selects the Arpeggio.
Settings: 1–8

Shows the Category of the selected Arpeggio.
Settings: Refer to the Data List.

Shows the Sub category of the selected Arpeggio.
Settings: Refer to the Data List.

Shows the name of the selected Arpeggio.
Settings: Refer to the Data List.

Sets the velocity rate of the Arpeggio playback.
If the Velocity is set to the value of 0 as a result, the setting will be changed to a value of 1.
When it is set to a value larger than 128, the setting will be changed to a value of 127.
Settings: −100%–+100%

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arp Group
Indicator

Arp (Arpeggio Select)

Category (Arpeggio Category)

Sub (Arpeggio Sub Category)

Name (Arpeggio Name)

Velocity (Arpeggio Velocity Rate)
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Sets the Gate Time (or time length for playing the notes) for Arpeggio playback.
If the Gate Time is set to a value of 0 as a result, the setting will be changed to a value of 1.
Settings: −100%–+100%

On the Advanced screen, you can set the Arpeggio parameters.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Arpeggio → Advanced

The same as the Common screen.

Sets the velocity level for triggering an Accent Phrase.
Accent Phrases are sequence phrases that have been programmed to certain types of Arpeggio
patterns to be played back only when the keys are played at a fast velocity. Accent Phrases are
triggered when the velocity is faster than Accent Vel Threshold (Arpeggio Accent Velocity
Threshold).
If the Accent Phrase is not triggered properly, try lowering the Accent Vel Threshold (Arpeggio
Accent Velocity Threshold) value.

Gate Time (Arpeggio Gate Time Rate)

Advanced

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arp Group
Indicator

Accent Vel Threshold (Arpeggio Accent Velocity Threshold)
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NOTE
For more information on the Arpeggio types that support this function, refer to the Data List.
Settings: Off, 1–127

Sets the Accent Phrase to be triggered when a key is pressed at the velocity value larger than
the Accent Vel Threshold (Arpeggio Accent Velocity Threshold) (set to On) or triggered at the
timing set in the selected Arpeggio type (set to Off).
Settings: Off, On

Enables the Random SFX function.
The Random SFX function triggers special sounds included in some Arpeggio types. There are
various types of special sounds you can use. For example, you can use this function to add
guitar fret noises when you release your finger from the key.
Settings: Off, On

NOTE
For more information on the Arpeggio types that support this function, refer to the Data List.

Sets the velocity value for triggering special sounds for the Random SFX function.
Settings: −64–+0–+63

Sets special sounds to be triggered by the velocity level for pressing keys or by the velocity
level automatically set.
Settings: Off, On

Sets the velocity for playing back the Arpeggio.
Settings: Original, Thru

Original: Follows the velocity level set in the Arpeggio Type.
Thru: Follows the velocity level of the keystroke.

Sets the Trigger Mode to the Gate setting that starts and stops the Arpeggio playback by
pressing a key, or to the Toggle setting that alternates start and stop by pressing a key.
Settings: Gate, Toggle

Accent Start Quantize (Arpeggio Accent Start Quantize)

Random SFX (Arpeggio Random SFX)

Random SFX Velocity Offset (Arpeggio Random SFX Velocity Offset)

Random SFX Key On Ctrl (Arpeggio Random SFX Key On Control)

Velocity Mode (Arpeggio Velocity Mode)

Trigger Mode (Arpeggio Trigger Mode)
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Changes the Arpeggio selection.
Settings: 1–8

On the Common screen, you can set the Motion Sequencer parameters for the entire Part.

Operation

Sets the swing value of the Arpeggio and Motion Sequencer for the Performance.
This is specified as an offset value to the Part Swing.
Settings: −120–+120

Sets the percentage for stretching or compressing the Arpeggio and Motion Sequencer
playback time for the entire Performance.
This parameter is effective on the Lane for which Unit Multiply is set to Common.
The subdivision of the beat and the tempo will change when you stretch or compress playback
time, so you can create a completely new feel for the Motion Sequence you have originally
selected.

Arp Select (Arpeggio Select)

Motion Seq

Common

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Motion Seq → Common

(When a selected Part is something other than Common) [SHIFT] + [MSEQ ON/OFF]

Common Swing (Common Swing Offset)

Common Unit (Common Unit Multiply)
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Settings: 50%–400%
200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.

Sets the Motion Sequencer Amplitude for the entire Performance.
This is specified as an offset value to the Motion Sequencer Amplitude for the Part.
Amplitude here is the degree of changes to the Motion Sequence.
This parameter value offsets the Amplitude of the Lanes within the Performance if MS FX is set
to On for the lane.
Settings: −127–+127

Sets the Motion Sequencer Pulse Shape for the Performance.
This is specified as an offset value to the Motion Sequencer Pulse Shape for the Part.
This parameter changes the shape of the step curve that makes up the sequence.
This parameter value offsets the parameters for the Lanes within the Performance if the MS FX
is set to On for the lane and Control is set to On.
Settings: −100–+100

Sets the Motion Sequencer Smoothness for the Performance.
This is specified as an offset value to the Motion Sequencer Smoothness for the Part.
Smoothness here is the smoothness of the changes in the sequence over time.
This parameter value offsets the Smoothness of the Lanes within the Performance if the MS FX
is set to On for the lane.
Settings: −127–+127

Sets the Motion Sequencer Randomness for the Performance.
This is specified as an offset value to the Motion Sequencer Randomness for the Part.
This parameter indicates the randomness of changes in the step value of the sequence.
This parameter value offsets the Randomness of the Lanes within the Performance if the MS FX
is set to On for the lane.
Settings: −127–+127

Changes the timing of the even-numbered beats (backbeats) counted from the value specified
in MS Grid to add a swing feel to the Motion Sequencer playback.

Common Amplitude (Common Motion Sequencer Amplitude Performance Offset)

Common Shape (Common Motion Sequencer Pulse Shape Performance Offset)

Common Smooth (Common Motion Sequencer Smoothness Performance Offset)

Common Random (Common Motion Sequencer Randomness Performance Offset)

Part Swing (Part Swing)
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Settings: −120–+120

Sets the percentage for stretching or compressing the Arpeggio playback time for the Part.
The parameter setting is effective when the Unit Multiply of each Lane is set to Arp.
Settings: 50%–400%, Common

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The playback time is halved, and the tempo is doubled as a result.
Common: The value set in the Unit Multiply common to all Parts is applied.

Sets the Motion Sequencer Amplitude for the Part.
This is specified as an offset value to the Motion Sequencer Amplitude for each Lane.
This parameter value offsets the Amplitude of the Lanes within the Part if the MS FX is set to On
for the lane.
Settings: −127–+127

Sets the Motion Sequencer Pulse Shape for the Part.
This is specified as an offset value to the Motion Sequencer Step Curve parameter for each
Lane.
This parameter value offsets the parameters for the Lanes within the Part if the MS FX is set to
On for the lane and Control is set to On.
Settings: −100–+100

Sets the Motion Sequencer Smoothness for the Part.
This is specified as an offset value to the Motion Sequencer Smoothness for each Lane.
This parameter value offsets the Smoothness of the Lanes within the Part if MS FX is set to On
for the Lane.
Settings: −127–+127

Sets the Motion Sequencer Randomness for the Part.
Sets randomness of the changes in the Step value of the sequence.

+1 and higher: Moved behind the beat.

-1 and lower: Moved ahead of the beat.

0: Does not change the even-numbered beats or add any swing feel.
This setting is useful for creating desired rhythms for playing swing, shuffle, and bounce feels.

Part Unit (Arpeggio Unit Multiply)

Part Amplitude (Part Motion Sequencer Amplitude)

Part Shape (Part Motion Sequencer Pulse Shape)

Part Motion Seq Smooth (Part Motion Sequencer Smoothness)

Part Motion Seq Random (Part Motion Sequencer Randomness)
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Settings: 0–127

Sets the Motion Seq Lane to show when the View Mode of the Home screen is set to Motion
Seq.

Selects the Motion Sequence to playback.
Settings: 1–8

On the Lane screen, you can set the parameters for each Motion Sequencer Lane.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Motion Seq → Lane

Sets the Motion Sequencer for the entire Performance on or off.
Settings: Off, On

Sets the Motion Sequencer of the Part on or off.
Settings: Off, On

Motion Seq View Lane

MS Select (Motion Sequence Select)

Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)

Motion Seq Part Sw (Motion Sequencer Part Switch)

Lane Select
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Selects a Lane.
Settings: 1–4

Indicates the Lane and the Sequence.

Opens the Motion Sequence screen.
You can create a sequence of up to 16 steps.

Sets the value for each step in the Motion Sequence.
You can use Control sliders 1 to 8 to change the values for Steps 1 to 8 and Steps 9 to 16,
depending on the cursor position.
Settings: 0–127

Sets each Lane on or off.
You can use up to four Motion Sequencer lanes in one Part, or up to eight lanes in an entire
Performance. When set to Off, the parameters for that lane will not be shown.
Settings: Off, On

Sets the selected Lane to receive the signals from the knobs for changing the Motion
Sequencer parameters such as Swing and Smooth.
Settings: Off, On

Sets the selected Lane to receive the signals from the [MSEQ TRIGGER] button.
When set to On, the Motion Sequence will not be played back unless you press the [MSEQ
TRIGGER] button.
Settings: Off, On

Changes the Motion Sequence selection.
Settings: 1–8

Target Sequence

Edit Sequence

Motion Seq Step Value

LaneSw (Lane Switch)

MS FX (Lane FX Receive)

Trigger (Lane Trigger Receive)

Sequence Select (Motion Sequence Select)

Sync/Speed tab

Sync (Lane Sync)
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Sets the speed and the timing of the playback of the Motion Sequence set for the Destination in
the Control Assign screen.
Settings: Off, Tempo, Beat, Arp, Lane1 (when Lanes 2–4 are selected)

Off: Plays back the Lane Motion Sequencer alone.
Tempo: Plays back the Lane Motion Sequencer at the Performance tempo.
Beat: Plays back in sync with the beat.
Arp: Plays back the Lane Motion Sequencer in sync with the top of the Arpeggio
playback.
Lane1: Plays back the Lane Motion Sequencer in sync with Lane 1.

Sets the playback speed for the Motion Sequence.
This parameter is available when Lane Motion Sequencer is set to Off.
Settings: 0–127

Sets the delay time for starting the playback of the Motion Sequence when Sync is set to Off.
Settings: 0–127

Sets the time to reach the maximum amplitude for the Motion Sequence when Sync is set to
Off.
Settings: 0–127

Sets the percentage for stretching or compressing the Motion Sequencer playback time for
the current Lane.
This parameter is available when Lane Motion Sequencer is set to Off or something other
than Lane 1.
Settings: 50%–6400%, Common, Arp

200%: The playback time is doubled, and the tempo is halved as a result.
100%: The playback time is kept unchanged.
50%: The time length is halved, and the tempo is doubled as a result.
Common: The value set in the Unit Multiply common to all Parts is applied.
Arp: The value set in the Unit Multiply of the Part Arpeggio is applied.

When Sync is set to Off

Speed (Lane Speed)

Delay Time (Lane Key On Delay Time Length)

Fade In Time (Lane Fade In Time Length)

When Sync is set to something other than Off

Unit Multiply (Lane Unit Multiply)

Lane Key On Delay (Lane Key On Delay Time Length)

291



Sets the delay time for starting the playback of the Motion Sequence when Sync is set to
something other than Off or Lane1.
Settings: 0–32

Sets the time to reach the maximum amplitude for the Motion Sequence when Sync is set to
something other than Off.
Settings: 0–32

Sets the velocity range (lowest and highest values) for playing back the Motion Sequence of the
selected Lane.
This parameter is available when Lane Motion Sequencer is set to something other than Lane
1.
When the Velocity Limit is set to a range from the highest value to the lowest value, the Motion
Sequence will be played back in two velocity ranges: from the maximum to the highest value,
and from the lowest value to the minimum.
Settings: 1–127

Resets the Motion Sequence playback when you press any key on the keyboard.
This parameter is available when Lane Motion Sequencer is set to Arp or something other than
Lane 1.
This parameter is not available when Trigger is set to On.
Settings: Off, Each-On, 1st-On

Each-On: Each time you play any note, the sequence will be reset and the playback
starts from the beginning.
1st-On: Playback starts from the beginning at the first note you play. If the first note is
held while a second note is played, the sequence is not reset at the second or any
subsequent notes.

Sets the Motion Sequence to loop (repeat) playback or one-shot playback.
This parameter is available when Lane Motion Sequencer is set to something other than Lane
1.
Settings: Off, On

Lane Fade In (Lane Fade In Time Length)

Lane Vel Limit (Lane Velocity Limit)

Loop/Length tab

Key On Reset (Lane Key On Reset)

Loop (Lane Loop)

Loop Start
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Sets the step for starting playback the second time or later when repeating Motion Sequence
playback.
Settings: 1–Length (Loop Length)

Sets the number of steps in the Motion Sequence.
Settings: Loop Start (Lane Loop Start) –16

Sets the length of a step in the Motion Sequence.
Settings: 60, 80, 120, 160, 240, 320, 480

The Control Assign screen lets you set the Controllers for the Part.
By assigning a parameter (Destination) to a controller (Source), you can control the sound in a
large variety of ways. You can use physical controllers such as the Pitch Bend wheel and knobs
as well as the Motion Sequencer and Envelope Follower.
Up to 32 controllers can be assigned simultaneously to a Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Control Assign

When Display Filter is set to Super Knob, tapping [+] shows the message in the upper area of
the display and automatically adds the Control Assign settings for the Common Edit.

Length (Motion Sequence Length)

MS Grid (Motion Sequencer Grid)

Mod/Control

Control Assign
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NOTE
When there are no assignable knobs available, [+] will not be shown.

Sets the auto select of the Display Filter on or off.
When set to On, moving the controller you wish to set to Source automatically sets the controller
to the Display Filter.
Settings: Off, On

Selects the controller for showing the settings on the screen.
When you select Super Knob, all settings having the Super Knob Link set to On will be shown.
Settings: PitchBend, ModWheel, AfterTouch, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon,

Breath, AsgnKnob 1–8, Super Knob, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow
1–16, EnvFollowAD, EnvFollowMst, All

NOTE
If the controller set to Display Filter is used by other Parts, the corresponding PART buttons will flash.

This calls up the Pitch settings screen.
The screen shown here is the same as the one opened from [EDIT/ ] → General/Pitch →
Pitch.
This parameter is not available when Source is set to something other than PitchBend.

This allows you to enter a new name for Knobs 1 to 8 to show on the Sub display.
This parameter is not shown when Source is set to something other than AsgnKnob 1–8.

Opens the Motion Sequence screen.
You can create a sequence of up to 16 steps.
This parameter is not available when Source is set to something other than MS Lane 1–4.

Opens the settings screen for the Envelope Follower.
This parameter is not available when Source is set to something other than EnvFollow 1–16,
EnvFollowAD, or EnvFollowMst.

Auto Select

Display Filter

Edit Pitch Bend

Display Name (Assignable Knob Name)

Edit Motion Sequencer

Edit Envelope Follower

Page
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Selects the next page when there are more than four Destinations. The next page does not
appear when the Destinations are four or fewer.
Settings: 1–8

Sets the parameter to the Destination. Tapping the [+] icon allows you to add a new Destination.

Sets the controller for controlling the parameters set to the Destination.
Settings: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD,
EnvFollowMst

You can set the controller setting for each Element on or off.
This parameter is shown only when the selected Destination is related to Elements.
When the ExElemSw on the General/Pitch - ElementSettings screen is set to On, you can
change the switch number by changing the Display Element.
The actual range of numbers you can use in the switch depends on the value set in
ElementCount on the General/Pitch - ElementSettings screen.
Settings: Off, On

Shown only when ExElemSw on the General/Pitch - ElementSettings screen is set to On.
You can select a different group of eight elements corresponding to ElementSw.
Settings: 1–8, 9–16, ..., 121–128 (up to the Element Count setting)

Sets the change curve of the parameter set to Destination.
The horizontal axis represents the controller value set in Source while the vertical axis
represents the parameter value set in Destination.
Settings: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold,
Harmonic, Steps, User 1–32 (when a User bank is selected), Library 1–16 (when a
Library file is loaded)

Destination

Source

Element Sw (Element Switch) 1–128

Display Element

Curve Type
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Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)
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Adjusts the curve shape.
This setting may not be available depending on the curve type.

Copies the parameters set to Destination to Display Name.
This parameter is not shown when Source is set to something other than AsgnKnob 1–8.

Opens the setting screen for User Curve.
You can create either an 8-point linear curve or an 8-step curve.

Opens the Control Assign screen for Common Edit.

Deletes the selected Destination.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → After Touch

Selects the mode for sending Aftertouch messages from the keyboard to the internal tone
generator.
This parameter is set to Channel on the MONTAGE M6 and MONTAGE M7, regardless of the
setting here.

Destination to Name

Edit User Curve

Edit Common Control Assign

Delete

After Touch

Keyboard AT Mode (After Touch Mode)
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Settings: Poly (polyphonic aftertouch), Channel (channel aftertouch)

Sets the parameter for the Destination. Tapping the [+] icon lets you add a new Destination.

Cannot be changed from this screen.
This parameter is fixed to Poly AT.

You can set the controller setting for each Element on or off.
This parameter is shown only when the selected Destination is related to Elements.
When the ExElemSw on the General/Pitch - ElementSettings screen is set to On, you can
change the switch number by changing the Display Element.
The actual range of numbers you can use in the switch depends on the value set in the
ElementCount on the General/Pitch - ElementSettings screen.
Settings: Off, On

Shown only when ExElemSw on the General/Pitch - ElementSettings screen is set to On.
You can select a different group of eight elements corresponding to ElementSw.
Settings: 1–8, 9–16, ..., 121–128 (up to the Element Count setting)

Sets the change curve of the parameter set to Destination.
The horizontal axis represents the controller value set in Source while the vertical axis
represents the parameter value set in Destination.
Settings: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold,
Harmonic, Steps, User 1–32 (when a User bank is selected), Library 1–8 (when a
Library file is loaded)

Destination

Source

Element Sw (Element Switch) 1–128

Display Element

Curve Type
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Sets the polarity of the curve set in Curve Type.
Polarity (Curve Polarity)
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Settings: Uni, Bi
Uni: Parameter changes occur only within the positive range or the negative range
according to the curve shape.
Bi: Parameter changes occur both in positive and negative ranges according to the
curve shape.

Sets the ratio of the parameter values.
Settings: −64–+63

Opens the setting screen for User Curve.
You can create an 8-point linear curve or an 8-step curve.

Deletes the current Destination.

On the Tx/Rx Switch screen, you can set the switch for transmitting or receiving MIDI messages
(such as Control Change) on or off.

NOTE
When CC (Control Change) is set to Off, the parameters related to Control Change messages cannot be set.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Tx/Rx Switch

Ratio (Curve Ratio)

Edit User Curve

Delete

Tx/Rx Switch
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Shows the transmit switch.
This parameter is available only when Part Mode is set to External or when Keyboard Sw is set
to Off.

This parameter is available only when Part Mode is set to Internal.

Keyboard Control is used for selecting Parts to be played on the keyboard.
When Keyboard Control is set to On, you can simultaneously play Parts having Keyboard
Control set to On, if the Part is set to Common or Keyboard Control for the Part is set to On.
When Keyboard Control is set to Off, you can play the Part on the keyboard only when that Part
is selected.
Settings: Off, On

Sets the channel for transmitting and receiving MIDI messages when Part Mode is set to
Internal.
Settings: Ch1–Ch16, Off

Shows the channel for transmitting and receiving MIDI messages.

Sets the channel for receiving MIDI messages when Part Mode is set to External.

Transmit Sw (Transmit Switch)

Receive Sw (Receive Switch)

Keyboard Sw (Keyboard Control Switch)

Tx/Rx Channel (Transmit/Receive Channel)

MIDI I/O Ch. (MIDI In-Out Channel)

Transmit Ch.
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This calls up the Zone settings screen.
The screen shown here is the same as the one opened from [EDIT/ ] → General/Pitch →
Zone Settings.

Sets the transmission and reception of Program Change messages on or off.
Settings: Off, On

Sets the transmission and reception of Bank Select MSB and LSB messages on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI Pitch Bend messages on or off.
Settings: Off, On

Sets the transmission and reception of Channel Aftertouch on or off.
Settings: Off, On

Sets the transmission and reception of Polyphonic Aftertouch on or off.
Settings: Off, On

Sets the transmission and reception of Control Change messages on or off.
Settings: Off, On

Sets the transmission and reception of the Volume setting on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of the Pan setting on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Zone Settings

PC (Program Change)

BankSelect (Bank Select)

Pitch Bend

CAT (Channel After Touch)

PAT (Polyphonic After Touch)

CC (Control Change)

Vol/Exp (Volume/Expression)

Pan

302



Sets the transmission and reception of MIDI Modulation wheel messages on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI Sustain and Sostenuto messages on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the separately sold foot controllers
on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the separately sold foot switch on or
off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the [ASSIGN 1] and [ASSIGN 2]
buttons on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the [MSEQ TRIGGER] button on or
off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI Ribbon Controller messages on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

MW (Modulation Wheel)

Sustain

FC1 (Foot Controller 1)
FC2 (Foot Controller 2)

FS (Foot Switch)

A. Sw 1 (Assignable Function Switch 1)
A. Sw 2 (Assignable Function Switch 2)

MS Trigger (Motion Sequencer Trigger)

RB (Ribbon Controller)
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Sets the transmission and reception of MIDI Breath Controller messages on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the [PORTAMENTO] button on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for the PORTAMENTO [TIME] knob on
or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Sets the transmission and reception of MIDI messages for Knobs 1 to 8 on or off.
This parameter is not available when CC (Control Change) is set to Off.
Settings: Off, On

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Control
Settings

BC (Breath Controller)

Porta Sw (Portamento Switch)

Porta Time (Portamento Time)

A. Knob 1–8 (Assignable Knob)

Control Settings
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Sets the direction of the Control sliders 1 to 8 for this Part when the slider mode is set to
ELEM/OP/OSC.
When set to Reverse, the volume controls on the screen will change to organ sliders. The organ
sliders will be shown when you select a Part and set the View Mode to Part Info.
Settings: Normal (up from the bottom), Reverse (down from the top)

The Part LFO screen lets you make settings for the Part LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Part LFO

Selects the LFO Wave and sets the type of cyclical changes to the LFOs.
Settings: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4,

Trapezoid, S/H1, S/H2, User

Opens the setting screen for the User LFO.
You can create an LFO waveform of up to 16 steps.

Sets the speed of the LFO Wave changes to synchronize to Arpeggio or Song playback.
Settings: Off (not synchronized), On (synchronized)

Slider Direction

Part LFO

LFO Wave

Edit User LFO

Tempo Sync (LFO Tempo Sync)
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Sets the speed of LFO Wave changes.
This parameter is not available when Tempo Sync is set to On.
Settings: 0–63

Changes the LFO Speed randomly.
This parameter is not available when Tempo Sync is set to On.
Settings: 0–127

This parameter is available when Tempo Sync is set to On. You can sync the speed of
changes in LFO Wave by using musical note values.
Settings: 1/16 (sixteenth notes), 1/8 Tri. (eighth-note triplets), 1/16 Dot. (dotted sixteenth

notes), 1/8 (eighth notes), 1/4 Tri. (quarter-note triplets), 1/8 Dot. (dotted eighth
notes), 1/4 (quarter notes), 1/2 Tri. (half-note triplets), 1/4 Dot. (dotted quarter
notes), 1/2 (half notes), Whole Tri. (whole-note triplets), 1/2 Dot. (dotted half notes),
1/4 × 4 (quarter-note quadruplets; four quarter notes to the beat), 1/4 × 5 quarter-
note quintuplets; five quarter notes to the beat), 1/4 × 6 (quarter-note sextuplets;
six quarter notes to the beat), 1/4 × 7 (quarter-note septuplets; seven quarter notes
to the beat), 1/4 × 8 (quarter-note octuplets; eight quarter notes to the beat), 1/4 ×
16 (sixteen quarter-notes to the beat), 1/4 × 32 (32 quarter notes to the beat), 1/4 ×
64 (64 quarter notes to the beat)

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
The larger the value, the longer the delay time, or the time that elapses before the LFO comes
into effect.
Settings: 0–127

Sets the amount of time for the LFO effect to fade in after the delay time set in Delay (LFO
Delay Time) has elapsed.
Settings: 0–127

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: LFO changes to the maximum value without any fade-in.

When Tempo Sync is set to Off

Speed (LFO Speed)

Random Speed (Part LFO Random Speed Depth)

When Tempo Sync is set to On

Tempo Speed (LFO Tempo Speed)

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)

306



Low value: Fast fade-in

High value: Slow fade-in

Sets the time for maintaining the LFO effect after the maximum level had been reached.
Settings: 0–126, Hold

Hold: Does not fade out

Sets the amount of time for the LFO effect to fade out after the hold time set in Hold (LFO Hold
Time) has elapsed.
The larger the value, the longer it takes for the LFO effect to fade out.

Hold (LFO Hold Time)

Fade Out (LFO Fade Out time)
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Settings: 0–127

Low value: Fast fade-out

High value: Slow fade-out

Resets the oscillation of the LFO when a key is pressed.
Settings: Off, Each-on, 1st-on

Does not reset the oscillation of the LFO.
Pressing a key starts the LFO wave at
whatever phase the LFO happens to be
at that moment.

Key On Reset (LFO Key On Reset)

Off
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Resets the oscillation of the LFO every
time a key is pressed and starts the
waveform at the phase specified by the
Phase parameter.

Resets the oscillation of the LFO every
time a key is pressed and starts the
waveform at the phase specified by the
Phase parameter.

When a second note is played while the
first note is held, playback will not be
reset.

Sets the LFO Wave to loop (repeat) playback or one-shot playback.
Settings: Off, On

You can set the initial phase for the time LFO Wave is reset.
Settings: 0°, 90°, 120°, 180°, 240°, 270°

Each-on

1st-on

Loop (LFO Loop Switch)

Phase (LFO Phase)
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Sets the offset value to Phase for each Element.
Settings: 0°, 90°, 120°, 180°, 240°, 270°

Shown only when ExElemSw on the General/Pitch - ElementSettings screen is set to On.
You can select a different number for the group of four elements corresponding to the
ElementPhaseOffset and ElementDepthRatio.
Settings: 1–8, 9–16, ..., 121–128 (up to the Element Count setting)

This is specified as an offset value to the Phase (LFO Phase) for each Element.
You can set the initial phase for each Element when LFO Wave is reset.
When the ExElemSw on the General/Pitch - ElementSettings screen is set to On, you can
change the element number by changing the Display Element.
The actual range of numbers you can use for Element Phase Offset depends on the value set in
ElementCount on the General/Pitch - ElementSettings screen.

Sets the function to be controlled by the LFO Wave.
Settings: Insertion Effect A Parameter 1–24, Insertion Effect B Parameter 1–24, Level, Pitch,

Cutoff, Resonance, Pan, E.LFO Speed

Sets the depth of the LFO Wave control for each Destination.
Settings: 0–127

Element Phase Offset (LFO Element Phrase Offset)

Display Element

Element Phase Offset (LFO Element Phase Offset)

Destination (LFO Destination)

Depth (LFO Depth)

Element Depth Ratio (LFO Element Depth Ratio)
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Adjusts the Depth for each Element.
Set this parameter to Off to turn off the LFO.
This parameter is shown only when the selected Destination is related to Elements.
When the ExElemSw on the General/Pitch - ElementSettings screen is set to On, you can
change the element number set to Depth by changing the Display Element.
The actual range of numbers you can use for the Depth depends on the value set in
ElementCount on the General/Pitch - ElementSettings screen.
Settings: Off, 0–127

Opens the setting screen for User LFO.
You can create an LFO waveform of up to 16 steps.

Sets the number of LFO steps.
Settings: 2 steps, 3 steps, 4 steps, 6 steps, 8 steps, 12 steps, 16 steps

Sets the changes to the slope of the waveform currently shown on the screen.
Settings: Off (no slope), Up, Down, Up&Down

Sets the value for each step.
Settings: −64–+63

Selects the template for the LFO waveform.

User LFO Edit

Cycle

Slope

User LFO Step Value

Template
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Contents

On the Osc/Tune screen, you can set the Oscillator for the Element.
Here, you can select the Waveform used as the basis for the sound and set the key range and
velocity range of the Element.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Osc/Tune

Element Edit

Osc/Tune

Waveform Edit

Pitch EG

Filter

Type

Filter EG

Scale

Amplitude

Level/Pan

Amp EG

Scale

Element EQ

Element LFO

Osc/Tune (Oscillator/Tune)
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Sets the selected Element on or off.
Settings: Off, On

Shows the name of the Waveform selected for the Element.
Bank indicates the type of Waveform (Preset, User, and Library) assigned to the Element.
Settings: Refer to the Data List.

XA (Expanded Articulation) is a function for creating realistic sounds like those on acoustic
instruments as well as creating new synth sounds.
You can create such sounds by setting the XA Control to specify the way the Element is played.

Element Switch

Waveform Select

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Name (Waveform Name)

XA Control

Example of XA Control setting

Creating smooth legato
Make the Element alternate between one element with XA Control set to Normal and another
element with the XA Control set to Legato.

Producing sounds when releasing fingers from the keys.
Create an Element with XA Control set to Key Off.

Creating randomness for the same note
Make the Element with XA Control set to Cycle and another one with XA Control set to
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NOTE
The [ASSIGN 1] and [ASSIGN 2] buttons can be set to On or Off by sending the Control Change number set
in the Control → Control Number of the Common Audio Edit screen from an external device.

Settings: Normal, Legato, Key Off, Cycle, Random, A.Sw1 On, A.Sw2 On, A.Sw Off
Normal: Played as a normal Element.
Legato: Played when Mono/Poly is set to Mono. When you play in Legato, the
Element set to Legato will be played instead of the Element set to Normal.
Key Off: Played when a finger is lifted off from the key.
Cycle: Played when there are a series of Elements set in Cycle.
Random: Plays the Elements randomly when multiple Elements are set to Random.
A.Sw Off: Played when both [ASSIGN 1] and [ASSIGN 2] buttons are set to Off.
A.Sw1 On: Played when the [ASSIGN 1] button is set to On.
A.Sw2 On: Played when the [ASSIGN 2] button is set to On.

This parameter is for sorting Elements having the same XA Control setting into groups.
When XA Control of all Elements is set to Normal, this setting is not effective.
Settings: 1–8

Sets the output of the Element to Insertion Effect A or Insertion Effect B.
Setting it to Thru bypasses the Insertion Effects.
Settings: Thru, InsA, InsB

Loads the audio file saved on the USB flash drive as a Waveform.
Edit Waveform appears when a Waveform is loaded.

Opens the Waveform Edit screen.

Shifts the pitch of the Element in semitones.

Random.

Producing sounds unique to acoustic instruments
Some examples of sound unique to acoustic instruments include harmonics and palm mute
on the guitar, flutter-tonguing on the flute, and growl on the saxophone.
Set up an Element with XA Control set to A.Sw1 On or A.Sw2 On, or A.Sw Off, and control
from the [ASSIGN 1] and [ASSIGN 2] buttons on the top panel.

Elem Group (Element Group Number)

Elem Connect (Element Connection Switch)

New Waveform

Edit Waveform

Coarse (Course Tune)
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Settings: −48–+48

Finely adjusts the pitch of the Element.
Settings: −64–63

Sets how the pitch change responds to Velocity or the strength of the keystroke.
Settings: −64–63

Positive value: Faster Velocity values produce a higher pitch.
Negative value: Faster Velocity values produce a lower pitch.
0: No change in pitch.

Sets how the pitch change in the Fine Tuning responds to the position of the key.
Settings: −64–63

Positive values: The pitch goes down when you press a key in the bass section, and
the pitch goes up when you press a key in the treble section.
Negative values: The pitch goes up when you press a key in the bass section, and
the pitch goes down when you press a key in the treble section.

Changes the pitch of the Element randomly each time a key is pressed.
Set the parameter to a larger value to create more pitch changes. When the value is set to 0,
the pitch is kept unchanged.
Settings: 0–127

Sets the output level of the Oscillator to become lower as keystroke Velocity values become
further from the value set in Velocity Limit.
When set to 0, no sound is produced if the velocity is outside the Velocity Limit. The larger the
value, the more gradually the way the output level of the Oscillator decreases.
Settings: 0–127

Fine (Fine Tune)

Pitch/Vel (Pitch Velocity Sensitivity)

Fine/Key (Fine Tune Key Follow Sensitivity)

Random (Random Pitch Depth)

Vel Cross Fade (Velocity Cross Fade)

When Level/Vel is set to +0
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(1) When a larger value is used, the slope will be shifted to
the left.

(2) When Vel Cross Fade is set to 0, no sound is produced
outside the Velocity Limit.

Sets the timing of the Key On Delay to synchronize with the tempo.
Settings: Off, On

Sets the delay time from when the key is pressed to when sound is produced.
This parameter is not available when Tempo Sync is set to On.
Settings: 0–127

This parameter is available when Tempo Sync is set to On. You can set the timing for Key On
Delay by using musical notes.
Settings: 1/16 (sixteenth notes), 1/8 Tri. (eighth-note triplets), 1/16 Dot. (dotted sixteenth

notes), 1/8 (eighth notes), 1/4 Tri. (quarter-note triplets), 1/8 Dot. (dotted eighth
notes), 1/4 (quarter notes), 1/2 Tri. (half-note triplets), 1/4 Dot. (dotted quarter notes),
1/2 (half notes), Whole Tri. (whole-note triplets), 1/2 Dot. (dotted half notes), 1/4 × 4
(quarter-note quadruplets; four quarter notes to the beat), 1/4 × 5 (quarter-note
quintuplets; five quarter notes to the beat), 1/4 × 6 (quarter-note sextuplets; six
quarter notes to the beat), 1/4 × 7 (quarter-note septuplets; seven quarter notes to the
beat), 1/4 × 8 (quarter-note octuplets; eight quarter notes to the beat)

Sets the velocity range (lowest and highest values) for playing the Element wave.
When this is set so that the higher value is first and the lower value is second (for example, 93
to 34), the Element sounds only for velocities of 1 to 34 and 93 to 127.

Tempo Sync (Key On Delay Tempo Sync Switch)

Length (Key On Delay Time Length)

Length (Key On Delay Note Length)

Velocity Limit
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Settings: 1–127

Sets the note range (lowest and highest notes) for the Element.
When the first note specified is higher than the second (for example, C5 to C4), the Element is
played in the ranges C−2 to C4 and C5 to G8.
Settings: C−2–G8

Sets the reference note for Pitch/Key (Pitch Key Follow Sensitivity).
The key set with the note number here is played at the normal pitch regardless of the Pitch/Key
setting.
Settings: C−2–G8

Sets the difference in pitch between two adjacent keys. The reference point is the key specified
in Center Key.
This parameter is useful for playing unpitched sounds, such as special effects, or for playing a
percussion instrument as a Normal Part, or for any other cases where the pitch difference does
not have to be in semitones.

Settings: −200%–+0%–+200%
+100% (normal setting): Pitch difference between the two keys next to each other is
set to a semitone.
0%: No pitch difference between the two keys, and all keys are played at the pitch set
in Center Key.
Negative value: Sets an opposite pitch response such that lower notes result in
higher pitch, and higher notes result in lower pitch.

Note Limit

Center Key (Pitch Key Follow Sensitivity Center Key)

Pitch/Key (Pitch Key Follow Sensitivity)

Pitch/Key and Center Key
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A: Lower notes
B: Center Key
C: Higher notes
D: Difference in pitch
E: When Pitch/Key (Pitch Key Follow Sensitivity) is set to
+100%.
F: Larger
G: Smaller

Opens the Waveform Edit screen.
Here, you can set the various Key Banks that make up a Waveform.

A Key Bank is digital data comprised of a short audio segment, such as vocals or other
sounds, loaded into the instrument. It has the same characteristics as a wav file; however, to
avoid confusion a different name is used to distinguish it from the Waveform.

Key Banks are always saved as a part of a Waveform.
One Waveform is capable of holding multiple Key Banks. You can save even a few dozen Key
Banks, for example, in one Waveform. If you are saving multiple Key Banks in one waveform,
you can assign a key range and velocity range for each Key Bank by specifying the Note Limit

Waveform Edit

Key Banks

Key Banks and Waveforms
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and Velocity Limit. By setting up multiple Key Banks, you can play various Key Bank sounds
depending on the section of the keyboard you use and the strength of your keystroke.

Example of Key Bank and Waveform setup

A Waveform must be loaded into a Part before it can be played.
You can assign a Waveform to an AWM2 Part from Element Edit in Part Edit (AWM2), or to a
Drum Part from Key Edit in Drum Part Edit (AWM2).

Shows the name of the selected Waveform.

Parts and waveforms

Waveform

Category (Waveform Category)
Sub Category (Waveform Sub Category)
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Sets the Main category and Sub category of the selected Waveform.
Settings: Refer to the Data List.

You can save the Waveform you are editing under a new name, using up to 20 alphanumeric
characters. Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Shows the number of Key Banks in the waveform and the total size of the data capacity.

Shows the Key Bank number.

Shows the total size of data capacity.

Shows whether the Key Bank is stereo or mono.

Sets the velocity range (lowest and highest values) for playing the Key Bank.
Settings: 1–127

Sets the note range (lowest and highest notes) for playing the Key Bank.
Settings: 1–127

Sets the key (pitch) of the original waveform data.
Settings: C−2–G8

Sets the volume of the Key Bank.
Settings: 0–255

Sets the Pan position (in the stereo field) of the Key Bank.
Settings: L63 (left)–C (center)–R63 (right)

Name (Waveform Name)

Total

Keybank (Keybank Number)

Size (Keybank Size)

Channel (Keybank Channel)

Velocity Limit

Note Limit

Center Note

Volume

Pan
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Shifts the pitch of the Key Bank in semitones.
Settings: −64–+63

For fine pitch adjustment of the Key Bank.
Settings: −64–+63

Deletes the Key Bank.

Adds a Key Bank to the waveform.

The Pitch EG screen lets you set the Envelope Generator for the Oscillator.
By setting the PEG (Pitch Envelope Generator) time and level (the amount of pitch change), you
can set how the sound changes from the moment you press a key on the keyboard to when the
sound decays to silence.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Pitch EG

Sets the length of time it takes for keeping the pitch at Hold Level starting from the moment you
press a key on the keyboard.

Tune Coarse (Coarse Tune)

Tune Fine (Fine Tune)

Delete Keybank

Add Keybank

Pitch EG

Hold Time (PEG Hold Time)
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Settings: 0–127

Sets the length of time it takes for the pitch to change from the end of the Hold Time to the
Attack Level.
Settings: 0–127

Sets the length of time it takes for the pitch to change from the Attack Level to the Decay 1
Level.
Settings: 0–127

Sets the length of time it takes for the pitch to change from the Decay 1 Level to the Decay 2
Level.
Settings: 0–127

Sets the length of time it takes for the pitch to change from the moment you release the key until
it reaches the Release Level.
Settings: 0–127

Sets the pitch level for the moment you press the key.
Settings: −128–+127

Sets the pitch to change from the Hold Level or the moment you press a key.
Settings: −128–+127

Sets the next pitch value to change from the Attack Level.
Settings: −128–+127

Sets the next pitch value to change from the Decay 1 Level.
Settings: −128–+127

Attack Time (PEG Attack Time)

Decay1 Time (PEG Decay 1 Time)

Decay2 Time (PEG Decay 2 Time)

Release Time (PEG Release Time)

Hold Level (PEG Hold Level)

Attack Level (PEG Attack Level)

Decay1 Level (PEG Decay 1 Level)

Decay2 Level (PEG Decay 2 Level)

Release Level (PEG Release Level)
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Sets the final pitch to reach after you have released the key.
Settings: −128–+127

Sets the reference note (or a key to press) for Time/Key.
With the note (key) set here, the resulting sound of the pitch change set in PEG is played.
Settings: C−2–G8

Sets how the pitch change speed of the PEG responds to the position of the key.
The change speed in PEG is used for the specified key in Center Key.
Settings: −64–+63

Positive value: The higher the key pressed, the faster the pitch changes of the PEG.
Negative value: The higher the key pressed, the slower the pitch changes of the
PEG.
0: No PEG changes regardless of the key position.

A: Center Note
B: Slow

Center Note (PEG Time Key Follow Sensitivity Center Note)

Time/Key (PEG Time Key Follow Sensitivity)

Time/Key and Center Note
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C: Fast
D: Low key
E: High key
F: Positive value
G: Negative value

Sets how the pitch change speed of the PEG responds to Velocity or the strength of the
keystroke.
First, set the time value in Segment and then set the velocity sensitivity value in Time/Vel.
Settings: Time/Vel: −64–+63

Positive value: The faster the velocity, the faster the changes in the PEG.
Negative value: The faster the velocity, the slower the changes in the PEG; slow
velocities result in faster PEG changes.
0: No PEG changes regardless of the velocity setting.

Fast velocity (pitch change is fast) Slow velocity (pitch change is slow)

Settings: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: Time/Vel value affects the Attack Time
Atk+Dcy: The Time/Vel value affects the Attack Time and Decay 1 Time.
Decay: The Time/Vel value affects the Decay Time.
Atk+Rls: The Time/Vel value affects the Attack Time and Release Time.
All: The Time/Vel value affects the time-related settings in PEG.

Sets the depth range of pitch changes controlled by the PEG.
Settings: −64–+63

0: No pitch change.
The further the depth is from a value of 0, the wider the pitch change becomes.
Negative value: Pitch change is inverted.

Time/Vel (PEG Time Velocity Sensitivity)
Segment (PEG Time Velocity Sensitivity Segment)

PEG Depth

Depth/Vel (PEG Depth Velocity Sensitivity)
Curve (PEG Depth Velocity Sensitivity Curve)
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Sets how the depth range of the pitch change controlled by the PEG responds to Velocity or the
strength of the keystroke.
Also, with the Curve setting, you can set how the PEG Depth responds to the velocity. The
vertical axis represents velocity while the horizontal axis represents the depth range of the pitch
changes.
Settings: Depth/Vel: −64–+63

Positive value: Fast velocity widens the depth range of the PEG, while slow velocity
narrows the depth range.
Negative value: Fast velocity narrows the depth range of the PEG, while slow
velocity widens the depth range.
0: No PEG changes regardless of the velocity setting.

Fast velocity
(the depth range in pitch change is wider)

Slow velocity
(the depth range in pitch change is narrower)

Settings: Curve: 0–4

On the Type screen, you can select a filter type for the Element.
The available parameters differ depending on the filter type you have selected here.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Filter → Type

Filter

Type
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Sets the filter for the Element.
The filters available on this instrument are grouped into four types: LPF, HPF, BPF, and BEF.

Settings: LPF24D, LPF24A, LPF18, LPF18s, LPF12+HPF12, LPF6+HPF12,
HPF24D, HPF12, BPF12D, BPFw, BPF6, BEF12, BEF6, DualLPF, DualHPF,
DualBPF, DualBEF, LPF12+BPF6, Thru

This Filter Type cuts the signals above the value set in Cutoff Frequency.
The sound becomes brighter as you raise the Cutoff Frequency, because more high-
frequency signals are passed by the filter; conversely, it becomes darker as you lower the
Cutoff Frequency, because more high-frequency signals are cut or blocked by the filter. You
can produce a distinctive “peaky” sound by raising the Resonance or boosting the signal level
near the Cutoff Frequency.
This Filter Type is very popular and useful for producing classic synthesizer sounds.

Filter Type

LPF
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LPF24D: A dynamic −24 dB/oct Low-Pass Filter with a characteristic digital sound. Compared to
the LPF24A type, this filter can produce a more pronounced Resonance effect.

LPF24A: A digital dynamic Low-Pass Filter with characteristics similar to a 4-pole analog
synthesizer filter.
LPF18: 3-pole −18 dB/oct Low-Pass Filter.
LPF18s: 3-pole −18 dB/oct Low-Pass Filter. This filter has a smoother cutoff slope than the
LPF18 type.

This Filter Type only passes signals above the Cutoff Frequency.
You can produce a distinctive “peaky” sound by raising the Resonance or boosting the signal
level near the Cutoff Frequency.

LPF12+HPF12: A combination of a −12 dB/oct Low-Pass Filter and a −12 dB/oct High-Pass
Filter connected in serial. When this Filter Type is selected, HPF Cutoff and HPF Key Follow
Sensitivity can be set.
LPF6+HPF12: A combination of a −6 dB/oct Low-Pass Filter and a −12 dB/oct High-Pass Filter
connected in serial. When this Filter Type is selected, HPF Cutoff and HPF Key Follow
Sensitivity can be set.
HPF24D: A dynamic −24 dB/oct High-Pass Filter with a characteristic digital sound. This filter
can produce a pronounced Resonance effect.

HPF
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HPF12: −12 dB/oct dynamic High-Pass Filter.

This Filter Type that only passes signals for a specific frequency band (Cutoff Frequency) and
cuts all other signals.

BPF12D: The combination of a −12 dB/oct HPF and LPF with a characteristic digital sound.

BPFw: A −12 dB/oct BPF that combines HPF and LPF filters to allow wider bandwidth settings.

BPF
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BPF6: The combination of a −6 dB/oct HPF and LPF.

The Band-Eliminate Filter has an opposite effect on the sound compared to the Band-Pass
Filter.
When this Filter Type is selected, you can set the Cutoff Frequency around which the audio
signal is muted or eliminated.

BEF12: −12 dB/oct Band-Eliminate Filter.
BEF6: −6 dB/oct Band-Eliminate Filter.
DualLPF: Two −12 dB/oct Low-Pass Filters connected in parallel. You can edit the distance
between the two Cutoff Frequencies. The result of the filter is shown on the screen.

BEF

329



Lower Cutoff Frequency is set directly on the display
(and Higher Cutoff Frequency is automatically set)

DualHPF: Two −12 dB/oct High-Pass Filters connected in parallel.
DualBPF: Two −6 dB/oct Band-Pass Filters connected in parallel.
DualBEF: Two −6 dB/oct Band-Eliminate Filters connected in serial.

Lower Cutoff Frequency is set directly on the display
(and Higher Cutoff Frequency is automatically set)

LPF12+BPF6: A combination of a −12 dB/oct Low-Pass Filter and a −6 dB/oct Band-Pass Filter
connected in parallel. You can edit the distance between the two Cutoff Frequencies.

Lower Cutoff Frequency is set directly on the display
(and Higher Cutoff Frequency is automatically set)

Cutoff (Filter Cutoff Frequency)
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Sets the Cutoff Frequency.
The frequency set here is used by the filter set in Type.
Settings: 0–1023

Sets how the Cutoff Frequency responds to Velocity or the strength of the keystroke.
Settings: −64–+63

Positive values: The faster the Velocity, the higher the Cutoff Frequency value
becomes.
Negative values: The slower the Velocity, the higher the Cutoff Frequency value
becomes.
0: No changes for the Cutoff Frequency by Velocity.

The parameter shown here varies depending on the Filter Type setting. Resonance is shown for
LPF, HPF, BPF (excluding BPFw), or BEF, and Width is shown for BPFw.
For Resonance, this parameter indicates the strength of resonance. This can be used in
combination with the Cutoff parameter to add further character to the sound.
For the BPFw, this parameter is used for adjusting the width of the frequencies passed by the
filter.
This parameter may not be available depending on the Filter Type.
Settings: 0–127

Sets how the resonance level responds to Velocity or the strength of the keystroke.
This parameter may not be available depending on the Filter Type.

Settings: −64–+63
Positive value: The higher the Velocity, the greater the Resonance becomes.
Negative value: The lower the Velocity, the greater the Resonance becomes.
0: Resonance value does not change.

Sets how the Cutoff Frequency level of the filter responds to key position.
The reference point is the Cutoff Frequency for the key set in Center Key.
Settings: −200%–+200%

Positive values: The lower the key played, the lower the Cutoff Frequency becomes;
the higher the key played, the higher the Cutoff Frequency becomes.

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)

Resonance (Filter Resonance)
Width (Filter Width)

Res/Vel (Filter Resonance Velocity Sensitivity)

Cutoff/Key (Filter Cutoff Key Follow Sensitivity)

331



Negative values: The lower the key played, the higher the Cutoff Frequency
becomes; the higher the key played, the lower the Cutoff Frequency becomes.

Sets the distance between the Cutoff Frequencies for the Dual Filter types and the
LPF12+BPF6 filter.
This parameter may not be available depending on the Filter Type.
Settings: −128–+127

Sets the center frequency for the functions that control the filter cutoff and how fast the FEG
changes according to the key follow setting of HPF.
Increasing the value results in a higher Cutoff Frequency, and the low frequency signals are cut
or blocked to make the sound brighter. Decreasing the value results in a higher Cutoff
Frequency, and the low frequency signals are passed to make the sound deeper.
This parameter is not available when the Filter Type is set to LPF12+HPF12 or LPF6+HPF12.
Settings: 0–1023

Sets the level of the Cutoff Frequency of the high-pass filter according to the position of the key.
This parameter is not available when the Filter Type is set to LPF12+HPF12 or LPF6+HPF12.
Settings: −200%–+200%

Positive values: The lower the key played, the lower the Cutoff Frequency becomes;
the higher the key played, the higher the Cutoff Frequency becomes.
Negative values: The lower the key played, the higher the Cutoff Frequency
becomes; the higher the key played, the lower the Cutoff Frequency becomes.

Sets the Gain (signals sent to the Filter unit).
Lowering the value decreases the volume of the Element.
Settings: 0–255

On the Filter EG screen, you can set the Filter Envelope Generator (FEG) for the Element.
The FEG lets you set the degree (or level) of changes to the Cutoff Frequency and how those
changes evolve over time, starting from the moment you press a key on the keyboard to the
moment the sound decays.

Operation

Distance

HPF Cutoff (HPF Cutoff Frequency)

HPF Cutoff/Key (HPF Cutoff Key Follow Sensitivity)

Gain (Filter Gain)

Filter EG
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[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Filter → Filter EG

Sets the length of time it takes for maintaining the Cutoff Frequency at Hold Level starting from
the moment you press a key on the keyboard.
Settings: 0–127

Sets the length of time it takes for the Cutoff Frequency to change from the end of Hold Time to
the Attack Level.
Settings: 0–127

Sets the length of time it takes for the Cutoff Frequency to change from the Attack Level to the
Decay 1 Level.
Settings: 0–127

Sets the length of time it takes for the Cutoff Frequency to change from the Decay 1 Level to the
Decay 2 Level.
Settings: 0–127

Sets the length of time it takes for the Cutoff Frequency to change from the moment you release
your finger from the key until it reaches the Release Level.
Settings: 0–127

Hold Time (FEG Hold Time)

Attack Time (FEG Attack Time)

Decay1 Time (FEG Decay 1 Time)

Decay2 Time (FEG Decay 2 Time)

Release Time (FEG Release Time)
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Sets the Cutoff Frequency at the moment you press the key.
Settings: −128–+127

Sets the Cutoff Frequency value to change after you press the key.
Settings: −128–+127

Sets the next Cutoff Frequency value to change from the Attack Level.
Settings: −128–+127

Sets the Cutoff Frequency that is maintained while the key is held down.
Settings: −128–+127

Sets the next Cutoff Frequency value after you release your finger from the key.
Settings: −128–+127

Sets the reference note (or a key to press) for Time/Key.
With the note (key) set here, the change speed of the cutoff frequency set in Filter EG is used
as is.

Sets how the speed of the frequency change in FEG responds to the position of the key.
The change speed in FEG is used for the specified key in Center Key.
Settings: −64–+63

Positive values: The lower the key played, the slower the FEG change becomes; the
higher the key played, the faster the FEG change becomes.
Negative values: The lower the key played, the faster the FEG change becomes; the
higher the key played, the slower the FEG change becomes.
0: No changes to the FEG regardless of the key position.

Hold Level (FEG Hold Level)

Attack Level (FEG Attack Level)

Decay1 Level (FEG Decay 1 Level)

Decay2 Level (FEG Decay 2 Level)

Release Level (FEG Release Level)

Center Key (FEG Time Key Follow Sensitivity Center Key)

Time/Key (FEG Time Key Follow Sensitivity)

Time/Key and Center Key
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A: Center Key
B: Slow
C: Fast
D: Low key
E: High key
F: Positive value
G: Negative value

Settings: C−2–G8

Sets how the Cutoff Frequency responds to Velocity or the strength of the keystroke.
First, set the time value in Segment, and then the velocity sensitivity value in Time/Vel.
Settings: Time/Vel: −64–+63

Positive value: The faster the velocity, the faster the FEG changes.
Negative value: The faster the velocity, the slower the FEG changes, while slow
velocity makes the FEG change faster.
0: No changes regardless of the velocity setting.

Time/Vel (FEG Time Velocity Sensitivity)
Segment (FEG Time Velocity Sensitivity Segment)
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Fast velocity
(fast changes in Cutoff Frequency)

Slow velocity
(slow changes in Cutoff Frequency)

Settings: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: Time/Vel value affects the Attack Time.
Atk+Dcy: The Time/Vel value affects the Attack Time and Decay 1 Time.
Decay: The Time/Vel value affects the Decay Time.
Atk+Rls: The Time/Vel value affects the Attack Time and Release Time.
All: The Time/Vel value affects the time-related settings in FEG.

Sets the depth range for the Cutoff Frequency change controlled by the FEG.
Settings: −64–+63

0: No changes for the Cutoff Frequency by the Filter EG.
The depth range of the Cutoff Frequency change becomes wider when the setting is
far from the value 0.
For negative values, Cutoff Frequency changes are reversed.

Sets how the depth range of the Cutoff Frequency change controlled by the FEG responds to
Velocity (strength of the keystroke).
Also, with the Curve setting, you can set how the FEG Depth responds to the velocity.
The vertical axis represents the velocity while the horizontal axis represents the depth range of
the Cutoff Frequency change.
Settings: Depth/Vel: −64–+63

Positive values: Fast velocity widens the depth range of the Filter EG changes, while
slow velocity narrows the depth range.
Negative values: Fast velocity narrows the depth range of the Filter EG changes,
while slow velocity widens the depth range.
0: Cutoff Frequency does not respond to Velocity.

FEG Depth

Depth/Vel (FEG Depth Velocity Sensitivity)
Curve (FEG Depth Velocity Sensitivity Curve)
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Fast velocity
(the depth range in Cutoff Frequency change

is wider)

Slow velocity
(the depth range in Cutoff Frequency change

is narrower)

Settings: Curve: 0–4

On the Scale screen, you can set the filter scale for the Element.
The Filter Scale function allows you to change the Cutoff Frequency of the filter depending on
the pitch.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Filter → Scale

Sets the note numbers of four points to be set to Cutoff Offset.
Settings: C−2–G8

Scale

Break Point (Filter Cutoff Scaling Break Point) 1–4
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NOTE
The note numbers for Break Points 1 to 4 will be automatically arranged in ascending order.

Sets the value that increases or decreases the Cutoff on all four Break Points.
Settings: −128–+127

NOTE

On the Level/Pan screen, you can set Level and Pan (position in the stereo field) for each
Element.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Amplitude →
Level/Pan

Sets how the volume of each Element responds to key position. The reference point is the
volume specified in Center Key.

Cutoff Offset (Filter Cutoff Scaling Offset) 1–4

When the offset value is set above or below the Cutoff value, the Cutoff Frequency never goes beyond
the settings.
For any notes below Break Point 1, the value will be set to the Cutoff Frequency of Break Point 1. For any
notes above Break Point 4, the value will be set to the Cutoff Frequency of Break Point 4.

Amplitude

Level/Pan

Level/Key (Level Key Follow Sensitivity)
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Settings: −64–+0–+63
Positive values: The lower the key played, the softer the volume becomes; the
higher the played, the louder the volume becomes.
Negative values: The lower the key played, the louder the volume becomes; the
higher the key played, the softer the volume becomes.

Sets the output level (volume) for each Element.
Settings: 0–127

Sets how the Level (Volume) responds to Velocity or the strength of the keystroke. Offset
adjusts all settings specified in Level/Vel. When the value exceeds 127, the velocity is set to
127. Also, with the Curve setting, you can set how the volume responds to the velocity. The
vertical axis represents the velocity while the horizontal axis represents the range for the
volume changes.
Settings: Level/Vel: −64–+63

Positive value: The faster the Velocity, the louder the volume becomes.
Negative value: The slower the Velocity, the louder the volume becomes.
0: No changes regardless of the Velocity setting.

Settings: Offset: 0–127

Offset (Level Velocity Offset)
= 0

Offset (Level Velocity Offset)
= 64

Offset (Level Velocity Offset)
= 96

A: Level/Vel (Level Velocity Sensitivity) = 0
B: Level/Vel (Level Velocity Sensitivity) = 32
C: Level/Vel (Level Velocity Sensitivity) = 64
X: Velocity of the moment the key is pressed
Y: Velocity value sent to the internal tone generator

Level (Element Level)

Level/Vel (Level Velocity Sensitivity)
Offset (Level Velocity Offset)
Curve (Level Sensitivity Key Curve)
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Settings: Curve: 0–4

Sets the Pan position (in the stereo field) for the Element.
When there are right and left Pan settings for the Elements within a Part, it may be difficult to
hear the result of the pan setting.
Settings: L63–C–R63

Sets the amount by which the sound is panned alternately left and right for each key you press.
The value set in Pan is the center position for the right and left movement of the Pan.
Settings: L64–C–R63

Sets the amount by which the sound is panned randomly left and right for each key you press.
The value set in Pan is the center position in the stereo field.
Settings: 0–127

Sets how the position of the key you press affects the position of the Pan setting.
The value set in Pan is the position for C3.
Settings: −64–+0–+63

Positive values: Pan position is scaled to the left for lower keys and to the right for
higher keys.
Negative values: Pan position is scaled to the right for lower keys and to the left for
higher keys.

On the Amp EG screen, you can set the AEG (Amplitude Envelope Generator) Time for the
Element. This lets you determine how the volume changes from the moment you press a key on
the keyboard to when the sound decays.

Operation

Pan (Element Pan)

Alternate Pan (Alternate Pan Depth)

Random Pan (Random Pan Depth)

Scaling Pan (Scaling Pan Depth)

Amp EG
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[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Amplitude → Amp
EG

Sets the length of time it takes for the volume to change from the moment you press a key on
the keyboard until when it reaches the Attack Level value.
Settings: 0–127

Sets the length of time it takes for the volume to change from the Attack Level to the Decay 1
Level.
Settings: 0–127

Sets the length of time it takes for the volume to change from the Decay 1 Level to the Decay 2
Level.
Settings: 0–127

Sets the length of time it takes for the sound to decay after you have released the key.
Settings: 0–127

Sets the volume for the moment you press the key.
Settings: 0–127

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)

Decay 2 Time (AEG Decay 2 Time)

Release Time (AEG Release Time)

AEG Initial Level

AEG Attack Level
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Sets the volume for changing after you have pressed a key.
Settings: 0–127

Sets the next volume value to change from the Attack Level.
Settings: 0–127

Sets the volume that is maintained while the key is held down.
Settings: 0–127

Sets the reference note (or a key to press) for Time/Key. According to the note (key) set here,
the resulting sound of the pitch change set in PEG is played.
Settings: C−2–G8

Sets how the speed of the volume changes in AEG responds to key position. The speed change
in AEG is used for the specified key in Center Note.
Settings: −64–+63

Positive values: The lower the key played, the slower the AEG volume changes; the
higher the key played, the faster the AEG volume changes.
Negative values: The lower the key played, the faster the AEG volume changes; the
higher the key played, the slower the AEG volume changes.
0: No AEG volume changes regardless of the key position.

AEG Decay 1 Level

AEG Decay 2 Level

Center Note (AEG Time Key Follow Center Note)

Time/Key (AEG Time Key Follow Sensitivity)

Time/Key (AEG Time Key Follow Sensitivity) and Center
Note (AEG Time Key Follow Center Note)
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A: Center Note
B: Slow
C: Fast
D: Low keys
E: High keys
F: Positive values
G: Negative values

Adjusts the sensitivity of the AEG Time Key Follow Sensitivity to AEG Release.
The lower the value, the lesser the sensitivity.
Settings: 0–127

127: AEG Time Key Follow Sensitivity is the same as Decay 1 and Decay 2.
0: AEG Time Key Follow Sensitivity does not affect the AEG Release.

Sets how the time for volume changes in AEG responds to Velocity or the strength of the
keystroke.
First, set the time value in Segment, and then the velocity sensitivity value in Time/Vel.

Release Adj (AEG Time Key Follow Sensitivity Release Adjustment)

Time/Vel (AEG Time Velocity Sensitivity)
Segment (AEG Time Velocity Segment)
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Settings: Time/Vel: −64–+63
Positive value: The faster the velocity, the faster the AEG volume changes.
Negative value: The faster the velocity, the slower the AEG volume changes; the
slower the velocity, the faster the AEG volume changes.
0: No changes regardless of the velocity setting.

Fast velocity (fast volume change) Slow velocity (slow volume change)

Settings: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: Time/Vel value affects the Attack Time
Atk+Dcy: The Time/Vel value affects the Attack Time and Decay 1 Time.
Decay: The Time/Vel value affects the Decay Time.
Atk+Rls: The Time/Vel value affects the Attack Time and Release Time.
All: The Time/Vel value affects the time-related settings in AEG.

By setting this switch On, you can connect a separately sold foot controller FC3A to the
[SUSTAIN] jack on the rear panel and use the half-damper function for your keyboard
performance.
The Half-damper function gives you greater expressive control over sound decay, letting you
use damper pedal operation just as you would on an acoustic piano—continuously and not just
as an on/off switch.
Settings: Off, On

Sets the time from the moment you have released a key while you are pressing the foot
controller FC3A fully down to when the sound decays when the Half Damper (Half Damper
Switch) is set to On. This parameter is not shown when Half Damper (Half Damper Switch) is
set to Off.
You can adjust the decay time from the Half Damper Time to the Release Time by changing the
amount you press on the pedal.
When you release the pedal, the Release Time is used for decaying sound. By setting the
Release Time to a small value, and Half Damper Time to a large value, you can play a natural
decaying sound, like on an acoustic piano.

Settings: 0–127

Half Damper (Half Damper Switch)

Time (Half Damper Time)
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On the Scale screen, you can set the Amplitude Scale for the Element.
This changes the volume according to the key position on the keyboard.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Amplitude → Scale

Sets the note number for Level Offset.
Settings: C−2–G8

NOTE
The note numbers for Break Points 1 to 4 will be automatically arranged in ascending order.

Sets the values of four Break Points for controlling Level.
Settings: −128–+127

On the Element EQ screen, you can set the equalizer for the Element.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Element EQ

Scale

Break Point (Level Scaling Break Point) 1–4

Level Offset (Level Scaling Offset) 1–4

Element EQ
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Selects the desired EQ type.
Settings: 2-band, P.EQ, Boost6, Boost12, Boost18, Thru

2-band: Shelving EQ that boosts or cuts the band of signals above or below a certain
frequency (Low Freq or High Freq).
P.EQ: Parametric EQ that boosts or cuts the signal level (Gain) around the Center
Frequency (Freq).
Boost6: Boosts the level by 6 dB.
Boost12: Boosts the level by 12 dB.
Boost18: Boosts the level by 18 dB.
Thru: Bypasses the equalizer leaving the entire signal unaffected.

Sets the signal level of the Low band.
Settings: −12.00dB–+12.00dB

EQ Type (Element EQ Type)

When EQ Type is set to 2-band

EQ Low Gain (Element EQ Low Gain)
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Sets the frequency of the Low band.
Settings: 50.1Hz–2.00kHz

Sets the signal level of the High band.
Settings: −12.00dB–+12.00dB

Sets the frequency of the High band.
Settings: 503.8Hz–10.1kHz

Sets the signal level for the frequency range set in EQ Freq.
Settings: −12.00dB–+12.00dB

Sets the frequency to be cut or boosted.
Settings: 139.7Hz–12.9kHz

By boosting or cutting the signal level of the frequency set in EQ Freq, you can create various
frequency response curves.
Settings: 0.7–10.3

EQ Low Freq (Element EQ Low Frequency)

EQ Hi Gain (Element EQ High Gain)

EQ Hi Freq (Element EQ High Frequency)

When EQ Type is set to P.EQ

EQ Gain (Element EQ Gain)

EQ Freq (Element EQ Frequency)

EQ Q (Element EQ Q)
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On the Element LFO screen, you can set the LFO (Low Frequency Oscillator) for the Element.
The LFO (Low Frequency Oscillator) for the Element generates signals in the low band, and you
can use it for modulation (cyclical variation) of the pitch, filter, and amplitude.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Element selection → Element LFO

Selects an LFO wave, for creating various distinct types of modulation.
Settings: Saw, Triangle, Square

Saw (Sawtooth wave) Triangle (Triangle wave) Square (Square wave)

Switches between the old set of settings (Off: 0–63) and a new set of settings with higher
resolution (On: 0–415) for Speed (LFO Speed).
To maintain compatibility of data created with the old settings, set this parameter to Off.
Settings: Off, On

Element LFO

LFO Wave

Extended LFO

Speed (LFO Speed)
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Sets the speed of LFO Wave changes. The larger the value of this parameter, the faster the
speed becomes.
Settings: 0–63 (ExtendedLFO set to Off), 0–415 (ExtendedLFO is set to On)

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–127

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: LFO changes to the maximum value without any fade-ins.

Low value: Fast fade-in

High value: Slow fade-in

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)

Key On Reset (LFO Key On Reset)
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Resets the oscillation of the LFO when a key is pressed.
Settings: Off, On

This parameter creates a vibrato effect (cyclical changes to the pitch) by using LFO waves.
Setting the parameter to larger values results in greater change to the volume.
Settings: 0–127

This parameter creates a wah effect (cyclical changes to the filter cutoff frequency) by using
LFO waves.
Larger values result in greater range for cutoff frequency changes.
Settings: 0–127

This parameter creates a tremolo effect (cyclical changes in the volume) by using LFO waves.
Setting the parameter to larger values results in greater change to the volume.
Settings: 0–127

Pitch Mod (LFO Pitch Modulation Depth)

Filter Mod (LFO Filter Modulation Depth)

Amp Mod (LFO Amplitude Modulation Depth)
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The Drum Part (AWM2) consists of 73 drum keys.
Drum Part Edit (AWM2) includes Part Common Edit for setting parameters for the entire Part
and Key Edit for setting parameters for individual drum keys.

Drum Part Edit (AWM2) screen
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Contents

Part Common Edit

General/Pitch

Part Settings

Zone Settings

Pitch

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

Tx/Rx Switch

Control Settings
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Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Part Settings

Sets the Main category and Sub category of the selected Part.
Settings: Refer to the Data List.

You can save the Part you are editing under a new name, using up to 20 alphanumeric
characters.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Sets the volume of the selected Part.
Settings: 0–127

Sets the Pan for the selected Part.
Settings: L63–C (center)–R63

General/Pitch

Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)

Part Name

Volume

Pan

Dry Level
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Sets the Dry Level of the selected Part.
This parameter is available only when Part Output is set to MainL&R or Drum.
Settings: 0–127

Sets the Variation Send of the selected Part.
This parameter is available only when Part Output is set to MainL&R or Drum.
Settings: 0–127

Sets the Reverb Send of the selected Part.
This parameter is available only when Part Output is set to MainL&R or Drum.
Settings: 0–127

Sets the output destination for the audio signals of the selected Part.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off, Drum

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and OUTPUT
[R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
ASSIGNABLE OUTPUT [R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.
Off: No output of the audio signal for the Part.
Drum: You can set the output for each drum key.

Sets the Part to be played only with the Arpeggio.
The Part set to On will be played by Note On messages sent for the Arpeggio.
Settings: Off, On

Sets Pan to On or Off from the Key Edit ([EDIT/ ]→Part selection→Key
selection→Level/Pan→Pan).
When this parameter is set to Off, the Pan position in Key Edit will be set to C (center).
Settings: Off, On

Var Send (Variation Send)

Rev Send (Reverb Send)

Part Output (Part Output Select)

Arp Play Only (Arpeggio Play Only)

Element Pan (Element Pan Switch)
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Sets the velocity range (lowest and highest values) for the Part.
Settings: 1–127

Sets the note range (lowest and highest notes) for the Part.
Settings: C−2–G8

Increases or decreases the velocity value that is sent to the internal tone generator.
Settings: 0–127

When Depth = 64 and Offset
= 32

When Depth = 64 and Offset
= 64

When Depth = 64 and Offset
= 96

(1) Actual resulting velocity (affecting the tone generator)
(2) Velocity with which you play a note

Sets how the level of the velocity value (sent to the internal tone generator) responds to Velocity
or the strength of the keystroke.
Settings: 0–127

Velocity Limit

Note Limit

Velocity Offset (Velocity Sensitivity Offset)

Velocity Depth (Velocity Sensitivity Depth)

When Offset is set to 64:
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(1) Actual resulting velocity (affecting the
tone generator)

(2) Velocity with which you play a note

The screen shown here is the same as the one opened from General/Pitch → Zone Settings on
the Part Edit (AWM2).

On the Pitch screen, you can set the pitch for the Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Pitch

Zone Settings

Pitch
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Adjusts the pitch in semitones.
Settings: −24–+0–+24

Adjusts the pitch of the Part in 0.1 Hz increments.
By slightly shifting the pitch, you can detune the sound.
Settings: −12.8Hz–+0.0Hz–+12.7Hz

Parts assigned to the same group are given the same pitch.
However, Portamento, Mono/Poly, and Micro Tuning are not available for the Drum Part.

Sets the range of the changes created with the Pitch Bend wheel in semitones.
Settings: −48–+0–+24

The screen here is the same as the one opened from Filter/Amp → Filter EG on the Part Edit
(AWM2).

The screen here is the same as the one opened from Filter/Amp → Amp EG on the Part Edit
(AWM2).

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Effect → Routing

Note Shift

Detune

Pitch Control Group

Pitch Bend↓(Pitch Bend Range Lower)
Pitch Bend↑(Pitch Bend Range Upper)

Filter/Amp

Filter EG

Amp EG

Effect

Routing

357



Basically, this is the same screen as Effect → Routing in Part Edit (AWM2.)
The parameters added to Drum Part Edit (AWM2) are shown below.

Shows the name of the selected Drum Key.
Settings: C0–C6

Sets the key to be output to Insertion Effect A or Insertion Effect B.
Setting this to Thru bypasses the Insertion Effects.
Settings: Thru, InsA, InsB

You can use the keyboard to directly select a Drum Key by setting this parameter On.
Settings: Off, On

Sets the level of the Drum Key signals sent to Insertion Effect A or Insertion Effect B to the
Reverb or Variation Effect.
This setting is applied to the entire Drum Part (all Drum Keys).
This parameter is available only when Connect (Drum Key Connection Switch) is set to InsA or
InsB, and Part Output is set to MainL&R or Drum.
Settings: 0–127

Drum Key (Drum Key Select)

Connect (Drum Key Connection Switch)

Keyboard Select

InsRev (Insertion to Reverb Send Level)
InsVar (Insertion to Variation Send Level)

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
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Sets the level of the drum key signals sent to Insertion Effect A or Insertion Effect B to the
Reverb or Variation Effect.
This parameter can be set for each Drum Key.
This parameter is available when Connect (Drum Key Connection Switch) is set to Thru, and
either when Part Output is set to Main, or when Part Output is set to Drum and Drum Key Out is
set to MainL&R.
Settings: 0–127

Sets the output destination for each Drum Key.
This parameter is shown only when Part Output is set to Drum.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and OUTPUT
[R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
ASSIGNABLE OUTPUT [R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.

NOTE
When Connect (Drum Key Connection Switch) is set to InsA or InsB, and this parameter is fixed to the
MainL&R setting.

The screen here is the same as the one opened from Effect → InsA or InsB on the Part Edit
(AWM2).

The screen here is the same as the one opened from Effect → 3-band EQ on the Part Edit
(AWM2).

Drum Key Out (Drum Key Output Select)

Ins A
Ins B

3-band EQ
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The screen here is the same as the one opened from Effect → 2-band EQ on the Part Edit
(AWM2).

The screen here is the same as the one opened from Arpeggio → Common on the Part Edit
(AWM2).

The screen here is the same as the one opened from Arpeggio → Individual on the Part Edit
(AWM2).

The screen here is basically the same as the one opened from Arpeggio → Advanced on the
Part Edit (AWM2); however, the parameter shown below has been added.

When this parameter is set to On, Arpeggio playback uses C1 for the bass drum and D1 for the
snare drum.
Most drum kits have the bass drum assigned to C1 and the snare drum assigned to D1.
However, some drum kits have the bass drum and snare drum assigned to some other keys. In
that case, the Arpeggio would use those assigned keys for playback instead.
For this reason, the Arpeggio may not be played back properly depending on the particular
combination of drum kit and Arpeggio type. When such problems occur, setting Fixed SD/BD
(Arpeggio Fixed SD/BD) to On may be able to solve the problem.
Settings: Off, On

The screen here is the same as the one opened from Motion Seq → Common on the Part Edit
(AWM2).

2-band EQ

Arpeggio

Common

Individual

Advanced

Fixed SD/BD (Arpeggio Fixed SD/BD)

Motion Seq

Common
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The screen here is the same as the one opened from Motion Seq → Lane on the Part Edit
(AWM2).

The screen here is basically the same as the one opened from Mod/Control → Control Assign
on the Part Edit (AWM2), except that the available Destination settings are different.
For the list of Destination settings, refer to the Control List on Data List.

The screen here is the same as the one opened from Mod/Control → Tx/Rx Switch on the Part
Edit (AWM2).

The screen here is the same as the one opened from Mod/Control → Control Settings on the
Part Edit (AWM2).

Lane

Mod/Control

Control Assign

Tx/Rx Switch

Control Settings
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On the Osc/Tune screen, you can set the Oscillator for each key within the Drum Part.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Key selection → Osc/Tune

Sets the selected Drum Key to use.
Settings: Off, On

Key Edit

Osc/Tune

Filter

Level/Pan

Element EQ

Osc/Tune

Drum Key Switch

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
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Shows the name of the Waveform selected for the Drum Key.
Bank indicates the type of Waveform (Preset, User, and Library) assigned to the Element.
Settings: Refer to the Data List.

Sets how sound is produced when the internal tone generator receives Note On messages of
the same sound twice (or more) in a row.
Settings: Single, Multi

Single: Stops the first note and then plays the same note again.
Multi: Plays the second note over the first note. This setting makes rolls sound
natural, especially crash cymbals or other percussion instruments having a long
decay.

Sets the Key to be output to Insertion Effect A (InsA) or Insertion Effect B (Ins B), or bypasses
the Insertion Effect (Thru).
This parameter is basically the same as Connect (Drum Key Connection Switch) on Effect →
Routing on the Drum Part Edit (AWM2).
Settings: Thru, InsA, InsB

Loads an audio file saved to USB flash drive as a Waveform.
Edit Waveform appears when a Waveform is loaded.

Opens the Waveform Edit screen.

Shifts the pitch of the waveform assigned to the Drum Key.
Settings: −48–+48

Finely adjusts the pitch of the wave assigned to the Drum Key.
Settings: −64–+63

Sets how the pitch responds to Velocity or the strength of the keystroke.

Sub Category (Waveform Sub Category)
Name (Waveform Name)

Assign Mode (Key Assign Mode)

Connect (Drum Key Connection)

New Waveform

Edit Waveform

Coarse (Coarse Tune)

Fine (Fine Tune)

Pitch/Vel (Pitch Velocity Sensitivity)
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Settings: −64–+63
Positive value: The faster the Velocity, the higher the pitch becomes.
Negative value: The faster the Velocity, the lower the pitch becomes.
0: Remains unchanged

Sets the drum key to receive MIDI note-off messages.
Settings: Off, On

On: The sound stops when release the key. Use this setting for percussion instrument
sounds to make them last without decay.
Off: The sound decays after you release the key.

This setting helps you to prevent improper or unnatural combinations of drum keys to be played
together.
For example, you can assign open and closed hi-hats to the same Group so that you can avoid
them being played together.
For drum keys that can be played naturally with any combination, set this parameter to Off.
Settings: Off, 1–127

Sets the level of the drum key signals sent through Insertion Effect A or Insertion Effect B to the
Reverb or Variation Effect.
This parameter can be set to each drum key.
This parameter is not available depending on the Connect (Drum Key Connection), Part Output,
and Drum Key Output settings.
Settings: 0–127

Sets the output destination for the Drum Key.
This parameter is not available depending on the Connect (Drum Key Connection) and Part
Output settings.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and OUTPUT
[R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
ASSIGNABLE OUTPUT [R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.

Rcv Note Off (Receive Note Off)

Group (Alternate Group)

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)

Drum Key Out (Drum Key Output Select)
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AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.

Sets the Keyboard select setting on or off.
When this parameter is set to On, you can select the desired drum key for editing by pressing a
key on the keyboard.
Settings: Off, On

Sets the filter for the Drum Part.
You can change the tone quality by using a low pass filter and high pass filter on each drum key.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Key selection → Filter

Sets the cutoff frequency for the low pass filter.
Settings: 0–1023

Sets the velocity sensitivity to the cutoff frequency of the low pass filter.
For positive values of this parameter, the stronger (higher velocity) you play the key, the higher
the cutoff frequency becomes.
For negative values of this parameter, the stronger you play the key, the lower the cutoff
frequency becomes.

Keyboard Select

Filter

Cutoff (LPF Cutoff Frequency)

Cutoff/Vel (LPF Cutoff Velocity Sensitivity)
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Settings: −64–+63

Sets the level of the resonance effect on the low pass filter.
Settings: 0–127

Sets the cutoff frequency of the high pass filter.
Settings: 0–1023

Sets the Level and Pan (position in the stereo field) for each Drum Key.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Key selection → Level/Pan

Sets the length of time it takes for the volume to change from the moment you press a key on
the keyboard until the time the volume reaches the value set at the Attack Level.
Settings: 0–127

Sets the length of time it takes for the volume to change from the Attack Level to the Decay 1
Level.
Settings: 0–127

Resonance (LPF Resonance)

HPF Cutoff (HPF Cutoff Frequency)

Level/Pan

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)
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Sets the length of time it takes for the volume to change from the Decay 1 Level to the Decay 2
Level.
Settings: 0–126, Hold

Sets the next volume value to change from the Attack Level.
Settings: 0–127

Decay2 Time = 0 – 126 Decay2 Time = Hold

Sets the output level for the Drum Key.
This parameter lets you adjust the level balance among the drum keys.
Settings: 0–127

Sets how Level (Volume) responds to Velocity or the strength of the keystroke.
Settings: −64–+63

Positive values: The faster the Velocity, the louder the volume becomes.
Negative values: The slower the Velocity, the louder the volume becomes.
0: No changes regardless of the velocity setting.

Sets the pan for the drum key.
You can adjust the position in the stereo field for the Drum Part (Drum Kit).
Settings: L63 (left)–C (center)–R63 (right)

Sets the amount by which the sound is panned alternately left and right for each key you press.
The value set in Pan is the center position for the right and left movement of the Pan.
Settings: L64–C–R63

Decay 2 Time (AEG Decay 2 Time)

Decay 1 Level (AEG Decay 1 Level)

Level (Drum Key Level)

Level/Vel (Level Velocity Sensitivity)

Pan

Alternate Pan (Alternate Pan Depth)
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Sets the amount by which the sound is panned randomly left and right for each key you press.
The value set in Pan is the center position in the stereo field.
Settings: 0–127

The screen here is the same as the one opened from Effect → Element EQ on the Part Edit
(AWM2) Element Edit.

Random Pan (Random Pan Depth)

Element EQ
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The Normal Part (FM-X) consists of eight Operators.
Part Edit (FM-X) includes Part Common Edit for setting parameters for the entire Part and
Operator Edit for setting parameters for each Operator.

Part Edit (FM-X) screen
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Contents

Part Common Edit

General / Pitch

Part Settings

Zone Settings

FM-X Settings

Pitch

PEG/Scale

Filter / Amp

Filter Type

Filter EG

Filter Scale

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

After Touch

Tx/Rx Switch

Control Settings
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On the Part Settings screen, you can set the general parameters (such as Part names and tone
generation) for the Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Part Settings

The screen here is basically the same as the one opened from General/Pitch → Part Settings
on the Part Edit (AWM2) for the most part; however, the parameters shown below are added.

Sets how the sound is panned randomly left and right for each key played.
The value set in Pan is the center position in the stereo field.
Settings: 0–127

Sets how the sound is panned alternately left and right for each key played.
The value set in Pan is the center position for the right and left movement of the Pan.
Settings: L64–C–R63

Part LFO

2nd LFO

General / Pitch

Part Settings

Random Pan (Random Pan Depth)

Alternate Pan (Alternate Pan Depth)
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Sets how the position of the key you press affects the position of the Pan setting.
The Pan for the Note Number C3 is the stereo field set in Pan.
By setting this parameter to a positive value, Pan is set to the left for lower keys, and to the right
for higher keys.
When this parameter is set to a value of 0, there will be no changes to the Pan setting. When
the parameter is set to a negative value, the pan is set to the left for lower keys, and to the right
for higher keys.
Settings: −64–+0–+63

Sets the timing of the Key On Delay to synchronize with the tempo.
Settings: Off, On

Sets the delay time from when the moment the key is pressed to when sound is produced.
This parameter is not available when KeyOnDly Sync is set to On.
Settings: 0–127

This parameter is available when KeyOnDly Sync is set to On. You can set the timing for Key
On Delay by using musical note values.
Settings: 1/16 (sixteenth notes), 1/8 Tri. (eighth-note triplets), 1/16 Dot. (dotted sixteenth

notes), 1/8 (eighth notes), 1/4 Tri. (quarter-note triplets), 1/8 Dot. (dotted eighth
notes), 1/4 (quarter notes), 1/2 Tri. (half-note triplets), 1/4 Dot. (dotted quarter notes),
1/2 (half notes), Whole Tri. (whole-note triplets), 1/2 Dot. (dotted half notes), 1/4 × 4
(quarter-note quadruplets; four quarter notes to the beat), 1/4 × 5 quarter-note
quintuplets; five quarter notes to the beat), 1/4 × 6 (quarter-note sextuplets; six
quarter notes to the beat), 1/4 × 7 (quarter-note septuplets; seven quarter notes to the
beat), 1/4 × 8 (quarter-note octuplets; eight quarter notes to the beat)

The screen here is the same as the one opened from General/Pitch → Zone Settings on the
Part Edit (AWM2).

On the FM-X Settings screen, you can set the FM Color parameters provided as a convenient
editing tool for the FM-X sounds as well as the Algorithm (or how the Operators are arranged).

Scaling Pan (Scaling Pan Depth)

KeyOnDly Sync (Key On Delay Tempo Sync)

Delay Length (Key On Delay Time Length)

Delay Length (Key On Delay Note Length)

Zone Settings

FM-X Settings
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Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → FM-X
Settings

Controls the Attack Time of the EG that changes the depth of the frequency modulation over
time.
Settings: −99–+99

Controls the Decay Time of the EG that changes the depth of the frequency modulation over
time.
Settings: −99–+99

Controls the Sustain Level of the EG that changes the depth of the frequency modulation over
time.
Settings: −99–+99

Controls the Release Time of the EG that changes the depth of the frequency modulation over
time.
Settings: −99–+99

Changes the Algorithm.
Settings: Refer to the Data List.

FM Attack

FM Decay

FM Sustain

FM Release

Algorithm (Algorithm Number)
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Feedback causes the Operator to modulate itself by sending some of the output signals back.
Here with this parameter, you can set the degree of such modulation.
Settings: 0–7

Changes the depth of the frequency modulation.
Settings: −99–+99

Changes the frequency of the harmonic overtones of FM synthesis.
Settings: −99–+99

Changes the texture of FM synthesis.
Settings: −99–+99

Opens the Algorithm Search screen.

Sets the range of the cutoff frequency change by the FEG.
Settings: −64–+63

Changes the sound by setting the cutoff frequency of the filter. When the Low Pass Filter is
selected, larger values here result in a brighter sound, and smaller values result in a darker
sound.
This parameter is specified as an offset value to the filter cutoff frequency.
Settings: −64–+63

Adds special characteristics to the sound by adjusting the signal level near the cutoff frequency.
This is specified as an offset value to the filter resonance.
Settings: −64–+63

Opens the setting screen for Filter Type.

Feedback (Feedback Level)

FM Depth

FM Harmonics

FM Texture

Algorithm Search

Filter Offset FEG Depth

Filter Offset Cutoff (Filter Cutoff Frequency)

Filter Offset Resonance (Filter Offset Resonance/Width)

Filter Type
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Opens the Filter EG screen.

The screen here is basically the same as the one opened from General/Pitch → Pitch on the
Part Edit (AWM2), except that Legato Slope (Portamento Legato Slope) is invalid.

On the PEG/Scale screen, you can set the pitch envelope generator and scale for the Part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → PEG/Scale

Sets the length of time it takes for the pitch to change from the moment you press a key on the
keyboard until the time the pitch reaches the value set at Attack Level.
Settings: 0–99

Sets the length of time it takes for the pitch to change from the Attack Level to the Decay 1
Level.
Settings: 0–99

Filter EG

Pitch

PEG/Scale

Attack Time (PEG Attack Time)

Decay1 Time (PEG Decay 1 Time)

Decay2 Time (PEG Decay 2 Time)

375



Sets the length of time it takes for the pitch to change from the Decay 1 Level to the Decay 2
Level.
Settings: 0–99

Sets the length of time it takes for the pitch to change from the moment you have released the
key until it reaches the Release Level.
Settings: 0–99

Sets the pitch for the moment you press the key.
Settings: −50–+50

Sets the pitch to change from Initial Level after you have pressed a key.
Settings: −50–+50

Sets the next pitch value to change from the Attack Level.
Settings: −50–+50

Sets the next pitch value to change from the Decay 1 Level.
Settings: −50–+50

Sets the final pitch to reach after you have released the key.
Settings: −50–+50

Sets the amount of pitch change controlled by the PEG.
Settings: 8 oct, 2 oct, 1 oct, 0.5 oct

For example, when this parameter is set to 8 oct, you can specify the smallest value
to the Pitch EG level to create a pitch change of −4 octaves by sending the pitch
value 0 to the internal tone generator, and by specifying the largest value to create a
pitch change of +4 octaves.

Sets how the time of the pitch change in PEG responds to Velocity or the strength of the
keystroke.

Release Time (PEG Release Time)

Initial Level (PEG Initial Level)

Attack Level (PEG Attack Level)

Decay1 Level (PEG Decay 1 Level)

Decay2 Level (PEG Decay 2 Level)

Release Level (PEG Release Level)

PEG Depth

Depth/Vel (PEG Depth Velocity Sensitivity)
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Settings: 0–7

Sets how the speed of the pitch change in PEG responds to key position.
The speed change in PEG is used for the specified key in Center Key (fixed to C3).
Settings: 0–7

Positive values: The lower the key played, the slower the change in the PEG; the
higher the key played, the faster the change in the PEG.
0: No PEG changes regardless of the key position.

Changes the pitch of the Element randomly each time the key is pressed.
Settings: 0–127

Sets how the pitch responds to Velocity or the strength of the keystroke.
Settings: −64–+63

Positive value: The faster the Velocity, the higher the pitch becomes.
Negative value: The faster the Velocity, the lower the pitch becomes.
0: No pitch change

The screen here is the same as the one opened from Filter → Type on the Part Edit (AWM2)
Element Edit.

The screen here is the same as the one opened from Filter → Filter EG on the Part Edit
(AWM2) Element Edit.

The screen here is the same as the one opened from Filter → Scale on the Part Edit (AWM2)
Element Edit.

Time/Key (PEG Time Key Follow Sensitivity)

Random Pitch (Random Pitch Depth)

Pitch/Vel (Pitch Velocity Sensitivity)

Filter / Amp

Filter Type

Filter EG

Filter Scale
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The screen here is the same as the one opened from Filter/Amp → Amp EG on the Part Edit
(AWM2).

The screen here is basically the same as the one opened from Effect → Routing on the Part
Edit (AWM2); however, there are a few differences as shown below.

The screen here is the same as the one opened from Effect → InsA or InsB on the Part Edit
(AWM2).

The screen here is the same as the one opened from Effect → 3-band EQ on the Part Edit
(AWM2).

The screen here is the same as the one opened from Effect → 2-band EQ on the Part Edit
(AWM2).

The screen here is the same as the one opened from Arpeggio → Common on the Part Edit
(AWM2).

Amp EG

Effect

Routing

No output setting for each Element

Cannot select Parallel for Ins Connect

Ins A
Ins B

3-band EQ

2-band EQ

Arpeggio

Common
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The screen here is the same as the one opened from Arpeggio → Individual on the Part Edit
(AWM2).

The screen here is the same as the one opened from Arpeggio → Advanced on the Part Edit
(AWM2).

The screen here is the same as the one opened from Motion Seq → Common on the Part Edit
(AWM2).

The screen here is the same as the one opened from Motion Seq → Lane on the Part Edit
(AWM2).

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Control Assign

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign
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The screen here is basically the same as the one opened from Mod/Control → Control Assign
on the Part Edit (AWM2), except that the available Destination settings are different.
For a list of settings, refer to the Data List.
Also, the parameters shown below are the ones available, instead of ElementSw.

You can set the controller setting for each Operator on or off. This parameter is shown only
when the selected Destination is related to Operators.
Settings: Off, On

Sets the sensitivity of the controller selected for the Destination.
This parameter is shown only when the Destination is set to OP Freq or OP AEG Offset.
Settings: −7–+7

Switches between the Operator Sw and Operator Rate.
This parameter is shown only when the Destination is set to OP Freq or OP AEG Offset.
Settings: Off, On

The screen here is basically the same as the one opened from Mod/Control → After Touch on
the Part Edit (AWM2), except that the available Destination settings are different.

Operator Sw (Operator Switch)

Operator Rate

Sw/Rate

After Touch
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The screen here is the same as the one opened from Mod/Control → Tx/Rx Switch on the Part
Edit (AWM2).

The screen here is the same as the one opened from Mod/Control → Control Settings on the
Part Edit (AWM2).

On the Part LFO screen, you can set the Part LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → Part LFO

Selects the LFO Wave and sets the type of cyclical changes for the LFOs.
Settings: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4,

Trapezoid, S/H1, S/H2, User

Opens the setting screen for the User LFO.
You can create an LFO waveform of up to 16 steps.

Tx/Rx Switch

Control Settings

Part LFO

LFO Wave

Edit User LFO
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Sets the speed of the LFO Wave changes to synchronize to Arpeggio or Song playback.
Settings: Off (not synchronized), On (synchronized)

Sets the speed of LFO Wave changes.
This parameter is not available when Tempo Sync is set to On.
Settings: 0–63

Changes the LFO Speed randomly.
This parameter is not available when Tempo Sync is set to On.
Settings: 0–127

This parameter is available when Tempo Sync is set to On. You can set the speed of changes
in LFO Wave by using musical note values.
Settings: 1/16 (sixteenth notes), 1/8 Tri. (eighth-note triplets), 1/16 Dot. (dotted sixteenth

notes), 1/8 (eighth notes), 1/4 Tri. (quarter-note triplets), 1/8 Dot. (dotted eighth
notes), 1/4 (quarter notes), 1/2 Tri. (half-note triplets), 1/4 Dot. (dotted quarter
notes), 1/2 (half notes), Whole Tri. (whole-note triplets), 1/2 Dot. (dotted half notes),
1/4 × 4 (quarter-note quadruplets; four quarter notes to the beat), 1/4 × 5 quarter-
note quintuplets; five quarter notes to the beat), 1/4 × 6 (quarter-note sextuplets;
six quarter notes to the beat), 1/4 × 7 (quarter-note septuplets; seven quarter notes
to the beat), 1/4 × 8 (quarter-note octuplets; eight quarter notes to the beat), 1/4 ×
16 (sixteen quarter-notes to the beat), 1/4 × 32 (thirty-two quarter-notes to the
beat), 1/4 × 64 (sixty-four quarter-notes to the beat)

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
The larger the value, the longer the delay time before the LFO comes into effect.
Settings: 0–127

Sets the amount of time for the LFO effect to fade in after the delay time set in Delay (LFO
Delay Time) has elapsed.

Tempo Sync (LFO Tempo Sync)

When Tempo Sync is set to Off

Speed (LFO Speed)

Random Speed (Part LFO Random Speed Depth)

When Tempo Sync is set to On

Tempo Speed (LFO Tempo Speed)

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)
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Settings: 0–127
The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: LFO changes to the maximum value without any fade-in.

Low value: Fast fade-in

High value: Slow fade-in

Sets the time for maintaining the LFO effect after the maximum level has been reached.
Settings: 0–126, Hold

Hold: Does not fade out

Hold (LFO Hold Time)
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Sets the amount of time for the LFO effect to fade out after the hold time set in Hold (LFO Hold
Time) has elapsed.
The larger the value, the longer it takes for the LFO effect to fade out.
Settings: 0–127

Low value: Fast fade-out

High value: Slow fade-out

Resets the oscillation of the LFO when a key is pressed.
Settings: Off, Each-on, 1st-on

Fade Out (LFO Fade Out time)

Key On Reset (LFO Key On Reset)
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Does not reset the oscillation of the LFO.
Pressing a key starts the LFO wave at
whatever phase the LFO happens to be
at that moment.

Resets the oscillation of LFO every time a
key is pressed and starts the waveform at
the phase specified by the Phase
parameter.

Resets the oscillation of LFO every time a
key is pressed and starts the waveform at
the phase specified by the Phase
parameter.

When the second note is played while the
first note is held, playback will not be
reset.

Sets the LFO Wave to loop (repeat) playback or one-shot playback.
Settings: Off, On

Sets the initial phase for when LFO Wave is reset.
Settings: 0°, 90°, 120°, 180°, 240°, 270°

Off

Each-on

1st-on

Loop (LFO Loop Switch)

Phase (LFO Phase)
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Sets the function to be controlled by the LFO Wave.
Settings: Insertion Effect A Parameter1–24, Insertion Effect B Parameter1–24 (depending on

the Insertion Effect)

Sets the depth of LFO Wave control for each Destination.
Settings: 0–127

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Mod/Control → 2nd LFO

Destination (LFO Destination)

Depth (LFO Depth)

2nd LFO

LFO Wave (2nd LFO Wave)
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Selects the 2nd LFO Wave.
Settings: Triangle, Saw Down, Saw Up, Square, Sine, S/H

NOTE
The amplitude modulation phrase is shifted with Sine.

Switches between the old set of settings (Off: 0–99) and a new set of settings with higher
resolution (On: 0–415) for Speed (2nd LFO Speed).
To maintain compatibility of data created with the old settings, set this parameter to Off.
Settings: Off, On

Sets the speed of LFO Wave (2nd LFO Wave) changes.
Settings: 0–99 (When Extended is set to Off), 0–415 (When Extended is set to On)

Sets the initial phase for when LFO Wave (2nd LFO Wave) is reset.
Settings: 0°, 90°, 180°, 270°

Sets the time length for the 2nd LFO effect to fade in after you have released the key and the
delay time set in Delay has elapsed.
Settings: 0–99

Resets the oscillation of the 2nd LFO when a key is pressed.
Settings: Off, On

This parameter creates a vibrato effect (cyclical changes to the pitch) by using the LFO Wave
(2nd LFO Wave), and lets you specify the depth of pitch modulation by the LFO.
Settings: 0–99

Sets the depth of the modulation by LFO signals set in Pitch Modulation Depth (2nd LFO Pitch
Modulation Depth).
Settings: 0–7

Extended LFO (2nd LFO Extended LFO)

Speed (2nd LFO Speed)

Phase (2nd LFO Phase)

Delay (2nd LFO Delay Time)

Key On Reset (2nd LFO Key On Reset)

Pitch Modulation Depth (2nd LFO Pitch Modulation Depth)

Pitch Modulation Operator Depth Ratio (2nd LFO Pitch Modulation Depth Offset)

Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth)

387



This parameter creates cyclical changes in the volume by using the LFO Wave (2nd LFO
Wave), and lets you specify the depth of volume modulation by the LFO.
Settings: 0–99

Sets the depth of the modulation by LFO signals set in Amplitude Modulation Depth (2nd LFO
Amplitude Modulation Depth).
Settings: 0–7

This parameter creates cyclical changes to the filter cutoff frequency by using the LFO Wave
(2nd LFO Wave), and lets you specify the depth of filter modulation by the LFO.
Settings: 0–99

Amplitude Modulation Operator Depth Ratio (2nd LFO Amplitude Modulation Depth
Offset)

Filter Modulation Depth (2nd LFO Filter Modulation Depth)
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On the Form/Freq screen, you can set the waveform and frequency of the Operator.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Operator selection → Form/Freq

Sets the length of time it takes for the pitch to reach the value set at the Attack Level.
Settings: 0–99

Sets the length of time it takes for the pitch to change from the value set at the Attack Level to
the moment the PEG changes to the value 0.
Settings: 0–99

Operator Edit

Form/Freq

Level

Algorithm Search

Form/Freq

Attack Time (PEG Attack Time)

Decay Time (PEG Decay Time)
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Sets the pitch for the moment you press the key.
Settings: −50–+50

Sets the change in pitch from the Hold Level or the moment you press a key.
Settings: −50–+50

(1) Pitch (frequency) set to Coarse Tune and Fine Tune

Sets the waveform for the selected Operator.
Settings: Sine, All 1, All 2, Odd 1, Odd 2, Res 1, Res 2

Sine: Sine wave with no harmonic overtones
All 1: Wave with harmonic overtones in a wide Spectral range
All 2: Wave with harmonic overtones in a narrow Spectral range
Odd 1: Wave containing odd harmonics in a wide Spectral range
Odd 2: Wave containing odd harmonics in a narrow Spectral range
Res 1: Wave having a peak on a particular harmonic in a wide Spectral range
Res 2: Wave having a peak on a particular harmonic in a narrow Spectral range

Sets the width of the transition band (skirt).
The smaller the value, the narrower the skirt becomes to boost a particular harmonic.
This parameter is not available when Spectral is set to Sine.
Settings: 0–7

Initial Level (PEG Initial Level)

Attack Level (PEG Attack Level)

Spectral (Spectral Form)

Skirt (Spectral Skirt)
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Sets the sensitivity of the resonance effect in Spectral.
The center frequency will be shifted to higher-order harmonics, so you can create the
resonance effect or add special characteristics to the sound.
This parameter is available only when Spectral is set to Res 1 or Res 2.
Settings: 0–99

Sine is a simple waveform containing only the fundamental wave with no harmonics, while other
waveforms contain harmonic overtones. Therefore, when you have set Form to a wave other
than Sine, the parameters related to the harmonics and its “peak” values (formants) will be
available. Below are some specific parameters for controlling each wave explained in Spectral.

You can increase the number of harmonic overtones by setting a larger Skirt value to expand
the spectrum range.

Resonance (Spectral Resonance)
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Setting a larger Resonance value will shift the center frequency to higher-order harmonics.
Resonance is set to 0: Shifts to the first harmonic.
Resonance is set to 99: Shifts to the 100th harmonic.

Resets the oscillation of the Oscillator when a key is pressed.
Settings: Off, On

Off: Does not reset the oscillation of the Oscillator. Pressing a key starts the LFO
wave at whatever phase the LFO happens to be at that moment.

Sets how the pitch responds to Velocity or the strength of the keystroke.
This parameter is available only when Freq Mode is set to Fixed.
Settings: −7–+7

Positive value: The faster the Velocity, the higher the pitch becomes.
Negative value: The faster the Velocity, the lower the pitch becomes.
0: kept unchanged

Sets the output pitch of the Operator.
Settings: Ratio, Fixed

Ratio: Sets the output pitch according to the key.
Fixed: Sets the pitch to the Coarse or Fine setting, regardless of the pitch of the key
being pressed.

Adjusts the output pitch of each Operator.

Key On Reset (Oscillator Key On Reset)

Pitch/Vel (Pitch Velocity Sensitivity)

Freq Mode (Oscillator Frequency Mode)

Coarse (Coarse Tune)
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Settings: When Freq Mode is set to Ratio: 0–31
When Freq Mode is set to Fixed: 0–21

Finely adjusts the output pitch of each Operator.
Settings: When Freq Mode is set to Ratio: 0–99

When Freq Mode is set to Fixed: 0–127

Sets the output pitch of each Operator slightly higher or lower.
When the same value is set to Coarse and Fine, the Operator with the Detune setting will have
slight pitch differences. As a result, you can create a warmer sound or chorusing effect.
Settings: −15–+15

Sets the difference in pitch between two adjacent keys.
This parameter is available only when Freq Mode is set to Fixed.
Settings: 0–99

0: No pitch difference between the two adjacent keys and all keys are played at the
pitch set in Coarse or Fine.
99: Pitch difference between two adjacent keys is set to a semitone.

On the Level screen, you can set the general parameters for the Operator.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Operator selection → Level

Fine (Fine Tune)

Detune

Pitch/Key (Pitch Key Follow Sensitivity)

Level
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Sets the length of time it takes for the value to change from the moment you have pressed a
key on the keyboard until the value reaches the Hold Level.
Settings: 0–99

Sets the length of time it takes for the value to change from the moment you press a key on the
keyboard until the time the value reaches the Attack Level.
Settings: 0–99

Sets the length of time it takes for the value to change from Attack Level to Decay 1 Level.
Settings: 0–99

Sets the length of time it takes for the value to change from Decay 1 Level to Decay 2 Level.
Settings: 0–99

Sets the length of time it takes for the value to change from the moment you have pressed a
key on the keyboard until when the value reaches the Hold (Release) Level.
Settings: 0–99

Sets the value to be changed to after pressing a key.
Settings: 0–99

Hold Time (AEG Hold Time)

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)

Decay 2 Time (AEG Decay 2 Time)

Release Time (AEG Release Time)

AEG Attack Level
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Sets the next value to change from the Attack Level.
Settings: 0–99

Sets the value that is maintained while the key is held down.
Settings: 0–99

Sets the final value to reach after you have released the key.
Settings: 0–99

Sets the output level for the Operator.
Settings: 0–99

Sets how the Level responds to Velocity or the strength of the keystroke.
Settings: −7–+7

Positive values: The faster the Velocity, the louder the volume becomes.
Negative values: The slower the Velocity, the louder the volume becomes.
0: No change regardless of the velocity setting.

Sets how the speed of the level change in AEG responds to key position.

AEG Decay 1 Level

AEG Decay 2 Level

Rel (Hold) Level (AEG Release (Hold) Level)

Level (Operator Level)

Level/Vel (Level Velocity Sensitivity)

Time/Key (AEG Time Key Follow Sensitivity)
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Settings: 0–7
Positive values: The lower the key played, the slower the AEG volume changes; the
higher the key played, the faster the AEG volume changes.
0: No AEG volume change regardless of the key position.

Sets the note number for the Break Point of amplitude scaling.
Settings: A−1–C8

Sets the steepness of the change curve.
Settings: 0–99

Sets the change curve for amplitude scaling.
Settings: −Linear, −Exp, +Exp, +Linear

The keyboard is divided in two at the Break Point. Set Curve Lo for the steepness of the curve
on the left side of the Break Point, and Lvl/Key Lo for the steepness of the curve on the right
side of the Break Point.
Similarly, set Curve Hi to select the curve for the right side of the Break Point, and Lvl/Key Hi to
the steepness of the curve (as shown below.)

Break Point (Level Scaling Break Point)

Lvl/Key Lo (Level Scaling Low Depth)
Lvl/Key Hi (Level Scaling High Depth)

Curve Lo (Level Scaling Low Curve)
Curve Hi (Level Scaling High Curve)
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The key at the Break Point is the same as the output level set in the Operator Level. With the
keys on the left side of the Break Point, the output level is corrected to the curve set in Curve Lo
(Level Scaling Low Curve) and Lvl/Key Lo (Level Scaling Low Depth). With the keys on the right
side of the Break Point, the output level is corrected to the curve set in Curve Hi (Level Scaling
High Curve) and Lvl/Key Hi (Level Scaling High Depth). The output level of Exp curves changes
exponentially, while the output level of Liner curves changes linearly. In either case, the farther
away from the Break Point, the larger the changes to the output level.

Opens the Algorithm Search screen.
You can filter the search result based on the number of Operators connected in chains and the
number of carriers.

You can filter the search result based on the number of Operators connected in chains.
Settings: 1–8

You can filter the search result based on the number of carriers.
Settings: 1–8

Algorithm Search

Chain

Carrier
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The Normal Part (AN-X) consists of three Oscillators and Noise.
The Part Edit (AN-X) includes Part Common Edit for setting parameters for the entire Part and
Oscillator Edit for setting parameters for each Oscillator and Noise Edit for editing Noise.

Part Edit (AN-X) screen
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Contents

Part Common Edit

General/Pitch

Part Settings

Zone Settings

AN-X Settings

Pitch

Pitch EG

Pitch LFO

Modifier

Wave Folder

Modifier EG

Modifier LFO

Filter/Amp

Mixing

Filter Type

Filter EG

Filter LFO

Amp EG

Amp LFO

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arp/MS

Arp Common

Individual

Advanced

MS Common
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The screen here is the same as the one opened from General/Pitch → Part Settings on the Part
Edit (AWM2).

The screen here is the same as the one opened from General/Pitch → Zone Settings on the
Part Edit (AWM2).

On the AN-X Settings screen, you can set the parameters that are specific to the AN-X sound
engine.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → AN-X
Settings

Lane

Mod/Control

Control Assign

After Touch

Tx/Rx Switch

Control Settings

Part LFO

General/Pitch

Part Settings

Zone Settings

AN-X Settings
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Creates thickness by layering multiple sounds.
Settings: Off, 2, 4

Sets how the pitch of the layered sound is to be shifted.
Settings: 0–15

Sets how the layered sounds are spread in the stereo field.
Settings: 0–15

Specifies how to reset the Oscillator.
Settings: Off, Phase, Tune, Full

Off: Does not reset.
Phase: Resets the phase of OSC 1–3 at key-on.
Tune: Makes the pitch of OSC 1–3 uniform.
Full: Enables both Phase and Tune simultaneously.

Unison

Unison Detune

Unison Spread

OSC Reset
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Specifies the pitch of the Oscillator and variation of Filter Cutoff.
Oscillator pitch and variation of Filter Cutoff are affected by Ageing.
Settings: 0–127

0: No variation
64: Standard
127: Maximum variation

Adjusts the frequency response as well as OSC Pitch, Filter Cutoff, and EG Time according to
the virtual age of the instrument model.
Settings: −100 (old)–+100 (new)

Voltage Drift

Ageing

Correlation between Voltage Drift and Ageing
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(1) Variations in Cutoff or Pitch

The screen here is the same as the one opened from General/Pitch → Pitch on the Part Edit
(AWM2), except that Legato Slope (Portamento Legato Slope) is invalid.

On the Pitch EG screen, you can set the Pitch Envelope Generator.
You can use it to set how the sound changes over time, starting from the moment you press a
key on the keyboard to when the sound decays.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Pitch EG

Pitch

Pitch EG
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Sets the length of time it takes for the EG to reach the maximum.
Settings: 0–255

Sets the length of time it takes for the EG to reach the Sustain value.
Settings: 0–255

Sets the sustain level.
Settings: 0–511

Sets the length of time it takes after you have released the key until the EG reaches the value 0.
Settings: 0–255

Sets how the velocity changes the EG over time.
The larger the value, the faster the EG changes over time when the keys are played with fast
velocity.
Settings: −255–0–+255

Sets the maximum amount of pitch change for the EG (in cents).
Settings: −4800–+4800 cents

0: No pitch change
The further the depth is from the value 0, the wider the pitch change range becomes.
Negative value: Pitch change is inverted.

Attack (Pitch EG Attack Time)

Decay (Pitch EG Decay Time)

Sustain (Pitch EG Sustain Level)

Release (Pitch EG Release Time)

Time/Vel (Pitch EG Time Velocity Sensitivity)

PEG Depth - Osc 1–3 (Oscillator 1–3 Pitch EG Depth)
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Sets how the depth range of the pitch change controlled by the PEG responds to Velocity or the
strength of the keystroke.
Also, with the Curve setting, you can set how the PEG Depth responds to velocity. The vertical
axis represents velocity while the horizontal axis represents the depth range of the pitch
change.
Settings: −255–+255

Positive value: Faster velocity values widen the depth range of the PEG, while
slower values narrow the depth range.
Negative value: Faster velocity values narrow the depth range of the PEG, while
slower values widen the depth range.
0: No PEG changes regardless of the velocity setting.

Fast velocity
(the depth range in pitch change is wider)

Slow velocity
(the depth range in pitch change is narrower)

On the Pitch LFO screen, you can set the Pitch LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → General/Pitch → Pitch LFO

PEG Depth/Vel - Osc 1–3 (Oscillator 1–3 Pitch EG Depth Velocity Sensitivity)

Pitch LFO
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Selects the LFO Wave and sets the type of cyclical changes to the LFOs.
Settings: Saw, Square, Triangle, Sine, Random

Resets the phase of the LFO when a key is pressed.
Settings: Off, On

Sets the speed of LFO wave changes.
Settings: 0–415

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–214

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: The LFO changes to the maximum value without any fade-ins.

LFO Wave (Pitch LFO Wave)

Key On Reset (Pitch LFO Key On Reset)

Speed (Pitch LFO Speed)

Delay (Pitch LFO Decay Time)

Fade In (Pitch LFO Fade In Time)
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Small value: fast fade-in

Large value: slow fade-in

Sets the phase for resetting the wave when a key is pressed.
Settings: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Phase of the wave

Phase (Pitch LFO Phase)
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Sets the depth range of pitch change controlled by the LFO.
Settings: −4800–+4800 cents

0: No pitch change
The further the depth is from the value 0, the wider the pitch change range becomes.
Negative value: Pitch change is inverted.

Modifier is a function block for adding distortion to the signal output from the OSC block and for
adding harmonics to the sound.

Wave folder is an effect created by folding waveforms according to the specified value. This
effect lets you create smooth changes from delicate distortion to sonic destruction. With the AN-
X sound engine, you can use this effect on each note independently.

Various controllers including EG, LFO, Velocity, and Polyphonic Aftertouch are available for
controlling this effect in real-time.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Modifier → Wave Folder

Pitch LFO Depth - Osc 1–3 (Oscillator 1–3 Pitch LFO Depth)

Modifier

Wave Folder
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Specifies the degree of wave folding.
Settings: 0–255

Sets how the Wave Folder responds to Velocity.
Settings: −255–0–+255

Changes the texture of the Wave Folder.
Settings: 0–255

Changes the Wave Folder type.
Settings: Soft, Hard

Opens the setting screen for Modifier EG.

Opens the setting screen for Modifier LFO.

On the Modifier EG screen, you can set the Envelope Generator for the Modifier.

Operation

Wave Folder (Modifier Wave Folder)

Folder/Vel (Modifier Wave Folder Velocity Sensitivity)

Texture (Modifier Wave Folder Texture)

Folder Type (Modifier Wave Folder Type)

Modifier EG Settings

Modifier LFO Settings

Modifier EG
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[PERFORMANCE] → Part Common selection → [EDIT/ ] → Modifier → Modifier EG

Sets the length of time it takes for the EG to change from the moment you press a key on the
keyboard until it reaches the maximum.
Settings: 0–255

Sets the length of time it takes for the EG to change from the moment you press a key on the
keyboard until it reaches the value set at the Sustain level.
Settings: 0–255

Sets the sustain level.
Settings: 0–511

Sets the length of time for the EG to reach a value of 0 after you have released the key.
Settings: 0–255

Sets how the velocity changes the EG over time.
Larger the value the faster the changes of EG over time when the keys are played with fast
velocity.
Settings: −255–0–+255

Attack (Modifier EG Attack)

Decay (Modifier EG Decay)

Sustain (Modifier EG Sustain Level)

Release (Modifier EG Release Time)

Time/Vel (Modifier EG Velocity Sensitivity)

EG Depth Wave Folder (Modifier Wave Folder EG Depth)
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Sets how the Wave Folder responds to Modifier EG.
Settings: −127–+127

On the Modifier LFO screen, you can set the Modifier LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Modifier → Modifier LFO

Selects the LFO Wave and sets the type of cyclical changes to the LFOs.
Settings: Saw, Square, Triangle, Sine, Random

Resets the phase of the LFO when a key is pressed.
Settings: Off, On

Modifier LFO

Wave (Modifier LFO Wave)

Key On Reset (Modifier LFO Key On Reset)
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Sets the speed of LFO wave changes.
Settings: 0–415

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–214

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: The LFO changes to the maximum value without any fade-ins.

Small value: fast fade-in

Speed (Modifier LFO Speed)

Delay (Modifier LFO Delay Time)

Fade In Time (Modifier LFO Fade In Time)

412



Large value: slow fade-in

Sets the phase for resetting the wave when a key is pressed.
Settings: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Phase of the wave

Sets the depth range of pitch change controlled by the LFO.
Settings: −127–+127

0: No pitch change
The further the depth is from the value 0, the wider the pitch change range becomes.
Negative value: Pitch change is inverted.

Phase (Modifier LFO Phase)

LFO Depth (Modifier LFO Depth)
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On the Mixing screen, you can set the output of each Oscillator while checking the signal flow
diagram for the AN-X part.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Mixing

Sets how OSC3 modulates OSC1 and OSC2 by using frequency modulation (FM).
Settings: 0–255

Opens the OSC/Tune screen for Oscillator Edit.

Opens the Noise screen.
Useful for creating various SFX sounds by using filters such as VCF and HPF on the noise
signals.

Filter/Amp

Mixing

FM 3 → 1 (Oscillator 1 FM Level)
FM 3 → 2 (Oscillator 2 FM Level)

Osc 1 (Oscillator 1)
Osc 2 (Oscillator 2)
Osc 3 (Oscillator 3)

Noise
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Sets how the OSC3 modulates OSC1 and OSC2 by using Ring Modulation.
Settings: 0–255

1, 2, and 3 are for setting the Oscillator volume.
Noise is for adjusting the level of the signal output from the Noise Unit. You can control the level
balance with other signals such as OSC 1, OSC 2, and Ring Modulator.
Settings: 0–511

Sets the output destination for the Oscillators and Noise.
Settings: Filter, Amp

Opens the Filter/Amp → Filter Type screen for Part Edit (AN-X).

Opens the Filter/Amp → Amp EG screen for Part Edit (AN-X).

On the Filter Type screen, you can select the filter type.
The available parameters differ depending on the filter type you have selected here.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Filter Type

Ring 3 → 1 (Oscillator 1 Ring Level)
Ring 3 → 2 (Oscillator 2 Ring Level)

1 (Oscillator 1 Out Level)
2 (Oscillator 2 Out Level)
3 (Oscillator 3 Out Level)
Noise (Noise Out Level)

Connect 1 (Oscillator 1 Out Select)
Connect 2 (Oscillator 2 Out Select)
Connect 3 (Oscillator 3 Out Select)
Noise Connect (Noise Out Select)

Filter 1
Filter 2

Amplifier

Filter Type
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Sets the filter.
The filters available for the AN-X are grouped into three types: LPF, HPF, and BPF.
Settings: Thru, LPF24, LPF18, LPF12, LPF6, HPF24, HPF18, HPF12, HPF6, BPF12, BPF6

Cuts the signals above the value set in Cutoff Frequency.
The sound becomes brighter as you raise the Cutoff Frequency, since more signals are
passed by the filter.
The sound becomes darker as you lower the Cutoff Frequency, since signals are cut or
blocked by the filter.
You can produce a distinctive “peaky” sound by raising the Resonance or boosting the signal
level near the Cutoff Frequency.
This Filter Type is very popular and useful for producing classic synthesizer sounds.

LPF24: −24 dB/oct
LPF18: −18 dB/oct

Filter 1 Type
Filter 2 Type

LPF
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LPF12: −12 dB/oct
LPF6: −6 dB/oct

A Filter Type that only passes signals above the Cutoff Frequency.
You can produce a distinctive “peaky” sound by raising the Resonance or boosting the signal
level near the Cutoff Frequency.

HPF24: −24 dB/oct
HPF18: −18 dB/oct
HPF12: −12 dB/oct
HPF6: −6 dB/oct

A Filter Type that only passes signals for a specific frequency band (Cutoff Frequency) and
cuts all other signals.

BPF12: −12 dB/oct
BPF6: −6 dB/oct

Sets the cutoff frequency. The frequency set here is used by the filter set in Type.

HPF

BPF

Cutoff (Filter Cutoff)
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Settings: 0–1023

Sets the size of the Resonance.
Settings: 0–255

Sets how Cutoff Frequency responds to Velocity or the strength of the keystroke.
Settings: −255–+255

Positive value: The faster the Velocity, the higher the Cutoff Frequency value.
Negative value: The slower the Velocity, the higher the Cutoff Frequency value.
0: Cutoff Frequency does not respond to Velocity.

Sets how the resonance level responds to Velocity or the strength of the keystroke.
This parameter may not be available depending on the Filter Type.
Settings: −255–+255

Positive value: The higher the Velocity, the greater the Resonance becomes.
Negative value: The lower the Velocity, the greater the Resonance becomes.
0: Resonance value does not change in response to Velocity.

Sets how the cutoff frequency level of the filter responds to the key position. When the value is
set to 1oct, both the pitch and the cutoff frequency change at the same rate.
Settings: Off, 1/3oct, 1/2oct, 2/3oct, 1oct, 2oct

Sets the amount of distortion controlled by the Saturator section of the filter.
Settings: 0.0–60.0 (dB) (in units of 0.75 dB)

Sets how the Drive responds to Velocity.
Settings: −255–0–+255

Sets the output level for the Filter.
Settings: −12.0–+12.0 (dB) (in units of 0.375 dB)

Resonance (Filter Resonance)

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)

Res/Vel (Filter Resonance Velocity Sensitivity)

Cutoff/Key (Filter Cutoff Key Follow)

Filter 1 Drive (Filter 1 Saturator Drive)
Filter 2 Drive (Filter 2 Saturator Drive)

Filter 1 Drive/Vel (Filter 1 Saturator Drive Velocity Sensitivity)
Filter 2 Drive/Vel (Filter 2 Saturator Drive Velocity Sensitivity)

F1 Out Level (Filter 1 Out Level)
F2 Out Level (Filter 2 Out Level)
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On the Filter EG screen, you can set the Filter Envelope Generator.
You can set how the Filter Cutoff changes over time, starting from the moment you press a key
on the keyboard to when the sound decays.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Filter EG

Sets the length of time it takes for the EG to reach the maximum.
Settings: 0–255

Sets the length of time it takes for the EG to change from the maximum to the Sustain level.
Settings: 0–255

Sets the sustain level.
Settings: 0–511

Sets the length of time it takes for the EG to reach a value of 0 after you have released the key.
Settings: 0–255

Sets how the Cutoff Frequency responds to Velocity or the strength of the keystroke.

Filter EG

Attack (Filter Cutoff EG Attack Time)

Decay (Filter Cutoff EG Decay Time)

Sustain (Filter Cutoff EG Sustain Level)

Release (Filter Cutoff EG Release Time)

Time/Vel (Filter Cutoff EG Time Velocity Sensitivity)
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Settings: −255–0–+255
Positive values: The faster the velocity the faster the FEG changes
Negative value: Fast velocity values result in slower FEG changes, while slow
velocity values result in faster FEG changes.
0: No changes regardless of the Velocity setting.

Sets the depth range for the cutoff frequency change controlled by the FEG.
Settings: −9600–+9600 cents (in units of 50 cents)

0: No changes to the cutoff frequency by the Filter EG.
The depth range of the cutoff frequency change becomes wider the further the setting
is from a value of 0.
Negative values: Cutoff frequency changes are reversed.

Sets how the depth range of the cutoff frequency change controlled by the FEG responds to
Velocity or the strength of the keystroke.
Settings: −255–0–+255

Positive values: Faster velocity values widen the depth range of the Filter EG, while
slower values narrow the depth range.
Negative values: Faster velocity values narrow the depth range of the Filter EG,
while slower values widen the depth range.
0: Cutoff frequency does not respond to the Velocity.

On the Filter LFO screen, you can set the Filter LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Filter LFO

FEG Depth - Filter 1–2 (Filter 1–2 Cutoff EG Depth)

FEG Depth/Vel - Filter 1–2 (Filter 1–2 Cutoff EG Depth Velocity Sensitivity)

Filter LFO
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Selects an LFO wave. By using the wave you have selected here, you can create various types
of modulation.
Settings: Saw, Square, Triangle, Sine, Random

Resets the oscillation of the LFO when a key is pressed.
Settings: Off, On

Sets the speed of LFO wave changes.
Settings: 0–415

LFO Wave (Filter Common Cutoff LFO Wave)

Key On Reset (Filter Common Cutoff LFO Key On Reset)

Speed (Filter Common Cutoff LFO Speed)

Delay (Filter Common Cutoff LFO Delay Time)
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Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
The larger the value, the longer the delay for the LFO to come into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–214

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: The LFO changes to the maximum value without any fade-ins.

Small value: fast fade-in

Large value: slow fade-in

You can set the initial phase for the time the LFO Wave is reset.
Settings: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Fade In (Filter Common Cutoff LFO Fade In Time)

Phase (Filter Common Cutoff LFO Phase)
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Phase of the wave

Sets the depth of the LFO Wave control for Filter 1 and Filter 2.
Settings: −9600–+9600 (cents) (in units of 50 cents)

On the Amp EG screen, you can set the AEG (Amplitude Envelope Generator).
By setting the Amp EG, you can set how the volume changes from the moment you press a key
on the keyboard to when the sound decays.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Amp EG

Depth (Filter Cutoff LFO Depth)

Amp EG

Attack (Amplitude EG Attack Time)
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Sets the length of time it takes from the moment you press a key on the keyboard to when the
Amplitude Level is reached.
Settings: 0–255

Sets the length of time it takes for the volume to change from the Amplitude Level to the Sustain
Level.
Settings: 0–255

Sets the volume that is maintained while the key is held down.
Settings: 0–511

Sets the length of time it takes after you have release the key to when the sound decays.
Settings: 0–255

Sets the length of time it takes for volume changes in AEG to respond to Velocity or the strength
of the keystroke.
Settings: −255–+255

Positive value: The faster the velocity, the faster the AEG volume changes.
Negative value: Fast velocity values result in slower AEG volume changes, while
slow velocity values result in faster AEG volume changes.
0: No changes regardless of the velocity setting.

Fast velocity (fast volume change) Slow velocity (slow volume change)

Sets the volume level of Amplitude.
Settings: 0–511

Sets how the Amplitude level responds to Velocity.
Settings: −255–0–+255

Decay (Amplitude EG Decay Time)

Sustain (Amplitude EG Sustain Level)

Release (Amplitude EG Release Time)

Time/Vel (Amplitude EG Time Velocity Sensitivity)

Level (Amplitude Level)

Level/Vel (Amplitude Level Velocity Sensitivity)
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Sets how the Amp Level responds to pitch.
When Amplitude Level Key is set to 127, the Amp Level goes down 6 dB as the pitch goes up
one octave.
Settings: 0–127

Sets the amount of distortion controlled by the Saturator of the Amplitude section.
Settings: 0.0–60.0 (dB) (in units of 0.75 dB)

On the Amp LFO screen, you can set the Amplitude LFO.

Operation

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Filter / Amp → Amp LFO

Selects an LFO wave. By using the wave you have selected here, you can create various types
of modulation.
Settings: Saw, Square, Triangle, Sine, Random

Level/Key (Amplitude Level Key Follow)

Drive (Amplitude Saturator Drive)

Amp LFO

LFO Wave (Amplitude LFO Wave)
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Resets the oscillation of the LFO when a key is pressed.
Settings: Off, On

Sets the speed of LFO wave changes.
Settings: 0–415

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
The larger the value, the longer the delay time for the LFO to come into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–214

The larger the value, the longer it takes for the LFO effect to reach the maximum.
0: The LFO changes to the maximum value without any fade-ins.

Key On Reset (Amplitude LFO Key On Reset)

Speed (Amplitude LFO Speed)

Delay (Amplitude LFO Delay Time)

Fade In (Amplitude LFO Fade In Time)
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Small value: fast fade-in

Large value: slow fade-in

You can set the initial phase for the time the LFO wave is reset.
Settings: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Phase of the wave

Phase (Amplitude LFO Phase)
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Sets the depth range of volume changes controlled by the LFO.
Settings: −127–+127

The screen here is almost the same as the one opened from Effect → Routing on Part Edit
(AWM2), with the exceptions listed below.

The screen here is the same as the one opened from Effect → InsA or InsB on Part Edit
(AWM2).

The screen here is the same as the one opened from Effect → 3-band EQ on Part Edit (AWM2).

The screen here is the same as the one opened from Effect → 2-band EQ on Part Edit (AWM2).

The screen here is the same as the one opened from Arpeggio → Common on Part Edit
(AWM2).

The screen here is the same as the one opened from Arpeggio → Individual on Part Edit
(AWM2).

Depth (Amplitude Level LFO Depth)

Effect

Routing

No output setting for each Element

Cannot select Parallel for Ins Connect

Ins A
Ins B

3-band EQ

2-band EQ

Arp/MS

Arp Common

Individual
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The screen here is the same as the one opened from Arpeggio → Advanced on Part Edit
(AWM2).

The screen here is the same as the one opened from Motion Seq → Common on Part Edit
(AWM2).

The screen here is the same as the one opened from Motion Seq → Lane on Part Edit (AWM2).

The screen here is the same as the one opened from Mod/Control → Control Assign on Part
Edit (AWM2), except that the available Destination settings are different.

Use the parameters shown below, instead of ElementSw and others.

You can set the controller setting for each Oscillator on or off. This parameter is shown only
when the selected Destination is related to Oscillators.
Usually, there are three switches shown, but when the Destination is set to OSC FM or OSC
Ring, only two of them will be shown.
Settings: Off, On

You can set the controller setting for each Filter on or off.
This parameter is shown only when the selected Destination is related to filters.
Settings: Off, On

Advanced

MS Common

Lane

Mod/Control

Control Assign

Oscillator Sw (Oscillator Switch)

Filter Sw

429



The screen here is the same as the one opened from Mod/Control → After Touch on Part Edit
(AWM2), except that the available Destination settings are different.

The screen here is the same as the one opened from Mod/Control → Tx/Rx Switch on Part Edit
(AWM2).

The screen here is the same as the one opened from Mod/Control → Control Settings on Part
Edit (AWM2).

The screen here is the same as the one opened from Mod/Control → Part LFO on Part Edit
(AWM2), except that the only available Destination setting is Ins.

After Touch

Tx/Rx Switch

Control Settings

Part LFO
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Contents

On the Osc/Tune screen, you can set the general parameters for the Oscillator.
The modulation and wave shaping functions available on this screen are FM (Frequency
Modulation), Ring Modulation, Oscillator Sync, Pulse Width, and Wave Shaper.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Oscillator selection → Osc/Tune

Sets the waveform for the Oscillator.
Settings: Saw1, Saw2 (variation of Saw1 with thicker sound), Square, Triangle, Sine

Oscillator Edit

Osc/Tune

Osc EG

Osc LFO

Osc/Tune

Wave (Oscillator Wave)
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Sets the volume of the Oscillators.
Settings: 0–511

Sets how the Oscillator volume responds to Velocity.
Settings: −255–+0–+255

Performs negative/positive inversion of the Oscillator output.
Settings: Off, On

Sets the output destination for the Oscillators.
Settings: Filter, Amp

Sets the pitch of the Oscillator in octaves.
Settings: 64’, 32’, 16’, 8’, 4’, 2’, 1’

Finely adjusts the pitch of the Oscillator.
Settings: −1200–+0–+1200 (cent)

Modulates the frequency of the Oscillator by using another Oscillator.

Sets the level of the Frequency Modulation.
Settings: 0–255

Sets how Frequency Modulation responds to Velocity.

Out Level (Oscillator Out Level)

Out Level/Vel (Oscillator Out Level Velocity Sensitivity)

Invert (Oscillator Out Invert Enable)

Connect (Oscillator Out Select)

Octave (Oscillator Octave)

Pitch (Oscillator Pitch)

FM (Frequency Modulation)

FM Level (Oscillator FM Level)

FM Level/Vel (Oscillator FM Level Velocity Sensitivity)
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Settings: −255–+0–+255

By mixing two Oscillator signals, you can create a metallic inharmonic sound.

Sets the level of Ring Modulation.
Settings: 0–255

Sets how Ring Modulation responds to Velocity.
Settings: −255–+0–+255

Oscillator Sync is a system that creates complex waves by forcing two Oscillators to
synchronize.
The AN-X sound engine allows each Oscillator to set its synchronization timing, so you can use
a single Oscillator for creating complex waveforms.

Sets the level of the Oscillator Sync.
Settings: 0–4800 (cents) (in units of 25 cents)

Sets how Sync Pitch responds to Velocity.
Settings: −255–+0–+255

Pulse Width is the ratio of the negative and positive parts of the Square wave.

When Pulse Width is set to a
small value

When Pulse Width is set to
50%

When Pulse Width is set to a
large value

The AN-X sound engine lets you use Pulse Width not just on Square waves but also other
waves.

Ring Modulation

Ring Level (Oscillator Ring Level)

Ring Level/Vel (Oscillator Ring Level Velocity Sensitivity)

Oscillator Sync

Sync Pitch (Oscillator Self Sync Pitch)

Sync Pitch/Vel (Oscillator Self Sync Pitch Velocity Sensitivity)

Pulse Width
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Modulation of the LFO by using Pulse Width is called Pulse Width Modulation (PWM), which
allows you to create a characteristic swirling sound.

With the AN-X sound engine, you can use PWM by using Osc EG and Osc LFO, and you can
specify the level of PWM on the Osc EG screen and Osc LFO screen.

Sets the Pulse Width of the wave.
Settings: 1.0%–50.0%–99.0%

Sets how Pulse Width responds to Velocity.
Settings: −255–+0–+255

Creates a characteristic distortion and changes to the harmonic content by changing the shape
of the waveform.

Sets the level of the Wave Shaper.
By using Wave Shaper, the wave changes dynamically.
Settings: 0–255

Sets how the Wave Shaper responds to Velocity.
Settings: −255–+0–+255

Opens the General/Pitch → Pitch EG screen for Part Edit (AN-X).

Opens the General/Pitch → Pitch LFO screen for Part Edit (AN-X).

Opens the Osc EG screen for Oscillator Edit.

Opens the Osc LFO screen for Oscillator Edit.

Pulse Width (Oscillator Pulse Width)

PulseWidth/Vel (Oscillator Pulse Width Velocity Sensitivity)

Wave Shaper

Shaper (Oscillator Wave Shaper)

Shaper/Vel (Oscillator Wave Shaper Velocity Sensitivity)

Pitch EG Settings

Pitch LFO Settings

Osc 1–3 EG Settings

Osc 1–3 LFO Settings
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On the Osc EG screen, you can set the Envelope Generator for the Oscillator.

You can set how the Sync, Pulse Width, and Wave Shaper change over time, starting from the
moment you press a key on the keyboard to when the sound decays.

To set how the pitch changes over time, use Pitch EG.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Oscillator selection → Osc EG

Sets the length of time it takes for the EG to change from the moment you press a key on the
keyboard until it reaches the value set at the Attack Level.
Settings: 0–255

Sets the length of time it takes for the EG to change from the moment you press a key on the
keyboard until it reaches the value set at the Decay Level.
Settings: 0–255

Sets the Sustain Level.
Settings: 0–511

Osc EG

Attack (Oscillator EG Attack Time)

Decay (Oscillator EG Decay Time)

Sustain (Oscillator EG Sustain Level)

Release (Oscillator EG Release Time)
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Sets the length of time for the EG to reach a value of 0 after you have released the key.
Settings: 0–255

Sets how the Sync responds to Osc EG.
Settings: −4800–+4800 (cent)

Sets how the Pulse Width responds to Osc EG.
Settings: −127–+0–+127

Sets how the Shaper responds to Osc EG.
Settings: −127–+0–+127

On the Osc LFO screen, you can set the Oscillator LFO.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Oscillator selection → Osc LFO

Selects an LFO wave.
By using the wave you have selected here, you can create various types of modulation.
Settings: Saw, Square, Triangle, Sine, Random

Osc EG Depth Sync (Oscillator Self Sync EG Depth)

Osc EG Depth Pulse Width (Oscillator Pulse Width EG Depth)

Osc EG Depth Shaper (Oscillator Wave Shaper EG Depth)

Osc LFO

LFO Wave (Oscillator LFO Wave)
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Resets the oscillation of the LFO when a key is pressed.
Settings: Off, On

Sets the speed of LFO wave changes.
Settings: 0–415

Sets the delay time between the moment you press a key on the keyboard and the moment the
LFO comes into effect.
Settings: 0–127

Sets the time length for the LFO effect to fade in after you have released the key and the delay
time set in Delay has elapsed.
Settings: 0–214

Sets the LFO phase for resetting the wave when a key is pressed.
Settings: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Sets how the Sync responds to Osc LFO.
Settings: −4800–+4800 (cent)

Key On Reset (Oscillator LFO Key On Reset)

Speed (Oscillator LFO Speed)

Delay (Oscillator LFO Delay Time)

Fade In (Oscillator LFO Fade In Time)

Oscillator LFO Phase

Osc LFO Depth Sync (Oscillator Self Sync LFO Depth)

Osc LFO Depth Pulse Width (Oscillator Pulse Width LFO Depth)
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Sets how the Pulse Width responds to Osc LFO.
Settings: −127–+0–+127

Sets how the Shaper responds to Osc LFO.
Settings: −127–+0–+127

Osc LFO Depth Shaper (Oscillator Wave Shaper LFO Depth)
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On the Noise screen, you can set the Noise Generator.

Operation

[PERFORMANCE] → [EDIT/ ] → Part selection → Oscillator selection → Noise

Sets the frequency response for the Noise.
Settings: 0–64–127

0–63: Cuts the treble
64: White noise
65–127: Cuts the bass

Sets the volume of the Noise.
Settings: 0–511

Sets how the Noise volume responds to Velocity.
Settings: −255–+0–+255

Noise Edit

Noise

Noise Tone (Noise Generator Tone)

Out Level (Noise Generator Out Level)

Out Level/Vel (Noise Generator Out Level Velocity Sensitivity)
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Sets the output destination for the Noise.
Settings: Filter, Amp

Connect (Noise Generator Out Select)
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Category Search is a convenient function that allows you to quickly find a specific Performance,
Part, Arpeggio, or Waveform you wish to use from a specified category.

Contents

Category Search screen

Performance Category Search

Performance Merge

Part Category Search

Rhythm Pattern

Arp Category Search (Arpeggio Category Search)

Waveform Search (Waveform Category Search)
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On the Performance Category Search screen, you can search for and select Performances.
While the Category Search screen is shown, you can use the buttons on the Top Panel to
change the Part Select, Mute or Solo settings.

Operation

Select a filter to use in a search.
Settings: Category, Attribute

Filters by category.
By unchecking the Main or Sub checkbox, you can cancel filtering by category.
Settings: Refer to the Data List.

Filters by attribute.
By unchecking the Attribute checkbox, you can cancel filtering by attribute.
Settings: AWM2, FM-X, AN-X, MC, SSS, Smart Morph, Single, Multi, MOTIF XF, MONTAGE,

MONTAGE M

Performance Category Search

Press the [CATEGORY] button

Tap the Performance name → Select Category Search from the context menu

Filter

Main (Main Category)
Sub (Sub Category)

Attribute
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Filters by bank or favorites.
When Favorite is selected, only the Performances with Favorite marks will appear in the list.
When the Category Search screen is shown, you can press the [CATEGORY] button to switch
the Bank in the order of All → Favorite → Preset → User → Library name (when a Library file is
loaded).
When you hold down the [CATEGORY] button, the selection will be reset to All.
Settings: All, Favorite, Preset, User, Library name (when a Library file is loaded)

Allows you to enter certain characters included in the name for easy searching.
Tapping on the name calls up the onscreen keyboard, allowing you to enter up to 20
alphanumeric characters.

Calls up the Job menu.

Sets the sort order of the Performance list.
Settings: Default, Name, Date

Name: Sorts by name. The down arrow indicates that the list is arranged in ascending
order (A to Z). The up arrow indicates that the list is arranged in descending order.
Date: Sorts by the date the setting was stored. The down arrow indicates that the list
is arranged in descending order (new to old). The up arrow indicates that the list is
arranged in ascending order.

Sets the audition phrase playback on or off.
This parameter is not available when Audition Lock is On at: [UTILITY] → Settings →
Advanced.
Settings: Off, On

Deletes the selected content.
This parameter is available only when a Performance in the User Bank is selected.

Changes the name of the selected content.
This parameter is available only when a Performance in the User Bank is selected.

Bank/Favorite (Bank/Favorite Select)

Name Search

Job

Sort

Audition

Delete

Rename
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Clears all Favorite marks from the Performances.
This parameter is not available when there are no Performances with Favorite marks.

Shows the Performance name, along with its active Parts, attributes, and Favorite status.

Favorite All Clear

List

444



om02screenparameters0230

The Performance Merge screen allows you to assign multiple Parts of the selected Performance
to empty Parts of another Performance. For example, you can layer a four-Part piano
Performance and a two-part string Performance to create a rich six-part Performance.

Operation

[PERFORMANCE] → Select a Part (when the selected Part and all subsequent Parts are
empty) → Tap [+]

When selecting a Performance, the sound of the Part specified here is assigned to the currently
selected Part.
Settings: All, Part 1–16

All: All Parts in the selected Performance are assigned to empty Parts of the other
selected Performance (as much as possible).
Part 1–16: Only the sound of the specified Part will be assigned to the other selected
Part.

When this is off, the Parts shown on the display before you have opened the Performance
Merge screen will be muted.
Settings: Off, On

Performance Merge

Source

Mute Org (Original Part Mute)

Mute Add (Additional Part Mute)
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When this is off, the Parts added on the Performance Merge screen will be muted.
Settings: Off, On

446



om02screenparameters0240

On the Part Category Search screen, you can search for and select Parts.

Operation

When selecting a Performance, the sound of the Part specified here is assigned to the currently
selected Part.
The initial setting is Part 1.
Settings: Part 1–16

Sets the Solo function on or off.
When this switch is turned on, the selected Part is set to solo.
Settings: Off, On

Loads a group of parameter values when a Performance is selected.
The parameters set to Off will retain their current settings even when a new Performance is

Part Category Search

[SHIFT] + [CATEGORY]

(When selecting a Part to which a sound has already been assigned) Tap the Performance
name → Select Category Search from the context menu

(When selecting an empty Part) Tap [+]

Source (Source Part)

Solo

Param. with Part (Parameter with Part)
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selected.
Parameter groups: Mixing, Arp/MS, Scene, Zone
Settings: Off, On
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On the Rhythm Pattern screen, you can search for and select Rhythm Patterns.

The Rhythm Pattern function allows you to instantly add a rhythm Part to the current
Performance. Also, by combining Rhythm Patterns with envelope follower effects, you can
further change the sound.

Operation

[SHIFT] + [SONG/PATTERN]

Selects Arpeggio view or Envelope Follower view.

Filters by bank or favorites.
When Favorite is selected, only the Rhythm Patterns with Favorite marks will appear in the list.
Settings: All, Favorite, Preset, User, Library name (when a Library file is loaded)

Allows you to enter certain characters included in the name for easy searching.
Tapping on the name calls up the onscreen keyboard, allowing you to enter up to 20
alphanumeric characters.

Rhythm Pattern

Arp (Arpeggio)
Envelope Follower

Bank/Favorite (Bank/Favorite Select)

Name Search
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Sets the sort order of the Rhythm Pattern list.
Settings: Default, Name, Date

Name: Sorts by name. The down arrow indicates that the list is arranged in ascending
order (A to Z). The up arrow indicates that the list is arranged in descending order.
Date: Sorts by date the setting was stored. The down arrow indicates that the list is
arranged in descending order (new to old). The up arrow indicates that the list is
arranged in ascending order.

When this is off, the Part shown on the display before you have opened the Rhythm Pattern
screen will be muted.
Settings: Off, On

When this is off, the Parts added on the Rhythm Pattern screen will be muted.
Settings: Off, On

Shows the Rhythm Pattern list.

Cancels the operation.

Frequently used parameters for Arpeggio settings are displayed on the left side of the screen.

Sort

Mute Org (Original Part Mute)

Mute Add (Additional Part Mute)

List

Cancel

When Arp is on

Tempo
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Sets the tempo.
Settings: 5–300

Sets the volume of the Rhythm Pattern.
Settings: 0–127

Shows the currently selected Arpeggio category, Sub category, and name.
By tapping on the name, you will see the context menu for Arpeggio Category Search and
entering numbers.
Settings: Refer to the Data List.

Changes the Arpeggio selection.
Settings: 1–8

Frequently used parameters for the Envelope Follower settings are shown on the left side of
the screen.
This allows for quick editing of parameters frequently used for Rhythm Patterns.
When you wish to change other parameters, use Edit to open the setting screen for the
Envelope Follower.

Enables Envelope Follower.

Volume

Category (Arpeggio Main Category)
Sub Category (Arpeggio Sub Category)
Name

Arp Select (Arpeggio Select)

When Envelope Follower is on

Quick Assign
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Settings: Off, On

Sets the input gain for the input source.
Settings: −24.0dB–0.0dB–24.0dB

Sets the destination for the Envelope Follower.
Settings: Volume, Cutoff, Resonance, Pitch, Pan, Reverb Send, Variation Send, LFO Speed,

LFO Depth 1, LFO Depth 2, LFO Depth 3

Same as the Control Assign screen.

The Envelope Follower Edit screen appears.

Here, we will show an example of how to add the Rhythm Pattern 8Z Trance Basics 1 to the
Performance Supertrance, and then modify the sound with the Envelope Follower.

1 Select the desired Performance for adding the rhythm part.

Here, select Supertrance.

2 Press the [SHIFT] button + [SONG/PATTERN] button.

The Rhythm Pattern screen appears.
When all of Parts 1–8 are being used, PartFull will be shown and no Rhythm Patterns can
be added.

3 Tap the Rhythm Pattern kit you wish to use from the Rhythm Pattern list.

Gain (Envelope Follower Gain)

Destination

Curve Type
Polarity (Curve Polarity)
Ratio (Curve Ratio)
Param1 (Curve Parameter 1)
Param2 (Curve Parameter 2)

Edit

How to use the Rhythm Pattern function

Adding a Rhythm Part (simple way)
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Here, tap on 8Z Trance Basics 1.

The rhythm Part has been added.

4 Play the keyboard and the Rhythm Pattern starts playing.

5 Press the [PERFORMANCE] button or the [EXIT] button to confirm the
Rhythm Pattern.

The Rhythm Pattern screen closes.

NOTE
You can also confirm the selection by tapping the  (Home) icon.

6 To stop the Rhythm Pattern, press the [ARP ON/OFF] button or the [ ]
(stop) button.

Envelope Follower is a function that extracts the envelope (amplitude envelope) of the
waveform from input signals, and then lets you use that envelope as a controller for modifying
sounds. For example, by assigning a Rhythm Pattern to a Part and setting the Envelope
Follower of the Part as a “Source,” the sound of the other Parts is modified accordingly. This is
especially useful for automatic “ducking,” where you want to lower the volume of other
instruments while a certain instrument sound you want to emphasize is being played.

1 Tap the Envelope Follower button on the Rhythm Pattern screen.

The Envelope Follower screen appears.

Setting the Envelope Follower
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2 Turn the Envelope Follower switch on.

Here, you can play the keyboard to hear the sound with the Envelope Follower enabled.

3 Adjust settings as needed.

Here, in this example, set the Polarity to Bi, the Ratio to −63, and the Gain to −12dB.
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For more detailed adjustments, tap the Edit button on the screen to open the Envelope
Follower setting screen.

When you wish to change the Rhythm Pattern kit or Arpeggio type, press the [SHIFT]
button + [SONG/PATTERN] button to go back to the Rhythm Pattern screen. The
Envelope Follower settings are retained even after the kit or the Arpeggio type has been
changed.
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On the Arp Category Search screen, you can search for and select Arpeggio types.

Operation

Turns the Classic view on.
In the Classic view, only common Arpeggios are listed, and no filters are available for searching.
Settings: Off, On

Filters by category.
By unchecking the Main or Sub checkbox, you can cancel filtering by category.
Settings: Refer to the Data List.

Filters by attribute.
By unchecking the Attribute checkbox, you can cancel filtering by attribute.

Arp Category Search (Arpeggio Category Search)

[PERFORMANCE] → Part Common selection → [EDIT/ ] → Arpeggio → Individual →
[CATEGORY]

[PERFORMANCE] → Common selection → [EDIT/ ] → Arp / MS → Arp Overview →
Part selection → [CATEGORY]

Classic (Classic Switch)

Main (Main Category)
Sub (Sub Category)

Attribute
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Settings: Note, Chord, Other, Intro, Main, Fill, Ending, AF, Accent, Random SFX, Mg, number
of measures, time signature, tempo

Filters by bank or favorites.
When Favorite is selected, only the Arpeggio types with the Favorite marks will appear in the
list.
Settings: All, Favorite, Preset, User, Library name (when a Library file is loaded)

Allows you to enter certain characters included in the name for easy searching.
Tapping on the name calls up the onscreen keyboard, allowing you to enter up to 20
alphanumeric characters.

Calls up the Job menu.

Deletes the selected content.
This parameter is available only when the Arpeggio in the User Bank is selected.

Changes the name of the selected content.
This parameter is available only when the Arpeggio in the User Bank is selected.

Clears all Favorite marks from the Arpeggio list.
This parameter is not available when there are no Arpeggio types with Favorite marks.

Sets the sort order of the Arpeggio type list.
Settings: Default, Name, Date

Name: Sorts by name. The down arrow indicates that the list is arranged in ascending
order (A to Z). The up arrow indicates that the list is arranged in descending order.
Date: Sorts by date the setting was loaded. The down arrow indicates that the list is
arranged in descending order (new to old). The up arrow indicates that the list is
arranged in ascending order.

Bank/Favorite (Bank/Favorite Select)

Name Search

Job

Delete

Rename

Favorite All Clear

Sort

List
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Shows the Arpeggio name, time signature, beats, recommended tempo, Attributes, and Favorite
status.
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On the Waveform Search screen, you can search for and select Waveforms.

Operation

Waveform related screen → Part selection → Waveform selection → [CATEGORY]

Filters by bank or Favorites.
When Favorite is selected, only Waveforms with Favorite marks will appear in the list.
Settings: All, Favorite, Preset, User, Library name (when a Library file is loaded)

Allows you to enter certain characters included in the name for easy searching.
Tapping on the name calls up the onscreen keyboard, allowing you to enter up to 20
alphanumeric characters.

Filters by category.
By unchecking the Main or Sub checkbox, you can cancel filtering by category.
Settings: Refer to the Data List.

Calls up the Job menu.

Waveform Search (Waveform Category Search)

Bank/Favorite (Bank/Favorite Select)

Name Search

Main (Main Category)
Sub (Sub Category)

Job
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Deletes the selected content.
This parameter is available only when a Waveform in the User Bank is selected.

Changes the name of the selected content.
This parameter is available only when a Waveform in the User Bank is selected.

Clears all Favorite marks from the Waveform list.
This parameter is not available when there are no Waveforms with Favorite marks.

Sets the sort order of the Waveform list.
Settings: Default, Name, Date

Name: Sorts by name. The down arrow indicates that the list is arranged in ascending
order (A to Z). The up arrow indicates that the list is arranged in descending order.
Date: Sorts by date the setting was stored. The down arrow indicates that the list is
arranged in descending order (new to old). The up arrow indicates that the list is
arranged in ascending order.

Delete

Rename

Favorite All Clear

Sort
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Live Sets are useful for live performance situations when you wish to change the Performance
instantly along with the songs you are playing.

Contents

Live Set screen

Live Set

Live Set Register

Live Set Edit
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On the Live Set screen, you can call up a Performance.
When you press [SHIFT] + [EDIT/ ] while the User Bank is selected, a dialog will be shown
and then you can copy or exchange pages or banks.

Operation

Selects the Live Set bank.
Settings: Preset, User 1–8 (default) or Library name (when a Library file is loaded)

Selects the Live Set page.

Displays a list of Performances registered on the selected Live Set page.

Opens the Performance Category Search screen.

Live Set

Press the [LIVE SET] button

Tap the  (Live Set) icon

Bank (Bank Name)

Page

Live Set Slot 1–16

Category Search

Current Performance Name
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Shows the name of the Performance registered in the selected slot.

Shows the name of the selected slot.
When a Pattern, Song, or audio is assigned to a slot, the name of the Pattern or Song, or the
audio file will be shown.

Shows the attribute(s) of the Performance registered in the selected slot.

On the Live Set screen, the PTN icon changes to PTN CHAIN when a Pattern with chain on is
assigned to a slot.

: Displayed for a slot to which a Pattern is assigned.
: Displayed for a slot to which a Pattern with chain on is assigned.

: Displayed for a slot to which a Song is assigned.
: Displayed for a slot to which audio is assigned.

The Live Set Edit screen appears.
Edit appears only when User Bank is selected.

Current Slot Name

Performance Attribute

Edit
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On the Live Set Register screen, you can register Performances to Live Set slots.

Operation

Stores the current Performance as a new Performance and registers it to the selected slot.

Opens the Data Utility screen.

Stores the new Performance over the existing Performance and registers it to the selected slot.

Registers a Performance without storing it.

Live Set Register

[SHIFT] + [LIVE SET]

Hold down the [SHIFT] button and tap the <Live Set> button at the Navigation Bar

Store as New Perf. and Register (Store as New Performance and Register)

Jump to Data Utility

Overwrite Current Perf. and Register (Overwrite Current Performance and Register)

Register without Storing
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On the Live Set Edit screen, you can edit Live Sets.
Only Live Sets in the User Bank can be edited.

Operation

[LIVE SET] → [EDIT/ ]

Saves the selected Live Set bank under a new name. You can use up to 20 alphanumeric
characters.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Saves the selected Live Set page under a new name. You can use up to 20 alphanumeric
characters.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

Tap Done to close the Live Set Edit and show the Live Set screen.

Displays a list of Performances registered to the selected Live Set.

Live Set Edit

Bank (Bank Name)

Page (Page Name)

Done

Live Set Slot 1–16
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Selects the slot type.
Settings: Perform, Song, Audio, Pattern

Perform: Registers only the Performance to the slot
Song: Registers the Performance and Song to the slot
Audio: Registers the Performance and audio file to the slot
Pattern: Registers the Performance and Pattern to the slot

Shows the Slot Name when the Slot Type is Perform.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name for the
current slot. You can use up to 20 alphanumeric characters.
When the Slot Type is Pattern, the Pattern Name is displayed; when the Slot Type is Song, the
Song Name is displayed; and when the Slot Type is Audio, the Audio Name is displayed. The
registered Pattern, Song or audio will be shown. When you tap on the name, the Utility Load
screen appears. Then you can select the Pattern, Song, or audio to register.

Shows the name of the Performance registered to the selected slot.
When you tap on the name, the Performance Category Search screen appears.

Sets the color for the selected slot.
Settings: Black, Red, Yellow, Green, Blue, Azure, Pink, Orange, Purple, Sakura, Cream, Lime,

Aqua, Beige, Mint, Lilac

Sets the volume of the Performance registered in the selected slot.

Calls up the Job menu.

Turns the copy function on.
You can copy settings by selecting a slot to copy from, tapping Copy, and then selecting the slot
to copy to.
Settings: Off, On

Slot Type

Slot Name
Pattern Name
Song Name
Audio Name

Performance (Performance Name)

Color

Volume

Job

Copy
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Turns the exchange function on.
You can exchange settings by selecting the first slot, tapping Exchange, and then selecting the
second slot.
Settings: Off, On

Select the slot, and then tap Delete to delete any registered Performances and other settings
from the slot.

Tap [+] to register the selected Performance to that slot.

Operation

Tap [LIVE SET] (or tap the Live Set icon) → User bank selection → Slot selection → [ ] (Play)
button

NOTE

Exchange

Delete

[+] (Add)

Playing back the Pattern, Song, or Audio file from the Live Set screen

Performance and slot cannot be changed while the Pattern or Song is being played back. If you attempt
to change them, an error message will appear.
When you press the [ ] (Play) button while the Pattern, Song, or audio file is played back, the Pattern,
Song, or audio file playback screen will open.
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The Utility screen is used for setting common items for the entire instrument.

Contents

The Sound screen is used for setting the sound output from the instrument.

Operation

Utility screen

Settings

Sound

Edit User Micro Tuning

Quick Setup

Audio I/O

MIDI I/O

Advanced

System

Contents

Load

Save

Data Utility

Library Import

Tempo Settings

Effect Switch

Other Info

Shift Function

Legal Notices

Settings

Sound

468



[UTILITY] → Settings → Sound

Sets the overall volume of the sound output from the instrument.
Settings: 0–127

Adjusts the pitch of the overall sound produced by the Tone Generator block of the instrument in
semitones.
Settings: −24semi–+24semi

Adjusts the tuning of the overall sound produced by the Tone Generator block of the instrument
in semitones. You can fine-adjust the pitch in cents.
Settings: −102.4–+102.3

Shifts the pitch of the keys in octaves.
It is linked to the OCTAVE buttons on the top panel.
Settings: −3–+3

NOTE
The Keyboard Octave Shift setting is reset to 0 at the next startup.

Shifts the pitch of the keys in semitones.
Settings: −11semi–+11semi

Tone Generator Volume

Tone Generator Note Shift

Tone Generator Tune

Keyboard Octave Shift

Keyboard Transpose
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NOTE

Determines the actual velocity to be generated and transmitted according to the velocity with
which you play notes on the keyboard.
The graph shown in the display indicates the velocity response curve. The horizontal axis
represents the received velocity value (or the strength with which you have pressed the key),
while the vertical axis represents the actual velocity value transmitted to the internal or external
tone generators.
Settings: Normal, Soft 1, Soft 2, Hard 1, Hard 2, Wide, Fixed

Normal: Commonly used setting where the linear “curve” produces one-to-one
correspondence between the strength of your keyboard playing (velocity) and the
actual sound change.
Soft 1: Provides increased response
Soft 2: A curve between Soft 1 and Normal
Hard 1: Provides decreased response
Hard 2: A curve between Hard 1 and Normal
Wide: Accentuates your playing strength by producing lower velocities in response to
softer playing and louder velocities in response to harder playing. As such, you can
use this setting to expand your dynamic range.
Fixed: Produces the same velocity value, no matter what your playing strength. The
value set in Keyboard Fixed Velocity is used here.

Sends a fixed velocity to the tone generator regardless of how hard or soft you play the
keyboard.
This parameter is available only when the Keyboard Velocity Curve is set to Fixed.
Settings: 1–127

Selects the type of aftertouch output to external devices.
Settings: Off, Channel, Poly

Sets the curve that determines the level of the aftertouch value relative to the strength when you
press the key.
Settings: Normal, Soft 1, Soft 2, Hard 1, Hard 2

For any notes outside the range C−2 to G8 (the range that can be played on the Tone Generator of this
instrument), the note will be played at one octave higher (or lower).
The Keyboard Transpose setting is reset to +0 semi at the next startup.

Keyboard Velocity Curve

Keyboard Fixed Velocity

AT MIDI Out (After Touch MIDI Out)

AT Curve (Poly After Touch Curve)
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Select the type of footswitch connected to the FOOT SWITCH [SUSTAIN] jack on the rear
panel.

Select FC3A (Half On).
If you do not need to use the half-damper feature, select FC3A (Half Off).

Select FC4A or FC5.
The half-damper feature is not available with the FC4, FC4A, and FC5.

Select Reverse Polarity.
The half-damper feature is not available.

Settings: FC3A (Half On), FC3A (Half Off), FC4A/FC5, Reverse Polarity

NOTE
The Sustain Pedal (Sustain Pedal Select) setting is not necessary when you use the half-damper feature by
sending the Control Change from the external MIDI device.

When this parameter is on, the micro tuning settings in the global settings are prioritized over
the micro tuning settings for each Part of the Performance.
This applies to all Parts except the Drum Part.
Settings: Off, On

NOTE
The Global Tuning setting is reset to Off the next time the instrument is turned on.

Shows the name of the selected micro tuning.
Tapping on the name lets you call up the menu for selecting the micro tuning.
Settings: Equal Temperament, Pure Major, Pure Minor, Weckmeister, Kirnberger, Vallotti &

Young, 1/4 Shift, 1/4 tone, 1/8 tone, Indian, Arabic1, Arabic2, Arabic3
User: User1–8
Library: Library name (when a Library file is loaded)

Sustain Pedal (Sustain Pedal Select)

FC3, FC3A (half-damper feature enabled)

FC4, FC4A, FC5

Pedal with reverse polarity

Global Tuning

Micro Tuning Name (Global Micro Tuning Name)

Micro Tuning Root (Global Micro Tuning Root)
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Sets the root note for the micro tuning.
This parameter is not shown if the selected type in Micro Tuning Name does not require a root
note.
Settings: C–B

Opens the User Micro Tuning settings screen.

This is the setting screen for User Micro Tuning.

Indicates the selected User Micro Tuning Number.
Settings: 1–8

You can save the User Micro Tuning you are editing under a new name.
Tapping on the name calls up the onscreen keyboard, allowing you to enter a name.

You can adjust the pitch of each note in cents to set the micro tuning.
Settings: −99–+99

Initializes the selected User Micro Tuning.

Edit User Tuning

Edit User Micro Tuning

Tuning No. (Micro Tuning Number)

Tuning Name (Micro Tuning Name)

C, C♯, D, D♯, E, F, F♯, G, G♯, A, A♯, B

Initialize
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This function allows you to set all necessary settings for connecting the external device to the
optimal values by simply selecting a group of settings.
Parameters across several setting screens can be set at once.

Operation

Displays the audio signal flow diagram.
The signal flow depicted changes depending on the connection on the [USB TO HOST] terminal
and the other settings of the instrument.

Displays the MIDI signal flow diagram.
The signal flow diagram changes depending on the settings of the instrument.

Sets to one from Quick Setup.
Settings: Standalone, 1–3

The parameters for Quick Setup are as follows.

Audio settings Direct Monitor Switch

Quick Setup

[QUICK SETUP]

[UTILITY] → Settings → Quick Setup

Audio Signal Flow

MIDI Signal Flow

Quick Setup (Quick Setup Select)
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MIDI settings Local Control

Performance settings

Part 1–16 Output Select
A/D In Output Select
Digital In Output Select
Part 1–8 Keyboard Control Switch
Part 1–16 Part Mode
Part 1–16 Tx Channel

For Audio settings, see Audio I/O. For MIDI settings, see MIDI I/O.

Settings for using the instrument by itself and for operating the external device from the
instrument

Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

On On Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

Settings for recording your performance in MIDI on DAW software

Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

Off On Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

Settings for recording each Part on the internal Tone Generator to DAW software as an
individual audio track

Local
Control

Direct
Monitor

Output Select
Keyboard

Sw
Part Mode Tx Channel

On Off
Different for each
Part

Part 1–8: On
Part 1–16:
Int

Part 1–16: Ch 1–
16

Settings for using the internal Tone Generator with a sound generator plug-in on a computer

Initial settings for Quick Setup

Standalone

MIDI Rec on DAW

Audio Rec on DAW

With Plugin Host App
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Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

On On Main L&R
Part 1–5: On
Part 6–8: Off

Part 1–4: Int
Part 5–16: Ext

Part 1–4: Ch 1–4
Part 5–8: Ch 1–4
Part 9–16: Ch 9–16

Stores the current settings to any one of Quick Setup 1 to 3.

On the Audio I/O screen, you can set the audio signal input and output.

Operation

[UTILITY] → Settings → Audio I/O

Displays the current audio signal flow diagram.
The flow diagram changes depending on the connection on the [USB TO HOST] terminal and
the other settings of the instrument.

When you tap on the Main Monitor Volume in the Audio Signal Flow, the cursor moves to Main,
and when you tap on Assign, the cursor moves to Assign.

Sets the input gain for the A/D INPUT jack to Mic or Line.
Settings: Mic, Line

Mic: Intended for a device with a low output level, such as a microphone.

Store Current Settings

Audio I/O

Audio Signal Flow

A/D Input (A/D Input Gain)
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Line: Intended for a device with a high output level, such as a synthesizer, or audio
device.

NOTE
A guitar or bass having an active pickup can be directly connected. On the other hand, when using a passive
pickup, connect the instrument via an effect unit or direct box.

Adjusts the volume of the audio signal input from the [USB TO HOST] terminal. This is applied
to the output signals from both the OUTPUT (BALANCED) jacks and the ASSIGNABLE
OUTPUT (BALANCED) jacks.
Settings: 0–127

NOTE
USB Input Volume is stored as a global setting and not for each Performance.

Switches the mode for the audio signal output from the [USB TO HOST] terminal.
The instrument must be rebooted for this setting to be effective.
Settings: 16 Stereo/44.1kHz, 4 Stereo/44.1–192kHz

16 Stereo/44.1kHz: Up to 32 channels (16 stereo channels) at a sampling frequency
of 44.1 kHz
4 Stereo/44.1–192kHz: Up to 8 channels (4 stereo channels) at a sampling frequency
of 44.1 kHz to 192 kHz

NOTE
When set to 4 Stereo/44.1–192kHz, the available frequencies are: 44.1 kHz, 48 kHz, 96 kHz, and 192 kHz.

Sets the output gain of the OUTPUT (BALANCED) jacks.
Settings: −6dB, +0dB, +6dB, +12dB

Sets the output gain of the ASSIGNABLE OUTPUT (BALANCED) jacks.
Settings: −6dB, +0dB, +6dB, +12dB

Sets the output gain of the Main L&R channel of the [USB TO HOST] terminal.
Settings: −6dB, +0dB, +6dB, +12dB

USB Volume

Audio I/O Mode

Main L&R (Analog Output L&R Output Gain)

Assign L&R (Assignable Output L&R Output Gain)

USB Main (USB Main L&R Output Gain)

USB 1–30 (USB Individual Output Gain)
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Sets the output gain of the channels 1–30 of the [USB TO HOST] terminal.
Settings: −6dB, +0dB, +6dB, +12dB

Sets the audio signal output from Main L&R (USB Out) and USB 1–30 channels to the external
device (such as a computer) to be also played back from this instrument (direct monitoring).
When this is set to on, the audio signal output to the Main L&R (USB Out) channel and USB 1–
30 channels is also sent to the OUTPUT (BALANCED) jacks and [PHONES] jack of this
instrument.
When there is no USB connection, the Direct Monitor switch is automatically turned on.
Settings: Off, On

Shows the Monitor Volume screen.

On the MIDI I/O screen, you can set the MIDI input and output.

Operation

[UTILITY] → Settings → MIDI I/O

Displays the current MIDI signal flow diagram.
The flow diagram changes depending on the settings of the instrument.
By tapping near the Local Control switch on the MIDI Signal Flow, you can turn Local Control on
or off.

Direct Monitor

Monitor Volume

MIDI I/O

MIDI Signal Flow
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Selects the terminal(s) for transmitting and receiving MIDI messages.
Settings: MIDI, USB

Switches Local Control on or off.
When the Local Control is set to off, the Controller block and the Tone Generator block will be
disconnected, and no sound is produced when you play the keyboard. However, regardless of
this setting, the keyboard performance data on this instrument are transmitted as MIDI
messages, and MIDI messages sent from the external device are processed by the Tone
Generator block.
Settings: Off, On

Sets the MIDI channel for input and output of the Part with Common and the Part with the
Keyboard Control Switch to be set to On.
Settings: Ch1–Ch16

Selects the type of aftertouch output to external devices.
Settings: Off, Channel, Poly

Sets the parameters related to synchronization to the connected external device.
Select the internal clock of this instrument or the external MIDI clock of DAW software on the
computer or the external MIDI device, or the audio signal input from the A/D INPUT jacks for
playing back the Arpeggios, Motion Sequencer, Songs, and Patterns.
Settings: Internal, MIDI, A/D In (ABS)

Internal: Synchronizes to the internal clock. For using this instrument by itself or as
the primary clock source for other devices.
MIDI: Synchronizes to the MIDI clock received from the external MIDI device. For
using the external device as the primary clock source.
A/D In: Synchronizes to the tempo, extracted by the Audio Beat Sync function, of the
audio signal input from the A/D INPUT jacks.

Sets the MIDI clock messages to be transmitted.
Settings: Off, On

MIDI IN/OUT

Local Control

MIDI I/O Channel

AT MIDI Out (After Touch MIDI Out)

MIDI Sync

Clock Out (MIDI Clock Out)

Receive (Receive Sequencer Control)
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Receives the MIDI messages for starting and stopping the Song.
Settings: Off, On

Transmits the MIDI messages for starting and stopping the Song.
Settings: Off, On

Sets whether to use the current settings of the controllers such as modulation wheel, aftertouch,
foot controller, and breath controller (Hold) or to reset to their initial settings (Reset) when you
switch between Performances.
Settings: Hold, Reset

When set to Reset, the controllers will be reset when you switch between Performances as
shown below:

Pitch bend Center

Modulation wheel Minimum

Aftertouch Minimum

Foot controller Maximum

Footswitch Off

Ribbon controller Center

Breath controller Maximum

Expression Maximum

Assignable switches 1 and 2 Off

Each lane of the motion
sequencer

When the Motion Seq Polarity for the lane is set to Unipolar: the value is 0
(minimum)
When the Motion Seq Polarity for the lane is set to Bipolar: the value is 64
(center)

Sets the Control Change number generated by the operation of the footswitch connected to the
FOOT SWITCH [ASSIGNABLE] jack. When this instrument receives a MIDI message with the
same Control Change number specified here from the external MIDI device, the instrument will
act as if the footswitch has been operated.
Settings: Off, 1–95, Arp Sw, MS Sw, Play/Stop, Live Set+, Live Set−, Oct Reset, Tap Tempo

Transmit (Transmit Sequencer Control)

Controller Reset

FS Assign (FootSwitch Assign Control Number)

Super Knob CC (Super Knob Control Change Number)
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Sets the Control Change number generated by the operation of the Super Knob.
When this instrument receives the MIDI message with the same Control Change number
specified here from the external device, the instrument will act as if the Super Knob has been
operated.
Settings: Off, 1–95

NOTE
When this parameter is set to Off, the System Exclusive (SysEx) is used for handling MIDI messages.

Sets the Control Change number generated when you switch between Scenes.
Also, Scene will change when a MIDI message with the same Control Change number set here
is received from the external MIDI device.
Settings: Off, 1–95

NOTE

Opens the Control → Control Number screen for the Common Edit.

On the Advanced screen, you can set the detailed settings for the instrument.

Operation

[UTILITY] → Settings → Advanced

Scene CC (Scene Control Change Number)

Depending on the Control Change number, one of the Scenes 1–8 will be selected.
0–15: Scene 1, 16–31: Scene 2, 32–47: Scene 3, 48–63: Scene 4, 64–79: Scene 5, 80–95: Scene 6, 96–
111: Scene 7, 112–127: Scene 8
If the Super Knob Control Change number and the Scene Control Change number are set to the same
value, an exclamation mark appears in front of the number. In that case, the Scene Control Change takes
priority, and the Super Knob Control Change is disabled.

Control Number

Advanced
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Switches the audition lock on or off.
When set to on, the audition function is disabled.
Settings: Off, On

When this parameter is set to on, the audition phrase will be played back in a loop.
When this is set to on, the playback of the audition phrase will stop automatically after it has
been played to the end.
Settings: Off, On

Auto Power Off is a function that automatically turns off the instrument when the instrument is
inactive for a certain length of time to reduce energy consumption.
Here, you can set the length of time until the instrument is automatically turned off.
Settings: Off (Auto Power Off disabled), 5 min, 10 min, 15 min, 30 min, 60 min, 120 min

Sets the MIDI device number.
For sending and receiving System Exclusive messages such as Bulk Dump and Parameter
Change to and from an external MIDI device, you need to set this number to match the device
number of the other device.
Settings: 1–16, All, Off

Sets the reception and transmission of Bank Select messages between the instrument and the
external MIDI device.

Audition Lock

Audition Loop

Auto Power Off (Auto Power Off Time)

Device Number

Bank Select (Receive/Transmit Bank Select)
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When this is set to on, the instrument will receive or recognize Bank Select messages sent from
the external MIDI device.
Settings: Off, On

Sets the reception and transmission of Program Change messages between the instrument and
the external MIDI device.
When this is set to on, the instrument will receive or recognize Program Change messages sent
from the external MIDI device.
Settings: Off, On

Sets the reception of Bulk Dump messages.
Settings: Protect (does not receive), On (receive)

Sets the interval time for transmission of Bulk data when this instrument receives the Bulk
Request message from the external device.
Settings: 0–900ms

This ensures that specified events to be recognized properly when, for example, a Song is
played back from the middle, or with the Forward (fast-forward) and Back (rewind) operations.
Events set with MIDI Event Chase will then function properly with the Forward and Back
operations.
Settings: Off, PC (Program Change), PC+PB+Ctrl (Program Change + Pitch Bend + Control

Change)

Initializes the User data when the instrument is turned on.
Settings: Off, On

Set to Vendor for connecting to the computer with the Yamaha Steinberg USB Driver installed.
Set this to Generic when you connect this instrument to a computer that meets the MIDI 2.0
operational requirements or when you use a smartphone or any device that does not allow the
Yamaha Steinberg USB Driver to be installed.
Settings: Vendor, Generic

Pgm Change (Receive/Transmit Program Change)

Receive Bulk

Bulk Interval

Event Chase (Song Event Chase)

Init On Boot (Initialize User Data on Boot-up)

USB Driver Mode

Initialize Advanced Settings
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Initializes the settings on the Advanced screen.

On the System screen, you can set the parameters related to the entire instrument.

Operation

Sets the screen to be shown on the display when the instrument is turned on.
Settings: Perform, Live Set

Opens the screen for ribbon controller calibration.
Use it when the ribbon controller does not respond correctly.

Opens the screen for touchscreen calibration.
Use it when the touchscreen does not respond correctly.

System

[UTILITY] → Settings → System

[UTILITY] + [DAW REMOTE] (→ Calibrate Touch Panel setting)

Power on Mode

Calibrate Ribbon Controller

Calibrate Touch Panel

Initial Live Set Bank (Initial Live Set Bank)
Initial Live Set Page (Initial Live Set Page)
Initial Live Set Slot (Initial Live Set Slot)
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When Power On Mode is set to Live Set, use this parameter to set the initial Live Set Slot to be
selected after startup.

NOTE
You can also set the slot by selecting a Performance on the Live Set screen, opening this screen, and then
tapping the Set Current Slot button.

Sets the current Performance to the Live Set slot selected after startup.

Initializes all Utility screen settings.

Turns the touchscreen operation sound on or off.
Settings: Off, On

Sets the Part Name to show the Category and Part Type or just Part Name.
Settings: Type, Name

Determines the font size of the contents names and category names on the Live Set screen and
the Category Search screen.
Settings: Normal, Large

Initializes all data in the User area of User memory (Performances, Motion Sequences, Live
Sets, and such) and all settings on the Utility screen.

NOTICE

When Initialize User Data is carried out, all applicable data and system settings you created
will be reset to the factory default.
Be careful not to lose important data. It is also recommended saving the necessary settings
to a USB flash drive in advance.

Sets the flashing function of the Super Knob on or off.
Settings: Off, On

Set Current Slot (Set Current Slot to Initial Live Set)

Initialize All Settings

Beep

Part Display

Live Set Font

Initialize User Data

Knob Flash (Super Knob LED Blink)

484



Sets the brightness of lighting on the Super Knob.
Settings: 0–128

Controls the dimming of the button lamps.
Settings: Off, 1/4, 1/2

Initializes all data in User memory and all Utility screen settings.

NOTICE

When Initialize User Data is carried out, all applicable data and system settings you created
will be reset to the factory default.
Be careful not to lose important data. It is also recommended to save the necessary settings
to a USB flash drive in advance.

Shows the firmware version of the instrument.

On the Load screen, you can load files and data.

Operation

KnobBrightness

Half Glow (LED Half Glow Brightness)

Initialize All Data

Product Info

Contents

Load

[UTILITY] → Contents → Load

[SHIFT] + [STORE]
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All data or a specific set of data is loaded from a single file saved on a USB flash drive or setting
stored on the instrument.
Here, you can select which set of data in a file to load.
Available settings vary depending on the route you take to open the screen.

Settings: The file types which can be loaded are as follows.

Content Type Device Type
File

extension Description

User File File

.Y2U
(.Y2W)

.X7U

.X8U

User file saved on a USB flash drive is loaded into
the User area of User memory.

When the User file has been divided, both .Y2U
and .Y2W must be saved on the USB flash drive.

The following settings are included in a User file.

Content Type

Performance
Arpeggio
Motion Sequence
Curve
Live Set
Micro Tuning
Waveform
Audition
Utility settings (.Y2U only)
Quick Setup (.Y2U only)
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Content Type Device Type
File

extension Description

Library File File

.Y2L
(.Y2M)

.X7L

.X8L

Library files saved on a USB flash drive are loaded
into the Library area of User memory.

When a Library file has been divided, both .Y2L
and .Y2M must be saved on the USB flash drive.

The following settings are included in a Library file.

Backup File File

.Y2A
(.Y2B)

.X7A

.X8A

Backup files saved on a USB flash drive are loaded
into the User memory.
A backup file includes everything in the User and
Library areas, as well as Songs, and Patterns.

When a backup file has been divided, both .Y2A
and .Y2B must be saved on the USB flash drive.

Song&Perf
(Song &
Performance)

Internal data

Only the specified Song is loaded from Songs
stored in the User area of the User memory.
Both MIDI sequences and Performances can be
loaded.

Song Internal data
Only the specified Song is loaded from Songs
stored in the User area of the User memory.
Only MIDI sequences can be loaded.

.mid File File .MID
Standard MIDI Files (SMF) saved on a USB flash
drive are loaded (either in format 0 or format 1).

.wav File File .WAV Audio files saved on a USB flash drive are loaded.

Pattern&Perf
(Pattern &
Performance)

Internal data

Only the specified Pattern is loaded from Patterns
stored in the User area of the User memory.
Both MIDI sequences and Performances can be
loaded.

Pattern Internal data
Only the specified Pattern is loaded from Patterns
stored in the User area of the User memory.
Only MIDI sequences can be loaded.

Performance
Arpeggio
Motion Sequence
Curve
Live Set (only one bank)
Micro Tuning
Waveform
Audition
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Content Type Device Type
File

extension Description

Audio File * File
.WAV
.AIF

Audio files saved on a USB flash drive are loaded
as Waveforms.

Example: [PERFORMANCE] → [EDIT/ ] →
Part selection → Element selection → Osc/Tune

Motion Seq
(Motion Sequence)
*

Internal data
Only the specified sequence is loaded from the
Motion Sequences saved (stored) in the User area
of the User memory.

Smart Morph * Internal data
Only Smart Morph data is loaded from the
Performance saved (stored) in the User area of
User memory.

NOTE
Content types marked with an asterisk (*) are not displayed when this screen is opened from the Utility
screen.

Indicates the name of the parent folder and the name of the current folder.
Once you tap on the parent folder name, it is then the current folder.

Sets whether the Job function is enabled (On) or disabled (Off).
When this parameter is turned on, tapping on the current file, folder, or content will call up the
Rename or Delete context menu.
When you tap on the connected USB flash drive, the context menu for Format will appear.
Settings: Off, On

Indicates the used capacity and total capacity of the selected storage.
The indication differs depending on the content type.

Indicates the folders and files within the current folder.

Sets the sort order for the files in File select.

Parent Folder Name
Current Folder Name

Job

Free Storage

Folder and file select

Sort
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Settings: Name, Size, Date, Default (Varies by content type)
Name: Sorts by name. The down arrow indicates that the list is arranged in ascending
order (A to Z). The up arrow indicates that the list is arranged in descending order.
Size: Sorts in order of data size. The down arrow indicates that the list is in ascending
order (small to large). The up arrow indicates that the list is in descending order. This
is not available when the content type is Motion Seq, Song, Song&Perf, Pattern,
Pattern&Perf, Performance, or Smart Morph.
Date: Sorts by the date the setting was stored. The down arrow indicates that the list
is arranged in descending order (new to old). The up arrow indicates that the list is
arranged in ascending order. This is available only when the content type is Motion
Seq, Song, Song&Perf, Pattern, Pattern&Perf, Performance, or Smart Morph.
Default: Sorts in ascending order of content number. This is available only when the
content type is Song, Song&Perf, Pattern, Pattern&Perf, Performance, Motion Seq, or
Smart Morph.

Selects the mode for loading.
This is shown only for a User File or a Library File.
Settings: Default, 1 Perf

Default: Loads all Performances.
1 Perf: Loads only a specified Performance.

Select the key to which the loaded WAV or AIFF is to be assigned.
This is shown only for audio files.
Settings: Keyboard Select (C−2–G8), All

Sets whether Center Key is updated by keyboard operation.
This is shown only for audio files.

When the files appearing in the File select do not fit on a single page, a scroll button will appear
to allow you to select a page.

On the Save screen, you can save files and data.

Operation

Mode

Key (Center Key)

Keyboard Select

Page

Save
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[UTILITY] → Contents → Save

This is basically the same as the Load screen.

All data or a specific set of data is saved on a USB flash drive or stored on the instrument.
Here, you can set which data to store or save.
Available settings vary depending on the route you take to open the screen.
Settings: The following table shows the content types that can be stored or saved.

Content Type Device Type
File

extension Description

Performance Internal data
Saves (Stores) the Performance to the User area of
the User memory.

Content Type
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Content Type Device Type
File

extension Description

User File File
.Y2U
(.Y2W)

Settings stored in the User area of User memory
are saved to a USB flash drive as a User file.

The following settings are included in a User file.

When the file size exceeds 2 GB and the file has
been divided, both .Y2U and .Y2W must be
handled as a set.

Library File File
.Y2L
(.Y2M)

Settings stored in the Library area of User memory
are saved to a USB flash drive as a Library file.

The settings contained in the Library file are as
follows (same as the User file, except for the Utility
settings).

When the file size exceeds 2 GB and the file has
been divided, both .Y2L and .Y2M must be handled
as a set.

Performance
Arpeggio
Motion Sequence
Curve
Live Set
Micro Tuning
Waveform
Audition
Utility settings
Quick Setup

Performance
Arpeggio
Motion Sequence
Curve
Live Set (only one bank)
Micro Tuning
Waveform
Audition
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Content Type Device Type
File

extension Description

Backup File File
.Y2A
(.Y2B)

Settings stored in the User memory are saved to a
USB flash drive as a backup file.

A backup file includes everything in the User and
Library areas, Songs, and Patterns.

When the file size exceeds 2 GB and the file has
been divided, both .Y2A and .Y2B must be handled
as a set.

.mid File File .MID
MIDI data stored in the Song and Pattern area of
User memory is saved to a USB flash drive as a
Standard MIDI File (SMF; only in format 1).

Motion Seq
(Motion Sequence)
*

Internal data
Stores (saves) the Motion Sequence being edited
to the User area.

NOTE
Content types marked with an asterisk (*) are not displayed when this screen is opened from the Utility
screen.

On the Data Utility screen, you can manage files and data in User memory.

Operation

[UTILITY] → Contents → Data Utility

Data Utility
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This is basically the same as the Load screen.

Shows the Content types in User memory as folders. Tap the folder to open.

Tapping on the name calls up the context menu for Rename and Delete.

When Job is turned on, the following three items are displayed.

Selects all of the contents in the folder.
Displayed when nothing has been selected.

Folder select

Arp

Audition

Curve

Library

Live Set

MicroTuning

Motion Seq

Pattern

Performance

Song

Waveform

Content Select

Select All

Unselect All
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Unselects all of the contents in the folder.
Displayed when any of the contents have been selected.

Deletes all selected content.
Displayed when any of the contents have been selected.

On the Library Import screen, you can copy specific Performance(s) in the library to the User
Bank.

Operation

[UTILITY] → Contents → Library Import

This is basically the same as the Load screen.

Selects all Performances in the current library folder.
Shown only when no Performance has been selected.

Deselects all Performances in the current library folder.
Displayed only when any Performance has been selected.

Delete

Library Import

Select All

Unselect All

Import to User Bank
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Copies the selected Performance to the User Bank.
When this operation is carried out, the User Waveforms and User Arpeggios, User Curves, User
Micro Tuning, and User Auditions used in the selected Performance are also copied to the User
Bank.
Displayed only when any Performance has been selected.

On the Tempo Settings screen, you can set the parameters related to tempo and
synchronization.

Operation

Sets the Performance tempo.
When MIDI Sync is set to MIDI or A/D In and the instrument is set to synchronize to an external
device, Ex.Tempo will be shown instead of the setting value.
Settings: 5–300

Sets the flashing of the Super Knob on or off.
Settings: Off, On

Tempo Settings

[TEMPO/TAP]

[UTILITY] → Tempo Settings

 (Tempo Settings) icon

Tempo

Knob Flash (Super Knob LED Blink)

Global Tempo
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When this parameter is set to off, a tempo setting for each Performance is used.
When set to on, the current tempo is retained when you change the Performance.
Settings: Off, On

You can set the desired tempo by tapping the area shown on the screen or by pressing
(tapping) the [ENTER] button on the top panel while the cursor is on this parameter.
Or you can use the [TEMPO/TAP] button to set the tempo in the same way.
This parameter is not available when MIDI Sync is set to MIDI and the instrument is set to
synchronize to an external device.

NOTE
When MIDI Sync is set to A/D In, the tempo search starts at the first tapping action.

Sets the parameters related to synchronization to the connected external device.
Select Internal for using the internal clock of this instrument, MIDI for using the external MIDI
clock of the DAW software on the computer or the external MIDI device, or A/D In (ABS) for
using the audio signal input from the A/D INPUT jacks, for playing back the Arpeggios, Motion
Sequencer, and Songs.
Settings: Internal, MIDI, A/D In (ABS)

Internal: Synchronizes to the internal clock. For using this instrument by itself or as
the primary clock source for other devices.
MIDI: Synchronizes to the MIDI clock received from the external MIDI device. For
using the external device as the primary clock source.
A/D In: Synchronizes to the tempo of the audio signal input from the A/D INPUT
jacks.

Sets the MIDI clock messages to be transmitted.
Settings: Off, On

Sets when to play back the click sound (metronome).
Settings: Off, Rec, Rec/Play, Always

Off: No click sound is played.
Rec: The click sound is played during Song or Pattern recording.
Rec/Play: The click sound is played during Song or Pattern recording and playback.
Always: The click sound is always played.

Tap Tempo

MIDI Sync

Clock Out (MIDI Clock Out)

Mode (Click Mode)

Precount (Click Precount)
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Sets the number of count-in measures from the time the [ ] (Play) button is pressed until
recording actually starts when recording a Song or Pattern.
Settings: Off (recording starts when you press the [ ] (Play) button), 1meas–8meas

NOTE
Since the click sound uses the internal Tone Generator, the use of the click sound affects the overall
polyphony of the instrument.

Sets the volume of the click sound.
Settings: 0–127

Sets the beat at which the click sound is played.
Settings: 1/16 (sixteenth notes), 1/8 (eighth notes), 1/4 (quarter notes), 1/2 (half notes), Whole

(whole notes)

Selects the type of click sound.
Settings: 1–10

Adjusts the timing for starting the next Arpeggio when playing back an Arpeggio for multiple
Parts. When set to Off, the Arpeggio is played back when you play the Part on the keyboard.
Settings: Off, 60 (thirty-second note), 80 (sixteenth note triplet), 120 (sixteenth note), 160

(eighth note triplet), 240 (eighth note), 320 (quarter note triplet), 480 (quarter note)

Sets the output destination for the click sound.
Settings: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–USB30

MainL&R: Outputs in stereo (two channels) to the OUTPUT [L/MONO] and [R] jacks.
AsgnL&R: Outputs in stereo (two channels) to the ASSIGNABLE OUTPUT [L] and
[R] jacks.
USB1&2–USB29&30: Outputs in stereo (channels 1 and 2, to channels 29 and 30) to
the [USB TO HOST] terminal.
AsgnL: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [L] jack.
AsgnR: Outputs in mono (one channel) to the ASSIGNABLE OUTPUT [R] jack.
USB1–30: Outputs in mono (channels 1 to 30) to the [USB TO HOST] terminal.

Volume (Click Volume)

Beat (Click Beat)

Type (Click Type)

Sync Quantize (Arpeggio Synchro Quantize Value)

Click Out (Click Output Select)
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On the Effect Switch screen, you can set the parameters related to effect bypass.
The settings on this screen are not saved (stored), so the settings are reset to the default when
the instrument is restarted.

Operation

Sets the Insertion Effect on or off.
Settings: Off, On

Sets the System Effect on or off.
Settings: Off, On

Sets the Master Effect on or off.
Settings: Off, On

Sets the Master EQ on or off.
Settings: Off, On

Effect Switch

[UTILITY] → Effect Switch

Tap the  (Effect) icon

[SHIFT] + [QUICK SETUP]

Insertion FX (Insertion Effect)

System FX (System Effect)

Master FX (Master Effect)

Master EQ
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Sets the Arpeggio Bypass on or off.
When this parameter is set to on, all Arpeggio operations are disabled.
Settings: Off, On

NOTE

Sets lock for the Keyboard Control on or off.
When set to on, Keyboard Control is locked for all Parts.
Turning it off unlocks Keyboard Control.

This is useful for creating or editing each MIDI track separately, for example, when using the
instrument as a 16-part multi-timbral sound module with the DAW software.

NOTE
When the Keyboard Control for each Part is changed while Keyboard Control Lock is on, Keyboard Control
will be unlocked.

Settings: Off, On

When this parameter is set to on, the volume of the A/D Part stays the same when you change
the Performance, and other parameters related to the A/D Part also stay the same.
When this parameter is set to off, the volume set for the Performance is used when you change
Performances, and other parameters related to the A/D Part will change accordingly.
Master FX and Master EQ are switched on and off simultaneously.
Settings: Off, On

On the Other Info screen, you can find other information.

Arp Bypass (Arpeggio Bypass)

When Arpeggio Bypass is on, the [ARP ON/OFF] button flashes.
When the Arpeggio Bypass is on, changing the Arpeggio switch for any Part will turn off Arpeggio Bypass.
The Songs recorded by using the Arpeggio function will have the Arpeggio sequence included in the data.
When you edit such Songs in the DAW software, you can set Arpeggio Bypass to On to prevent the
Arpeggio playback from being affected twice.

Kbd Ctrl Lock (Keyboard Control Lock)

Global A/D

Other Info
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Shows the list of shortcut operations for simultaneous pressing of the [SHIFT] button and other
buttons.

Shows content such as copyrights.

Shift Function

Legal Notices
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Contents

Screens shown by pressing specific buttons

Panel Lock

Split Job

NOTE RANGE

NAVIGATION

FX OVERVIEW

Store

DAW REMOTE

Control Assign

Control View
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Using the panel lock function prevents accidental operation during live performances.

Operation

When the Home screen or the Live Set screen is shown, press [SHIFT] + [TEMPO/TAP]

When the Panel Lock function is engaged, all operations will be unavailable, except the
keyboard, pedals, Master Volume, Super Knob, Pitch bend wheel, Modulation wheel, Ribbon
controller, and, of course, disengaging the unlock operation. This lock also applies to
touchscreen operations.

When the Panel Lock function is engaged, press [SHIFT] + [TEMPO/TAP] again to disengage
the Panel Lock.

Panel Lock
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Sets the Split function (for dividing the entire keyboard into sections, allowing you to play each
section with a different sound).

Operation

[SPLIT]

Specifies the number of split points.
Settings: 1–3

Specifies the key for the split point.
Settings: C#−2–G8

Shows the Part name and the Split group. Tapping on the Part name calls up the menu for
Category Search and Delete.
Press a Group button to assign the Part to the group.
Tap the group buttons while holding down the [SHIFT] button to assign a single Part to multiple
groups.

Split Job

Split Points

Split Point 1–3

Part Name
Group A–D

[+] (Add)
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When you tap [+], the Part Category Search screen or the Performance Merge screen opens,
so that you can add a Part to the Performance.

Cancels group assignments.

Confirms the settings and closes the screen.
Tapping the  (close) on the upper left cancels the setup and closes the screen.

X (Cancel)

Done
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Operation

[SHIFT]+[SPLIT]

The Part—Note view is shown on the Home screen.
The cursor moves to TG Note Limit Low of the selected Part and you can use the instrument’s
keyboard to enter the Note Range value.

NOTE RANGE
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This is the Navigation screen, which provides convenient and instant navigation when editing
the various parameters.

Operation

Tapping the icons calls up the corresponding setting screens.
Also, pressing the [NAVIGATION] button during editing calls up the current location icon .
From the NAVIGATION screen, you can jump to Filter and Amp EG of the Elements as well as
those of Part Common.

NAVIGATION

[NAVIGATION]

(With the View Mode on the Home screen is set to Default) Tap the Navigation button shown
on the display
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On the FX OVERVIEW screen, you can check the status of effect settings and easily access
screens for advanced settings.

Operation

Switches the Parts to display.
Settings: 1–4, 5–8, 9–12, 13–16, A/D in

Turns all Insertion Effects (A and B) on or off.
Settings: Off, On

Turns the Variation and Reverb effects on or off.
Settings: Off, On

FX OVERVIEW

[SHIFT]+[NAVIGATION]

(With the View Mode on the Home screen is set to Default) Tap the Fx Overview button
shown on the display

Switching Parts for display

All Ins

Var + Rev

Ins A
Ins B
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Shows the corresponding screen for detailed settings.

Switches each effect on or off.
Settings: Off, On

Sets the type and preset for each effect.
Settings: Effect Type: See the Effect types.

Preset: Refer to the Data List.

Var
Rev
MFX
MEQ

Effect switch

Type

Preset
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This is the confirmation screen when saving (storing) the current Performance in the User area.

Operation

[STORE]

Registers as a new Performance.

When a slot in the User Live Set bank is selected, a message confirming the update of the Live
Set slot will appear. To proceed with the update, check the box and select Store As New
Performance.

Saves the Performance you are editing over the existing settings (Bank, MSB, LSB, and
Program Change number) shown on the display.

Shown when saving is not possible due to an error such as “Performance full.”
[UTILITY] → Contents → Data Utility screen is displayed.

Store

Store As New Performance

Update Current Live Set Slot

Overwrite Current Perf.

Jump to Data Utility
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Pressing the [DAW REMOTE] button enables the DAW remote function, allowing you to
conveniently control your preferred DAW with the controllers on the instrument.

Operation

[DAW REMOTE]

Select the DAW remote function from three modes of operation.
You can also switch modes by pressing [DAW Remote] + one of the Slot number and Category
name selection buttons (such as [Piano], [Keyboard], and [Organ]).
Settings: Track, Plugin, Transport

Track: Mode for controlling multiple tracks on the DAW at once. Knob and control
slider operations are sent as Mackie Control compatible protocols from Port 2.
Plugin: Mode for controlling a specific plugin on the DAW. Knob and control slider
operations are sent as messages in Control Change Numbers for remote functions
from Port 1.
Transport: Mode for playing the keyboard while playing back the recorded data on
the DAW, or recording your keyboard performance on the DAW. You can use the
Sequencer transport buttons to start or stop the playback on the DAW. All controllers
except the Sequencer transport buttons operate as they normally do.

Opens the settings screen for each controller and the remote function.

DAW REMOTE

Mode (Remote Control Mode)

Switching screens
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Settings: Knob/Slider, Scene Sw, Display Knob, AS/Ribbon, Pedal, Settings

Sets Local Control on or off.
This is the same setting that can be made from: [UTILITY] → Settings → MIDI I/O screen.

Sets the Data dial and Cursor buttons on the Top panel for controlling the DAW.

Outputs the Track group selection (by eight tracks at a time).

Local (Local Control)

Use for Remote

On: For controlling the DAW

Off: For controlling the Main display on the top panel.

Track (Track Select)

For using controllers

Track mode

Controllers
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Controllers On the DAW

1 Knobs 1–8 Controls the pan of the track.

2 Control sliders 1–8 Controls the volume of the track.

3
PART buttons, [PART SELECT] button,
[KEYBOARD CONTROL] button

Selects track(s), and switches mute and solo of the
selected track(s) on or off.

4 SCENE buttons Function

5 Data dial, cursor buttons Moves the cursor position or Song position.

6 Sequencer transport buttons
Controls the transport actions (recording and
playback).

7 BANK buttons Selects a track group (eight tracks at a time).

8 PAGE buttons Selects a track group (one track at a time).

9 [SONG/PATTERN] button Turns loop playback on or off.

Other controllers are set to send the Control Change messages set in remote mode.

Plugin mode
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Controllers DAW operation

Knobs 1–8 Any Control Change you have selected.
(The Control Change number set with Edit in the DAW Remote screen is output.)Control sliders 1–8

* PART buttons, [PART SELECT] button, [KEYBOARD CONTROL] button, data dial, cursor
buttons, sequencer transport buttons, BANK buttons, and PAGE buttons behave the same way
as in Track mode.

Controllers

Transport mode
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Controllers On the DAW

Data dial, cursor buttons Moves the cursor position or Song position.

Sequencer transport button Controls the transport actions (recording and playback).

[SONG/PATTERN] button Turns loop playback on or off.

* Other controllers operate as normal.

Sets the Control Change message, such as the control number and channel mode, that is
output from Port 1.
The settings on each tab are as follows:

Controllers

For Editing

Edit

Common

Local (Local Control)
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Sets Local Control on or off.
This is the same setting that can be made from: [UTILITY] → Settings → MIDI I/O screen.

Sets the Data dial and Cursor buttons on the Top panel for controlling the DAW.

Sets the control number for the knobs and control sliders.
Settings: 1–95

Sets the control number for the SCENE buttons.
Settings: 1–95

Switches the operating mode of the SCENE buttons.
Settings: Momentary, Latch

Sets the control number for the Display Knobs.
Settings: 1–95

Sets the control number for the [PORTAMENTO] button.
Settings: 1–95

Switches the operating mode of the [PORTAMENTO] button.
Settings: Momentary, Latch

Use for Remote

On: For controlling the DAW.

Off: For controlling the Main display on the top panel.

Knob/Slider

CC Num. (Control Change Number)

Scene SW

Scene1–8 (Scene 1–8 Control Number)

Latch (Scene 1 Switch Mode)
Momentary (Scene 1 Switch Mode)

Display Knob

Display Knob 1–8CC# (Display Knob 1–6 Control Number)

AS / Ribbon

Portamento Switch

Portamento Switch Latch

Porta Knob (Portamento Knob)

515



Sets the control number for the PORTAMENTO [TIME] knob.
Settings: 1–95

Sets the control number for the ribbon controller.
Settings: 1–95

Switches the operating mode of the ribbon controller.
Settings: Hold, Reset

Sets the control numbers for the [ASSIGN 1] button, [ASSIGN 2] button, and [MSEQ TRIGGER]
button.
Settings: 1–95

Switches the operating mode of the [ASSIGN 1] button, [ASSIGN 2] button, and [MSEQ
TRIGGER] button.
Settings: Momentary, Latch

Sets the control number for Foot Controller 1 and Foot Controller 2.
Settings: 1–95

Shows the control number for the foot switch.
Settings: 1–95

Switches the operating mode of the foot switch.
Settings: Momentary, Latch

Ribbon Ctrl (Ribbon Controller Control Number)

RB Mode

Assign SW 1 (Assignable Switch 1 Control Number)
Assign SW 2 (Assignable Switch 2 Control Number)
MS Trigger (Motion Seq Trigger Switch Control Number)

Assign SW 1 Latch (Assignable Switch 1 Mode)
Assign SW 2 Latch (Assignable Switch 2 Mode)
MS Trigger Latch (Motion Seq Trigger Switch Control Number)

Pedal

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)

FS (Foot Switch Control Number)

FS Mode (Foot Switch Mode)
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Selects the particular DAW for use with this instrument.
Settings: Cubase, Logic Pro, Pro Tools, Live

Sets the MIDI channel for input and output of the Common and the Part with the Keyboard
Control Switch to be set to On.
The MIDI channel set here is used also for sending the Control Change message from DAW
Remote.
This is the same setting that can be made from: [UTILITY] → Settings → MIDI I/O screen.
Settings: Ch1–Ch16

Settings

DAW

MIDI I/O Ch.
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Registers the combination of Source and Destination in the Controller Set.

Operation

(When the cursor is on the parameter) Press the [CONTROL ASSIGN] button

Move the controller you wish to use for changing the parameter, or select one from the Motion
Sequencer Lane or Envelope Follower.

NOTE
When you move the Super Knob but there aren’t any unused assignable knobs to proceed with the setting, an
error message will appear.

When a Part parameter is selected, you can set the Assignable knobs to change the Common
parameters by operating an Assignable Knob while holding down the [COMMON] button.

Control Assign
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You can check the settings of the controller being operated.

Operation

When you move the controller you wish to check, the Control Assign screen opens and the
configuration information is displayed.

Control View

[SHIFT] + [CONTROL ASSIGN]

(With the View Mode on the Home screen is set to Default) Tap the Control View button
shown on the display
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Contents

Other information

Effect types

Effect parameters

Shortcut operations

Message List

Troubleshooting

Restoring the factory default settings (Initialize All Data)
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No Effect Disables the Effects. Does not output the sound.

Thru
Sets the Effect to Thru. The input sound is output without any effects
being applied.

HD Hall Simulates the natural acoustics of a concert hall.

REV-X Hall Hall reverb using the REV-X reverb algorithm

R3 Hall
Hall reverb using the reverb algorithm of the ProR3 Digital Reverb
Processor

SPX Hall Hall reverb from the classic SPX1000

HD Room Simulates the natural acoustics of a room.

REV-X Room Room reverb using the REV-X reverb algorithm

R3 Room
Room reverb using the reverb algorithm of the ProR3 Digital Reverb
Processor

SPX Room Room reverb from the classic SPX1000

HD Plate Simulates a plate reverb.

R3 Plate
Plate reverb using the reverb algorithm of the ProR3 Digital Reverb
Processor

SPX Stage Stage reverb from the classic SPX1000

Space Simulator Allows you to specify the width, height, and depth of the room size.

Gated Reverb Produces a gated reverb.

Reverse Reverb Produces reverse playback of a gated reverb.

Shimmer Reverb
Creates mystical shimmering effects by adding pitch-changed Reverb
sounds.

Cross Delay
The feedback of the delayed sound on each of the two channels is
routed to the opposite channel. Produces alternate delayed sounds on
the right and left.

Tempo Cross Delay Tempo-synchronized Cross delay

Tempo Delay Mono Tempo-synchronized Mono delay

Effect types

Reverb

Delay
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Tempo Delay Stereo Tempo-synchronized Stereo delay

Control Delay
Delay for creating scratch sounds by changing the delay length in real-
time.

Delay LR
Produces two delayed sounds on the left and right, with two feedback
delays.

Delay LCR Produces three delayed sounds on the left, center, and right.

Analog Delay Retro Simulates a bucket-brigade analog delay, set to short delay.

Analog Delay Modern Simulates a bucket-brigade analog delay, set to long delay.

G Chorus Creates a deep sound with complex modulation.

2 Modulator
Allows you to set the pitch modulation and amplitude modulation.
Spreads out the sound naturally.

SPX Chorus
Chorus effect that uses a 3-phase LFO to add modulation and
spaciousness to the sound.

Symphonic Multiplexes the modulations for creating more spaciousness.

Ensemble Detune
Chorus effect without modulation, created by adding a slightly pitch-
shifted sound.

VCM Flanger Flanger using VCM technology

Classic Flanger Flanger with typical swirling sounds

Tempo Flanger Flanger with tempo synchronized LFO

Dynamic Flanger
Flanger that controls the delay modulation in real-time depending on
the level of the input sound.

Control Flanger Allows manual operation instead of the LFO.

VCM Phaser Mono Mono Phaser using VCM technology

VCM Phaser Stereo Stereo Phaser using VCM technology

Tempo Phaser Phaser with tempo synchronized LFO

Dynamic Phaser
Effect that controls the phase in real-time depending on the level of the
input sound

Control Phaser Allows manual operation instead of the LFO.

Chorus

Flanger

Phaser
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Auto Pan Moves the Pan left and right.

Tremolo Creates cyclical changes to the volume.

Rotary Speaker 1 Simulates a rotary speaker.

Rotary Speaker 2 Simulates a rotary speaker including an amplifier.

VCM Rotary Speaker Classic
Standard rotary speaker effect using VCM technology. Suitable for
organs.

VCM Rotary Speaker Overdrive
Rotary speaker effect using VCM technology. Simulates the distorted
sound of a rotary speaker with a transistor preamp connected.

VCM Rotary Speaker Studio
Rotary speaker effect using VCM technology, with three-dimensional
rotation.

Amp Simulator 1 Simulates a guitar amplifier.

Amp Simulator 2 Simulates a guitar amplifier.

Comp Distortion Combines Compressor and Distortion.

Comp Distortion Delay Combines Compressor, Distortion, and Delay.

U.S. Combo American combo amp simulator

Jazz Combo Jazz combo amp simulator

U.S. High Gain American high gain amp simulator

British Lead British stack amp simulator

Multi FX Multi-effect processor for guitars

Small Stereo Stereo distortion for guitar sounds

British Combo British combo amp simulator

British Legend British stack amp simulator

VCM Compressor 376 Compressor using VCM technology

Classic Compressor Simple, easy-to-use compressor. Suitable for solo instruments.

Multi-band Comp
Splits the sound into three bands and applies compressor separately
on those bands.

Uni Comp Down Compressor with a downward algorithm that suppresses loud sounds.

Uni Comp Up Compressor with an upward algorithm that amplifies soft sounds.

Trem/Rtr (Tremolo & Rotary)

Dist (Distortion)

Comp (Compressor)
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Parallel Comp
Compressor applying parallel processing of the compressed sounds
and dry sounds

VCM Auto Wah
Auto Wah using VCM technology. Creates cyclical changes to the
center frequency of the filter.

VCM Touch Wah
Touch Wah using VCM technology. Changes the center frequency of
the filter depending on the level of the input sound.

VCM Pedal Wah
Pedal Wah using VCM technology. Changes the center frequency of
the filter by operating controllers, such as a pedal.

Lo-Fi Downgrades the quality of the audio input for a lo-fi sound.

Noisy Adds noise to the sound.

Digital Turntable Adds turntable noise to the sound.

Bit Crusher
Produces distortion by reducing the resolution or bandwidth of the
digital sound.

Ring Modulator Changes the input to a metallic sound.

Dynamic Ring Modulator
The OSC Freq parameter for the Ring Modulator is controlled in real-
time depending on the level of the input sound.

Dynamic Filter
The filter cutoff frequency is controlled in real-time depending on the
level of the input sound.

Auto Synth Resynthesizes the input signal using delay and modulation.

Spiralizer P
Special phaser-based filter with seemingly endless up or down pitch
changes.

Tempo Spiralizer P Spiralizer with tempo synchronized LFO

Spiralizer F
Special flanger-based filter with seemingly endless up or down pitch
changes.

Tempo Spiralizer F Spiralizer with tempo synchronized LFO

Isolator Controls the volume of each band by using a powerful filter.

Slice Slices the Amplitude EG of the input sound.

Tech Modulation Applies special modulation.

Control Filter A filter that allows manual operation of the cutoff frequency.

Wah

Lo-Fi

Tech
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Vinyl Break
Causes the pitch to drop gradually to create a sound effect of a
turntable stopped by hand or turning the device off.

Beat Repeat (even)
Creates mechanical beats by repeatedly playing sampled sounds. The
length of the repeat is specified as a fraction of a beat with a
denominator of an even number, such as 1/2, 1/4, 1/8, 1/16, and so on.

Beat Repeat (triplet)

Creates mechanical beats by repeatedly playing sampled sounds. The
length of the repeat is specified as a fraction of a beat with a
denominator having multiples of three, such as 1/3, 1/6, 1/12, and so
on.

Beat Repeat (even+tri.)
Creates mechanical beats by repeatedly playing sampled sounds.
Contains both even and triplet settings.

Beat Repeat (free)
Creates mechanical beats by repeatedly playing sampled sounds. The
length of the repeat is specified as a decimal number.

VCM EQ 501 5-band EQ using VCM technology

Presence Gives greater sonic presence to the input sound.

Harmonic Enhancer Adds harmonic overtones to make the input sound stand out.

Stereophonic Optimizer Adjusts the stereo location in the sound field.

Talking Modulator Resynthesizes the input sound to create vowel formants.

Wave Folder
Controls the harmonic overtones to create a rich sound that changes
over time.

VCM Mini Filter
Filter that adds thickness and depth to the sound. Simulates analog
synthesizer circuitry.

VCM Mini Booster
Booster with distinctive characteristics. Simulates analog synthesizer
circuitry.

Damper Resonance Simulates the resonance of open string notes of an acoustic piano.

Pitch Change Changes the pitch of the input sound.

Early Reflection An effect created by isolating the early reflections of the reverb.

Vocoder

Extracts characteristics from the microphone sound and applies it to
the Part played on the keyboard. Creates a distinctive, “robot voice”
effect when you play the keyboard and sing or speak into the
microphone at the same time.

NoiseGate+Comp+Eq
Contains Noise Gate, Compressor, and 3-band EQ. Suitable mainly for
vocals.

Misc
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A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Display name Parameter name Effect types using the parameter Description

AEG Phase AEG Phase Slice
Shifts the phase of
the Amplitude EG.

AM Depth AM Depth
2 Modulator, Tremolo, Noisy, Auto Synth,
Shimmer Reverb

Sets the depth of
Amplitude
Modulation.

AM Freq AM Frequency Shimmer Reverb
Sets the Amplitude
Modulation speed.

AM Inverse R AM Inverse R Auto Synth

Sets the phase of
the Amplitude
Modulation for the
right channel.

AM LR Phase AM LR Phase Shimmer Reverb

Sets the phase of
the Amplitude
Modulation
between the L and
R channels.

AM Speed AM Speed Noisy, Auto Synth
Sets the Amplitude
Modulation speed.

AM Wave AM Wave Auto Synth
Selects the wave
for modulating the
Amplitude.

AM Waveform AM Waveforms Shimmer Reverb
Selects the wave
for modulating the
Amplitude.

Amp Type Amp Type Amp Simulator 2
Selects the
amplifier type to be
simulated.

Analog Feel Analog Feel Classic Flanger

Adds the
characteristics of an
analog flanger to
the sound.

Effect parameters
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Display name Parameter name Effect types using the parameter Description

Attack Attack
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Sets the length of
time it takes for the
compressor to
reach the
maximum.

Attack Offset Attack Offset VCM Touch Wah

Sets the length of
time it takes for the
Wah effect to be
applied.

Attack Time Attack Time

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the attack time
of the Envelope
Follower.

Beat Repeat
Sets the Attack time
of the Gate applied
to the entire sound.
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Balance Balance U.S. Combo
Adjusts the balance
between the bass
and the treble.

Bass Bass
British Combo, British Lead, British
Legend, Jazz Combo, U.S. High Gain

Adjusts the tone
quality of the bass.

Bit Bit Bit Crusher
Reduces the bit
precision.

Bit Assign Bit Assign Lo-Fi
Sets how Word
Length is applied to
the sound.

Bit Link Bit Link Bit Crusher

Sets the level of the
Side setting that
follows the Mid
value when M/S is
on.

BPF 1–10 Gain BPF1–10 Gain Vocoder
Sets the Gain of
BPFs 1–10 of the
Vocoder effect.

Break Break Vinyl Break Sets Break to On.
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Brilliant Brilliant British Combo

Adjusts the volume
of the sound for
which the bass is
cut.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Display name Parameter name Effect types using the parameter Description

Chorus Chorus Jazz Combo
Selects the Chorus
type.

Click Density Click Density Digital Turntable
Sets the frequency
of the click sound to
be repeated.

Click Level Click Level Digital Turntable Sets the click level.

Clipper Clipper
Upward Compressor, Downward
Compressor

Sets the distortion
level of the Clipper
that determines the
maximum level for
limiting the wave.

Clipper Source Clipper Source
Upward Compressor, Downward
Compressor

Selects the signal
to which the Clipper
effect is applied.

Color Color

Control Phaser, VCM Phaser Mono, VCM
Phaser Stereo

Sets the fixed
phase modulation.

Shimmer Reverb
Sets the
characteristics of
the resulting sound.

Com Release Common Release Multi Band Comp

Sets the Release
Time (the time it
takes for the
Compressor effect
to fade away) used
commonly on three
bands.

Comp Attack Comp Attack NoiseGate+Comp+Eq

Sets the length of
time for the
Compressor to be
applied.
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Comp Level Comp Level Small Stereo
Adjusts the output
level of the
compressor.

Comp Out Lvl Comp Output Level NoiseGate+Comp+Eq
Sets the output
level of the
compressor.

Comp Ratio Comp Ratio NoiseGate+Comp+Eq
Sets the ratio of the
compressor.

Comp Release Comp Release NoiseGate+Comp+Eq

Sets the length of
time it takes until
the compressor
effect fades away.

Comp Sustain Comp Sustain Multi FX, Small Stereo

Adjusts the length
of time for the
compressor to
sustain.

Comp Sw Comp SW Small Stereo
Turns the
compressor on or
off.

Comp Threshold Comp Threshold NoiseGate+Comp+Eq
Sets the input level
for the effect to be
applied.

Compress Compress Comp Distortion Delay

Sets the threshold
(or the minimum
input level) for the
compressor to be
applied.

Compression Compression Parallel Compressor

Sets the extent to
which the
compressor is
applied.
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Control Type Control Type Control Delay

When set to
Normal, the delay
effect is always
applied to the
sound. When set to
Scratch, the delay
effect is not applied
if the controller
value 0 is set to the
Delay Time. The
delay is applied to
other cases.

Cross-Feedback Cross-Feedback Shimmer Reverb

Sets the balance of
the pitch-shifted
sound on the first
routing and the
pitched sound on
the second routing
to be sent to the
opposite routing for
the feedback of the
pitch-shifted sound.

Crush Type Crush Type Bit Crusher
Sets how the bit
precision is
reduced.

Cut Cut British Combo
Sets the velocity
curve to the end of
the sound.

Cutoff

Cutoff Frequency

Beat Repeat
Cuts the high
frequencies.

VCM Mini Filter

Sets the Cutoff
Frequency of the
Filter for the effect
sound.

Cutoff Frequency
Control

Control Filter
Sets the Filter
Cutoff Frequency.
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Damper Control Damper Control Damper Resonance
Sets the amount of
resonance for the
piano damper.

Decay Decay REV-X Hall, REV-X Room
Controls how the
reverb sound
decays.

Delay Control Delay Control Multi FX
Adjusts the depth or
amount of the effect
set to Delay SW.

Delay Input Lvl Delay Input Level
Analog Delay Retro, Analog Delay
Modern

Sets the input level
to the delay.

Delay Level Delay Level Auto Synth
Sets the level of the
delayed sound.

Delay Level C Delay Level C Delay LCR
Sets the level of the
delayed sound for
the center channel.

Delay Mix Delay Mix Comp Distortion Delay
Sets the mixing
level of the delayed
sound.

Delay Offset Delay Offset
G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Dynamic Flanger

Sets the offset
value for the delay
modulation.

Delay Sw Delay SW Multi FX
Sets the delay type
or modulation type.

Delay Time Delay Time

Tempo Delay Mono, Tempo Delay Stereo
Specifies the delay
length in note
duration.

Control Delay, Auto Synth, Tech
Modulation, Multi FX, Analog Delay Retro,
Analog Delay Modern

Sets the delay
length.

Delay Time C Delay Time C Delay LCR
Sets the delay
length for the center
channel.

Delay Time L Delay Time L
Delay LR, Delay LCR, Comp Distortion
Delay

Sets the delay
length for the left
channel.
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Delay Time L>R Delay Time L>R Cross Delay, Tempo Cross Delay

Sets the delay time
for the sound that is
input from the left to
be output from the
right.

Delay Time R Delay Time R
Delay LR, Delay LCR, Comp Distortion
Delay

Sets the delay
length for the right
channel.

Delay Time R>L Delay Time R>L Cross Delay, Tempo Cross Delay

Sets the delay time
for the sound that is
input from the right
to be output from
the left.

Delay Tm Ofs R
Delay Time Offset
R

Auto Synth, Tech Modulation
Sets the offset to
the delay length for
the right channel.

Density Density

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator

Sets the density of
the reverb.

Early Reflection, Gated Reverb, Reverse
Reverb

Sets the density of
the reflections.

Depth Depth

Space Simulator
Sets the depth of
the simulated room.

VCM Flanger

Sets the Amplitude
of the LFO wave
that controls the
cyclic change of the
delay modulation.

VCM Phaser Mono, VCM Phaser Stereo

Sets the Amplitude
value of the LFO
wave that controls
the cyclic change of
the phase
modulation.

Jazz Combo
Sets the depth of
the Chorus/Vibrato.

Detune Detune Ensemble Detune
Sets the amount by
which pitch is
detuned.
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Device Device Amp Simulator 1, Comp Distortion Delay
Sets the device for
creating distortion
sounds.

Diffusion Diffusion

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Gated
Reverb, Reverse Reverb, Shimmer
Reverb

Sets the spread of
the reverb.

Tempo Phaser, Early Reflection
Sets the spread of
the selected effect.

Direction Direction

Dynamic Flanger, Dynamic Phaser, VCM
Touch Wah, VCN Pedal Wah, Dynamic
Ring Modulator, Dynamic Filter

Sets the direction of
the modulation
controlled by the
envelope follower.

Tempo Spiralizer P, Tempo Spiralizer F
Sets the direction of
the pitch shift.

Dist Drive Dist Drive Multi FX, Small Stereo
Controls the
amount of
distortion.

Dist EQ Dist EQ Multi FX, Small Stereo

Switches the EQ
type for adjusting
the tone quality of
distortion.

Dist Presence Dist Presence Multi FX, Small Stereo
Adjusts the tone
quality for each
distortion type.

Dist Sw Dist SW Multi FX
Sets the distortion
type.

Dist Tone Dist Tone Multi FX, Small Stereo
Adjusts the tone
quality of distortion.

Dist Type Dist Type Small Stereo
Sets the distortion
type.

Distortion Distortion Jazz Combo
Sets the level of
distortion.

Divide Freq Hi Divide Freq High Multi Band Comp
Sets the Mid/High
frequency to divide
into three bands.
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Divide Freq Low Divide Freq Low Multi Band Comp
Sets the Low/Mid
frequency to divide
into three bands.

Divide Min Lvl Divide Min Level Slice
Sets the minimum
level of the sliced
section.

Divide Type Divide Type Slice
Specifies the timing
for slicing by note
duration.

Drive Drive

Noisy, Slice, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Sets the level of
distortion.

Harmonic Enhancer, Talking Modulator
Sets the level of the
effect.

Drive Horn Drive Horn Rotary Speaker 1

Sets the depth of
modulation
generated by the
rotation of the horn
(treble).

Drive Rotor Drive Rotor Rotary Speaker 1

Sets the depth of
modulation
generated by the
rotation of the rotor
(woofer).

Dry Level Dry Level Digital Turntable
Sets the level of the
dry sound.

Dry LPF Cutoff
Dry LPF Cutoff
Frequency

Digital Turntable

Sets the frequency
to cut by using the
Low-Pass Filter
applied to the dry
sound.

Dry Mix Level Dry Mix Level Auto Synth
Sets the level of the
dry sound.

Dry/Wet Dry/Wet Balance All
Sets the balance of
the dry sound and
the effect sound.
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Edge Edge Comp Distortion
Sets the curve that
determines how the
sound is distorted.

Emphasis Emphasis Lo-Fi
Sets the change of
the high frequency
characteristics.

EQ 1 Freq
EQ1(LSH)
Frequency

VCM EQ 501
Sets the cutoff
frequency of EQ1
(Low Shelving).

EQ 1 Gain EQ1(LSH) Gain VCM EQ 501
Sets the gain of the
EQ1 (Low
Shelving).

EQ 2 Freq EQ2 Frequency VCM EQ 501
Sets the center
frequency of EQ2.

EQ 2 Gain EQ2 Gain VCM EQ 501
Sets the gain of
EQ2.

EQ 2 Q EQ2 Q VCM EQ 501 Sets the Q of EQ2.

EQ 3 Freq EQ3 Frequency VCM EQ 501
Sets the center
frequency of EQ3.

EQ 3 Gain EQ3 Gain VCM EQ 501
Sets the gain of
EQ3.

EQ 3 Q EQ3 Q VCM EQ 501 Sets the Q of EQ3.

EQ 4 Freq EQ4 Frequency VCM EQ 501
Sets the center
frequency of EQ4.

EQ 4 Gain EQ4 Gain VCM EQ 501
Sets the gain of
EQ4.

EQ 4 Q EQ4 Q VCM EQ 501 Sets the Q of EQ4.

EQ 5 Freq
EQ5(HSH)
Frequency

VCM EQ 501
Sets the cutoff
frequency of EQ5
(High Shelving).

EQ 5 Gain EQ5(HSH) Gain VCM EQ 501
Sets the gain of the
of EQ5 (High
Shelving).
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EQ Frequency EQ Frequency

Noisy

Sets the frequency
to boost or
attenuate by using
the EQ.

VCM Mini Booster
Sets the frequency
of the EQ set to
Type.

EQ Gain EQ Gain Noisy
Sets the gain to
boost or attenuate
by using the EQ.

EQ High Freq EQ High Frequency

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX Chorus,
Symphonic, Ensemble Detune, Classic
Flanger, Tempo Flanger, Dynamic
Flanger, Tempo Phaser, Dynamic Phaser,
Auto Pan, Tremolo, Rotary Speaker 1,
Ring Modulator, Dynamic Ring Modulator,
Dynamic Filter, Slice, HD Hall, HD Room,
HD Plate, NoiseGate+Comp+Eq

Sets the frequency
of the high band to
boost or attenuate
by using the EQ.

EQ High Gain EQ High Gain

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX, Chorus,
Symphonic, Ensemble Detune, Classic
Flanger, Tempo Flanger, Dynamic
Flanger, Tempo Phaser, Dynamic Phaser,
Auto Pan, Tremolo, Rotary Speaker 1,
Ring Modulator, Dynamic Ring Modulator,
Dynamic Filter, Slice, HD Hall, HD Room,
HD Plate, NoiseGate+Comp+Eq

Sets the gain of the
high band to boost
or attenuate by
using the EQ.

EQ Low Freq EQ Low Frequency

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX Chorus,
Symphonic, Ensemble Detune, Classic
Flanger, Tempo Flanger, Dynamic
Flanger, Tempo Phaser, Dynamic Phaser,
Auto Pan, Tremolo, Rotary Speaker 1,
Ring Modulator, Dynamic Ring Modulator,
Dynamic Filter, Slice, Comp Distortion,
HD Hall, HD Room, HD Plate

Sets the frequency
of the low band to
boost or attenuate
by using the EQ.
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EQ Low Gain EQ Low Gain

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX Chorus,
Symphonic, Ensemble Detune, Classic
Flanger, Tempo Flanger, Dynamic
Flanger, Tempo Phaser, Dynamic Phaser,
Auto Pan, Tremolo, Rotary Speaker 1,
Ring Modulator, Dynamic Ring Modulator,
Dynamic Filter, Slice, Comp Distortion,
HD Hall, HD Room, HD Plate

Sets the gain of the
low band to boost
or attenuate by
using the EQ.

EQ Mid Freq EQ Mid Frequency

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Sets the frequency
of the mid band to
boost or attenuate
by using the EQ.

EQ Mid Gain EQ Mid Gain

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Sets the gain of the
mid band to boost
or attenuate by
using the EQ.

EQ Mid Width EQ Mid Width

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Sets the width of
the middle band to
boost or attenuate
by using the EQ.

EQ Width EQ Width Noisy
Sets the width to
boost or attenuate
by using the EQ.

ER/Rev Balance ER/Rev Balance
R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator

Sets the level
balance of the early
reflection and
reverb sounds.
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F/R Depth F/R Depth Auto Pan

Sets the depth of
the pan on the front
and rear (available
when PAN Direction
is set to L Turn or R
Turn).
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FB Hi Dmp Ofs R
FB Hi Damp Offset
R

Tech Modulation

Sets the offset to
the amount of
decay in the high
band for the R
channel.

FB High Damp
Feedback High
Damp

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator,
Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR,
Classic Flanger, Early Reflection, Gated
Reverb, Reverse Reverb, Comp
Distortion Delay, Tech Modulation

Adjusts the
attenuation of high
frequency sound by
using the feedback
sound. The smaller
the value, the faster
the attenuation of
the high frequency
sounds.

FB Level Ofs R FB Level Offset R Auto Synth, Tech Modulation
Sets the offset to
the feedback level
for the R channel.

FB Time L Feedback Time L Delay LR
Sets the length of
feedback for left
delay.

FB Time R Feedback Time R Delay LR
Sets the length of
feedback for right
delay.

Feedback Feedback

VCM Flanger, VCM Phaser Mono, VCM
Phaser Stereo, Control Flanger, Control
Phaser

Sets the level of the
output signal
returned to the
effect block.

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the level of the
output signal
returned to the
effect block.
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Feedback Feedback Level

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator,
Early Reflection, Gated Reverb, Reverse
Reverb

Sets the feedback
level of the initial
delay.

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX Chorus,
Classic Flanger, Tempo Flanger, Dynamic
Flanger, Comp Distortion Delay, Auto
Synth, Teck Modulation

Sets the level of the
delay sound to be
sent back to the
input. (Phase is
inverted for
negative values.)

Analog Delay Retro, Analog Delay
Modern

Sets the feedback
level of the delayed
sound.

Tempo Phaser, Dynamic Phaser

Sets the level of the
signal output from
the phaser and
returned to the
input. (Inverted for
negative values).

Feedback Lvl 1 Feedback Level 1 Pitch Change

Sets the feedback
level of the delayed
sound on the first
routing.

Feedback Lvl 2 Feedback Level 2 Pitch Change

Sets the feedback
level of the delayed
sound on the
second routing.

Feedback Time Feedback Time Delay LCR, Comp Distortion Delay
Sets the delay
length of the
feedback.

Filter Type Filter Type

Lo-Fi
Selects the effect
type.

Dynamic Filter, Control Filter Sets the filter type.

Beat Repeat
Sets the filter type
for the effect sound.

Fine 1 Fine 1 Pitch Change, Shimmer Reverb
Fine-tunes the pitch
on the first routing.
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Fine 2 Fine 2 Pitch Change, Shimmer Reverb
Fine-tunes the pitch
on the second
routing.

Flanger Control Flanger Control Control Flanger

Sets the delay
value (the value of
the Comb Filter) of
the delay
modulation.

Fold Fold Wave Folder Distorts the sound.

Fold Type Fold Type Wave Folder
Selects the level of
distortion.

Formant Offset Formant Offset Vocoder

Adds the offset
value to the Cutoff
Frequency of the
BPF for the input of
the instrument
sound.

Formant Shift Formant Shift Vocoder

Shifts the Cutoff
Frequency of each
BPF for the input of
the instrument
sound.

Freeze Freeze Beat Repeat

When this
parameter is set to
On, the beat is
repeated.
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Gain Gain

U.S. High Gain
Sets the gain of the
preamplifier.

VCM Mini Booster
Adjusts the Gain of
the ShelfEQ.

Gain Boost Gain Boost U.S. Combo
Switches the gain
of the power
amplifier.

Gain Limit Gain Limit Upward Compressor
Sets the maximum
Gain level.
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Gate Time Gate Time

Slice
Sets the gate time
of a slice.

Beat Repeat
Sets the gate time
of the entire sound.
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Height Height Space Simulator
Sets the height of
the simulated room.

Hi Damp Freq
High Damp
Frequency

HD Hall, HD Room, HD Plate
Adjusts the
attenuation of the
high band.

High Attack High Attack Multi Band Comp

Sets the length of
time for the
compressor to be
applied to the high
band.

High Cut High Cut U.S. Combo Cuts the high band.

High Gain High Gain Multi Band Comp
Sets the output
level for the high
band.

High Gain L
High Subband Gain
Lch

Stereophonic Optimizer

Sets the resultant
gain of the High
band after the
adjustment of the
stereo sound (L
channel).

High Gain R
High Subband Gain
Rch

Stereophonic Optimizer

Sets the resultant
gain of the High
band after the
adjustment of the
stereo sound (R
channel).

High Level High Level Isolator
Sets the level of the
high band.

High Mute High Mute Isolator
Switches the mute
for the high band.
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High Ratio High Ratio

REV-X Hall, REV-X Room, HD Hall, HD
Room, HD Plate

Adjusts the ratio of
the high
frequencies.

Multi Band Comp

Sets the
compression ratio
for the high
frequencies.

High Threshold High Threshold Multi Band Comp

Sets the minimum
input level for the
effect to be applied
to the high band.

High Treble High Treble Jazz Combo

Adjusts the tone
quality in the
frequency higher
than the Treble
setting.

Horn Accel Horn Acceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Sets how the
rotation of the horn
(treble) changes
from Slow to Fast.

Horn Decel Horn Deceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Sets how the
rotation of the horn
(treble) changes
from Fast to Slow.

Horn Fast Horn Speed Fast

Rotary Speaker 1, Rotary Speaker 2,
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the rotation
speed of the horn
(treble) for the Fast
setting.

Horn Level Horn Level
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the volume of
the horn (treble).

Horn Slow Horn Speed Slow

Rotary Speaker 1, Rotary Speaker 2,
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the rotation
speed of the horn
(treble) for the Slow
setting.

Horn Slow/Fast
Horn Slow/Fast
Time

Rotary Speaker 1

Sets the transition
time for the rotation
speed of the horn
(treble) to change
from Slow to Fast.
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HPF Cutoff
HPF Cutoff
Frequency

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Ring
Modulator, Dynamic Ring Modulator, Auto
Synth, Harmonic Enhancer, Early
Reflection, Gated Reverb, Reverse
Reverb

Sets the low
frequency to cut by
using the High-
Pass Filter.

Vocoder

Sets the Cutoff
Frequency of the
High-Pass Filter
applied to the
sound input from
the microphone.

HPF Output Lvl HPF Output Level Vocoder

Sets how much the
output from High-
Pass Filter is mixed
with the output from
the Vocoder.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Display name Parameter name Effect types using the parameter Description

Initial Delay Initial Delay

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Early
Reflection, HD Hall, HD Room, HD Plate,
Gated Reverb, Reverse Reverb

Sets the delay time
for the early
reflections.

Initial Delay 1 Initial Delay 1 Pitch Change
Sets the delay
length of the first
series of effects.

Initial Delay 2 Initial Delay 2 Pitch Change

Sets the delay
length of the
second series of
effects.

Initial Delay L Initial Delay Lch Ensemble Detune
Sets the length of
the left channel
delay.

Initial Delay R Initial Delay Rch Ensemble Detune
Sets the length of
the right channel
delay.
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Input Level Input Level

Bit Crusher, VCM Compressor 376,
Rotary Speaker 2, Parallel Compressor,
Wave Folder, VCM Mini Filter, VCM Mini
Booster

Sets the input level.

Input Mode Input Mode
G Chorus, 2 Modulator, SPX Chorus,
Auto Pan, Tremolo, Lo-Fi

Selects whether the
input sound is in
mono or stereo.

Input Select Input Select Cross Delay, Tempo Cross Delay Selects an input.

Inst Level Inst Level Vocoder
Sets the input level
of the Instrument
sound.
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Knee Knee
Upward Compressor, Downward
Compressor

Sets the curve
around the
Threshold. The
higher the value,
the shallower the
curve.
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L/R Depth L/R Depth Auto Pan
Sets the depth of
the left and right
pan.

L/R Diffusion L/R Diffusion Tempo Delay Mono, Tempo Delay Stereo

Sets the difference
of the delay on the
right and left for
creating
spaciousness.

Lag Lag
Tempo Cross Delay, Tempo Delay Mono,
Tempo Delay Stereo

Sets an additional
delay length applied
to the delayed
sound specified by
a note duration.
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Length Length Beat Repeat
Sets the length for
a repeat.

Level Offset Dyna Level Offset
Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the offset
value added to the
output of the
envelope follower.

LFO Depth LFO Depth

SPX Chorus, Symphonic, Classic
Flanger, Tempo Flanger, Ring Modulator

Sets the depth of
the modulation.

Tempo Phaser
Sets the depth of
the phase
modulation.

Wave Folder
Adjusts the depth of
the LFO effect.

LFO Shape LFO Shape Wave Folder
Adjusts the shape
of the LFO.

LFO Speed LFO Speed

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tremolo,
Ring Modulator, Multi FX

Sets the frequency
of the modulation.

Tempo Flanger, Tempo Phaser
Specifies the
modulation speed
by note duration.

Auto Pan
Sets the frequency
of the Auto Pan.

Wave Folder
Adjusts the LFO
speed.

LFO Wave LFO Wave

Classic Flanger, Ring Modulator
Selects the wave
for modulation.

Auto Pan
Sets the panning
curve.

VCM Auto Wah
Selects the wave:
sine or square.

Liveness Liveness
Gated Reverb, Reverse Reverb, Early
Reflection

Sets the attenuation
of the early
reflections.

Ln Chg Quantz
Length Change
Quantize

Beat Repeat

Quantizes the
timing for changing
the Length
parameter.
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Low Attack Low Attack Multi Band Comp

Sets the length of
time for the
compressor to be
applied to the low
band.

Low Cut Low Cut U.S. Combo Cuts the low band.

Low Gain Low Gain Multi Band Comp
Sets the output
level for the low
band.

Low Gain L
Low Subband Gain
Lch

Stereophonic Optimizer

Sets the resultant
gain of the Low
band after
adjustment of the
stereo sound (L
channel).

Low Gain R
Low Subband Gain
Rch

Stereophonic Optimizer

Sets the resultant
gain of the Low
band after the
adjustment of the
stereo sound (R
channel).

Low Level Low Level Isolator
Sets the level for
the low band.

Low Mute Low Mute Isolator
Switches the mute
for the low band.

Low Ratio Low Ratio

REV-X Hall, REV-X Room
Sets the adjustment
of the low
frequencies.

Multi Band Comp

Sets the
compression ratio
for the low
frequencies.

Low Threshold Low Threshold Multi Band Comp

Sets the minimum
input level for the
effect to be applied
to the low band.
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Lower Range Lower Range

VCM Auto Wah, VCM Touch Wah, VCM
Pedal Wah

Sets the maximum
value for the
variable range of
the Wah filter.

Control Flanger

Sets the maximum
value for the
variable range of
the Flanger Control.

Control Phaser

Sets the maximum
value for the
variable range of
the Phase Control.

LPF Cutoff
LPF Cutoff
Frequency

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Amp
Simulator 2, Comp Distortion, Noisy, Ring
Modulator, Dynamic Ring Modulator, Auto
Synth, Early Reflection, Gated Reverb,
Reverse Reverb, Auto Synth, Noisy

Sets the high
frequency range cut
by the Low-Pass
Filter.

LPF Resonance LPF Resonance Noisy

Adds
characteristics to
the input to the low
pass filter.
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M/S M/S Bit Crusher

When this
parameter is on,
each sound located
at the center, left,
and right changes
individually.

Make Up Gain Make Up Gain
Upward Compressor, Downward
Compressor

Adjusts the level of
the signal output
from the
compressor.
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Manual Manual

VCM Flanger
Sets the offset
value of the delay
modulation.

VCM Phaser Mono, VCM Phaser Stereo
Sets the offset
value of the phase
modulation.

Master Volume Master Volume
U.S. High Gain, British Lead, British
Legend

Adjusts the gain of
the power amplifier.

Mic Input Level Mic Input Level Vocoder
Sets the level of the
input from the
microphone.

Mic L-R Angle Mic L-R Angle

Rotary Speaker 1, Rotary Speaker 2,
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the L/R angle
of the microphone
for extracting sound
from the output.

Mic Out Gate
Mic Output Gate
Switch

Vocoder

Off: Always passes
HPF output and
Noise Generator
output.
On: Passes HPF
output and Noise
Generator output
when there is audio
input of the
Instrument sound.

Mic Position Mic Position
U.S. Combo, Jazz Combo, U.S. High
Gain, British Lead, British Combo, British
Legend, Rotary Speaker 2

Sets the relative
position of the
microphone to the
speaker.

Mid Middle
British Lead, British Legend, Jazz Combo,
U.S. High Gain

Sets the tone
quality of the mid
band.

Mid 1 Gain L
Mid1 Subband Gain
Lch

Stereophonic Optimizer

Sets the resultant
gain of the Mid1
band after the
adjustment of the
stereo sound (L
channel).
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Mid 1 Gain R
Mid1 Subband Gain
Rch

Stereophonic Optimizer

Sets the resultant
gain of the Mid1
band after the
adjustment of the
stereo sound (R
channel).

Mid 2 Gain L
Mid2 Subband Gain
Lch

Stereophonic Optimizer

Sets the resultant
gain of the Mid2
band after the
adjustment of the
stereo sound (L
channel).

Mid 2 Gain R
Mid2 Subband Gain
Rch

Stereophonic Optimizer

Sets the resultant
gain of the Mid2
band after the
adjustment of the
stereo sound (R
channel).

Mid 3 Gain L
Mid3 Subband Gain
Lch

Stereophonic Optimizer

Sets the resultant
gain of the Mid3
band after the
adjustment of the
stereo sound (L
channel).

Mid 3 Gain R
Mid3 Subband Gain
Rch

Stereophonic Optimizer

Sets the resultant
gain of the Mid3
band after the
adjustment of the
stereo sound (R
channel).

Mid Attack Mid Attack Multi Band Comp

Sets the length of
time for the
compressor to be
applied to the mid
frequencies.

Mid Cut Mid Cut U.S. Combo
Cuts the mid
frequencies.

Mid Gain Mid Gain Multi Band Comp
Sets the output
level for the mid
frequencies.
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Mid Level Mid Level Isolator
Sets the level for
the mid
frequencies.

Mid Mute Mid Mute Isolator
Switches the mute
for the mid
frequencies.

Mid Ratio Mid Ratio Multi Band Comp

Sets the
compression ratio
for the mid
frequencies.

Mid Sweep Mid Sweep U.S. Combo

Adjusts the
frequency range
over which the mid
frequencies are cut.

Mid Threshold Mid Threshold Multi Band Comp

Sets the minimum
input level for the
effect to be applied
to the mid band.

Mid Width Mid Width U.S. Combo
Sets the bandwidth
to cut the mid
frequencies.

Mix Mix VCM Flanger, Control Flanger
Sets the volume of
the effect sound.

Mix Level Mix Level Harmonic Enhancer
Sets the level of the
effect sound mixed
with the dry sound.

Mod Depth

Mod Depth
Noisy, Auto Synth, Tech Modulation,
Shimmer Reverb

Sets the depth of
the modulation.

Modulation Depth Rotary Speaker 2
Sets the depth of
cyclical changes in
the volume.

Mod Dpt Ofs R Mod Depth Offset R Auto Synth

Sets the offset to
the depth of the
modulation for the
R channel.

Mod Feedback Mod Feedback Noisy
Sets the level of
feedback to the
modulation.
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Mod Gain Mod Gain Tech Modulation
Sets the gain level
of the modulation.

Mod LPF Cutoff
Mod LPF Cutoff
Frequency

Tech Modulation

Sets the Cutoff
Frequency of the
Low-Pass Filter
applied to the
modulated sound.

Mod LPF Res
Mod LPF
Resonance

Tech Modulation

Adds
characteristics to
the modulated
sound by using the
Low-Pass Filter.

Mod Mix Mod Mix Balance Noisy, Tech Modulation
Sets the mix
balance of the
modulated sound.

Mod Phase Modulation Phase Classic Flanger
Sets the L/R phase
difference of the
modulated wave.

Mod Speed Mod Speed Noisy, Auto Synth, Tech Modulation
Sets the modulation
speed.

Mod Wave Type Mod Wave Type Auto Synth
Selects the wave
type for modulation.

Mode Mode

VCM Phaser Mono, VCM Phaser Stereo,
Control Phaser

Sets an element for
changing the
phaser type, or
more specifically,
the factor for
forming the phaser
effect.

British Combo
Switches the
preamplifier.

Modulator Lvl
Modulator Input
Level

Ring Modulator
Sets the modulator
level.

Move Speed Move Speed Talking Modulator

Sets how long it
takes to change to
the sound specified
by the Vowel
parameter.
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Noise Level
Background Noise
Level

VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the amount of
background noise.

Noise Level Noise Level

Vocoder
Sets the level of the
noise input.

Digital Turntable
Sets the noise
level.

Noise LPF Q Noise LPF Q Digital Turntable

Sets the
Resonance of the
Low-Pass Filter
applied to the
noise.

Noise Switch
Background Noise
Off/On

VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Turns the
background noise
on or off.

Noise Tone Noise Tone Digital Turntable
Sets the tone
quality of the noise.

Normal Normal British Combo
Adjusts the volume
of the sound with
flat EQ response.

Ns Gate Atk Noise Gate Attack NoiseGate+Comp+Eq
Sets the length of
time for the Noise
Gate to be applied.

Ns Gate Rls
Noise Gate
Release

NoiseGate+Comp+Eq
Sets the length of
time for the Noise
Gate to be inactive.

Ns Gate Thrs
Noise Gate
Threshold

NoiseGate+Comp+Eq

Sets the minimum
input level for the
Noise Gate to be
applied.

Ns LPF Cutoff
Noise LPF Cutoff
Frequency

Digital Turntable

Sets the frequency
to cut by using the
Low-Pass Filter
applied to the
noise.

Ns Mod Depth Noise Mod Depth Digital Turntable
Sets the depth of
the noise
modulation.
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Ns Mod Speed Noise Mod Speed Digital Turntable
Sets the speed of
the noise
modulation.
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Offset Filter Offset
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the initial pitch
value in semitones.

Ofs Transition
Offset Transition
Rate

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the transition
time for the Offset
value to change to
the new value.

On/Off Switch On/Off Switch

Isolator
Turns the isolator
on or off.

Stereophonic Optimizer
Turns the effect on
or off.

Osc Freq
OSC Frequency
Coarse

Ring Modulator
Sets the frequency
for modulating the
input wave.

Osc Freq Fine
OSC Frequency
Fine

Ring Modulator

Finely adjusts the
frequency for
modulating the
input wave.

Output Output
VCM Auto Wah, VCM Touch Wah, VCM
Pedal Wah

Sets the output
level.

Output Level Filter Output Level Control Filter
Sets the output
level of the filter.
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Output Level Output Level

Amp Simulator 1, Amp Simulator 2, Comp
Distortion, Comp Distortion Delay, U.S.
Combo, Jazz Combo, U.S. High Gain,
British Combo, British Lead, British
Legend, Multi FX, Small Stereo, VCM
Compressor 376, Classic Compressor,
VCM EQ 501, Talking Modulator, Lo-Fi,
Bit Crusher, Vinyl Break, Beat Repeat,
Rotary Speaker 2, Downward
Compressor, Upward Compressor,
Parallel Compressor, Presence, Wave
Folder, VCM Mini Filter, VCM Mini
Booster

Sets the output
level.

Vocoder
Sets the output
level of the
Vocoder.

Output Level 1 Output Level1 Pitch Change
Sets the output
level on the first
routing.

Output Level 2 Output Level2 Pitch Change
Sets the output
level on the second
routing.

Overdrive Overdrive

Amp Simulator 1, Amp Simulator 2, Comp
Distortion, Comp Distortion Delay, VCM
Auto Wah, VCM Touch Wah, VCN Pedal
Wah

Sets the level of
distortion.
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Pan 1 Pan 1 Pitch Change
Sets the pan on the
first routing.

Pan 2 Pan 2 Pitch Change
Sets the pan on the
second routing.

Pan AEG Min Lvl Pan AEG Min Level Slice

Sets the minimum
level of the
Amplitude EG
applied to the
panned sound.
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Pan AEG Type Pan AEG Type Slice

Sets the type of
Amplitude EG
applied to the
panned sound.

Pan Depth Pan Depth Slice
Sets the depth of
the pan.

Pan Direction Pan Direction Auto Pan
Sets the Auto Pan
type.

Pan Type Pan Type Slice Sets the pan type.

Panning Panning Jazz Combo
Sets the spread of
the Chorus/Vibrato.

Pedal Control Pedal Control VCM Pedal Wah
Controls the Cutoff
Frequency of the
Wah filter.

Phase Control Phase Control Control Phaser
Sets the depth of
the phase
modulation.

Phase Differ
LFO Phase
Difference

Tempo Flanger, Tremolo

Sets the L/R phase
difference of the
modulated wave.
(No phase
difference for 0 deg
or the value 64.)

Phase Reset LFO Phase Reset Tempo Flanger, Tempo Phaser, Slice
Sets how the initial
phase of the LFO is
reset.

Phase Shift Ofs Phase Shift Offset Tempo Phaser
Sets the offset
value of the phase
modulation.

Phaser Sw Phaser SW Multi FX
Sets the Phaser
type.

Pitch 1 Pitch 1 Pitch Change, Shimmer Reverb
Sets the pitch for
the first routing in
semitones.

Pitch 2 Pitch 2 Pitch Change, Shimmer Reverb
Sets the pitch for
the second routing
in semitones.
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P1/P2 Balance
Pitch 1/Pitch 2
Balance

Shimmer Reverb

Sets the volume
balance of the
pitch-shifted sound
on the first routing
and the pitch-
shifted sound on
the second routing.

P1&P2 Dly Ofs
Pitch 1 & Pitch 2
Delay Offset

Shimmer Reverb

Sets the delay
offset value for the
pitch-shifted sound
on the first routing
and the pitch-
shifted sound on
the second routing.

P1&P2 Panning
Pitch 1/Pitch 2
Panning

Shimmer Reverb

Sets the pan for the
pitch-shifted sound
on the first routing
and the pitch-
shifted sound on
the second routing.

Pitch Sweep Pitch Sweep Beat Repeat
Sets the pitch to
change gradually in
each repetition.

Plate Type Plate Type HD Plate
Sets how the sound
resonates.

Play Speed Play Speed Beat Repeat
Sets the playback
speed.

PM Depth PM Depth G Chorus, 2 Modulator, Tremolo
Sets the depth of
the pitch
modulation.

Post-comp HPF Post-comp HPF
Upward Compressor, Downward
Compressor

Sets the Cutoff
Frequency of the
High-Pass Filter
which follows the
compressor.

Pre Mod HPF F
Pre Mod HPF
Cutoff Frequency

Tech Modulation

Sets the Cutoff
Frequency of the
High-Pass Filter
before modulation
is applied.
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Preamp Preamp British Lead
Sets the gain of the
preamplifier.

Pre-Delay Pre-Delay Shimmer Reverb
Sets the delay time
for the early
reflections.

Pre-LPF Cutoff
Pre-LPF Cutoff
Frequency

Lo-Fi

Sets the Cutoff
Frequency of the
Low-Pass Filter for
cutting the high
frequency.

Pre-LPF Res
Pre-LPF
Resonance

Lo-Fi

Adds
characteristics to
the input to the
Low-Pass Filter.

Presence Presence

Presence
Sets the level of the
effect.

Amp Simulator 1, Comp Distortion Delay
U.S. Combo, U.S. Hi Gain, British Lead,
British Legend

Boosts the high
frequencies.
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R/H Balance Rotor/Horn Balance Rotary Speaker 1, Rotary Speaker 2

Sets the volume
balance of the horn
(treble) and rotor
(woofer).

Random Random Beat Repeat
Creates random
repetition.

Ratio Ratio
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Sets the ratio of the
compressor.

Release Release
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Sets the length of
time it takes until
the compressor
effect fades away.

Release Curve Release Curve
Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the release
curve of the
envelope follower.
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Release Time Release Time

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the release
time of the
envelope follower.

Beat Repeat
Sets the release
time of the gate for
the entire sound.

Repeat Repeat Beat Repeat
Sets the Repeat on
or off.

Resonance Resonance

Dynamic Filter, Control Filter, VCM Mini
Filter, VCM Mini Booster

Adds
characteristics to
the filter.

Beat Repeat

Sets the
Resonance of the
filter for the effect
sound.

Resonance Ofs Resonance Offset
VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Sets the offset
value to the
Resonance.

Retrigger Cycle Retrigger Cycle Beat Repeat
Sets the cycle for
retriggering the
repeat.

Reverb Delay Reverb Delay
R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator

Sets the delay time
from the early
reflections to the
reverb.

Reverb Time Reverb Time

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, HD Hall,
HD Room, HD Plate

Sets the reverb
length.

Room Size Room Size
REV-X Hall, REV-X Room, Early
Reflection, HD Hall, HD Room, Gated
Reverb, Reverse Reverb

Sets the size of the
room.

Rotor Accel Rotor Acceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Sets the rotation
speed of the rotor
(woofer) to change
from Slow to Fast.

Rotor Decel Rotor Deceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Sets the rotation
speed of the rotor
(woofer) to change
from Fast to Slow.
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Rotor Fast Rotor Speed Fast

Rotary Speaker 1, Rotary Speaker 2,
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the rotation
speed of the rotor
(woofer) for the
Fast setting.

Rotor Level Rotor Level
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the volume of
the rotor (woofer).

Rotor Slow Rotor Speed Slow

Rotary Speaker 1, Rotary Speaker 2,
VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Sets the rotation
speed of the rotor
(woofer) for the
Slow setting.

Rotor Slow/Fast
Rotor Slow/Fast
Time

Rotary Speaker 1

Sets the transition
time for the rotation
speed of the rotor
(woofer) to change
from Slow to Fast.

Rtg Attack T
Retrigger Attack
Time

Beat Repeat
Sets the Attack time
of the Gate applied
to the entire sound.

Rtg Gate Time
Retrigger Gate
Time

Beat Repeat
Sets the gate time
of the entire sound.

Rtg Quantize Retrigger Quantize Beat Repeat

When this
parameter is set to
On, the sound is
repeated at the
beginning of the
measure set in the
built-in sequencer.

Rtg Release T
Retrigger Release
Time

Beat Repeat
Sets the Release
time of the gate for
the entire sound.
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Sample Rate Sample Rate Bit Crusher
Lowers the Sample
Rate.

Sampling Freq
Sampling
Frequency Control

Lo-Fi
Controls the
sampling frequency.
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SC EQ Freq
Side Chain EQ
Frequency

Downward Compressor, Upward
Compressor

Sets the frequency
of the EQ used for
detecting the
compressor level.

SC EQ Gain
Side Chain EQ
Gain

Downward Compressor, Upward
Compressor

Sets the gain of the
EQ used for
detecting the
compressor level.

SC EQ Q Side Chain EQ Q
Downward Compressor, Upward
Compressor

Sets the Q of the
EQ used for
detecting the
compressor level.

Scale Type
Spiral Step Scale
Type

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets how to create
changes when the
Step Mode is set to
Scale.

Semitones
Spiral Step
Semitones

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Specifies the
variation width in
semitones when the
Step Mode is set to
Semitone.

Send to Noise Dry Send to Noise Digital Turntable
Sets the level of the
dry signal sent to
the noise effect.

Sensitivity Sensitivity

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the sensitivity
of the modulation
applied to the input
change.

VCM Touch Wah

Sets the sensitivity
of the Wah filter’s
change applied to
the input change.

SEQ Clock SEQ Clock Wave Folder
Adjusts the speed
of the built-in
sequencer.

SEQ Depth SEQ Depth Wave Folder
Adjusts the depth of
the effect on the
built-in sequencer.
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SEQ Pattern SEQ Pattern Wave Folder
Select the pattern
on the built-in
sequencer.

SEQ Ph Reset SEQ Phase Reset Wave Folder
Sets the mode for
resetting the built-in
sequencer.

SEQ Variation SEQ Variation Wave Folder
Changes the
behavior of the
built-in sequencer.

Shimmer Fdbk Shimmer Feedback Shimmer Reverb

Adjusts the
feedback level of
the pitch-shifted
sound.

Shimmer Gain Shimmer Gain Shimmer Reverb
Adjusts the level of
the pitch-shifted
sound.

Shimmer HPF
Shimmer HPF
Frequency

Shimmer Reverb

Sets the Cutoff
Frequency of the
High Pass Filter for
cutting the low
frequency of the
pitch-shifted sound.

Shimmer LPF
Shimmer LPF
Frequency

Shimmer Reverb

Sets the Cutoff
Frequency of the
Low Pass Filter for
cutting the high
frequency of the
pitch-shifted sound.

Side Bit Side Bit Bit Crusher
Reduces the bit
precision for the
side chain.

Side Chain EQ
Side Chain EQ
Switch

Downward Compressor, Upward
Compressor

Turns the EQ used
for detecting the
compressor level
on or off.

Side Chain Lvl
Side Chain Input
Level

VCM Compressor 376, Classic
Compressor, Dyna Flanger, Dyna Phaser,
Dyna Ring Mod, Dyna Filter, Multi Band
Comp

Sets the level of the
input to the control
circuit for Side
Chain.
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Side Smpl Rate Side Sample Rate Bit Crusher
Reduces the
Sample Rate for the
Side.

Size Size Shimmer Reverb
Sets the apparent
size of the reverb
space.

Smpl Rate Link Sample Rate Link Bit Crusher

Sets the level of the
Side setting that
follows the Mid
value when M/S is
on.

Space Type Space Type Space Simulator
Selects the space
simulation type.

Speaker Air Speaker Air
U.S. Combo, Jazz Combo, U.S. High
Gain, British Lead, British Combo, British
Legend

Emphasizes the
characteristics of
the speaker
cabinet.

Speaker Type Speaker Type

Amp Simulator 1, Comp Distortion Delay
Selects the speaker
simulation type.

U.S. Combo, Jazz Combo, U.S. High
Gain, British Lead, Small Stereo, British
Combo, British Legend, Multi FX

Sets the speaker
type.

Speed Speed

VCM Flanger

Sets the frequency
of the LFO wave
which controls the
cyclic change of the
delay modulation.

VCM Phaser Mono, VCM Phaser Stereo

Sets the frequency
of the LFO wave
which controls the
cyclic change of the
phase modulation.

VCM Auto Wah
Sets the speed of
the LFO.

Vinyl Break
Sets the length of
time for the sound
to stop.

Speed Adjust Speed Adjust Vinyl Break
Finely adjusts the
speed.
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Speed Control Speed Control

Rotary Speaker 1, Rotary Speaker 2
Switches the
rotation speed
(Slow or Fast).

VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Switches the
rotation speed
(Slow, Stop, or
Fast).

Spiral Spiral Switch
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Turns the LFO On
or Off.

Spiral Speed Spiral Speed
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the speed of
the pitch change.

Spiral Sync Spiral Sync
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the standard
cycle for changing
the pitch in steps.

Spread Spread
Ensemble Detune, VCM Flanger, VCM
Phaser Stereo, Control Phaser

Sets how the sound
spreads.

Stage Stage
VCM Phaser Mono, VCM Phaser Stereo,
Tempo Phaser, Dynamic Phaser, Control
Phaser

Sets the number of
steps for the phase
shifter.

Step Mode Spiral Step Mode
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the pitch to
change
continuously
(smoothly) or in
steps.

Step Transition
Spiral Step
Transition Rate

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Sets the transition
time for the pitch to
change in steps.
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Texture Texture
Parallel Compressor, Presence, VCM
Mini Filter, VCM Mini Booster

Creates various
changes to the
texture of the effect.

Threshold Threshold
Comp Distortion, Classic Compressor,
Downward Compressor, Upward
Compressor

Sets the input level
for the effect to be
applied.
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Threshold Level
Dyna Threshold
Level

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Sets the minimum
level at which the
envelope follower
starts.

Time Sweep Time Sweep Beat Repeat

Creates a gradual
change in the time
length with each
repetition.

Tone Tone
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Sets the tone
control.

Tone Shift Tone Shift British Lead
Switches the
characteristic of the
tone control.

Transition Rate
Delay Transition
Rate

Control Delay

Sets the transition
speed for changing
the current Delay
Time to the new
value.

Treble Treble
British Combo, British Lead, British
Legend, Jazz Combo, U.S. High Gain

Adjusts the tone
quality of the treble.

Type Type

VCM Flanger, Control Flanger
Selects the flanger
type.

VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Selects the Wah
type.

Early Reflection, Gated Reverb, Reverse
Reverb

Selects the
reflection type.

US High Gain, British Lead
Selects the
amplifier type.

Analog Delay Retro, Analog Delay
Modern

Sets the character
of the delay.

Parallel Compressor
Sets the
compressor type.

Mini Filter, Mini Boost Sets the filter Type.
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Upper Range Upper Range

VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Sets the maximum
value for the
variable range of
the Wah filter.

Control Flanger

Sets the maximum
value for the
variable range of
the Flanger Control.

Control Phaser

Sets the maximum
value for the
variable range of
the Phase Control.
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Vib Speed Vib Speed Jazz Combo

Sets the speed of
the vibrato.
Available when
Chorus is set to
Vib.

Vocoder Attack Vocoder Attack Vocoder
Sets the Attack
value of the
Vocoder output.

Vocoder Rls Vocoder Release Vocoder
Sets the Release
value of the
Vocoder output.

Volume Volume U.S. Combo, Jazz Combo
Sets the level of the
preamp.

Vowel Vowel Talking Modulator
Selects a vowel
type.
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Wah Pedal Wah Pedal Multi FX
Sets the position of
the Wah pedal.

Wah Sw Wah SW Multi FX Sets the Wah type.

565



Display name Parameter name Effect types using the parameter Description

Wall Vary Wall Vary Space Simulator

Sets the wall type
of the simulated
room. Higher
values produce
more diffuse
reflections.

Width Width Space Simulator
Sets the width of
the simulated room.

Width High Width High Stereophonic Optimizer
Adjusts the stereo
balance of the High
band.

Width Low Width Low Stereophonic Optimizer
Adjusts the stereo
balance of the Low
band.

Width Mid 1 Width Mid1 Stereophonic Optimizer
Adjusts the stereo
balance of the Mid1
band.

Width Mid 2 Width Mid2 Stereophonic Optimizer
Adjusts the stereo
balance of the Mid2
band.

Width Mid 3 Width Mid3 Stereophonic Optimizer
Adjusts the stereo
balance of the Mid3
band.

Word Length Word Length Lo-Fi

Sets the resolution
of the sound, or
how coarse the
sound is.
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By simultaneously pressing the [SHIFT] button and another button, you can use the shortcut
operations to instantly access the functions shown below.

Operation Function

[SHIFT] + Knob 1–8
Switches Knobs to high-precision mode or in smaller
increments (slows down value changes).
Convenient when making fine adjustments to values.

[SHIFT] + [EDIT/ ] Calls up the Copy/Exchange screen.

[SHIFT] + KNOB POSITION [LEFT]
Registers the Assign 1–8 value assigned to the knob to
the KNOB POSITION [LEFT] button.

[SHIFT] + KNOB POSITION [MID]
Registers the Assign 1–8 value assigned to the knob to
the KNOB POSITION [MID] button.

[SHIFT] + KNOB POSITION [RIGHT]
Registers the Assign 1–8 value assigned to the knob to
the KNOB POSITION [RIGHT] button.

[SHIFT] + [PAGE JUMP]
Calls up the parameter being edited on the Main display to
the Sub display.

[SHIFT] + [PART SELECT]
Enables the PART buttons for turning the solo setting on
or off.

[SHIFT] + [KEYBOARD CONTROL]
Enables the PART buttons for turning the mute setting on
or off.

[SHIFT] + [1–8/9–16]
Enables the PART buttons and sliders to switch between
Parts 9–16.

[SHIFT] + [COMMON]
Selects Common for Elements, Operators, and
Oscillators.

[SHIFT] + PART [1]–[8]
Selects one from Element 1–8, Operator 1–8, Oscillator
1–3, and Noise.

[SHIFT] + OCTAVE [−] Sets the transpose value to −1 (decrease).

[SHIFT] + OCTAVE [+] Sets the transpose value to +1 (increase).

[SHIFT] + OCTAVE [−] + OCTAVE [+] Sets the transpose value to 0 (reset).

[SHIFT] + SCENE [1]–[8]
Registers the created Scene to one of the SCENE [1]–[8]
buttons.

Shortcut operations

Using the [SHIFT] button
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Operation Function

[SHIFT] + [DEC/NO]
Sets the selected parameter value to −10 (decrease).
Returns to the previous page on the Live Set screen.

[SHIFT] + [INC/YES]
Sets the selected parameter value to +10 (increase).
Moves to the next page on the Live Set screen.

[SHIFT] + [ARP ON/OFF] Calls up the Arp Edit screen.

[SHIFT] + [MSEQ ON/OFF] Calls up the Motion Seq Edit screen.

[SHIFT] + [CONTROL ASSIGN] Calls up the Control View screen.

[SHIFT] + [LATCH] Calls up the Ribbon Settings screen.

[SHIFT] + [PERFORMANCE] Calls up the Property screen (Home screen only).

[SHIFT] + [LIVE SET] Moves to the Live Set Register screen.

[SHIFT] + [CATEGORY SEARCH]
Opens the Part Category Search screen for the selected
Part.

[SHIFT] + [UTILITY] Displays the parameter value.

[SHIFT] + [NAVIGATION] Calls up the FX OVERVIEW screen.

[SHIFT] + [QUICK SETUP] Calls up the Effect Switch screen.

[SHIFT] + [STORE] Calls up the Load screen.

[SHIFT] + [SPLIT]
Calls up the Home screen with the Part—Note view
selected.

[SHIFT] + [SONG/PATTERN] Calls up the Rhythm Pattern screen.

[SHIFT] + [TEMPO/TAP]
Activates the panel lock function on or off. (Only on the
Home screen or Live Set screen.)

[SHIFT] + Slot number [1]
Selects the first tab on the first column on the left side of
the screen.

[SHIFT] + Slot number [2]
Selects the second tab on the first column on the left side
of the screen.

[SHIFT] + Slot number [3]
Selects the third tab on the first column on the left side of
the screen.

[SHIFT] + Slot number [4]
Selects the fourth tab on the first column on the left side of
the screen.

[SHIFT] + Slot number [5]
Selects the fifth tab on the first column on the left side of
the screen.

[SHIFT] + Slot number [6]
Selects the sixth tab on the first column on the left side of
the screen.
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Operation Function

[SHIFT] + Slot number [9]
Selects the first tab on the second column on the left side
of the screen.

[SHIFT] + Slot number [10]
Selects the second tab on the second column on the left
side of the screen.

[SHIFT] + Slot number [11]
Selects the third tab on the second column on the left side
of the screen.

[SHIFT] + Slot number [12]
Selects the fourth tab on the second column on the left
side of the screen.

[SHIFT] + Slot number [13]
Selects the fifth tab on the second column on the left side
of the screen.

[SHIFT] + Slot number [14]
Selects the sixth tab on the second column on the left side
of the screen.

[SHIFT] + [A/D INPUT ON/OFF] Calls up the Audio In Edit screen.

[SHIFT] + [PORTAMENTO] Calls up the Pitch Edit screen.

[SHIFT] + [ASSIGN 1]/[ASSIGN 2] Calls up the Control Settings screen.

Operation Function

[DAW REMOTE] + Slot number [1] Calls up the DAW Remote screen in Track mode.

[DAW REMOTE] + Slot number [2] Calls up the DAW Remote screen in Plugin mode.

[DAW REMOTE] + Slot number [3] Calls up the DAW Remote screen in Transport mode.

[UTILITY] + [DAW REMOTE] Moves to the Touch Panel Calibration Setting screen.

Operation Function

[QUICK SETUP] + Slot number [5] Selects Standalone for Quick Setup.

[QUICK SETUP] + Slot number [6] Selects Quick Setup 1.

[QUICK SETUP] + Slot number [7] Selects Quick Setup 2.

[QUICK SETUP] + Slot number [8] Selects Quick Setup 3.

Operation Function

OCTAVE [−] + OCTAVE [+] Resets octave shift.

Using the [DAW REMOTE] button

Using the [QUICK SETUP] button

OCTAVE buttons
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Operation Function

[SHIFT] + OCTAVE [−] Sets the transpose value to −1 (decrease).

[SHIFT] + OCTAVE [+] Sets the transpose value to +1 (increase).

[SHIFT] + OCTAVE [−] + OCTAVE [+] Resets the transpose value.

You can toggle between Internal and External by quickly pressing the corresponding PART
button twice.
When switched to External, the Part name is displayed in blue.

Operation Function

[CATEGORY] Resets Bank/Favorite to All.

[QUICK EDIT] Resets to Selected Part.

[A/D INPUT ON/OFF] Turns the function on.

Quickly pressing the button twice

Holding down the button
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Message Description Required operation

** library will be
overwritten.

The Library file with the same
name has already been loaded
when you tried to load a library. The
existing data will be overwritten
when the new data is loaded.
The name of the Library file you are
attempting to load is displayed in
place of **.

** Control Assign full.

Could not carry out the operation
because there is no controller set
available. The Part name you are
attempting to add to the controller
set is displayed in place of “**.”

Delete the unnecessary controller set and
redo the operation.

** will be deleted.
Data will be deleted as a result of
this operation.

** will be loaded to
Pattern.

The .mid file will be loaded to the
Pattern.

** will be loaded to
Song.

The .mid file will be loaded to the
Song.

** will be loaded. The file will be loaded.

** will be overwritten.

When saving, the Performance,
file, folder, or Quick Setup with the
same name already exists. The
existing data will be overwritten
when saved.
The name of the Performance, file,
folder, or Quick Setup that you are
attempting to save is displayed in
place of “**.”

Activate the source
controller to assign.

You can assign parameters to the
controller you are about to operate.

Operate the controller that you wish to
assign.

Advanced settings will
be initialized.

Initializes the settings of the
[UTILITY] → Settings → Advanced
tab.

Message List
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Message Description Required operation

All data and libraries
will be initialized.
Unsaved user data will
be lost.

Restores the factory default
settings.

It is recommended to save any necessary
settings you wish to keep to a USB flash
drive in advance.

All data is initialized
upon power-on.

The instrument has been set to
restore factory defaults when the
instrument is turned on.

All data will be
overwritten by **

When loading is performed, all data
will be overwritten.
The name of the backup file you
are attempting to load is displayed
in place of “**.”

All Favorite Marks will
be cleared.

All Favorite marks will be deleted.

All settings will be
initialized. User data is
kept.

The settings for the instrument will
be initialized. The User data will not
be deleted.

All sound will be
stopped during
optimization.

The internal memory will be
restored.

All user data will be
initialized. Unsaved
user data will be lost.

The User area in the User memory
will be initialized. It is
recommended to save any
necessary settings you wish to
keep to a USB flash drive in
advance.

Arpeggio bypass
disabled.

The Arpeggio Bypass has been
deleted.

Arpeggio full.
Could not carry out the operation
because the Arpeggio is full.

Assignable knob full.
Could not carry out the operation
because all assignable knobs are
used in the controller set.

Delete any unnecessary controller set that
has an assignable knob set as a Source
and redo the operation.

Audio file is not found.
The specified audio file cannot be
found.

Audio Rec stopped due
to lack of memory
space.

Audio recording stopped
automatically because the USB
flash drive is full.

Use a new USB flash drive or delete
unnecessary files and try this operation
again.
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Message Description Required operation

Audition full.
Could not carry out the operation
because the User Audition data is
full.

Delete unnecessary User Audition data
from: [UTILITY] → Contents → Data Utility
screen.

Auto power off
disabled.

The Auto Power Off function has
been disabled.

Bulk data protected.
Bulk data cannot be received
because of the setting.

Can’t process.
Cannot process the requested
operation.

Can’t register unstored
performance.

Cannot register the Performance to
the Live Set because the bank or
program number being edited has
not yet been set.

Completed.
The specified load, save, format, or
other Job has been completed.

Connecting to USB
device...

Connecting the USB flash drive to
the instrument.

Converting Pattern to
Song.

The Pattern is being converted.

CPU Fan Error
The built-in cooling fan has
stopped.

This condition may cause the internal
temperature to rise and the instrument may
stop working.
Immediately back up all necessary data,
turn off the instrument and contact your
Yamaha dealer.

Current user data will
be overwritten by **.

User data already exists at the
destination for the file to be loaded.
If you proceed, the existing user
data will be overwritten.
The name of the User file you are
attempting to load is displayed in
place of “**.”

Curve full
Could not carry out the operation
because the User Curve data is
full.

Delete unnecessary User Curve data from:
[UTILITY] → Contents → Data Utility
screen.

Data memory full.

(When loading a Library file) The
content data in the library cannot
be saved because the instrument
memory is full.
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Message Description Required operation

Device number is off.
The bulk data cannot be sent or
received because the device
number is off.

Device number
mismatch.

The bulk data cannot be sent or
received because the device
number does not match.

Dividing the drum track
makes new
performance data.
Performance full.

Cannot carry out the operation
because there is no Performance
available for using Divide Drum
Track.

Dividing the drum track
makes new
performance data. You
can’t undo this
operation.

A new Performance will be created
by using Divide Drum Track. This
operation cannot be undone.

File is not found.
There are no files for the selected
type.

File or folder already
exists.

A file or folder with the same
already exists.

File or folder path is
too long.

Cannot open the specified file or
folder because its path name is too
long.

Folder is not empty.
You are attempting to delete a
folder that contains data.

Folder is too deep.
Cannot open the folder because it
is nested too deep in the folder
structure.

Illegal bulk data.
An error occurred while receiving
bulk data or bulk requests.

Illegal file name. The file name is invalid.

Illegal file.
The specified file cannot be
handled or loaded into this
instrument.

Illegal parameters.
Incorrect parameters have been
specified.

Illegal sample data.
The specified sample data is not
supported.
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Message Description Required operation

Illegal smart morph
data.

The specified Smart Morph data is
not supported.

Keybank full.
While loading, the total number of
keybanks exceeds the maximum
number.

Keyboard control lock
disabled.

The Keyboard Lock has been
disabled.

Knob value stored.
The Knob Value has been stored
(saved).

Library full.
The total number of libraries
exceeds the maximum number.

Micro Tuning full
Could not be loaded because the
User Micro Tuning data is full.

Delete unnecessary User Micro Tuning
data from: [UTILITY] → Contents → Data
Utility screen.

MIDI buffer full.
Could not be processed because
an excessively large amount of
MIDI data was received at once.

MIDI checksum error.
The checksum of the received
System Exclusive message is
incorrect.

No data.
There is no data in the selected
track or specified range.
Select the range again.

No read/write authority
to the file.

No read or write permissions for
this file.

Note ranges will be
initialized.

The Note Range will be initialized.

Now initializing all
data…

The factory settings are being
restored.

Now initializing… Some data is being initialized.

Now loading... The file is being loaded.

Now receiving MIDI
bulk data...

The instrument is receiving MIDI
bulk data.

Now saving... The file is being saved.

Now transmitting MIDI
bulk data...

The instrument is sending MIDI
bulk data.

Panel unlocked. The panel lock has been disabled.
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Message Description Required operation

Part *** will be
overwritten.

There is already a Part at the copy
destination. If you continue the
operation, the existing Part at the
copy destination will be overwritten.

Part full.
Could not open the Rhythm Pattern
screen because there were no
Parts available.

Delete the unnecessary Part(s) and redo
the operation.

Pattern full.
Could not carry out the operation
because the Pattern is full.

Pattern will be
converted to Song.

The Pattern will be converted to a
Song.

Performance data in ***
will be loaded.

The Performance Data in the file
for a past model will be loaded.

Performance full.
Could not carry out the operation
because the Performance is full.

Please connect USB
device.

Connect a USB flash drive.

Please keep power on. Writing data in the flash ROM.

Do not turn off the instrument while this
message is shown.
If the instrument is turned off while this is
displayed, User data may be lost or the
system may be corrupted, preventing the
system from starting properly the next time
the instrument is turned on.

Please reboot to
enable the new Audio
I/O Mode.

Restart the instrument to enable
the changes to the audio input and
output settings.

Please reboot to
enable the new USB
Driver Mode.

Restart the instrument to enable
the changes to the USB driver
mode settings.

Please reboot to
maintain internal
memory.

Restart the instrument to repair the
instrument memory.

Please stop audio
play/rec.

Stop audio recording or playback,
and then try again.

Please stop sequencer.
Stop the sequencer (Pattern or
Song), and then try again.
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Message Description Required operation

Please store the
pattern to change the
chain play mode.

Store the Pattern before changing
the chain playback mode.

Please wait… Processing. Please wait.

Press [SHIFT] +
[TEMPO/TAP] to unlock
panel.

Panel Lock has been enabled.
Press [SHIFT] + [TEMPO/TAP] to
unlock the panel.

Quick Setup ** is
loaded.

Quick Setup has been loaded.

Recall latest edits.
Recalls the last edited Performance
data and puts it in the edit buffer.

Redo **.

Carries out the operation again
(Redo) that had been undone.
The name of the operation is
displayed in place of “**.”

Sample is protected.
The sample is protected and
cannot be changed.

Sample is too long.
The sample size is too large and
cannot be loaded.

Sample is too short.
The sample size is too small and
cannot be loaded.

Sample memory full.
The memory for samples is full and
cannot be loaded.

Scene stored.
The Scene has been stored
(saved) to the SCENE button.

Selected items will be
copied to user bank.

The Performance will be copied to
the User Bank.

Smart Morph full.
The total number of Performances
with Smart Morph exceeds the
maximum number.

Some keybanks were
not loaded.

Some key banks are in the old
format and cannot be loaded.

Song/Pattern data
overload.

The Song or Pattern cannot be
played back because it is
overloaded.

Song full.
The total number of Songs exceeds
the maximum number.
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Message Description Required operation

SSS disabled. SSS has been disabled.

SSS enabled. SSS has been enabled.

Touch the white
square.

(During touch panel calibration) Tap
the white square that appears on
the display.

Turn on Memory
Switch to memorize **
into this scene.

To register a function to a Scene,
Memory (Memory Switch) for the
function must be turned on in
advance.

Turn on the switch from:
[PERFORMANCE] → Scene.

Undo **.
Cancels the last action (Undo).
The name of the operation is
displayed in place of “**.”

Unsupported USB
device.

This USB device is not supported
by this instrument.

USB connection
terminated.

The USB flash drive was shut off
due to abnormal current flow.

Disconnect the USB flash drive and then
press any button on the top panel.

USB device is full.
The USB flash drive is full and files
cannot be saved.

Use a new USB flash drive or delete
unnecessary files, and try this operation
again.

USB device is write-
protected.

The USB flash drive you are using
is write-protected.

USB device read/write
error.

An error occurred during read/write
to the USB flash drive.

USB device will be
formatted.

The USB flash drive will be
formatted.

User auditions will be
overwritten with stored
songs.

The existing User Audition will be
overwritten by the currently stored
Song.

VCM Rotary is disabled
except in Part 1.

The VCM Rotary can be used only
with Part 1. It cannot be used on
other Parts.

Voice data in *** will be
loaded.

The Voice Data in a file for a
previous model is loaded.

Waveform full.
The total number of waveforms
exceeds the maximum number.
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No sound? Wrong sound? When a problem like this occurs, make sure to check the
troubleshooting section before assuming that the product is faulty.
Many problems can be solved by carrying out Initialize All Data, after backing up your data to a
USB flash drive.
If the problem persists, consult your Yamaha dealer.

If not, calibrate the touchscreen.
[UTILITY] + [DAW REMOTE] → Calibrate Touch Panel

[UTILITY] → Settings  → System  → Calibrate Touch Panel

[UTILITY] → Settings  → System  → Calibrate Ribbon Controller

Since this instrument has no built-in speakers, it is necessary to connect amplifiers,
speakers, or headphones to hear any sounds.

When a foot controller is connected to the FOOT CONTROLLER jack, try moving the foot
controller.

When Local Control is set to Off, no sound is produced when you play the keyboard.
[UTILITY] → Settings  → MIDI I/O  → Local Control

Troubleshooting

The touchscreen response is poor

Is the cursor pointing to the precise location you have touched on the touchscreen?

The Ribbon Controller response is poor

Calibrate the ribbon controller.

No sound

Are all Control sliders set to appropriate levels (other than zero or minimum)?

Are any amplifiers, speakers, or headphones connected to the instrument?

Is this instrument as well as any connected devices turned on?

Have you made all the appropriate level settings—including the Master Volume on
this instrument and the volume settings on the connected device?

Is Local Control set to Off?

Is a blank Part selected?
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If so, assign a sound to the Part or select another Part.

When the Mute switch is turned on, no sound is produced when you play the keyboard.
[PERFORMANCE] → Part  selection → Mute

[PERFORMANCE] → Part  selection → Kbd Ctrl

When this parameter is turned on, the corresponding Part produces sound only via
Arpeggio playback.
[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings  →
Arp Play Only

[PERFORMANCE] → Part  selection → [EDIT/ ] → Arpeggio  → Common  →
Arp Play Only

If you are using a filter, try changing the cutoff frequency. Some cutoff settings may filter out
all of the sound.
[SHIFT] + [NAVIGATION]

[PERFORMANCE] → Common  selection → [EDIT/ ] → Effect

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection → Filter

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect

[PERFORMANCE] → Part  selection → [EDIT/ ] → Filter/Amp

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect

If so, set the parameters related to the A/D INPUT jacks to appropriate values, and then
play the keyboard while speaking or singing into the microphone connected to this
instrument. Check the A/D INPUT [GAIN] knob on the top panel is set to a value other than
0.
[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Routing

Is the Mute switch for each Part turned on?

Is the Keyboard Control of each Part turned off?

Is Arp Play Only of each Part turned on?

Are the MIDI volume or MIDI expression settings too low when using the external
controller?

Are the effect and filter settings appropriate?

For Normal Parts (AWM2) and Drum Parts

For Normal Parts (FM-X) and Normal Parts (AN-X)

Is Vocoder selected as the Insertion Effect Type of the Part?
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[PERFORMANCE] → Common  selection → [EDIT/ ] → Audio In

[UTILITY] → Settings  → Sound  → Tone Generator Volume

[PERFORMANCE] → Common  selection → [EDIT/ ] → General/Pitch  → Perf Settings
→ Volume

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings  →
Volume

[PERFORMANCE] → Part  selection → [EDIT/ ] → Part Settings  → General  →
Dry Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection →
Amplitude  → Level/Pan  → Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Operator  selection → Level  →
Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Oscillator  selection → OSC/Tune  →
Out Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection →
Osc/Tune

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings

[PERFORMANCE] → Part  selection → Element , Operator , or Oscillator  status on the
Navigation bar

Are the volume or level settings too low?

For Normal Parts (AWM2) and Drum Parts

For Normal Parts (FM-X)

For Normal Parts (AN-X)

Are the settings such as Element Switch, Note Limit, Velocity Limit, and Velocity
Offset appropriate?

For Normal Parts (AWM2) and Drum Parts

For Normal Parts (FM-X) and Normal Parts (AN-X)

Is the Mute switch for each Element or Operator of Part turned on?

With a Normal Part (FM-X), is the Carrier Level set to “0”?
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[PERFORMANCE] → Part  selection → [EDIT/ ] → Operator  selection → Level  →
Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings  →
Part Output

When Destination is set to Volume or Cutoff, no sound is produced depending on the
setting and controller status.
[PERFORMANCE] → Part  selection → [EDIT/ ] → Mod / Control  → Control Assign

[PERFORMANCE] → Common  selection → [EDIT/ ] → Audio In  → Mixing  →
A/D In Input Mode

Set to Mic when a microphone or any device with a low output level is connected. Set to
Line when an audio device, electronic instrument, or any device with a high input level is
connected.
[UTILITY] → Settings  → Audio I/O  → A/D Input

[PERFORMANCE] → Common  selection → [EDIT/ ] → Audio In  → Mixing  →
A/D In Volume

[PERFORMANCE] → Common  selection → [EDIT/ ] → Audio In  → Routing

Is the output setting of each Part turned off?

Are the controller settings appropriate?

No sound from the A/D INPUT jacks

Is the connected microphone turned on?

Is a dynamic microphone connected to the instrument?

Is the cable between the microphone or audio equipment and this instrument
properly connected?

Is the A/D INPUT [GAIN] knob turned to the minimum?

Is the A/D INPUT [ON/OFF] button turned on (lit)?

Check if the cable connection to the A/D INPUT jacks matches the Mono/Stereo
settings for the jack.

Check if the Mic or Line setting is appropriate.

Are the volume settings of the A/D Input Part too low?

Are the effect settings for the A/D Input Part appropriate?

Is the output setting of the A/D Input Part appropriate?
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[PERFORMANCE] → Common  selection → [EDIT/ ] → Audio In  → Mixing  →
A/D In Output Select

When Vocoder is selected as the Insertion Effect, the audio input from the A/D INPUT jacks
may not produce any sounds unless you play the keyboard.
[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Routing

Set this parameter to something other than always, since this setting always plays back the
click sound regardless of the sequencer status.
[UTILITY] → Tempo Settings  → Click Mode

The sound may be distorted depending on the effect type and settings.
[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect

Excessively high filter resonance settings can cause distortion.

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection → Filter

[PERFORMANCE] → Part  selection → [EDIT/ ] → Filter/Amp  → Filter Type

[UTILITY] → Settings  → Sound  → Tone Generator Volume

[UTILITY] → Settings  → Audio I/O

Check if the Vocoder effect is selected.

Playback continues without stopping

When the [KEYBOARD HOLD] button is on, try turning it off.

When the [ARP ON/OFF] button is on, try turning it off.

For the Pattern/Song/Audio screen, press the [ ] (Stop) button.

When an effect sound (such as Delay) continues and does not stop, change the
effect setting or select a different Performance.

When the click sound continues, check the following setting.

Distorted sound

Are the effect settings appropriate?

Are the filter settings appropriate?

For Normal Parts (AWM2) and Drum Parts

For Normal Parts (FM-X) and Normal Parts (AN-X)

Is the volume set too high?
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[PERFORMANCE] → Common  selection → [EDIT/ ] → General/Pitch  → Perf Settings
→ Volume

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings  →
Volume

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  selection → Amplitude  →
Level/Pan  → Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Key  selection → Level/Pan  → Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Operator  selection → Level  →
Level

[PERFORMANCE] → Part  selection → [EDIT/ ] → Oscillator  selection → OSC/Tune  →
Out Level

If you wish to play chords, set this parameter to Poly.
[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Part Settings  →
Mono/Poly

[UTILITY] → Settings  → Sound  → Tone Generator Tune

Normal Parts (AWM2)

For Drum Parts

For Normal Parts (FM-X)

For Normal Parts (AN-X)

The sound is cut off

Is the entire sound exceeding the maximum polyphony?

AWM2 (preset waveforms): 128 (both stereo and mono)

AWM2 (user or library waveforms): 128 (both stereo and mono)

FM-X: 128

AN-X: 16

Only one note sounds at a time

Check if the tone generation mode is set to Mono.

Wrong pitch

Is Tune set to a value other than 0?
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[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Pitch  → Note Shift

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch → Pitch  → Detune

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Pitch  →
Micro Tuning Name

[UTILITY] → Settings  → Sound  → Global Settings

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  selection → Element LFO  →
Pitch Mod

[PERFORMANCE] → Part  selection → [EDIT/ ] → Mod/Control  → 2nd LFO  →
Pitch Modulation Depth

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → Pitch LFO  →
Pitch LFO Depth

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection →
Osc/Tune  → Coarse

[PERFORMANCE] → Part  selection → [EDIT/ ] → Element  or Key  selection →
Osc/Tune  → Fine

[PERFORMANCE] → Part  selection → [EDIT/ ] → Operator  selection → Form/Freq  →
Coarse

[PERFORMANCE] → Part  selection → [EDIT/ ] → Operator  selection → Form/Freq  →
Fine

Is Note Shift or Detune set to a value other than 0?

When the Part produces a wrong pitch, have you selected a special temperament in
Micro Tuning?

Have you set a special temperament in Global Tuning?

When the Part produces a wrong pitch, is LFO Pitch Modulation Depth set too high?

For Normal Parts (AWM2)

For Normal Parts (FM-X)

For Normal Parts (AN-X)

When the Part produces a wrong pitch, are the Coarse Tune and Fine Tune settings
appropriate?

For Normal Parts (AWM2) and Drum Parts

For Normal Parts (FM-X)
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[PERFORMANCE] → Part  selection → [EDIT/ ] → Mod/Control  → Control Assign  →
Destination

[PERFORMANCE] → Part  selection → [EDIT/ ] → General/Pitch  → AN-X Settings

Check the effect settings by using [SHIFT] + [NAVIGATION].

[UTILITY] → Effect Switch

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Routing  → Var Send

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Routing  → Rev Send

[PERFORMANCE] → Common  selection → [EDIT/ ] → Effect  → Routing  →
Var Return

[PERFORMANCE] → Common  selection → [EDIT/ ] → Effect  → Routing  →
Rev Return

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Routing  → Connect

[PERFORMANCE] → Part  selection → [EDIT/ ] → Effect  → Ins A  or Ins B

You can simultaneously play back Arpeggios for up to eight Parts.

When the Part produces a wrong pitch, is the Controller Destination set to Pitch?

For an AN-X Part, is Voltage Drift set to an excessively large value?

No effect is applied

Is the Effect Switch off?

Is Variation Send or Reverb Send set to a value other than 0?

Is Variation Return or Reverb Return set to a value other than 0?

Is the Insertion Effect on all Elements or all Keys in the Part set to Thru?

(For System Effects) Is the effect type selected for each effect set to No Effect?

(For Insertion Effects) Is the effect type selected for each effect set to Thru?

Is the Insertion Switch setting appropriate?

Cannot start the Arpeggio

Is the [ARP ON/OFF] button on?

Check the number of Parts for which the Arpeggio switch is turned on.

Are the Note Limit and Velocity Limit settings for the Arpeggio appropriate?
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[PERFORMANCE] → Part  selection → [EDIT/ ] → Arpeggio  → Common

[PERFORMANCE] → Part  selection → [EDIT/ ] → Arpeggio  → Individual  → Name

When the Arpeggio switch is set to off, the Arpeggio will not be played back even when you
turn on the [ARP ON/OFF] button on the Top panel.
[PERFORMANCE] → Part  selection → Arp Part

[PERFORMANCE] → Part  selection → [EDIT/ ] → Arpeggio  → Common  → Hold

Memory space on the instrument can hold up to 128 Patterns and 128 Songs. If you
attempt to record more than 128 Songs or Patterns, you will get a Song full message, and
no more recording is possible.

[UTILITY] → Settings  → MIDI I/O  → MIDI IN/OUT

Turn on Receive Bulk.

Is the Arpeggio Type set to Off?

Check the Arpeggio switch settings for each Part.

Cannot stop the Arpeggio

If you cannot stop Arpeggio playback by releasing your finger from the key, change
the Arpeggio Hold switch to off.

Turn off the [KEYBOARD HOLD] button on the Top panel.

Pattern or Song playback does not start by pressing the [ ] (Play) button

Is there any data in the selected Pattern or Song?

Cannot record Pattern or Song

Is there any memory space available for recording a Pattern or Song?

Data communication between the instrument and the connected computer is not
working properly

Is the Port setting on the computer appropriate?

Have you selected the proper terminal (MIDI or USB) on the Utility screen?

MIDI Bulk dump data transmission or reception is not working properly

Is Receive Bulk protected?
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[UTILITY] → Settings  → Advanced  → MIDI Receive Bulk

[UTILITY] → Settings  → Advanced  → MIDI Device Number

[UTILITY] → Settings  → Advanced  → MIDI Device Number

Open the Save screen and set the device to a USB flash drive. Check to see if the free
storage space shown in the upper right corner of the screen is 0.0 KB.
[UTILITY] → Contents  → Save

Check the following URL for the list of USB devices that have been confirmed to work with
this instrument.
https://download.yamaha.com/

To enable the reception of data recorded by using the Bulk dump function of this
instrument, you must set the same device number for both transmission and
reception.

Is the same device number set to the connected MIDI device?

Cannot save to the USB flash drive

Is the USB flash drive write-protected?

Is there enough free space on the USB flash drive?

Are you using a USB flash drive that has been confirmed to work with this
instrument?

In the display, there are some black points (unlit) or white points (always lit)

This is a characteristic of color LCDs, and is not a malfunction.
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NOTICE

When the Initialize All Data function is carried out, all the Performances and songs in the
User memory you have stored, as well as the Utility settings for the overall keyboard
settings, will be overwritten with their defaults. Be careful not to lose important data.
Therefore, you should regularly save backups of important settings to a USB flash drive.

1. Open the settings screen from [UTILITY] → Settings → System.

This calls up the settings screen for the entire instrument.

2. Tap [Initialize All Data].

The confirmation screen appears.
To cancel the operation, tap the Cancel No button on the screen or press the [DEC/NO]
button on the top panel.

3. Tap the [Initialize Yes] button on the screen or press the [INC/YES] button
on the top panel.

The Initialize All Data operation is carried out.

Restoring the factory default settings (Initialize All Data)
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